ENVI EX User’s Guide
Legal
The IDL®, IDL Advanced Math and Stats™, ENVI®, ENVI Zoom™, and ENVI® EX software programs and the accompanying procedures, functions, and documentation described herein are sold under license agreement. Their use, duplication, and disclosure are subject to the restrictions stated in the license agreement. ITT Visual Information Solutions reserves the right to make changes to this document at any time and without notice.

Limitation of Warranty
ITT Visual Information Solutions makes no warranties, either express or implied, as to any matter not expressly set forth in the license agreement, including without limitation the condition of the software, merchantability, or fitness for any particular purpose. ITT Visual Information Solutions shall not be liable for any direct, consequential, or other damages suffered by the Licensee or any others resulting from use of the software packages or their documentation.

Permission to Reproduce this Manual
If you are a licensed user of these products, ITT Visual Information Solutions grants you a limited, nontransferable license to reproduce this particular document provided such copies are for your use only and are not sold or distributed to third parties. All such copies must contain the title page and this notice page in their entirety.

Export Control Information
The software and associated documentation are subject to U.S. export controls including the United States Export Administration Regulations. The recipient is responsible for ensuring compliance with all applicable U.S. export control laws and regulations. These laws include restrictions on destinations, end users, and end use.

Acknowledgments
ENV® and IDL® are registered trademarks of ITT Corporation, registered in the United States Patent and Trademark Office. ION™, ION Script™, ION Java™, and ENVI Zoom™ are trademarks of ITT Visual Information Solutions.

ESRI®, ArcGIS®, ArcView®, and ArcInfo® are registered trademarks of ESRI.

Portions of this work are Copyright © 2009 ESRI. All rights reserved.

PowerPoint® and Windows® are registered trademarks of Microsoft Corporation in the United States and/or other countries.

Macintosh® is a registered trademark of Apple Inc., registered in the U.S. and other countries.

UNIX® is a registered trademark of The Open Group.

Adobe Illustrator® and Adobe PDF® Print Engine are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Numerical Recipes™ is a trademark of Numerical Recipes Software. Numerical Recipes routines are used by permission.

GRG2™ is a trademark of Windward Technologies, Inc. The GRG2 software for nonlinear optimization is used by permission.

NCSA Hierarchical Data Format (HDF) Software Library and Utilities. Copyright © 1988-2001, The Board of Trustees of the University of Illinois. All rights reserved.

NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities. Copyright © 1998-2002, by the Board of Trustees of the University of Illinois. All rights reserved.

CDF Library. Copyright © 2002, National Space Science Data Center, NASA/Goddard Space Flight Center.


SMACC. Copyright © 2000-2004, Spectral Sciences, Inc. and ITT Visual Information Solutions. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyrighted by DataDirect Technologies, © 1991-2003.


Portions of this computer program are copyright © 1995-2008 Celartem, Inc., doing business as LizardTech. All rights reserved. MrSID is protected by U.S. Patent No. 5,710,835. Foreign Patents Pending.

Portions of this software were developed using Unisearch’s Kakadu software, for which ITT has a commercial license. Kakadu Software. Copyright © 2001. The University of New South Wales, UNSW, Sydney NSW 2052, Australia, and Unisearch Ltd, Australia.

This product includes software developed by the Apache Software Foundation (www.apache.org/).


Portions of this software are copyrighted by Merge Technologies Incorporated.

Support Vector Machine (SVM) is based on the LIBSVM library written by Chih-Chung Chang and Chih-Jen Lin (www.csie.ntu.edu.tw/~cjlin/libsvm), adapted by ITT Visual Information Solutions for remote sensing image supervised classification purposes. IDL Wavelet Toolan Copyright © 2002, Christopher Torrence.

IMSL is a trademark of Visual Numerics, Inc. Copyright © 1970-2006 by Visual Numerics, Inc. All Rights Reserved.

Other trademarks and registered trademarks are the property of the respective trademark holders.
Contents

Chapter 1: Introduction to ENVI EX........................................................................................7
  About ENVI EX.................................................................................................................. 8
  ENVI EX Documentation................................................................................................. 9

Chapter 2: The ENVI EX Interface .......................................................................................11
  The ENVI EX Interface..................................................................................................... 12
  Image Window .................................................................................................................. 13
  Status Bar ......................................................................................................................... 14
  Toolbars ............................................................................................................................. 15
  Enhancement Tools .......................................................................................................... 23
  Category Bars .................................................................................................................... 25
  Working with Layers ........................................................................................................... 32
  Cursor Value Window ....................................................................................................... 35
  Setting Preferences.......................................................................................................... 38
  Annotation Preferences...................................................................................................... 46
  Performance Tips and Tricks ............................................................................................. 50

Chapter 3: Opening and Displaying Data.............................................................................51
  Supported File Formats...................................................................................................... 52
  Opening Files in ENVI EX ................................................................................................. 53
  Displaying Large Images .................................................................................................. 55
  Quad Display and Data Reduction for Vector Layers......................................................... 56
  The Data Manager ............................................................................................................ 58
  Opening Remote Datasets ................................................................................................. 64
  Geo Link to ArcMap ........................................................................................................... 75

Chapter 4: Using Portals......................................................................................................77
  About Portals..................................................................................................................... 78
  Working with Portals ......................................................................................................... 79
## Contents

<table>
<thead>
<tr>
<th>Chapter 5: Image Processing</th>
<th>.85</th>
</tr>
</thead>
<tbody>
<tr>
<td>RX Anomaly Detection</td>
<td>.86</td>
</tr>
<tr>
<td>Pan Sharpening</td>
<td>.88</td>
</tr>
<tr>
<td>Vegetation Suppression</td>
<td>.90</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6: Using Workflows</th>
<th>.91</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Workflows</td>
<td>.92</td>
</tr>
<tr>
<td>About the Feature Extraction Workflow</td>
<td>.94</td>
</tr>
<tr>
<td>About the Classification Workflow</td>
<td>.133</td>
</tr>
<tr>
<td>About the Image Difference Change Detection Workflow</td>
<td>.141</td>
</tr>
<tr>
<td>About the Thematic Change Detection Workflow</td>
<td>.147</td>
</tr>
<tr>
<td>About the RPC Orthorectification Workflow</td>
<td>.150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7: Working with Vectors</th>
<th>.153</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Vectors</td>
<td>.154</td>
</tr>
<tr>
<td>Working with Vector Records</td>
<td>.155</td>
</tr>
<tr>
<td>Creating Vector Layers</td>
<td>.157</td>
</tr>
<tr>
<td>Creating Vector Records</td>
<td>.158</td>
</tr>
<tr>
<td>Editing Vector Records and Vertices</td>
<td>.160</td>
</tr>
<tr>
<td>Editing Vector Layer Properties</td>
<td>.168</td>
</tr>
<tr>
<td>Viewing Attributes</td>
<td>.169</td>
</tr>
<tr>
<td>Vector Tips and Tricks</td>
<td>.170</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8: Working with Feature Counting</th>
<th>.171</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Feature Counting</td>
<td>.172</td>
</tr>
<tr>
<td>Marking, Editing, and Deleting Features</td>
<td>.173</td>
</tr>
<tr>
<td>Saving the Feature Counting Layer</td>
<td>.175</td>
</tr>
<tr>
<td>Jumping to Features</td>
<td>.176</td>
</tr>
<tr>
<td>Restoring Features</td>
<td>.177</td>
</tr>
<tr>
<td>Viewing the Feature Counting Report</td>
<td>.178</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9: Working with Annotations</th>
<th>.179</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Annotations</td>
<td>.180</td>
</tr>
<tr>
<td>Creating Annotation Layers</td>
<td>.181</td>
</tr>
<tr>
<td>Adding Annotation Items to an Annotation Layer</td>
<td>.182</td>
</tr>
<tr>
<td>Editing Annotation Item Properties</td>
<td>.186</td>
</tr>
<tr>
<td>Deleting Annotation Items</td>
<td>.188</td>
</tr>
<tr>
<td>Annotation Tips and Tricks</td>
<td>.189</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10: Creating Output</th>
<th>.191</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving Files</td>
<td>.192</td>
</tr>
<tr>
<td>The Select Input File Dialog</td>
<td>.196</td>
</tr>
<tr>
<td>Chipping the Display</td>
<td>.198</td>
</tr>
<tr>
<td>Working with the Print Layout View</td>
<td>.201</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11: Working with the NITF Module</th>
<th>.205</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the NITF/NSIF Module and NITF for ArcGIS</td>
<td>.206</td>
</tr>
<tr>
<td>The NITF/NSIF Format</td>
<td>.207</td>
</tr>
<tr>
<td>Data Extension Segments and Tagged Record Extensions</td>
<td>.213</td>
</tr>
<tr>
<td>NITF Preferences</td>
<td>.218</td>
</tr>
<tr>
<td>Display Levels</td>
<td>.220</td>
</tr>
<tr>
<td>NITF Map Information</td>
<td>.222</td>
</tr>
<tr>
<td>Displaying NITF Images</td>
<td>.224</td>
</tr>
<tr>
<td>Viewing NITF Metadata</td>
<td>.225</td>
</tr>
<tr>
<td>Editing NITF Metadata</td>
<td>.227</td>
</tr>
<tr>
<td>Saving NITF Files</td>
<td>.229</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction to ENVI EX

In this chapter you will find:

About ENVI EX ................................................................. 8
ENVI EX Documentation .................................................. 9
About ENVI EX

ENVI EX is a powerful viewer with a dynamic display that allows for rapid viewing and manipulation of remotely sensed images, vectors, and annotations. The interface provides quick access to common display tools such as contrast, brightness, sharpening, and transparency. You can work with multiple layers of data at one time and in one window, use the Data Manager and Layer Manager to keep track of multiple datasets, and “punch through” layers to view and work with another layer or layers in the same window. In addition, ENVI EX will reproject and resample images and vectors on-the-fly. ENVI EX works seamlessly with ESRI layers and feature classes, and it allows you to create professional map presentations.

ENVI EX also contains the robust RX Anomaly Detection, Pan Sharpening, and Vegetation Suppression tools. The RX Anomaly Detection tool detects spectral or color differences between layers and extracts unknown targets that are spectrally distinct from the image background. Use Pan Sharpening to sharpen low spatial resolution multispectral data using high spatial resolution panchromatic data. The Vegetation Suppression tool allows you to remove the vegetation spectral signature from multispectral and hyperspectral imagery.

ENVI EX includes advanced image manipulation tools for GIS users that allow you to interactively visualize your data. With ENVI EX, you can perform image processing tasks quickly and easily from the Toolbox. The ENVI EX automated image analysis workflows take the complexity out of image processing. They provide step by step procedures and instructions to guide you through orthorectifying images, detecting thematic change or image differences in an area over time, finding features of interest over a wide area, and classifying land cover. All of the processing and analysis tools in ENVI EX are based on ENVI’s scientific algorithms and methods. ENVI EX is available at additional cost from ITT Visual Information Solutions or your ENVI distributor.

While anyone can take advantage of the display and enhancement tools, defense imagery analysts and other military personnel will find the optional NITF support to be a valuable addition to this software product. (Contact your ITT Visual Information Solutions sales representative to purchase a NITF/NSIF Module license.)

For a list of supported platforms, see the Installation and Licensing Guide.
ENVI EX Documentation

ENVI EX includes a robust, searchable Help system. From the menu bar, select Help > Contents, or click the Help button on the toolbar. Help pertaining to the step you are working on is also available from many dialogs in the application.

The application Help launches in your default web browser and is supported on Mozilla Firefox 1.x and later, Internet Explorer 5.5 and later, and Safari 1.31 and later. See the Release Notes for detailed information related to the Help tool on other browsers.

In addition to Help, the Installation and Licensing Guide details how to install and license ITT Visual Information Solutions software on your machine.
Chapter 2: The ENVI EX Interface

In this chapter you will find:

The ENVI EX Interface ................................................................. 12
Image Window .............................................................................. 13
Status Bar .................................................................................... 14
Toolbars ....................................................................................... 15
Enhancement Tools ..................................................................... 23
Category Bars ............................................................................. 25
Working with Layers ................................................................. 32
Cursor Value Window ............................................................... 35
Setting Preferences .................................................................... 38
Annotation Preferences ......................................................... 46
Performance Tips and Tricks .................................................... 50
The ENVI EX Interface

Following is a summary of the main components of the interface.

- **Menu bar**
- **Toolbars**
- **Category Bars**
  - Detach from the interface by clicking ▲ or expand or collapse by clicking ◀
- **Image window**
- **Portal**
- **Status Bar**
  - Right-click to select the contents to display in each of the Status bar segments.
- **Process Manager**
  - View and cancel actively running processes.
Image Window

The Image window displays an image at full resolution when you first load it. If the first layer loaded is a vector layer, the vector layer is scaled to fit within the Image window.

When you have a layer selected in the Layer Manager, the boundary of the selected layer is shown with a red border. The Image window resizes when you resize ENVI EX.

If your layer is large, the Image window displays the subsection of the image defined by the View box in the Overview window. To navigate a large image, use the Pan or Fly tools, or move the View box in the Overview window.

If your layer is relatively small, the Image window shows the full extent of the image displayed on a white canvas.

ENVI EX applies a default 2% linear stretch to every image loaded in the Image window.
Status Bar

The Status bar is the horizontal bar at the bottom of the ENVI EX interface. By default, for non-georeferenced files, the Status bar is initially blank. For georeferenced files, the Status bar displays the following information about the base layer in the Layer Manager:

- Latitude and longitude of the current location of the cursor in Degrees/Minutes/Seconds (dynamically updating as the cursor moves)
- Projection and datum

The Status bar displays information as you hover the cursor over either the Overview window or the Image window.

**Note:** The Status bar always displays information about the base layer in the Layer Manager, not about all layers loaded into the Layer Manager. For information on all layers, see "Cursor Value Window" on page 35. For more information on working with base layers, see "Base Layers" on page 29.

You can customize the information displayed in each segment of the Status bar. To change the type of information displayed in a segment, right-click in a segment and choose an option from the menu.

When you customize the Status bar contents using this method, the Status bar only retains the information for the current ENVI EX session. You can permanently set defaults for each segment by setting the Status Bar Segment 1, 2, 3 preference.

Process Manager

If you are running one or more processes (for example, **File > Save As**, building pyramids, or any of the Toolbox options, the right-most segment of the Status bar displays the process name and status for the oldest running process, along with an option to cancel the process (click the **Cancel Process** button). When all processes finish, this segment becomes blank.

As one or more processes are running, click the **Process Description** button to display a window that shows the name and status of each process, and the name of the input raster images. (See image above).
Toolbars

The toolbars allow you to perform common tasks in ENVI EX.

Note: If the toolbars are not fully visible, increase the size of the ENVI EX window.

Common Tools

The most common toolbar buttons include the following (in order from left to right):

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open]</td>
<td>Open</td>
<td>Open a supported file type.</td>
</tr>
<tr>
<td>![Data Manager]</td>
<td>Data Manager</td>
<td>Open the Data Manager.</td>
</tr>
<tr>
<td>![Cursor Value]</td>
<td>Cursor Value</td>
<td>Open the Cursor Value window.</td>
</tr>
<tr>
<td>![Undo]</td>
<td>Undo</td>
<td>Undo the last action. You can also undo the last action by selecting Edit &gt; Undo action from the menu bar.</td>
</tr>
<tr>
<td>![Redo]</td>
<td>Redo</td>
<td>Redo the last action. You can also redo the last action by selecting Edit &gt; Redo action from the menu bar.</td>
</tr>
<tr>
<td>![Select]</td>
<td>Select</td>
<td>For images: click this button to exit the Zoom, Fly, Crosshairs, Vector Edit, Pan, and Rotate tools. For vectors: click this button, then click in the Image window to select vector records in the active layer. ENVI EX highlights the selected vector records in cyan. If the layer has an attribute table, information about the selected vector record appears in the Cursor Value window. Use the Ctrl or Shift keys as you click to select multiple vector records. You can also click and drag to draw a box around the vector records to select. To deselect vector records, right-click and select Clear Selections. To select vector records for editing, use the Vector Edit tool. For annotations: Click this button, then click in the Image window to select annotation items in the active layer. ENVI EX selects the annotation items. Use the Ctrl or Shift keys as you click to select multiple annotation items. You can also click and drag to draw a box around the annotation items to select. To deselect annotation items, right-click and select Clear Selections. To move the selected items, click and drag. To delete the selected annotation items, right-click and select Delete.</td>
</tr>
</tbody>
</table>
Chipping

Use the **Chip to File** button 🖼️ to create a screen capture of the image and/or vector layers displayed in the Image window. See "Chipping the Display" on page 198 for details.

Panning

You can pan your display using the middle mouse button. Click and hold the button, then drag the display in any direction. You can also use the following toolbar buttons to pan:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄️ Pan</td>
<td>Pan the display in the Image window. Place the cursor in the Image window and do one of the following:</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>• Click and drag the display in any direction.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>• If your <strong>Default Middle Mouse Action</strong> preference setting is <strong>Pan</strong>, click the middle mouse button and drag the display in any direction. Panning is active when you are using the <strong>Select</strong>, <strong>Fly</strong>, <strong>Crosshairs</strong>, <strong>Vector</strong>, <strong>Feature Counting</strong>, <strong>Annotations</strong>, <strong>Rotate</strong>, or <strong>Zoom</strong> tools; you do not need to select the <strong>Pan</strong> button to activate it.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>• Click in the Image window, then press any arrow key to move 10 display pixels in the direction of the arrow. To move continuously in the direction of the arrow, hold down the arrow key.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>• Click in the Image window, press and hold the <strong>Ctrl</strong> key, then press any arrow key to move 2 display pixels in the direction of the arrow. To move continuously in the direction of the arrow, hold down the arrow key.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>• Click in the Image window, press and hold the <strong>Shift</strong> key, then press any arrow key to move 40 display pixels in the direction of the arrow. To move continuously in the direction of the arrow, hold down the arrow key.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Pan</td>
<td>To exit this tool, click the <strong>Select</strong> button.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Fly</td>
<td>Pan the display in the Image window in any direction. Place the cursor in the Image window and do one of the following:</td>
<td></td>
</tr>
<tr>
<td>🔄️ Fly</td>
<td>• Click and drag the display in the direction of the cursor arrow. To interactively change the panning direction, move the cursor around on the display.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Fly</td>
<td>• If your <strong>Default Middle Mouse Action</strong> preference setting is <strong>Fly</strong>, click and hold the middle mouse button and drag the display in the direction of the cursor arrow. Flying is active when you are using the <strong>Select</strong>, <strong>Pan</strong>, <strong>Crosshairs</strong>, <strong>Vector</strong>, <strong>Feature Counting</strong>, <strong>Annotations</strong>, <strong>Rotate</strong>, or <strong>Zoom</strong> tools; you do not need to select the <strong>Fly</strong> button to activate it.</td>
<td></td>
</tr>
<tr>
<td>🔄️ Fly</td>
<td>To exit this tool, click the <strong>Select</strong> button.</td>
<td></td>
</tr>
</tbody>
</table>
Crosshairs

Use the Crosshairs button to overlay crosshairs on the Image window. The Cursor Value window automatically opens when you enable Crosshairs. As you move the cursor around the Image window, the Cursor Value window displays information about the data under the crosshairs. If using crosshairs on a vector layer, be sure that any layer modifications are saved, to provide the most accurate data. You can do the following with crosshairs:

- Click anywhere in the Image window to move the crosshairs over the clicked pixel (for images), or over the nearest vertex (for vectors).
- Double-click anywhere in the Image window to center the crosshairs in the Image window over the clicked pixel (for images), or over the nearest vertex (for vectors).
- For images: Click and drag the crosshairs to a pixel. Release the mouse button to center the crosshairs on the pixel under the cursor.
- For images: Click any arrow key to move 1 screen pixel in the direction of the arrow. Use Ctrl + arrow keys to move 10 screen pixels and Shift + arrow keys to move 20 screen pixels.
- For vectors: Click and drag the crosshairs to snap to the nearest vertex in the active layer (if the nearest vertex is close to the cursor). Release the mouse button to center the crosshairs over the vertex. If no vertices are near the cursor, the crosshairs center on the canvas area under the cursor.
- For images: If using the Go To tool and Crosshairs together, the crosshairs intersection is positioned over the location you specify.

Vectors

Use the following tools for vector record creation and manipulation in your display. To exit any of these tools, click the Select button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Vector Create" /></td>
<td>Vector Create</td>
<td>Create new vector records in a vector layer. See &quot;Creating Vector Layers&quot; on page 157 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Vector Edit" /></td>
<td>Vector Edit</td>
<td>Edit vector records. See &quot;Editing Vector Records and Vertices&quot; on page 160 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Vertex Edit" /></td>
<td>Vertex Edit</td>
<td>Edit vector vertices or move points. See &quot;Editing Vector Records and Vertices&quot; on page 160 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Vector Join" /></td>
<td>Vector Join</td>
<td>Join polyline vector records. See &quot;Joining Polylines&quot; on page 161 for details.</td>
</tr>
</tbody>
</table>

You can undo actions until you save the vector layer, or until you revert to the layer that was last saved.

Feature Counting

Use the Feature Counting button to mark features displayed in the Image window. See "About Feature Counting" on page 172 for details.
Annotations

Use the following tools for annotation item creation and manipulation in your display.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Text Annotation" /></td>
<td>Text Annotation</td>
<td>Add a text annotation to an annotation layer. See &quot;Creating Text Annotations&quot; on page 182 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol Annotation" /></td>
<td>Symbol Annotation</td>
<td>Add a symbol annotation to an annotation layer. See &quot;Creating Symbol Annotations&quot; on page 182 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Polygon Annotation" /></td>
<td>Polygon Annotation</td>
<td>Add a polygon annotation to an annotation layer. See &quot;Creating Polygon Annotations&quot; on page 183 for details. This option also adds a point to point-based training data in the Classification workflow. See Interactively Creating Training Data for details.</td>
</tr>
<tr>
<td><img src="image" alt="Polyline Annotation" /></td>
<td>Polyline Annotation</td>
<td>Add a polyline annotation to an annotation layer. See &quot;Creating Polyline Annotations&quot; on page 183 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Rectangle Annotation" /></td>
<td>Rectangle Annotation</td>
<td>Add a rectangle or square annotation to an annotation layer. See &quot;Creating Rectangle Annotations&quot; on page 184 for details. This option also adds a point to point-based training data in the Classification workflow. See Interactively Creating Training Data for details.</td>
</tr>
<tr>
<td><img src="image" alt="Ellipse Annotation" /></td>
<td>Ellipse Annotation</td>
<td>Add an ellipse or circle annotation to an annotation layer. See &quot;Creating Ellipse Annotations&quot; on page 184 for details. This option also adds a point to point-based training data in the Classification workflow. See Interactively Creating Training Data for details.</td>
</tr>
<tr>
<td><img src="image" alt="Arrow Annotation" /></td>
<td>Arrow Annotation</td>
<td>Add an arrow annotation to an annotation layer. See &quot;Creating Arrow Annotations&quot; on page 185 for details.</td>
</tr>
<tr>
<td><img src="image" alt="Picture Annotation" /></td>
<td>Picture Annotation</td>
<td>Add a picture annotation to an annotation layer. See &quot;Creating Picture Annotations&quot; on page 185 for details.</td>
</tr>
</tbody>
</table>
Rotating

Use the following tools to rotate your display:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Rotate icon] | Rotate | Rotate the display in the Image window. If the display includes annotation layers, most annotation items rotate with the associated image (you can change the default for an item in the Rotate with View property). By default, text, symbol, and picture annotations do not rotate; they retain their original orientation. Place the cursor in the Image window and do one of the following:
- Click and drag the cursor to rotate clockwise or counter clockwise.
- Press an arrow key to rotate 5 degrees clockwise (down/right arrows) or counter clockwise (up/left arrows).
- Press and hold the Ctrl key, then press an arrow key to rotate 1 degree clockwise (down/right arrows) or counter clockwise (up/left arrows).
- Press and hold the Shift key, then press an arrow key to rotate 45 degrees clockwise (down/right arrows) or counter clockwise (up/left arrows).
To exit this tool, click the Select button. |
| ![Top Up icon] | Top Up | Rotate the display in the Image window so that objects (especially buildings) are oriented vertically with your monitor. If the image contains rational polynomial coefficient (RPC) information, ENVI EX uses that to compute the rotation angle. If the image does not contain RPC information, or if it uses a standard projection, ENVI EX rotates the display to 0 degrees. |
| ![North Up icon] | North Up | Rotate the display in the Image window so that North is at the top of the Image window. This option is only available for georeferenced images. |

Use the Rotate To drop-down list to select a fixed rotation angle (expressed in degrees) for the display in the Image window. Or, type your own degree of rotation and press Enter on your keyboard. This drop-down list interactively reports the current degree of rotation of the display when you use any rotation tool.

The following options are available from the Rotate To drop-down list (in degrees): 0, 90, 180, and -90.
Zooming

You can zoom in and out on the display using the mouse wheel. Wheel up to zoom in and wheel down to zoom out. You can also use the following tools to zoom in or out:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom</td>
<td>Zoom in on the display in the Image window. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Roll the mouse wheel to zoom in and out by a fixed percentage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click and drag over an area to draw a rubber-band box and zoom in on that area.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click once on the display to center the display on that location and zoom in by a fixed percentage.</td>
</tr>
<tr>
<td></td>
<td>Fixed Zoom In</td>
<td>Click button to zoom into the center of the display in the Image window by a fixed percentage (the default is 1.25x, which can be set using the &quot;Display General Preferences&quot; on page 41).</td>
</tr>
<tr>
<td></td>
<td>Fixed Zoom Out</td>
<td>Click button to zoom out from the center of the display in the Image window by a fixed percentage (the default is 1.25x, which can be set using the Display General Preferences).</td>
</tr>
</tbody>
</table>

Use the Zoom To drop-down list to select a fixed zoom extent (expressed as a percentage, followed by a ratio) for the display in the Image window. Or, type your own zoom percentage and press Enter on your keyboard. The default value is 100%. This drop-down list interactively reports the current zoom factor of the display when you use any zoom tool. The following options are available:

- 800% (8:1)
- 500% (1:2)
- 3.125% (1:32)
- 400% (4:1)
- 250% (1:4)
- 1.563% (1:64)
- 200% (2:1)
- 12.5% (1:8)
- 0.781% (1:128)
- 100% (1:1)
- 6.25% (1:16)
- Full Extent

Pyramids must be built before zooming out will work efficiently. See "Pyramid Preferences" on page 44 for pyramid preference settings.

Go To

Use the Go To tool to jump to a specific location in an image and center the Image window over that location. If Crosshairs are enabled, the crosshairs intersection is positioned over the location you specify.

1. Enter the coordinates in the Go To field, using one of the entry formats in the table below. You can also copy a location from the Cursor Value window and paste it in the Go To field.
2. Press Enter.

ENVI EX stores the locations you enter during your session in the Go To drop-down list. To jump to a stored location, select the desired location from the drop-down list.
**Note:** If you use the **Go To** tool and the layer is not selected (that is, you clicked outside of any valid data region, but are still in the canvas), then ENVI EX uses the bottom layer for the geographic jump.

Separate coordinate values with a comma, a space, or a comma and a space:

<table>
<thead>
<tr>
<th>Entry Type</th>
<th>Valid Entry Formats</th>
</tr>
</thead>
</table>
| **Lat, Lon** | Enter the values in decimal degrees format or in degrees, minutes, seconds format. If the values fall within -180 to 180 for x and -90 to 90 for y, ENVI EX assumes the coordinates are lat/lon (for example, 179.9, 89.9). One exception to the range provided above is 1.0, 1.0, which goes to file coordinates.  
Decimal degrees format examples:  
40.004036, 105.219047  
40.004036N, 105.219047W  
40.0481N, 105.3420W  
Degrees, minutes, seconds examples:  
40 0 14.53, 105 13 8.57  
40 0 14.53N, 105 13 8.57W  
40 0’34.34”N, 105 13’46.20”W |
| **FileX, FileY** | Enter the value as x,y points. If both values are integers, or are outside the range used for lat/lon, ENVI EX assumes they are file coordinates.  
File x,y format examples:  
181.1, 91.1  
169, 79  
29, 45 |
| **MapX, MapY** | Enter the value as x,y points. If the x and y values are greater than 30,000, ENVI EX assumes it is a map coordinate.  
Map x,y format examples:  
481168, 4426792  
481872.8250, 4427702.4750  
482970.42, 4427702.47 |
| **PixelX, PixelY** | Enter the value as x,y points, optionally following one of the values with a “p.” If x and y values are greater than 30,000, append a "p" to one of the values to indicate it is a pixel coordinate, not a map coordinate.  
Pixel x,y format examples:  
38p, 45  
433.5, 469.5  
-0.1039p, 0.749 |
Mensuration

Use the **Mensuration** tool  to measure distance and azimuthal direction on an image. Toggle the **Mensuration** tool on, select the Arrow or Polyline annotation tool and draw an annotation to calculate distance and direction (degrees relative to North). Multi-segment polylines will calculate and display distance for each segment as well as the total distance of the entire polyline. For Geographic Lat/Lon images, distance is calculated using the average latitude between the two endpoints of the line being measured. Distance and direction are displayed in the Cursor Value window. By default, georeferenced images will display distance in meters, Non-georeferenced images will display distance in pixels. Set the default measurement units using the Mensuration Units Preference.

Portals

Use the following tools to add and control a Portal in your display:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Blend]</td>
<td>Blend</td>
<td>Gradually transitions the display from one layer to another. See &quot;Blending&quot; on page 81 for details.</td>
</tr>
<tr>
<td>![Flicker]</td>
<td>Flicker</td>
<td>Toggles between two layers at a desired speed. See &quot;Flickering&quot; on page 81 for details.</td>
</tr>
<tr>
<td>![Swipe]</td>
<td>Swipe</td>
<td>Spatially transitions from one layer to another, using a vertical dividing line that moves between two overlapping layers. See &quot;Swiping&quot; on page 82 for details.</td>
</tr>
</tbody>
</table>
Enhancement Tools

Enhancement tools let you interactively control the amount of brightness, contrast, stretching, and transparency for the selected image layer. For each tool, you can click and drag the slider or enter a value in the adjacent field. You can also use the following options to change slider values:

- Click on the slider bar to the right or left of the indicator or click the slider then use the Page Up or Page Down keys to move the slider value up or down incrementally by 10.
- Click on the icons to the right or left of the slider bar or click the slider then use the arrow keys on the keyboard to move the slider value up or down incrementally by one. The up/right arrow keys increase the enhancement; the left/down arrow keys decrease it.
- Click the slider then use the Home key to move the slider to 100 and the End key to move the slider to 0.
- Click the Reset button for the tool to return to the default value.
- Click the Undo or Redo buttons, or select Edit > Undo action or Edit > Redo action from the menu bar to undo and redo actions.

The value in the adjacent field interactively updates as you move the slider using any of the options listed, and the Image window immediately shows the results.

**Note:** If the enhancement tools are not fully visible, increase the size of the ENVI EX window.

**Brightness**

Click and drag the Brightness slider or type a number in the adjacent field to darken or brighten the display of the selected image. The valid range for this slider is 0 (dark) to 100 (bright). Click the Reset Brightness button to return to the default value of 50. The Brightness slider is disabled when viewing paletted images (for example, classification images) and vector layers.

**Contrast**

Click and drag the Contrast slider or type a number in the adjacent field to adjust the contrast of the selected image. The valid range for this slider is 0 (low contrast) to 100 (high contrast). Click the Reset Contrast button to return to the default value of 20. The Contrast slider is disabled when viewing paletted images (for example, classification images) and vector layers.

**Stretch Types**

A default 2% linear stretch is automatically applied to any image you open in ENVI EX. To specify a different contrast stretch for your image, select an option from the Stretch Types drop-down list:

- **No stretch:** Do not apply a contrast stretch to the image.
- **Linear:** This option is selected by default unless the data requires an optimized linear stretch (see Optimized Linear description). Apply a 2% linear stretch to the image. To enter a different percent stretch, type a new value in the Stretch Percent field in the interactive stretch dialog.
- **Equalization:** Apply a histogram equalization stretch to the image.
Enhancement Tools

- **Gaussian**: Apply a Gaussian stretch to the image. The default standard deviation value is 0.3. To enter a different standard deviation, type a new value in the **Stretch Percent** field in the interactive stretch dialog.

- **Square Root**: Takes the square root of the input histogram then applies a linear stretch. The default value is 0.5. To enter a different square root value, type a new value in the **Stretch Percent** field in the interactive stretch dialog.

- **Logarithmic**: Apply a logarithmic stretch on the image.

- **Optimized Linear**: Apply an optimized linear stretch, also known as a dynamic range adjustment, to the image. By default, unsigned integer data (e.g. TIFF, NITF, JPIP, and ENVI) use the optimized linear stretch as the default for display, rather than the linear stretch. The optimized linear stretch has a dynamic range set that is optimal for integer data. This stretch provides the maximum amount of information from not only the midtones, but also from the shadow and highlight regions of this data type. Images stretched using this stretch type prohibit use of the Contrast enhancement.

Click the **Reset Stretch Type** button to return to the stretch type defined in the **Default Image Stretch** preference.

The stretch tool is not available for vector layers.

**Interactive Stretching**

The **Interactive Stretch** button is available when you select **Linear**, **Equalization**, **Gaussian**, **Square root**, or **Logarithmic** from the **Stretch Types** drop-down list.

Clicking this button opens an Interactive Stretch dialog that allows you to adjust the contrast of the selected image using a histogram. Click and drag the vertical dotted bars to interactively stretch the RGB colors, or type values in the adjacent fields and press **Enter** on your keyboard (or click outside of the field). You can change the default value used in **Linear**, **Gaussian**, or **Square Root** stretch types by typing a value into the **Stretch Percent** field in this dialog. The Image window updates automatically as you change the stretch.

Images with single-band lookup tables cannot be interactively stretched.

Click outside of the dialog or press **Esc** on your keyboard to close the Interactive Stretch dialog.

**Sharpen**

Click and drag the **Sharpen** slider or type a number in the adjacent field to blur or sharpen the display of the selected image. The valid range for this slider is 0 (blurry) to 100 (sharp). Click the **Reset Sharpen** button to return to the default value of 10. The **Sharpen** slider is disabled when viewing paletted images (for example, classification images) and vector layers.

**Transparency**

Click and drag the **Transparency** slider or type a number in the adjacent field to make your image or vector layer more opaque or transparent. The valid range for this slider is 0 (opaque) to 100 (transparent). Click the **Reset Transparency** button to return to the default value of 0.
Category Bars

ENVI EX includes three category bars: the Overview window, the Layer Manager, and the Toolbox.

You can expand or collapse each of these categories by clicking the ▼ arrow next to the category name. You can also detach a category from the main window by clicking the Detach button on the category bar. A detached category displays as a separate dialog that you can move anywhere on your screen or drag to a second monitor. To re-attach a category, click the Close button (X) on the top right corner of the dialog. ENVI EX retains expand, collapse, attach, or detach category changes you make from one session to the next.

The vertical bar that separates the categories from the Image window collapses and expands the entire category view. You can detach the categories you wish to see and then click on the vertical bar to collapse the category view and maximize your image display.

When you are working in the Image window, any detached windows go behind the Image window.

Overview Window

The Overview window provides a view of the full extent of the layers loaded into the Image window. Each time you display a new layer, the Overview window resizes to encompass the extents of all layers in the Image window. If you have an image selected in the Layer Manager, the selected image displays in the Overview window with a red border. The Overview window is not populated until ENVI EX builds supporting files (reduced resolution data sets or pyramids for images, rasterized file for vector layers); therefore, it may appear blank for several seconds while these files are being built. See "Displaying Large Images" on page 55 and "Quad Display and Data Reduction for Vector Layers" on page 56 for details.

By default, vector layers automatically display in the Overview window. However, you can choose to hide the display of all vector layers in the Overview window for the current ENVI EX session. To toggle vector layers on or off in the Overview window, right-click in the window and select Show Vectors. This option temporarily overrides the Show Vectors preference setting.

Note: ESRI layers do not display in the Overview Window.

In addition to detaching the Overview window (described in "Category Bars" on page 25), you can resize the detached window by clicking and dragging any of its sides or corners. When you resize the window, it maintains the aspect ratio of the contained canvas.

The Undo and Redo toolbar functions and Edit > Undo action and Edit > Redo action items from the menu bar are not available for actions performed in the Overview window.

View Box

The View box is a small, partially transparent window inside the Overview window that shows the extent of the imagery visible in the Image window:
• Click and drag any side or corner of the View box to resize it and therefore change the extent of the imagery in the Image window. If you click and drag a side, the View box adjusts shape to maintain the proper aspect ratio of the Image window.

• Increase or decrease the size of the View box (by clicking and dragging a corner), to zoom in or out on the image displayed in the Image window.

• Click inside of the View box and drag it to any location within the Overview window to dynamically update the Image window.

• Click outside of the View box in the Overview window to re-center the View box on the spot where you clicked.

• As you pan and zoom in the Image window, the View box changes location and size, respectively, in the Overview window.

By default, the Overview window shows the path history of the View box as you move it. The path history displays as a yellow highlight. To toggle the path history display on or off, right-click in the Overview window and select Show Path History. To clear the current path history display, right-click in the Overview window and select Clear Path History.

Images with Different Extents

The View box behaves differently when you are viewing multiple images with different extents. Following is an example of two layers with different extents, shown in the Overview window:
If your View box is within the smaller of the two layers and you remove the larger layer (by right-clicking the larger layer name in the Layer Manager and selecting **Remove Selected Layer**), the View box stays where it is and the Overview window updates to show the full extent of the smaller layer.

If your View box is outside of the smaller layer and you remove the larger layer, the Overview window updates to show the extent of the smaller layer. However, the View box remains in its previous location and is therefore no longer visible. Click once in the Overview window to bring it back into view.
If you expand the View box so that it is larger than the smallest layer, and you remove the larger layer, the Overview window updates to show the extent of the smallest layer. However, the View box now covers the entire layer, so its edges are not visible. Drag the View box diagonally inside the Overview window until you see an edge. Then, resize it to a smaller size so that you can see the entire View box. You can also zoom in on the image using the zoom tools on the toolbar, therefore making the View box smaller and more accessible.

Layer Manager

You can display multiple image, vector, and annotation layers in one ENVI EX session. The Layer Manager lists these layers in a tree view and lets you manage how the layers are displayed in the Image window and Overview window. In addition to expanding or collapsing the Layer Manager, as described in "Category Bars" on page 25, you can also expand and collapse individual layers in the Layer Manager tree by clicking the + or - next to the layer name.

Displaying Layers

Layer names and information display as follows in the Layer Manager.

Image Layers

From image files, you can create new RGB or grayscale combinations using the same multispectral file and you can display each as a layer in the Layer Manager tree. This is helpful, for example, if you want to create separate true-color and color-infrared layers for the same file. For example, you can use Landsat TM Bands 1, 2, and 3 to render a true-color layer, and you can use Bands 2, 3, and 4 to render a color-infrared layer.

Image layers are listed with an icon to the left of the layer name. The icon indicates the image type ( for grayscale, for RGB). Band names appear under the layer name, with wavelength information in parentheses. If you display additional layers with the same filename (for example, displaying different band combinations), sequential numbering appears in brackets to the left of the duplicate layer names (for example, [1] bldr_sp.img). The name of the original layer you displayed is not numbered.

Vector Layers

Vector layer names are listed with an icon to the left of the layer name. The icon indicates the vector type ( for points or multipoints, for polygons, for polylines) and is displayed in the same color as the loaded layer. As with image layers, if you display additional layers with the same name, sequential numbering appears in brackets to the left of the duplicate layer names, and the original layer is not numbered.
Annotation Layers

Annotation layers are listed with the \textcolor{red}{\text{\textbullet}} icon to the left of the layer name. The annotation items are listed below the layer name as item types, with icons to the left of the type (\textcolor{red}{\text{\textbullet}} Text, \textcolor{blue}{\text{\textbullet}} Symbol, \textcolor{red}{\text{\textbullet}} Polygon, \textcolor{red}{\text{\textbullet}} Rectangle, \textcolor{red}{\text{\textbullet}} Ellipse, \textcolor{red}{\text{\textbullet}} Polyline, \textcolor{red}{\text{\textbullet}} Arrow \textcolor{red}{\text{\textbullet}} Picture). The icon color matches the color of the actual annotation item.

NITF annotation layers are named as Annotation # and are listed with the \textcolor{red}{\text{\textbullet}} icon to the left of the layer name. NITF annotation segments (objects) are listed under the layer name with colored icons to the left of the segment type (see above).

ESRI Layers

ESRI layer files are listed with an icon to the left of the layer name and legend patches showing examples of map symbols (points, lines, rectangles) below the layer name. The layer icon indicates the layer type (\textcolor{red}{\text{\textbullet}} for raster, \textcolor{blue}{\text{\textbullet}} for points, \textcolor{red}{\text{\textbullet}} for lines and polygons). Legend patches are described in ArcMap Help.

Portal Layers

Portal layers are listed as the name of the layer shown in the Portal names are not necessarily unique, as it is possible to create two or more Portals from the same layer. Because Portal names do not need to be unique, they are not sequentially numbered.

Feature Counting Layer

The feature counting layer is listed as a single layer with the \textcolor{red}{\text{\textbullet}} icon next to it. This layer does not display individual feature counting items below the layer name.

Training Data Layers

The training data layer, used to created training areas for classification, is listed as a single layer with the \textcolor{red}{\text{\textbullet}} icon to the left of the layer name Training Areas. The training data polygons are listed below the layer name as \textcolor{red}{\text{\textbullet}} Polygon.

Base Layers

The first layer loaded into the Layer Manager that contains map information is the base layer. This layer defines the map projection and resolution. Subsequent layers loaded into the Layer Manager are reprojected on-the-fly to match the base layer projection. If the data being loaded into the layer has no associated map information, ENVI EX assumes it matches the projection and pixel size of the base layer, so no resampling or reprojection is done.

Because the base layer defines the projection and resolution, you should always load images with map information or with higher resolution into ENVI EX first. If you load an image with a higher resolution into ENVI EX after one with a lower resolution and map information, ENVI EX reprojects the higher resolution image to match the projection of the lower resolution image, without losing resolution.

Images that only contain rational polynomial coefficient (RPC) information or a pseudo projection cannot be used as a base layer when using other layers with projection information because they are not rectified standard projections.
If an image contains both RPC and traditional map projection information, ENVI EX will not save the RPC information to the file header when you save the image to ENVI raster format.

In addition to setting the projection and resolution, the base layer defines the information that displays in the Status bar and provides the information for the **Zoom To** drop-down list.

**GeoTIFF Map Information**

ENVI EX reads and writes ellipsoid semimajor and semiminor axes in GeoTIFF files, and it also saves non-standard datum information. These values are stored in the following GeoTIFF structure fields:

```
GEOGSEMIAXISGEOKEY
GEODEMORAXISGEOKEY
```

For radial datums, the semimajor and semiminor axis values are the same; these are double-precision, floating-point values.

A `GEOGCITATIONGEOKEY` structure field stores the string value of the datum name.

RPC information, affine map transformations (kx/ky or pseudo projections), and custom projections are not retained when saving a file to TIFF or GeoTIFF format.

**Selected Layers**

Each time you open a new data file in ENVI EX, the layer appears at the top of the Layer Manager and becomes the **selected** layer. To select a layer, click its name in the Layer Manager. The boundary of the selected layer displays with a red border in the Image window and Overview window. The purpose of a selected layer is to allow you to apply a display enhancement (brightness, contrast, transparency, etc.) to that layer only, without affecting other layers.

**Active Layers**

Vector and annotation layers in ENVI EX can be the selected layer, but for editing purposes they also need to be designated as the **active layer**. Specifying the active layer is necessary when you have multiple layers of the same type open, as it indicates the layer you want to edit. Vector and annotation layers are independent; if you have one or more of each layer type loaded, there will be one active vector layer and one active annotation layer.

ENVI EX tools are applied differently to vector and annotation layers, depending on the tool. Vector, Annotation, and Crosshairs tools work on the **active** layer, but the transparency and Go To tools work on the **selected** layer, just as they do with imagery. The selected layer may or may not be the same layer as the active layer at any given time. For example, you may add new vector records to the active layer, then click to select a vector layer in the Layer Manager and apply transparency to that layer.

When working with active layers:

- When you create or load a new vector or annotation layer, it becomes the active layer for that layer type.
- To change the active layer for a layer type, right-click on a layer name in the Layer Manager and select **Set as Active Layer** or **Set As Active Annotation Layer**. The icon next to the active layer’s name is highlighted by a red box for vectors or a cyan box for annotations, and the right-click menu option **Set as Active Layer** or **Set As Active Annotation Layer** is disabled.
• When you have an active vector layer and an active annotation layer loaded and you are alternating between the two, select the appropriate tool button from the toolbar. For example, select a Vector tool if you want to edit the active vector layer.

• For vector layers, if you modified the active layer, ENVI EX prompts you to save the changes before you can set a new active layer. Save the changes if you want to keep them; otherwise, they are discarded.

• Reordering layers in the Layer Manager does not change which layer is the active layer. When you remove the active layer from the Layer Manager, another displayed layer automatically becomes the active layer.
Working with Layers

You can do the following with layers:

Ordering Layers

You can control the order of layers in the Image window and Overview window by dragging and dropping layers in the Layer Manager tree or by using menu options. To use the menu options, right-click on a layer name in the Layer Manager and select Order, or select Edit > Order Layer from the menu bar and select one of the following options:

- **Bring to Front**: Bring the layer to the front.
- **Send to Back**: Send the layer to the back.
- **Bring Forward**: Bring the layer one step closer to the front.
- **Send Backward**: Send the layer one step toward the back.

Removing Layers

You can remove a layer from the Layer Manager and close the display of that layer in the Image window. Though the layer no longer appears in the Layer Manager, its image, vector, or annotation file still remains open in the Data Manager.

To remove a single layer, perform one of the following steps:

- Right-click on a layer name in the Layer Manager, and select Remove.
- Select the layer name in the Layer Manager, then select Edit > Remove Selected Layer from the menu bar.

To remove all layers that are currently open, perform one of the following steps:

- Right-click on the Layers folder in the Layer Manager, and select Remove All.
- Select Edit > Remove All Layers from the menu bar.

**Note**: Removing annotation layers from NITF files is disabled in ENVI EX.

Hiding Layers

By default, all layers in the Layer Manager are displayed in the Overview window and the Image window. You can temporarily hide the display of a layer so that you can work with other layers in the Image window. To do this, right-click on a layer name in the Layer Manager, and disable the Show option to turn off the display of that layer in the Overview window and the Image window. Right-click on a hidden layer and enable the Show option to turn on the display of that layer. For vector layers, you can also set the default for a layer in the vector’s Properties dialog described in "Editing Vector Layer Properties" on page 168.

To toggle showing all vector layers in the Overview window on or off, right-click in the Overview window and select Show Vectors. You can change the system default setting for this via the Show Vectors preference.

Zoom Options

For images, right-click on a layer name in the Layer Manager, select Zoom To Layer, and choose one of the following options:
• **Full Extent:** Zoom to the full extent of the layer. If you display two or more layers and you select this zoom option for one layer, the Image window updates to show the full extent of both layers, not just the selected layer.

• **Full Resolution:** Zoom to the full resolution (1:1) of the layer.

For vectors, right-click on a layer name in the Layer Manager and select **Full Extent**.

If you display two or more layers and you select this zoom option for one layer, the Image window updates to show the full extent of both layers, not just the selected layer.

### Loading a Layer into a New Portal

Right-click on a layer name in the Layer Manager, and select **Display In Portal** or click the **Portal** button. This button is only available when two or more layers are displayed in the Layer Manager. Portal layers are shown in a separate Portals directory within the Layer Manager. For more information on Portals, see "About Portals" on page 78.

### Sending Images to ArcMap from the Layer Manager

Right-click on `.shp` and `.evf` files in the Layer Manager and select **Send to ArcMap** to open the files in ArcMap.

If ArcMap is not already running, ENVI EX will initiate it for you. The dataset will automatically display in ArcMap with the ArcMap default enhancements, and it will be added as a new layer to the ArcMap table of contents.

If you have one or more instances of ArcMap already running, an ArcMap Instances dialog appears. Select an instance to display your dataset, or start a new instance of ArcMap. Click **OK**.

### Toolbox

The Toolbox is where you initiate and access image processing functions and workflows. You can double-click a Toolbox function to initiate a process or a workflow.

If you have a Windows machine, you can use the Toolbox in these additional ways:

- Drag and drop an item from the Layer Manager onto the desired Toolbox function to initiate a process or a workflow.
- Drag and drop an item from the Data Manager onto the desired Toolbox function to initiate a process or a workflow.
- Drag and drop an item from ArcCatalog, ArcMap, or the Windows file manager onto the desired Toolbox function to initiate a process or a workflow.

### Starting a Process or Workflow Using Double-click

When you double-click a Processing function or Feature Extraction, the Select an Input File dialog appears.

- If the data to use is already open, select it as described in "Selecting Previously Opened Files" on page 196.
- To open new data, see "Opening New Files from the Select Input File Dialog" on page 196.

When you double-click a Workflows item, the File Selection panel appears.
• If the workflow requires a single input and data in a supported format is already open, the filename is entered in the File Selection panel input file field. If multiple items are open and are in a supported format, the first supported item listed in the Data Manager is the one entered in the input field.

• If the data is already open and the workflow requires two input files, the File Selection panel input file fields are blank, Click Browse. The Input File dialog appears. See "Opening New Files from the Select Input File Dialog" on page 196 for details.

• If no data is open, or if you want to open new data, click Browse in the File Selection panel. The Input File dialog appears. See "Opening New Files from the Select Input File Dialog" on page 196 for details.

• If you know the location and name of the data to open, you can type the path and name in the File Selection panel input field.

Starting a Process or Workflow on Windows Using Drag and Drop

Note: The file you drag and drop onto a Toolbar item must be a file type supported by the process or workflow you wish to initiate.

• To initiate a process or a workflow with drag and drop, click the item, drag it to the Toolbox, and drop it on the name of the desired function. If the data is not supported by image processing or a workflow, the cursor looks as follows when you hover over the desired function:

• For Processing, the Select an Input File dialog appears, with the selected data highlighted. Click OK to proceed.

• For Feature Extraction, the Select an Input File dialog appears, with the selected data highlighted. Click OK to proceed.

• For all other workflows, the File Selection panel appears, with the name entered into the input field. If the workflow requires two inputs, the name is entered into the first input field.
Cursor Value Window

The Cursor Value window contains information about the displayed data at the current cursor location and data from the Mensuration tool when applicable.

You can access the Cursor Value window during any ENVI EX session by selecting **Display > Cursor Value** from the menu bar, or by clicking the **Cursor Value** toolbar button. The Cursor Value window opens automatically when you click the **Crosshairs** button.

When **Blend**, **Flicker**, or **Swipe** operations are active, the Cursor Value window does not update when you move your mouse.

If you move the cursor outside of the Image window or the Overview window, the Cursor Value window displays the coordinates of the last place the cursor was before leaving the Image window or Overview window. When you return the cursor to either window, the Cursor Value window resumes displaying the current cursor location.

**Cursor Location Data from the Image Window**

For all images, the Cursor Value window displays the layer name for each layer.

For non-georeferenced images, the following information displays along with the layer name:

- File x,y locations (in pixels) for the current location of the cursor.
- Data value(s) for the bands displayed at the current cursor location.
- Class names for classification images.

Example:

```
blsr_tm.img
File: 8,611
Data: [85, 33, 36]
```

For georeferenced images, the Cursor Value window displays the following along with the layer name:

- Map projection and datum, and whether the file contains rational polynomial coefficient (RPC) information.
- Map x,y coordinates for the current location of the cursor.
- Latitude and longitude values for the current location of the cursor.
- Data value(s) for the bands displayed at the current cursor location.
Example:
Geo: 40°4'11.53"N, 105°22'26.11"W
Map: 468114.0000, 4435369.0000
Proj: UTM, Zone 13N, NAD 27

bldr_sp.img
File: 8,611
Pixel: [0]

For all vector and ESRI feature class layers, the Cursor Value window displays the following for the selected vector record:

- Vector layer name
- Selected vector record number

If the vector or ESRI feature class layer has an associated attribute table, the attribute table data displays for the selected vector record.

Example:
Geo: 34°47'44.98"N, 90°53'34.49"W
Proj: Geographic Lat/Lon, NAD 83
lakes.shp
Selected Record: 11
AREA: 22228.402
NAME: Lake Michigan

If Crosshairs are enabled for an image, the Cursor Value window shows the following additional information:

- The location of the crosshairs, in file units relative to the visualization that established the base map.
- If a base map projection was established, the location of the crosshairs, in map units.

Example:
Crosshair
Loc: 398.000, 426.000
Geo: 40°0'0.18"N, 105°13'5.22"W
Map: 481381.600, 4427785.600

Click and hold the mouse button to view only the crosshair information in the Cursor Value window.

If Crosshairs are enabled and are centered over a vector vertex, or if the cursor is in Vector Edit mode, the Cursor Value window shows the following. Be sure that any layer modifications are saved, to provide the most accurate data.

- The layer name.
- The index of the current vector record (0 based) and the total number of records.
- If the file is multipart: the index of the current vector part (0 based) and the total number of parts in the vector record.
- The index of the vertex (0 based) within the vector part and the total number of vertices in the part.
- The location of the crosshairs in the native coordinates of the vector file.
- If the vector layer has an attribute table, the Cursor Value contains the attribute table data.
Cursor Location Data from the Overview Window

If the cursor is in the Overview window, the Cursor Value window shows the following information:

- For non-georeferenced images and vector layers: file x,y location (in pixels) for the current location of the cursor.
- For georeferenced images:
  - Map projection and datum, and whether the file contains rational polynomial coefficient (RPC) information.
  - Map x,y coordinates for the current location of the cursor.
  - Latitude and longitude values for the current location of the cursor.
Setting Preferences

You can set preferences to affect the behavior of visualizations, layer management, and data analysis. When you change a preference, it immediately takes effect without requiring you to restart the application.

To edit your preferences, select File > Preferences from the menu bar. The Preferences dialog appears.

Select the preference you want to edit from the Settings tree. The right side of the dialog shows the settings available for the preference you select. Each preference category displays a Name and Description field, which are not editable.

Edit the preferences as desired, then click OK to save the changes to your preferences file, enviex_prefs.sav, which is in the following directory:

Windows: Documents and Settings\username\.idl\itt\components-37-x_x-osname-bits\n
Unix and Linux: /home/username/.idl/itt/components-37-x_x-osname-bits/

Where x_x is the ENVI version number, osname is the operating system you are running, and bits is 32 or 64.

To edit True/False fields or other fields with drop-down lists, double-click in the field and select your preference. To revert to your previously saved changes, click Restore Defaults.

See Feature Extraction Preferences for Feature Extraction preference descriptions.
## Application Preferences

To edit application preferences, select **File > Preferences** from the menu bar, then select **Application** in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confirm on Exit</strong></td>
<td>Enable or disable displaying the message “Exit Application?” when you close the application. The default is <strong>True</strong>.</td>
</tr>
<tr>
<td><strong>Enable System Logging</strong></td>
<td>Enable or disable system logging. The default is <strong>False</strong>. If this field is set to <strong>True</strong>, ENVI EX saves an ASCII log of error messages named <code>envizoomsystemlog.txt</code> in your home directory:</td>
</tr>
<tr>
<td></td>
<td><strong>Windows</strong>: Documents and Settings\username.idl\itt\components-37-x_x-osname-bits\</td>
</tr>
<tr>
<td></td>
<td><strong>Unix and Linux</strong>: /home/username/.idl/itt/components-37-x_x-osname-bits/</td>
</tr>
<tr>
<td></td>
<td>Where <code>x_x</code> is the ENVI version number, <code>osname</code> is the operating system you are running, and <code>bits</code> is 32 or 64. The log file is overwritten with each new ENVI EX session.</td>
</tr>
<tr>
<td><strong>Display Errors on Screen</strong></td>
<td>Enable or disable display of error messages. The default is <strong>True</strong>, causing error messages to be displayed. Setting this preference to <strong>False</strong> suppresses the display of error messages received during operation. If the <strong>Enable System Logging</strong> preference is set to <strong>True</strong>, the errors will be written to the application system log. If both the <strong>Display Errors on Screen</strong> and <strong>Enable System Logging</strong> preferences are set to <strong>False</strong>, then the errors will appear at the IDL console.</td>
</tr>
<tr>
<td><strong>OPS Pool Size</strong></td>
<td>The number of out-of-process servers (OPS) to start in the pooled resource service (PRS). This specifies the number of OPS instances to create for the tile server and asynchronous action resources. When clients request access, the requests are queued and run by priority. The tile server manages accessing the data tiles for display. The asynchronous actions server manages certain data actions, such as long-running and high-latency operations, as a separate process. When ENVI EX runs for the first time, it queries the hardware for the number of CPUs and sets this value accordingly. Setting this value to a large number on a machine with only one or two CPUs and loading multiple large datasets causes severe performance degradation.</td>
</tr>
</tbody>
</table>
Data Manager Preferences

To edit Data Manager preferences, select File > Preferences from the menu bar, then select Data Manager in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Display Files on Open</td>
<td>Enable or disable automatically loading the selected file in the Image window upon file open. The default is <strong>True</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>False</strong> disables automatically loading the selected file. If you set the Launch Data Manager After File/Open preference to <strong>Always</strong> or <strong>If file not Auto-Displayed</strong>, the Data Manager appears and you can display the image from there. For information on how files are automatically loaded, see &quot;Supported File Formats&quot; on page 52.</td>
</tr>
<tr>
<td>Auto Display Method for</td>
<td>The method for automatically displaying multispectral files. The choices are <strong>True Color</strong> (default) and CIR (color infrared). These settings only apply if the image file contains wavelength information.</td>
</tr>
<tr>
<td>Multispectral Files</td>
<td></td>
</tr>
<tr>
<td>Clear Display When Loading New</td>
<td>Enable or disable clearing all layers from the Image window and the Layer Manager when you display a new image. The default is <strong>False</strong>, meaning ENVI EX continues to display all current layers when you display a new image. If this field is set to <strong>True</strong>, all layers are removed when a new layer is loaded, but the existing files remain open in the Data Manager.</td>
</tr>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>Launch Data Manager at Startup</td>
<td>Enable or disable opening the Data Manager when you start ENVI EX.</td>
</tr>
<tr>
<td></td>
<td>If this field is set to <strong>False</strong>, open the Data Manager as needed by selecting File &gt; Data Manager from the menu bar or by clicking the Data Manager button.</td>
</tr>
<tr>
<td>Launch Data Manager After File/</td>
<td>The method for showing the Data Manager. The choices are as follows:</td>
</tr>
<tr>
<td>Open</td>
<td>• <strong>Never</strong>: Do not automatically open the Data Manager for any file-open instance.</td>
</tr>
<tr>
<td></td>
<td>• <strong>If file not Auto-Displayed</strong> (default): Open the Data Manager when the Auto Display Files on Open value is <strong>False</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Open the Data Manager every time a file is opened.</td>
</tr>
<tr>
<td>Close Data Manager After</td>
<td>Enable or disable automatically closing the Data Manager after you load new data. The default is <strong>False</strong>.</td>
</tr>
<tr>
<td>Loading New Data</td>
<td></td>
</tr>
<tr>
<td>Load File After Chip or Save</td>
<td>Enable or disable whether output is automatically added to the Data Manager upon file save. This preference only applies to Chipping the Display and Save As. The default is <strong>True</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you set this preference to <strong>False</strong>, output is saved to disk but not added to the Data Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Results that are output to memory are always added to the Data Manager.</td>
</tr>
</tbody>
</table>

The Data Manager will also appear if:

- You set **Auto Display Files on Open** to **False**, and you set **Launch Data Manager After File/Open** to **If file not Auto-Displayed**.
- You set **Launch Data Manager After File/Open** to **Always**.
Directories Preferences

To edit default directory preferences, select File > Preferences from the menu bar, then select Directories in the Preferences dialog tree.

To edit the directory fields, double-click in the field, then select Edit. The Browse For Folder dialog appears. Navigate to the directory, then click OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Directory on Open</td>
<td>Enable or disable automatically changing the Default Input Directory value when you navigate to and open a file in a directory other than the current default. The default is True.</td>
</tr>
<tr>
<td>Default Input Directory</td>
<td>The directory for input images. ENVI EX uses this directory unless you specify another path when opening a file.</td>
</tr>
<tr>
<td>Temporary Directory</td>
<td>The directory used to store ENVI EX temporary files.</td>
</tr>
<tr>
<td>Output Directory</td>
<td>The directory for output files. ENVI EX writes output files to this directory unless you specify another path when entering an output filename.</td>
</tr>
<tr>
<td>Alternate Header Directory</td>
<td>The directory for header files associated with input images from read-only devices, such as a CD or folders with no write permissions. ENVI EX typically stores header files in the same directory as the input image; however, when that directory is read-only, ENVI EX writes to the alternate header directory. When opening a file, if ENVI EX is unable to locate a header file, it looks in the alternate header directory. This setting also affects pyramids. For more information, see Pyramids.</td>
</tr>
</tbody>
</table>

Overview Window Preferences

To edit Overview window preferences, select File > Preferences from the menu bar, then select Overview Window in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Vectors</td>
<td>Enable or disable showing vector layers in the Overview window. The default is True. ESRI feature class layers (vector layers referenced in a file) are not visible in the Overview window. You can override this setting during a session by right-clicking in the Overview window and disabling the Show Vectors option.</td>
</tr>
</tbody>
</table>

Display General Preferences

To edit general display preferences, select File > Preferences from the menu bar, then select Display General in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Factor</td>
<td>The zoom factor to use when you zoom in or out of the image. The default is 1.25.</td>
</tr>
</tbody>
</table>
### Setting Preferences

#### Display General Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom Interpolation Method</strong></td>
<td>The interpolation method to use when zooming on raster layers. This preference takes effect for any new layers that you create. Interpolation behavior may vary, depending on the method you choose, and whether the <strong>Use Graphics Card to Accelerate Enhancement Tools</strong> preference is enabled. Variations are noted in the following descriptions. The choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Nearest Neighbor</strong>: (default) Each pixel in the displayed image receives its value from the nearest pixel in the input (reference) image. If the <strong>Use Graphics Card to Accelerate Enhancement Tools</strong> preference is enabled, brightness, contrast, and sharpen filters are performed by the GPU,</td>
</tr>
<tr>
<td></td>
<td>• <strong>Bilinear</strong>: Each estimated pixel value in the displayed image is based on a weighted average of the four nearest neighboring pixels in the input image. Not all GPUs support bilinear interpolation of floating point textures; therefore, if <strong>Use Graphics Card to Accelerate Enhancement Tools</strong> is enabled, the setting is ignored and brightness, contrast, and sharpen filters are performed by the CPU.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Bicubic</strong>: Each estimated pixel value in the displayed image is based on a weighted average of the sixteen nearest pixels in the input image. If <strong>Use Graphics Card to Accelerate Enhancement Tools</strong> is enabled, the setting is ignored and brightness, contrast, and sharpen filters are performed by the CPU. If your graphics processing unit (GPU) does not support OpenGL Shader Language (GLSL), the <strong>Nearest Neighbor</strong> interpolation method is used instead.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Optimized Bicubic</strong>: Each estimated pixel value in the displayed image is based on a weighted average of the sixteen nearest pixels in the input image. The weighting coefficients are improved over standard Bicubic. If <strong>Use Graphics Card to Accelerate Enhancement Tools</strong> is enabled, the setting is ignored and brightness, contrast, and sharpen filters are performed by the CPU. If your graphics processing unit (GPU) does not support OpenGL Shader Language (GLSL), the <strong>Nearest Neighbor</strong> interpolation method is used instead.</td>
</tr>
</tbody>
</table>
| To use **Bicubic** and **Optimized Bicubic**: | • Your graphics card must support OpenGL 2.0 or higher, and you must have the most recent drivers installed.  
• The displayed image must not be palettized.  
Portals behave differently; they try to match the interpolation value of the target layer, regardless of the current preference setting. |
<p>| <strong>Mensuration Units</strong>   | The default distance measurement units for the <strong>Mensuration</strong> tool. The default is meters. If the <strong>Mensuration</strong> tool is being used on a non-georeferenced image, the Cursor Value window will always report the mensuration units in pixels. |
| <strong>Geographic Coordinate Format</strong> | The default format for geographic coordinate information in the Cursor Value window. The default is <strong>Degrees, Minutes, Seconds</strong>. Alternatively, you can choose to display the geographic location in <strong>Decimal Degrees</strong>. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom Setting for JPIP Images</strong></td>
<td>The default load extent for JPIP images. The default is <strong>Full Extent</strong> which displays an entire JPIP image and results in JPIP images loading faster.</td>
</tr>
<tr>
<td><strong>Default Selection Color</strong></td>
<td>The default color to use to highlight the current selection. This color appears as a border when you select layers, as a border to an open Portal, and when you select vectors or annotations to edit. The default is <em>(0,192,192)</em>.</td>
</tr>
</tbody>
</table>
| **Default Image Stretch**                  | The stretch to use for images when you load them. The options are as follows:  
  - None: Do not apply a contrast stretch to the image.  
  - Linear 2% (default): Apply a 2% linear stretch to the image.  
  - Histogram Equalization: Apply a histogram equalization stretch to the image.  
  - Gaussian: Apply a 0.3 Gaussian stretch to the image.  
  - Square Root: Take the square root of the input histograms then apply a 0.5 linear stretch to the image.  
  - Logarithmic: Apply a logarithmic stretch to the image. |
| **Use Low Resolution Tile Cache**          | For images with very high spatial resolution, ENVI EX displays low-resolution tiles in the Image window while it retrieves the full-resolution data (if this preference is set to Yes, the default). If you have a slow processor, you may set this preference to No, which should improve display performance. If you set this preference to No, nothing is visible in the Image window until ENVI EX loads each tile. |
| **Default Middle Mouse Action**            | The tool to use when you click and drag the middle mouse button in the Image window. The choices are the Pan tool or the Fly tool. The default is Pan. |
| **Use Graphics Card to Accelerate Enhancement Tools** | The default setting of Yes accelerates raster operations, such as image stretching, sharpening, brightness, contrast, and so forth, using your computer’s graphics processing card (GPU) instead of your computer’s central processing unit (CPU). All of the following criteria must be met for this preference to be effective:  
  - Your graphics card must support OpenGL 2.0 and must have the most recent drivers installed.  
  - You must set the Zoom Interpolation Method preference to Nearest Neighbor.  
  - The image data type must be byte, integer, unsigned integer, or floating-point.  
  - Your platform must be Windows or Linux. |
| **Use Degree Symbol When Displaying DMS**   | Set this preference to Yes (the default) to use the degree symbol when displaying Degrees, Minutes, Seconds in any Asian Language OS. |
Setting Preferences

Pyramid Preferences

To edit data pyramid preferences, select File > Preferences from the menu bar, then select Pyramid in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically Create Data Pyramids</td>
<td>Enable or disable creating copies of the data file at reduced resolutions (known as pyramids). The default is True, meaning ENVI EX builds the pyramids in the background when it opens an image file and before it displays the image in the Overview window. Using pyramids reduces the time required to display large portions of an image when panning, flying, zooming, etc. For more information, see &quot;Pyramids&quot; on page 55.</td>
</tr>
<tr>
<td>Minimum Data Dimensions to Create Pyramid</td>
<td>Set the minimum data dimensions that must be met for ENVI EX to create a data pyramid. The default is 1024 x 1024. ENVI EX does not build pyramid files for JPEG files (these are read into memory), JPEG 2000 files (which are able to return data at different resolutions), and files with spatial dimensions less than or equal to 512 x 512.</td>
</tr>
</tbody>
</table>
Print Layout Preferences

To edit Print Layout view preferences, select **File > Preferences** from the menu bar, then select **Printing** in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Map Template</strong></td>
<td>Change the default template. By default, the Print Layout will be displayed in the ArcMap Normal template (<strong>Normal.mxt</strong>). If the Preferences point to an invalid template, a warning message will be displayed the next time the Print Layout view is initialized.</td>
</tr>
<tr>
<td><strong>Map Template Directory</strong></td>
<td>Change the default map template directory. The default template directory specifies the initial browse location of the dialog used to pick a map template (see above). If the Preferences point to an invalid directory, a warning message will be displayed the next time the Print Layout view is initialized. See also &quot;Map Template&quot; on page 201</td>
</tr>
<tr>
<td><strong>Reference Scale</strong></td>
<td>Set the scale at which symbols will appear in the data frame, specified in map units. The Reference Scale sizes text and symbols along with the display. Without a Reference Scale, symbols and text will remain the same at all map scales, even if the extent is changed. The default is 0 (no Reference Scale).</td>
</tr>
</tbody>
</table>
Annotation Preferences

To edit annotation preferences, select File > Preferences from the menu bar, then select Annotation in the Preferences dialog tree.

You can set preferences for the different annotation types. You can override these settings as needed for each annotation through the individual annotation properties.

Text Annotation Preferences

The following are the text annotation preferences. You can temporarily override these settings when the Text Annotation tool is selected by right-clicking in the Image window (with no annotation items selected) and selecting Preferences.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>The annotation text color. The default is red (255,0,0).</td>
</tr>
<tr>
<td>Font Name</td>
<td>The font type to use for text annotations. The fonts that are installed on your system are available from the drop-down list. The default is Helvetica.</td>
</tr>
<tr>
<td>Font Style</td>
<td>The font style to apply to text annotations. The default is Normal.</td>
</tr>
<tr>
<td>Font Size</td>
<td>The font size for text annotations. The default is 16 points.</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>The horizontal alignment for text annotations. The default is Left.</td>
</tr>
<tr>
<td>Background Fill</td>
<td>Enable or disable using a background fill color for text annotations. The default is False.</td>
</tr>
<tr>
<td>Background Color</td>
<td>If the Background Fill setting is True, specify the color to use for the text annotation background. The default is black (0,0,0).</td>
</tr>
</tbody>
</table>

Symbol Annotation Preferences

The following are the symbol annotation preferences. You can temporarily override these settings when the Symbol Annotation tool is selected by right-clicking in the Image window (with no annotation items selected) and selecting Preferences.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>The annotation symbol color. The default is red (255,0,0).</td>
</tr>
<tr>
<td>Font Name</td>
<td>The font type to use for symbols. The fonts that are installed on your system are available from the drop-down list. The default is Symbol.</td>
</tr>
<tr>
<td>Font Size</td>
<td>The font size for the symbols. The default is 24 points.</td>
</tr>
<tr>
<td>Character</td>
<td>The symbol character to use. Click in this field and select Edit to open a dialog containing symbol choices. The default is ASCII 197.</td>
</tr>
<tr>
<td>Background Fill</td>
<td>Enable or disable using a background fill color for the symbol. The default is False.</td>
</tr>
<tr>
<td>Background Color</td>
<td>If the Symbol Background Fill setting is True, specify the color to use for the symbol background. The default is black (0,0,0).</td>
</tr>
</tbody>
</table>
Arrow Annotation Preferences

The following are the arrow annotation preferences. You can temporarily override these settings when the Arrow Annotation tool is selected by right-clicking in the Image window (with no annotation items selected) and selecting Preferences.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Color</td>
<td>The line color for annotation arrows. The default is red (255,0,0).</td>
</tr>
<tr>
<td>Line Style</td>
<td>The line style for annotation arrows. Style choices range from no line to solid, dashed, or dotted lines. The default is a solid line.</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>The line thickness for annotation arrows. The default is 1.</td>
</tr>
<tr>
<td>Arrow Head Size</td>
<td>The size of the annotation arrow heads, in points. The default is 25.</td>
</tr>
<tr>
<td>Arrow Head Angle</td>
<td>The angle, in degrees, of the annotation arrow heads. The default is 30 degrees.</td>
</tr>
<tr>
<td>Arrow Head Fill Interior</td>
<td>The arrow head fill interior, either None or Solid. The default is Solid.</td>
</tr>
</tbody>
</table>

Polygon Annotation Preferences

The following are the polygon, rectangle, and ellipse annotation preferences. You can temporarily override these settings when the Polygon Annotation, Rectangle Annotation, or Ellipse Annotation tool is selected by right-clicking in the Image window (with no annotation items selected) and selecting Preferences.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Outline</td>
<td>Enable or disable showing the outline of the polygon. The default is True.</td>
</tr>
<tr>
<td>Line Color</td>
<td>The line color for polygon annotations. The default is red (255,0,0).</td>
</tr>
<tr>
<td>Line Style</td>
<td>The line style for polygon annotations. Style choices range from no line to solid, dashed, or dotted lines. The default is a solid line.</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>The line thickness for polygon annotations. The default is 1.</td>
</tr>
<tr>
<td>Fill Interior</td>
<td>The polygon fill interior, either None or Solid. The default is None.</td>
</tr>
<tr>
<td>Fill Color</td>
<td>If the Polygon Fill Interior setting is True, specify the color to use for the polygon background. The default is red (255,0,0).</td>
</tr>
</tbody>
</table>

Polyline Annotation Preferences

The following are the polyline annotation preferences. You can temporarily override these settings when the Polyline Annotation tool is selected by right-clicking in the Image window (with no annotation items selected) and selecting Preferences.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Color</td>
<td>The line color for polyline annotations. The default is red (255,0,0).</td>
</tr>
<tr>
<td>Line Style</td>
<td>The line style for polyline annotations. Style choices range from no line to solid, dashed, or dotted lines. The default is a solid line.</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>The line thickness for polyline annotations. The default is 1.</td>
</tr>
</tbody>
</table>

Picture Annotation Preferences
The following is the picture annotation preference.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Picture Dimension</td>
<td>The maximum dimension to allow for a picture annotation. The default is 512 pixels.</td>
</tr>
</tbody>
</table>

**Vector Preferences**

To edit vector preferences, select File > Preferences from the menu bar, then select Vectors in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Reduced Vertices File</td>
<td>Enable or disable automatically building a reduced vertices file the first time a vector file is opened. ENVI EX creates a .qtr file in the same directory as the vector file to use for all subsequent file opens. A reduced vertices file (also known as a reduced resolution file) improves rendering performance when the ratio of vertex density to viewable area pixel resolution is very high. The default is True. For more information on reduced vertices files, see &quot;Quad Display and Data Reduction for Vector Layers&quot; on page 56.</td>
</tr>
<tr>
<td>Maximum Vertices Per Quad Node</td>
<td>The maximum number of vertices to allow in each quadtree node. When this number is exceeded, the node splits. The default is 75000.</td>
</tr>
<tr>
<td>Maximum Vertices to Read in as Memory</td>
<td>The maximum number of vertices to read in as memory. This setting is used before building the reduced vertices file. ENVI EX checks how many vertices are stored in the file. If the number is smaller than or equal to this setting, all of the vector records are loaded into memory for efficient access. If the number is larger than this setting, no vector records are loaded into memory. In this case, records are read temporarily from the file each time a vector is accessed. The default is 100000.</td>
</tr>
<tr>
<td>Maximum Vertices to Display at Once</td>
<td>The maximum number of vertices to display in the viewable area at one time. When this number is exceeded, some data appear as bounding boxes in the viewable area. The default is 1000000.</td>
</tr>
</tbody>
</table>

**Remote Connectivity Preferences**

To edit remote connectivity preferences, select File > Preferences from the menu bar, then select Remote Connectivity in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OGC Proxy Server</td>
<td>A proxy server sits between your computer and remote servers to which you connect. If you consistently have trouble connecting to remote servers, you may have a proxy server installed. Contact your system administrator for details, then enter the server name in the OGC Proxy Server field. This field is blank by default. ENVI EX does not attempt to connect through a proxy server, unless you specify one. JPIP/IAS servers do not support proxy servers.</td>
</tr>
<tr>
<td>OGC Proxy Port</td>
<td>The port number through which the proxy server connects to the Internet. The default is 80.</td>
</tr>
<tr>
<td>Recent Datasets to Remember</td>
<td>The number of datasets to maintain in the Recent Dataset List in the File &gt; Open Remote Dataset menu option. The default is 16.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Close Remote Connection Manager After Opening New Data</td>
<td>Enable or disable automatically closing the Remote Connection Manager dialog after you load new data. The default is False.</td>
</tr>
<tr>
<td>WMS Pixels Per Side</td>
<td>The number of pixels to use as the default setting for the greater of the width or height within a WMS layer. The default is 10000.</td>
</tr>
<tr>
<td>ESRI License Type</td>
<td>Set this preference to the type of ESRI license you currently have. The choices are Unknown (default), ArcInfo, ArcView, or ArcEditor. Setting this preference to a specific ESRI license type speeds up performance because ENVI EX will skip the license check when you read or export to a geodatabase, or when you interact with ArcMap software. You can find the license type installed on your computer by selecting Help &gt; About ArcMap from the ArcMap software menu bar.</td>
</tr>
</tbody>
</table>
Performance Tips and Tricks

If tile rendering performance is slow or non-responsive, try setting the preference **Use Graphics Card to Accelerate Enhancement Tools** to **No**. Or, set this preference to the default value of **Yes** to accelerate raster operations, such as image stretching, sharpening, brightness, contrast, and so forth, using your computer’s graphics card instead of your computer’s central processing unit (CPU). All of the following criteria must be met for this preference to be effective:

- Your graphics card must support OpenGL 2.0 and must have the most recent drivers installed.
- You must set the **Zoom Interpolation Method** preference to **Nearest Neighbor**.
- The image data type must be byte, integer, unsigned integer, or floating-point.
- Your platform must be Windows or Linux.

If you experience problems using the Preview Portal or ENVI EX workflows:

- Update your graphic card with the most recent driver.
- Try setting the preference **Use Graphics Card to Accelerate Enhancement Tools** to **No**.

For images with very high spatial resolution, ENVI EX displays low-resolution tiles in the Image window while it retrieves the full-resolution data as long as the **Use Low Resolution Tile Cache** preference is set to the default value of **Yes**. If you have a slow processor, you may set this preference to **No**, which should improve display performance. If you set this preference to **No**, nothing is visible in the Image window until ENVI EX loads each tile.

In the case of very large vector files (those with over 50K records), it is recommended that you view individual attributes using the Cursor Value window rather than attempting to use the **View Attributes** option. Using this method will help in avoiding lengthy wait times as the Attribute table is populated and displayed. For more information on vectors, see "Displaying ESRI Layers and Feature Classes" on page 60 and "About Vectors" on page 154.
Chapter 3: Opening and Displaying Data

In this chapter you will find:

- Supported File Formats ................................................................. 52
- Opening Files in ENVI EX .......................................................... 53
- Displaying Large Images ............................................................ 55
- Quad Display and Data Reduction for Vector Layers .................. 56
- The Data Manager ....................................................................... 58
- Opening Remote Datasets ........................................................... 64
- Geo Link to ArcMap ...................................................................... 75
Supported File Formats

**ENVI EX -Supported Formats**

- Digital Terrain Elevation Database (DTED):
  - .dt0: Level-0 data with a spatial resolution of 30 arc seconds
  - .dt1: Level-1 data with a spatial resolution of 3 arc seconds
  - .dt2: Level-2 data with a spatial resolution of 1 arc second
- ENVI annotation (.ann)
- ENVI EX annotation (.anz)
- ENVI raster and classification images
- ENVI vector (.evf)
- ERDAS IMAGINE: ENVI EX reads and displays .img files, and it uses .ige spill files for large images if needed.
- GeoTIFF (.tif, .tiff)
  
  See "GeoTIFF Map Information" on page 30.
- GeoTIFF with metadata (.met, .txt)
  
  See "Opening Landsat GeoTIFF Files with Metadata" on page 53.
- JPEG (.jpg)
- JPEG 2000 (.jp2, .j2k)
- MrSID (.sid)
- NITF 1.1, 2.0, and 2.1 (.nitf, .ntf)
- NSIF 1.0 (.nsf)
- RapidEye (.xml)
  
  See "Opening Files in ENVI EX" on page 53 for instructions on reading RapidEye data.
- SPOT DIMAP (.dim)

ENVI EX reads and displays data from any sensor as long as the files are in one of the above formats. See "Opening Files in ENVI EX" on page 53 for more detailed instructions on reading Landsat, RapidEye, and GeoEye-1 data.

**GIS-Ready Formats**

- ESRI Geodatabase (.mdb, .gdb, .sde)
  - ESRI simple/standalone feature class
  - ESRI raster dataset
- ESRI Layer (.lyr)
- Shapefile (.shp)
- ESRI GRID (hdr.adf) with the exception of classification names and color tables
Opening Files in ENVI EX

1. Select File > Open from the menu bar, or click the Open button on the main toolbar or the Data Manager toolbar. Windows users can click and drag a file from ArcMap, ArcCatalog, or the Windows file manager into the Image window. The Open dialog appears.

2. Select a file to open. To filter the list of input files by data type, click the Files of type drop-down list and select a data type.

3. Click Open.

By default, ENVI EX automatically displays a true-color image, a grayscale image, an annotation layer, a vector layer, an ESRI feature class, or an ESRI layer based on your file type. You can change the Auto Display Files On Open default in the Data Manager preferences. If you choose not to automatically load the data, the Data Manager appears (see "The Data Manager" on page 58 for more information).

For images, ENVI EX uses information from the image metadata to determine how to automatically load the image. The following items assume the Auto Display Method For Multispectral Files preference is set to True Color.

• If the image has wavelength information and bands are available for visible red, green, and blue wavelengths, they will be assigned red, green, and blue.
• If the image has wavelengths, but they are not in the visible region, or the image does not have wavelength information, the following rules apply:
  • If the image has three bands, ENVI EX assumes that they are red, green, and blue (in that order), and assigns band 1 to red, band 2 to green, and band 3 to blue.
  • If the image has four bands, ENVI EX assumes that they are blue, green, red, and near infrared (in that order), and assigns band 3 to red, band 2 to green, and band 1 to blue.
• If the image has more than four bands, ENVI EX loads band 1 into a grayscale display.

Note: If the image is in NITF format and has default bands set, this will take precedence.

ENVI EX supports the following annotation items from ENVI .ann files: text, square/rectangle, circle/ellipse, polygon, polyline, arrow, symbol, and picture.

ENVI EX does not support map scale bars, image color ramp, map key, declination arrow and plot annotation items from the .ann file, and therefore does not display them if they are present. If you open an .ann file that contains only unsupported types, an information dialog appears.

Opening Landsat GeoTIFF Files with Metadata

ENVI EX reads Landsat (MSS, TM and ETM+) metadata files from the Global Land Cover Facility (GLCF) or from the U.S. Geological Survey (USGS). The metadata files provide information needed to open the associated imagery. Select File > Open from the menu bar. In the Open dialog, select a .met file for GLCF Landsat data or a .txt file for USGS Landsat data. The Data Manager displays the band and wavelength information for the Landsat multispectral bands first, followed by the thermal band and the panchromatic band.

Opening RapidEye Files

ENVI EX reads and displays RapidEye Level-1B (Basic) and Level-3A (Ortho) data. A Level-1B scene consists of five co-registered NITF 2.0 files (one for each band) with associated rational polynomial coefficients (RPCs).
When you open the *_metadata.xml file associated with a Level-1B image, ENVI EX opens all five bands at once. To view a single band of data, open the corresponding NITF file.

Level-3A images are distributed as GeoTIFF files with associated metadata. Each GeoTIFF file contains five bands of data. Opening the GeoTIFF or XML file distributed with the data will load all five bands into ENVI EX at once; however, opening the XML file will also load the associated metadata.

Opening GeoEye-1 Files

ENVI EX reads and displays GeoEye-1 data in NITF and GeoTIFF formats. An individual GeoTIFF file may only contain one band of data, while another may contain a combination of multispectral bands. In either case, you can either open the individual GeoTIFF file directly, or select the *_metadata.txt file if it is available. The metadata file provides the information needed to open the appropriate GeoTIFF files.
Displaying Large Images

Many modern remote sensing datasets from high-resolution sensors have a large file size; some images are several gigabytes. ENVI EX manages the display of large raster datasets using three primary methods, described below.

**Reduced Resolution Data Sets**

Some remote sensing images include reduced resolution data set (RRDS) files to speed the display of the imagery. RRDS files (also called RSETs) are versions of the original image at various reduced resolutions. ENVI EX uses the RRDS files to display imagery in the Image window when you zoom in or out of the display. RRDS files take precedence over any existing pyramid files when displaying large images in the Image window. If RRDS files are not available, ENVI EX creates and uses pyramids to display the images.

ENVI EX currently supports RRDS files generated by RemoteView, with file extensions of `.rv1` through `.rvn`. Each progressive number represents a spatial resampling twice that of the previous file. These files are in NITF 2.1 uncompressed format, so you must have a NITF/NSIF Module license installed before ENVI EX will use RRDS files to display these images.

**Pyramids**

For large data files, ENVI EX builds pyramids in the background while loading the image into the display and prior to displaying the image in the Overview window. ENVI EX does not build pyramid files for JPEG files (these are read into memory), JPEG 2000 files (which can return data at different resolutions), and files with spatial dimensions less than or equal to 512 x 512.

Pyramids are copies of the data file at various reduced resolutions. They are used to speed image display by reducing the resampling required when displaying large portions of an image at low resolution. The Process Manager in the Status bar shows the progress of building pyramids when you open a data file. ENVI EX only builds pyramids for a large data file the first time you open it. When you open the data file thereafter, it displays more quickly because it accesses the previously built pyramid file.

By default, pyramid files are created in the directory containing the original data file. If this directory is unavailable (due to write permission, for example), ENVI EX attempts to create the pyramid file in directory set in the **Alternate Header Directory** preference. If this is not available, ENVI EX uses the IDL temporary directory. Note that files on network drives may be slower to build pyramids due to network issues.

You can set preferences to disable pyramid creation or to specify the minimum data dimensions for creating pyramids. See "Pyramid Preferences" on page 44 for more information.

**Tiles**

Typical desktop and workstation computers running image processing software cannot feasibly load an image that is several gigabytes into memory at once and display it as a single unit. ENVI EX manages the display of large datasets by dividing them into discrete chunks called tiles.

ENVI EX initially creates an image without any data. It only loads image pixels when a tile section comes into view through panning or zooming. Depending on the file size and performance, you may see a grey tile until ENVI EX retrieves the proper tile to display. Tiling combined with the use of pyramids ensures the quickest display of large images.

If you set the **Use Low Resolution Tile Cache** preference to **Yes** on images with very high spatial resolution, ENVI EX displays low-resolution tiles in the Image window while it retrieves the full-resolution data.
Quad Display and Data Reduction for Vector Layers

When you open a vector file, ENVI EX automatically organizes the data into quadtrees. It partitions the geometrical entities into four spatial quadrants until each cell (or bucket) reaches its maximum capacity (set in the Maximum Vertices Per Quad Node preference). When a bucket reaches maximum capacity, it splits; this process continues until all of the data is subdivided. Quadtree files (.qtr) are located in the same directory as the original file; if that directory is read-only, the file is created in the directory set in the Temporary Directory preference.

If the Build Reduced Vertices File preference is set to Yes, ENVI EX performs data reduction on files with high-density vertex data to improve rendering performance. If data reduction is needed, ENVI EX builds the necessary files after the quadtree file is complete. Until ENVI EX finishes creating the reduced resolution shapefiles, the view in the Image window will show some of the quadtrees as bounding boxes with an X through them (see figure below). This means that data is present but could not be loaded into memory.

Once the reduced resolution shapefiles are available, the display is updated by replacing the bounding boxes with the vector data (see figure below). Reduced resolution filenames are the same as the original file, with _reduced appended to the name. The files are located in the same directory as the original file; if that directory is read-only, the files are created in the directory set in the Temporary Directory preference.

A third file type is created when a vector layer is drawn in the Overview window for the first time. ENVI EX creates a rasterization file (.zrf), which is used to display the vector layer in the Overview window. Rasterization files are located in the same directory as the original file; if that directory is read-only, the file is created in the directory set in the Temporary Directory preference.

The following example shows the Image window before the quadtree file completes, with quadtrees shown as bounding boxes.
The Data Manager

The Data Manager lists the files that you have opened and makes them accessible to load into your display. By default when you open a file, ENVI EX attempts to automatically display that file based on the file type and does not display the Data Manager. You can change this preference and other Data Manager preferences using the File > Preferences menu option described in "Data Manager Preferences" on page 40.

When you open a file, ENVI EX adds a new item to the bottom of the Data Manager tree. You can open multiple files in one ENVI EX session, and you can choose which of those files to display and how to display them using the Data Manager. You can expand and collapse files in the Data Manager tree by clicking the + or - next to the filename.

You can access the Data Manager during any ENVI EX session by selecting File > Data Manager from the menu bar, or by clicking the Data Manager button. You can enable the Display Data Manager when Launching ENVI EX preference to always automatically open the Data Manager at startup.

Data Manager Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open</td>
<td>Open a data file.</td>
</tr>
<tr>
<td><img src="image" alt="Expand All" /></td>
<td>Expand All</td>
<td>Expand all of the files in the Data Manager to show band names.</td>
</tr>
<tr>
<td><img src="image" alt="Collapse All" /></td>
<td>Collapse All</td>
<td>Collapse all of the files in the Data Manager so that only filenames are shown.</td>
</tr>
<tr>
<td><img src="image" alt="Close File" /></td>
<td>Close File</td>
<td>Select a file in the Data Manager, then click this button to close that file.</td>
</tr>
<tr>
<td><img src="image" alt="Close All Files" /></td>
<td>Close All Files</td>
<td>Close all files that are currently open. This option removes all files from the Layer Manager.</td>
</tr>
<tr>
<td><img src="image" alt="Pin/Unpin" /></td>
<td>Pin/Unpin</td>
<td>Toggle whether to have the Data Manager persist on the screen or automatically close when layers are loaded into the display. Unpin the Data Manager to have it automatically close when you load a file into the display.</td>
</tr>
</tbody>
</table>
Displaying Multispectral Images

When you open a multispectral image file, a multispectral icon appears next to the filename in the Data Manager.

1. When you click on band names in the Data Manager, color gun assignments will automatically cycle through red, green, then blue (in that order). Click the band name you want to assign to red. A red box appears next to the band name.

2. Repeat for the green and blue bands. Colored boxes appear next to the bands to indicate which color is assigned to those bands. If one band is assigned multiple colors, a split box appears next to the band name showing the colors.

3. Click Load Data. ENVI EX loads an RGB image into a new layer and automatically displays the image in the Image window.

**Displaying Different Bands from the Same Multispectral Image**

To assign a new RGB combination, click a different band name you want to assign to red, then continue with the green and blue selections.
Automatically Loading True Color, Color Infrared, or Default Bands

Information for how an image will be automatically loaded into ENVI EX is taken from the image header file. If this information is not available, the options below will not be accessible.

- To load a true-color image into the display, right-click on a filename in the Data Manager and select **Load True Color**.
- To load a color-infrared (CIR) image into the display, right-click on a filename in the Data Manager and select **Load CIR**.
- Right-click on a filename in the Data Manager and select **Load Default** to display an image for which you have assigned default bands in the associated ENVI header. If you do not define default bands to load but the image file contains wavelength information, **Load Default** uses the **Auto Display Method For Multispectral Files** preference.

Selecting Bands to Display

The Band Selection category of the Data Manager is collapsed by default. You can expand or collapse this category by clicking the arrow next to the category name. Band Selection provides another way to assign bands to RGB color guns. This approach is especially useful for hyperspectral images with hundreds of bands.

1. Click the **Red** button, then click the band name you want to assign to red.
2. Click the **Green** button, then click the band name you want to assign to green.
3. Click the **Blue** button, then click the band name you want to assign to blue.
4. Click **Load Data**. ENVI EX loads an RGB image into a new layer and automatically displays the image in the Image window.

Displaying Grayscale or Classification Images

When you open a single-band image file in the Data Manager, a grayscale icon \( \text{ grayscale } \) appears next to the filename. When you open a classification image, a classification icon \( \text{ classification } \) appears next to the filename.

- For a single-band image, select the band and click **Load Data**. ENVI EX loads the image into a new layer and displays the classification or grayscale image in the Image window.
- Right-click on a filename and select **Load Grayscale**. ENVI EX loads a grayscale image into a new layer and displays the image in the Image window. For a multispectral image, this will result in the first band being displayed.
- For a multispectral image, right-click on a band name that you want to view as a grayscale image, and select **Load Grayscale**. ENVI EX loads a grayscale image from that band into a new layer and displays the image in the Image window.

Displaying ESRI Layers and Feature Classes

When you open an ESRI layer in the Data Manager, an icon appears next to the filename to indicate the layer type (\( \text{ raster } \) for raster, \( \text{ points } \) for points, \( \text{ lines and polygons } \) for lines and polygons).

- Select the ESRI layer name(s) and click **Load Data**. ENVI EX loads the ESRI layer and displays it in the Image window. Layer files will be displayed in the Layer Manager and Data Manager with the layer name (not the filename).
• You can also expand the ESRI layer, select the data source, and load the source data (see "Displaying Grayscale or Classification Images" on page 60, "Displaying Multispectral Images" on page 59, or "Displaying Vector Layers" on page 61). ENVI EX loads the ESRI layer’s data source and displays it in the Image window.

Note: Layer files in ArcGIS consist of a set of rules for displaying and working with datasets. Information in files can include symbols, classifications, labeling rules, and other information describing the appearance and actions of the layer. When visualizing an ESRI layer, ENVI EX inherits properties from ArcGIS. If you open the source data for an ESRI layer, you will be using ENVI EX properties (e.g. stretch) and the two may not display the same way.

• You can load multiple ESRI layers with the same filename into the Data Manager.

Note: Layer files reference data sources, they do not include the actual data. If referenced data in a file is renamed or moved, the layer files must be updated in ArcMap or ArcCatalog to use the new path. For more information on files and data sources, see the ArcGIS Help.

When you open an ESRI simple/standalone feature class in a geodatabase in the Data Manager, an icon appears next to the filename to indicate the type ( for multispectral raster, for grayscale raster, for points, for polygons, for polylines). See also "Displaying ESRI Layers and Feature Classes" on page 60.

• Select the feature class name(s) and click Load Data. ENVI EX loads the feature class and displays it in the Image window.

Note: You cannot edit a vector layer originating from a geodatabase or referenced by an ESRI layer. However, you can access and edit the source data for an ESRI layer. For more information on ESRI layers, see "Displaying ESRI Layers and Feature Classes" on page 60.

Displaying Vector Layers

When you open a vector layer in the Data Manager, an icon appears next to the filename to indicate the vector type ( for points, for polygons, for polylines). See also "Displaying ESRI Layers and Feature Classes" on page 60.

• Select the vector layer name(s) and click Load Data. ENVI EX loads the vector layer and displays it in the Image window.

• Right-click on a vector layer name and select Load Vector. ENVI EX loads the layer and displays it in the Image window.

• Use Ctrl or Shift keys and click to select multiple filenames, then right-click and select Load Files. ENVI EX loads the layers and displays them in the Image window.

Displaying Annotation Layers

When you open an annotation layer in the Data Manager, an icon appears next to the filename to indicate the layer type ( ).

• Select the annotation layer name(s) and click Load Data. ENVI EX loads the annotation layer and displays it in the Image window.

• Right-click on an annotation layer name and select Load Annotation. ENVI EX loads the layer and displays it in the Image window.
Closing Files

If you attempt to close a file that is currently being displayed, a prompt appears to ensure you want to close that file and remove the layers containing those bands.

- To close a single file, right-click on a filename in the Data Manager and select Close File, or click the Close File button on the Data Manager toolbar.
- To close all files that are currently open, right-click on any filename in the Data Manager and select Close All Files, or click the Close All Files button on the Data Manager toolbar.
- To close selected files that are currently open, use Ctrl or Shift keys when you click to select multiple filenames in the Data Manager, then click the Close File button or right-click and select Close Files.

Accessing File Information

The File Information category of the Data Manager provides detailed information about the files listed in the Data Manager. This category is collapsed by default. You can expand or collapse this category by clicking the arrow next to the category name. When expanded, the File Information category lists information derived from the file header.

**Raster File Information**

- **File**: Filename, including the full path.
- **Dims**: File dimensions, including number of lines, samples, and bands; and interleave (BIL, BIP, or BSQ).
- **Data Type**: Data type (unsigned integer, byte, etc.)
- **Size**: File size in bytes. This information is available for all datasets except for WCS, WMS, and JPIP remote datasets.
- **File Type**: File format.
- **Wavelength**: Wavelength range, if wavelength information is available.
- **Projection**: Projection name (for georeferenced images), including datum and pixel size. If the file contains rational polynomial coefficient (RPC) information, the text *RPC* precedes the projection type.
- **Upper Left Corner**: Image coordinates for the upper-left pixel in the image for images with XSTART and YSTART values. If your image is a spatial subset of a larger image, the image coordinate system references the parent (or larger) image.

**Vector Layer Information**

- **File**: Filename, including the full path.
- **Shape Type**: Type of vector record (Point, Polyline, Polygon).
- **Number of Records**: Number of vector records in the file.
- **Number of Vertices**: Number of vertices in the file.
- **Number of Quad-Tree Nodes**: Number of quadtree nodes created.
- **File Size**: File size, in bytes.
- **Attributes**: Indicates whether or not an attribute table exists for this layer.
- **Projection**: Projection name (for georeferenced data), including datum and measurement units.

**Annotation Layer Information**
- **File**: Filename, including the full path.
- **Number of Annotation Items**: Number of annotation items in the file.
- **Number of Quad-Tree Nodes**: Number of quadtree nodes created. Annotations currently use only one node.
- **Projection**: Projection measurement units.

**ESRI Layer Information**
- **File**: Filename, including the full path.
- **Data Name**: ESRI layer name (name displayed in the ArcMap Table of Contents).
- **Layer Type**: Feature Layer or Raster Layer
- **Shape Type** (for ESRI feature classes only): Type of vector record (Point, Polyline, Polygon).
- **Data Type** (for ESRI raster layers only): Data type (unsigned integer, byte, etc.)
- **Dims**: File dimensions, including number of lines, samples, and bands; and interleave (BIL, BIP, or BSQ).
- **Top/Bottom/Left/Right**: The left, top, right, bottom coordinates of the raster dataset.
- **Projection**: Projection name (for georeferenced data), including datum and measurement units.
Opening Remote Datasets

Use File > Open Remote Dataset or File > Remote Connection Manager to access data from the following types of Web servers:

- OGC: for Web Map Service (WMS) and Web Coverage Service (WCS)
- JPEG 2000: for JPEG 2000 Internet Protocol (JPIP) and Image Access Solutions (IAS)
- Geodatabases: (only accessible from File > Remote Connection Manager)

See "Using the Remote Connection Manager" on page 69 and "Using the Open Remote Dataset Dialog" on page 66 for steps.

Also see "Remote Connectivity Preferences" on page 48 for descriptions of the preferences associated with opening and viewing remote datasets.

Supported Platforms

Supported platforms vary by connection type:

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Windows 32-bit</th>
<th>Windows 64-bit</th>
<th>Mac OS X PPC 32-bit</th>
<th>Mac OS X 32-bit</th>
<th>Mac OS X 64-bit</th>
<th>Linux 32-bit</th>
<th>Linux 64-bit</th>
<th>Solaris 32-bit</th>
<th>Solaris 64-bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcGIS® geodatabase a,b</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connect to and read from geodatabase</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save to file or personal geodatabase</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save to enterprise SDE geodatabase c</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IAS and JPIP a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OGC WCS and WMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a Windows users: these functions only run in 32-bit mode. If you have a 64-bit Windows PC and you want to use these functions, run ENVI or ENVI EX in 32-bit mode from the Windows Start menu.

b Supported on ArcGIS® Desktop 9.2 and later; tested on Windows XP 32-bit and Vista 32-bit with ArcGIS® Desktop 9.3.

c Requires an ArcInfo® or ArcEditor™ license (ArcView® software does not support this feature).

OGC Servers

The Open Geospatial Consortium (OGC) provides a variety of protocol specifications for transmitting geospatial data via the web. ENVI EX will support two of these specifications: WMS and WCS.

See http://www.opengeospatial.org for more information.
OGC servers have several common features:

- Data are sent as image files. The supported formats are JPEG 2000, JPEG, and TIFF/GeoTIFF formats. If a dataset you are querying cannot be transmitted in one of these formats, you cannot open the dataset.

- You can customize data delivery by specifying a spatial extent, interpolation type, pixel size, and map projection, which saves you from reading unwanted data for regions you are not interested in. ENVI EX can manage the details of server requests, such as downloading data tiles, deleting temporary files, and reading data.

- OGC servers provide a directory listing service called GetCapabilities to list OGC datasets available on any server, or you can directly connect to an OGC dataset.

**OGC WCS**

WCS is a protocol for serving raster data that represent properties of geographic locations. WCS servers provide coverages that you can manipulate. WCS servers list datasets at one level instead of in a folder hierarchy.

**OGC WMS**

WMS is a protocol for serving maps that are generated on-the-fly for display purposes only. A powerful feature of WMS servers is that you can identify multiple datasets that meet your criteria, and the server combines them into one displayable map layer. WMS servers do not specify a pixel size for a given dataset, so ENVI EX will estimate a default pixel size. You can change this value by setting the **WMS Pixels Per Side** preference. WMS servers list datasets on the server in a folder hierarchy.

**JPEG 2000 Servers**

OGC and JPIP servers support delivery of image data at different resolutions that are automatically resampled by the servers. IAS and JPIP servers send compression parameters known as wavelets, while OGC servers send actual image files. This means that ENVI EX can read any IAS server dataset.

**Note:** If you are working on a Windows 64-bit platform, you need to start ENVI EX in 32-bit mode to access data from JPIP or IAS servers.

**Note:** To view datasets from IAS and JPIP servers, you need a server that uses the ISO/IEC 15444-9 JPEG 2000 standard (JPEG 2000 Internet Protocol). IAS 3.x and higher provides support for this version of the standard.

**JPIP**

JPIP is a client-server protocol used to serve JPEG 2000 compressed imagery (.jp2, .j2c, and .jpx). No directory listing service is available with JPIP servers; you must specify the full path to a dataset you want to view, for example:

```
jpip://exampleserver:1234/file.jp2
```

If a dataset from a JPIP server contains map information, it is stored in the file header using a GeoJP2 protocol. ENVI EX will attempt to read and import map information and apply it to the input file whenever possible.
IAS

The IAS product, available from ITT Visual Information Solutions, provides a server that streams JPEG 2000 and NITF 2.1 C8 compressed imagery using the JPIP protocol, which you can display and analyze. IAS supports full JPIP streaming capabilities, plus it provides a directory listing service, NITF support, and a tool to convert any image file to JPEG 2000 or NITF 2.1 C8 formats. ENVI EX will not support opening CMYK compressed JPEG 2000 files using an IAS server.

An IAS server lists datasets in a hierarchy similar to that of a file system. You can browse data from an IAS server in ENVI EX.

An IAS server can list datasets that are not JPEG 2000 compressed, but it cannot serve them. An error message appears if you attempt to open this type of dataset from an IAS server. Once you select a JPEG 2000 compressed dataset through an IAS server, you can also access metadata.

IAS servers retain and serve metadata associated with NITF datasets. ENVI EX can read and interpret NITF metadata, including map and wavelength information, as well as file and image metadata, text segments (if present), and most tagged record extensions (TREs). If map information is not present in NITF metadata, the dataset is read in from a GeoJP2UUID box, if present.

For more information about IAS functionality, refer to the ITT Visual Information Solutions website.

Geodatabases

The ArcGIS geodatabase is a data storage mechanism that allows for many types and sources of geographic data, both raster and vector, to be supported in a consistent manner. ENVI EX supports reading and writing to personal geodatabases (in Microsoft Access .mdb format), file geodatabases, and enterprise geodatabases.

See "Using the Remote Connection Manager" on page 69 for instructions on reading geodatabase files and "Selecting an Output Geodatabase" on page 194 for instructions on writing to a geodatabase.

Using the Open Remote Dataset Dialog

The File > Open Remote Dataset menu option is useful when you are already familiar with the connection details of the dataset you want to open. You cannot use the Open Remote Dataset dialog to access a server, only a specific dataset. The Open Remote Dataset dialog only connects to datasets on JPIP, IAS, and OGC servers.

For JPIP and IAS servers, the connection string consists of the IP address or server (host) name, port number, the path (relative to the server root), and filename. Preface the URL with http:// or jpip://. For example:

```
http://ias-server:80/data/jpeg2000_file.jp2
```

For OGC servers, the connection string consists of the server name, port number, CGI get request (followed by a question mark), and optional OGC keywords. Preface the URL with http://. See "OGC Connection Keywords" on page 67 for a list of keywords. For example:
Using the Open Remote Dataset Dialog

Opening Remote Datasets

Because no port number was specified in the example above, ENVI EX uses port 80 as the default.

You can also define a proxy server by setting the **OGC Proxy Server** preference.

Follow these steps to open a remote dataset:

1. Select **File > Open Remote Dataset** from the ENVI EX menu bar. The Open Remote Dataset dialog appears.

2. There are two ways to open a dataset from this dialog:
   - To open a new dataset, type (or paste) the connection string for the dataset in the **URL** field. Refer to the beginning of this section for examples and details about the format of the connection string.
   - If you have previously opened any datasets, an arrow appears next to the **URL** field. Click the arrow and select the dataset from the drop-down list.

3. Click **OK**.

4. If a username and password are required to log in to a server, the Connection Authentication dialog appears. See "Connection Authentication" on page 68 for details on logging in.

   After you click **OK** and after authentication is complete (if required), the dataset is displayed and added to the Data Manager in ENVI EX

**OGC Connection Keywords**

The OGC keywords specify details about what data to open on the server and how to open it. You specify the details by using standard keywords defined by OGC. Separate keywords from their values with an equal sign (=), and separate keyword/value pairs with an ampersand (&), for example: width=500&height=500. The following keywords are supported:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bbox</strong></td>
<td>The geographic extent (or bounding box) of the dataset. The keyword value enables you to subset the data to open from the server (for example, if the dataset contains data for the whole world and you need only data for Colorado). Enter values in the following order: minx, miny, maxx, maxy. The default is to open the entire dataset. Example: bbox=23.73,37.97,23.752,37.984</td>
</tr>
</tbody>
</table>
Opening Remote Datasets

Connection Authentication

If a username and password are required to log in to a server or geodatabase, the Connection Authentication dialog appears. Perform the following steps:

1. Enter a **Username**.
2. Enter a **Password**. Passwords are displayed as a series of asterisks representing each character you type.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>The number of samples in the image when it is opened. The default for WCS is to use metadata from the image. The default for WMS is to use the base layer (if there is one) and use the pixel size of the base layer to calculate the width. If a base layer is not available, then width is determined by using the <strong>WMS Pixels Per Side</strong> preference. A square pixel size is selected, where the greater of the number of samples and lines are equal to the <strong>WMS Pixels Per Side</strong> value. Example: width=500</td>
</tr>
<tr>
<td>height</td>
<td>The number of lines in the image when it is opened. The default for WCS is to use metadata from the image. The default for WMS is to use the base layer (if there is one) and use the pixel size of the base layer to calculate the height. If a base layer is not available, then height is determined by using the <strong>WMS Pixels Per Side</strong> preference. A square pixel size is selected, where the greater of the number of samples and lines are equal to the <strong>WMS Pixels Per Side</strong> value. Example: height=500</td>
</tr>
<tr>
<td>format</td>
<td>The format in which to transmit the data across the Internet. The format must be among the list of formats supported by the OGC server. The supported transmission formats are JPEG 2000, JPEG, and TIFF. The default is to first look for JPEG 2000 (lower transmission time). If the server does not support JPEG 2000, then it looks for any supported JPEG format, then any supported TIFF format. If the server does not support the specified format, it returns an error. Example for WMS: format=image/jpeg Example for WCS: format=jpg</td>
</tr>
</tbody>
</table>

**WCS-only keywords**

| coverage | Required. The name of the dataset. Example: coverage=srtmplus_raw |
| crs      | The coordinate reference system of the image. This keyword value must be a string that comes from the list of reference systems supported by the server. Example: crs=EPSG:4326 |

**WMS-only keywords**

| layers   | Required. The name of the layer. You can specify multiple, comma-delimited layers. ENVI EX will allow the server to combine the WMS layers and display them as a single layer. Example: layers=streets |
| srs      | The spatial reference system of the image. This value must be a string that comes from the list of reference systems supported by the server. Example: srs=EPSG:4326 |
| style    | The display style from the server-supported style list. This specifies how to display certain features, if used (for example, display a two-pixel yellow line for roads). Example: style=visual |
3. Click OK in the Connection Authentication dialog to attempt a connection using the specified login information. If the connection fails, an error message appears and the Connection Authentication dialog remains open so that you can reenter the login information.

**Note:** Your username and password are retained for as long as the server or dataset is open.

**Using the Remote Connection Manager**

Use the Remote Connection Manager dialog to connect to geodatabases and servers, to add a connection to a list of frequently visited servers, and to manage connection properties. If accessing datasets on a WMS server, you can also use this dialog to combine two or more datasets into one displayable map layer.

To open a remote dataset from the Remote Connection Manager dialog:

1. Select **File > Remote Connection Manager** from the ENVI EX menu bar. The Remote Connection Manager dialog appears.

   You may also have accessed this dialog by clicking **Open Remote Dataset** in another dialog.

2. There are two ways to connect to a server or geodatabase from this dialog.
   
   - The dialog is initially empty. Click **Connection**, then select **New** and see the steps in "Managing Connection Properties" on page 72 to create a new connection.
   
   - If you have a commonly used connection that you have saved as a favorite, click **Favorites**, then select the server name from the menu. To add favorites to the Favorites list, see "Managing Favorites" on page 73. Connection may be slow.

The icons that appear in the Remote Connection Manager dialog differ depending on the connection type, to help you easily distinguish among the four types:
3. Select the server or geodatabase from the Connection List. The list of available datasets appears in the Dataset List with icons that indicate the dataset type:

- IAS dataset
- WMS dataset
- WCS dataset
- Geodatabase: Raster
- Geodatabase: Point or multi-point feature class
- Geodatabase: Polygon feature class
- Geodatabase: Polyline feature class
- Geodatabase: Unsupported data type

Select the dataset to open from the Dataset List. The properties for the selected dataset appear in the Properties List. If needed, you can edit some of the properties before opening the dataset, as described in "Editing Properties" on page 71.

**Note:** For OGC datasets only: if ENVI EX does not support one of the formats under the **Supported Formats** drop-down list (in the Properties List), you cannot open the dataset. You can view all of the dataset properties, but the Open button is disabled.

Additionally, some IAS datasets cannot be opened. When you select an IAS dataset from the Dataset List that cannot be opened, the properties do not display in the Properties List, and the Open button is disabled.

4. If you want to combine multiple datasets on a WMS server and open them as one map layer, select additional datasets from the Dataset List. You can multi-select datasets by pressing the **Ctrl** or **Shift** key as you select files.

5. Click **Open**. In ENVI EX, the dataset may be automatically displayed and added to the Layer Manager, depending on your display preferences. (See "Display General Preferences" on page 41.) If you opened multiple WMS datasets as one displayable map layer, the layer name in ENVI EX is a combination of all selected dataset names. If you opened an IAS dataset that contains metadata, you can view that metadata as described in "Viewing NITF Metadata" in ENVI EX Help. You cannot use ENVI EX’s vector tools to edit a vector layer originating from a geodatabase.

6. If you have connected to a geodatabase and datasets are added to or removed from the geodatabase while you are working in ENVI EX, you can refresh the Remote Connection Manager to see the updates. In the Remote Connection Manager, click **Connection** and select **Refresh**, or right-click on a geodatabase name in the Connection List and select **Refresh**. The Dataset List updates to show the changes.
## Editing Properties

Edits you make to dataset properties apply to the current dataset only. The properties you can edit depend on the server type. The following describes the properties you can edit:

<table>
<thead>
<tr>
<th>Geodatabases</th>
<th>You cannot edit properties in personal, file, or enterprise geodatabases.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IAS</td>
<td>All properties from IAS servers are read-only. Raw JPIP servers cannot display properties. The JPEG 2000 compression properties that are always available for viewing are Number of Layers, Number of Components, Number of Discard Levels, Progression, Number of Tiles, Bit Depth, and flags to indicate if the data are reversibly compressed, YCC rotated, or signed.</td>
</tr>
<tr>
<td></td>
<td>- If XML boxes or UUID boxes are present in the dataset, you can select from their respective drop-down lists to view them in a separate window.</td>
</tr>
<tr>
<td></td>
<td>- If NITF metadata is present in one of the XML boxes, the NITF metadata is imported if the file is opened, but only the XML data are accessible in the Remote Connection Manager’s Properties List.</td>
</tr>
<tr>
<td></td>
<td>- If a GeoJP2 style UUID box is present, the map information is extracted and the following fields are added to the properties listing: Projection, Top Boundary, Left Boundary, X Pixel Size, and Y Pixel Size.</td>
</tr>
<tr>
<td>WCS</td>
<td>The WCS properties you can edit are Formats, Coordinate System, Boundary (Top, Bottom, Left, and Right), Interpolation Type, and Pixel Size (X and Y).</td>
</tr>
<tr>
<td></td>
<td>- Formats, Coordinate System, and Interpolation Type are drop-down lists containing the values provided by the server. Select the value from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- Boundary and Pixel Size values are derived from the coverage data. You can manually edit these values to customize the geographic extent and resolution of the dataset to open.</td>
</tr>
<tr>
<td>WMS</td>
<td>The WMS properties you can edit are Formats, Spatial Reference System, Boundary (Top, Bottom, Left, and Right), Number of Samples, Number of Lines, and Map Style.</td>
</tr>
<tr>
<td></td>
<td>- Formats, Spatial Reference System, and Map Style are drop-down lists containing the values provided by the server. Select the value from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- Boundary, Number of Samples, and Number of Lines are derived from the layer data. You can manually edit these values to customize the geographic extent and resolution of the dataset to open.</td>
</tr>
<tr>
<td>Multi-WMS</td>
<td>When you select multiple WMS layers to open, the properties that appear are a subset of the properties available for a single WMS dataset. The multi-WMS properties you can edit are Formats, Spatial Reference System, Boundary (Top, Bottom, Left, and Right), Number of Samples, and Number of Lines.</td>
</tr>
<tr>
<td></td>
<td>- Formats and Spatial Reference System drop-down lists contain all of the options common to all of the selected datasets. Select the value from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- The Boundary, Number of Samples, and Number of Lines values default to value of the first dataset you selected in the Remote Connection Manager.</td>
</tr>
</tbody>
</table>
Managing Connection Properties

The Connection Properties dialog lets you enter connection information for a new connection or edit the name of an existing connection.

1. Choose one of the following:
   - To enter properties for a new connection, click Connection and select New. The Connection Properties dialog appears. The fields are initially blank.
   - To edit the name of an existing connection, select the connection you want to edit, click Connection and select Properties. Or, right-click on a server name in the Connection List and select Properties. The Connection Properties dialog appears. The fields are populated with the properties of that connection. You can only edit the connection name.

2. The URL field is optional and provides a convenient place for you to specify a path or connection details in a single string.
   
   If you press Enter or move to another field in the dialog, the remaining fields are automatically populated from the information in the URL. You can edit the fields described in Steps 3-8 if necessary. Or, click OK after entering a URL to connect as described in Step 10.

   Following are examples of URLs:

   **IAS**
   
   jpip://exampleserver:1234/

   **OGC WCS**
   
   http://exampleserver:1234/cgi-bin/mmaperv.exe?map=/ogc_data/wcs_test.map&service=wcs

   **OGC WMS**
   
   http://exampleserver:1234/cgi-bin/mmaperv.exe?map=/ogc_data/wms_test.map&service=wms

   **Enterprise geodatabase**
   
   exampleserver:5151

3. In the Name field, enter a custom name for the connection to help you recognize it in the Connection List. The default value is the name of the connection.

4. From the Type drop-down list, select from the available list of data sources. If you are editing existing connection properties, you cannot modify the selection. The choices are **File Based Geodatabase**, **Personal Geodatabase**, **Enterprise (SDE) Geodatabase**, **OGC Web Coverage Service (WCS)**, **OGC Web Map Service (WMS)**, and **IAS Service**. The list of available choices depends on your platform. (See "Supported Platforms" on page 64.)

5. For **File Based Geodatabase** or **Personal Geodatabase**, enter the Path to connect to.

6. For all other connection types, enter the Server name and the Port number you want to connect to. For **Enterprise (SDE) Geodatabase**, the port value is the instance.

7. If the connection type is **Enterprise (SDE) Database**, enter a required Database and transactional Version for querying Enterprise Database connections.

8. If the connection type is OGC, enter a required CGI Path for querying OGC connections, and you can enter an optional Prefix for querying OGC connections. This is a configuration string that is required to access the correct datasets on the server.
9. To open a file or personal geodatabase, select **File Based Geodatabase** or **Personal Geodatabase** from the **Type** drop-down list. Click the **Open** button. The Browse for Folder dialog appears. Select a geodatabase from your computer, and click **OK**. The **Path** field in the Connection Properties dialog is populated with the path and filename of the geodatabase.

10. Click **OK** in the Connection Properties dialog. ENVI EX confirms the information you entered is valid and returns you to the Remote Connection Manager dialog. You may be prompted for a username and password if they are required. See “Connection Authentication” on page 68 for details.

If the connection does not respond or any of the connection information is invalid, an error message appears and the Connection Properties dialog remains open so that you can reenter the properties.

If you are connecting to an enterprise server and your database version string is not set to `sde.DEFAULT`, the Connection Details dialog appears. Select a transactional version from the **Version Name** list, or specify the details for a historical version. See “Creating Spatial Database Connections” in ArcGIS Desktop Help for details.

The new or edited connection becomes the active connection in the Remote Connection Manager dialog, and ENVI EX queries that connection for available datasets and displays them in the Dataset List.

**Managing Favorites**

You can add commonly used connections to a list of favorites, so that you can easily open those connections in the future.

**Note:** The **Favorites** option is disabled for connections that require a password.

1. In the Remote Connection Manager dialog, select the connection name from the **Connection List**.

2. Select one of the following:
   - Right-click on the connection name and select **Add to Favorites**.
   - Click **Favorites** and select **Add to Favorites**.
     The Add to Favorites dialog appears.

3. Do any of the following:
   - In the **Name** field, enter a custom name for the connection to help you recognize it in the Favorites List.
   - If one or more folders exist in the Favorites List, select the folder into which to add the new favorite.

4. Click **OK**. The name is added to the Favorites List, which appears in the Remote Connection Manager dialog **Favorites** menu.

You can manage your Favorites List by creating folders in which to group favorites, by reordering favorites, and by deleting or renaming favorites. To manage favorites, click **Favorites** and select **Manage** to open the Favorites Manager dialog. This dialog contains the Favorites List.

- To create a new folder, right-click and select **New Folder**. The Enter Name dialog appears. Type a **Name** for the new folder and click **OK**. The new folder appears in the Favorites List.
- To reorder the Favorites List, or to move favorites to a folder, select the name from the Favorites List, then drag and drop the name to a new location.
To rename a favorite or folder, right-click on the name in the Favorites List and select **Rename**. The Enter Name dialog appears. Type a new **Name** and click **OK**. The new name appears in the Favorites List.

To delete a favorite or folder, right-click on the name and select **Delete**. The name is removed from the Favorites List. Deleting a folder deletes all of the connections and subfolders associated with it.

When you are finished working with the Favorites Manager dialog, click **OK** to close the dialog. To access a favorite connection, click **Favorites** and select the connection name.
Geo Link to ArcMap

The Display menu Geo Link to ArcMap option allows you to geographically link the same georeferenced image, or two images that are georeferenced, between the ENVI EX Image window and the active data frame in the ArcMap data view. Once linked, panning the image in ENVI EX or ArcMap will pan the image in the other application so that the center geolocation in both the ENVI EX and the ArcMap displays are the same. You can also move the image by moving the View box in the Overview window or by using the Go To tool in ENVI EX. The Geo Link to ArcMap feature is not supported in the ENVI EX Print Layout view or in the ArcMap layout view.

Geo Link to ArcMap currently supports datasets with the following types of georeferencing:

- Geographic coordinate systems
- Projected coordinate systems

Images with any other types of geo-referencing (RPC, RSM, affine map transformations kx/ky, pseudo projections, x/y start) are not supported in Geo Link to ArcMap.

To use the Geo Link to ArcMap feature:

1. Open the same georeferenced image or two different georeferenced images in ENVI EX and ArcMap.
2. From the ENVI EX menu bar, select Display, then click to enable/disable the Geo Link To ArcMap option.
   
   If you have more than one instance of ArcMap running, you will be prompted to select an instance to link to the Image window.

   If you change the active data frame in ArcMap after establishing a geo link, you will need to disable and re-enable the Geo Link to ArcMap option in ENVI EX.

   **Note:** Geo Link to ArcMap enables dynamic display in ArcMap; the symbology in ArcMap may vary slightly.

   **Note:** When Geo Link to ArcMap is enabled, ArcMap uses bilinear interpolation while zooming.
Chapter 4: Using Portals

In this chapter you will find:

About Portals ................................................................................................................. 78
Working with Portals ........................................................................................................ 79
About Portals

A Portal is a window inside the Image window that allows you to view multiple layers in the Layer Manager simultaneously. A Portal works as a separate layer (inside the Portals folder) in the Layer Manager.

The following example shows a Portal consisting of a multispectral image over a panchromatic image.
Working with Portals

A Portal is a window inside the Image window that allows you to view multiple layers in the Layer Manager simultaneously. A Portal works as a separate layer (inside the Portals folder) in the Layer Manager.

The following example shows a Portal consisting of a multispectral image over a panchromatic image.

To display a layer in a Portal, select one of the following options:

- Right-click on a layer in the Layer Manager and select Display in Portal to display that layer in a Portal.
- If you have two or more layers open, select Display > Portal from the menu bar or click the Portal button. If you have two layers open, the bottom layer in the Layer Manager tree is displayed in the Portal. If you have three or more layers open, the second layer in the Layer Manager tree is displayed in the Portal.
- You can load any displayed layer into an existing Portal by right-clicking in the Portal, selecting Load New Layer, and selecting the displayed layer from the list provided. This allows you to quickly change the layers displayed in the Portal.

Each time you create a new Portal in ENVI EX, it moves to the top of the Portals folder in the Layer Manager and becomes the selected layer (see "Selected Layers" on page 30 for more information). Displaying a layer in a Portal does not remove the layer from the Layers folder in the Layer Manager or from the Image window. You can remove the original layer without removing the Portal, you can reorder layers so that the original layer (now being displayed in the Portal) is at the bottom of the Layer Manager, or you can hide the original layer in the display without losing the view of that layer inside the Portal.

You can control the order of Portals in the Image window by dragging and dropping them within the Portals folder in the Layer Manager tree or by using menu options. Right-click on a Portal name in the Layer Manager and select Order. For more information on reordering Portals, see "Ordering Layers" on page 32.

As with other layers in the Layer Manager, selecting a Portal allows you to apply a display enhancement (brightness, contrast, transparency, etc.) to the Portal only, without affecting the associated layer or other layers.

Portals are displayed in the Image window but do not appear in the Overview window.
By default, Portals are displayed with a cyan border. You can toggle the border display on or off by right-clicking in a Portal and selecting **Show Border**.

### Portal Toolbar

The Portal toolbar is only visible when multiple layers are open, the **Select** button on the toolbar is enabled, the Portal is the selected layer, and your cursor is at the top of the Portal. You cannot see the Portal toolbar (or the frame for small Portals) while using the **Select**, **Pan**, **Fly**, **Crosshairs**, **Vector Edit**, or **Rotate** tools.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pin" /></td>
<td>Pin</td>
<td>Pin the Portal to the top layer. When you pin the portal, the button then changes to <strong>Unpin</strong>. Click again to unpin the Portal from the layer. By default, Portals can be moved around the Image window by clicking and dragging the Portal. However, you can also attach (or pin) the Portal so that the Portal moves with the layer. This way, when you pan the layer, the Portal stays fixed to its original position relative to the data.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Lock" /></td>
<td>Zoom Lock</td>
<td>Lock the Portal’s zoom factor so that it remains fixed when zooming in the selected layer. You can zoom independently in the Portal using the <strong>Fixed Zoom In</strong> or <strong>Fixed Zoom Out</strong> buttons on the Portal toolbar. Click <strong>Zoom Lock</strong> again to unlock the Portal’s zoom factor. The Portal’s zoom factor resets to the selected layer’s zoom factor after you click the <strong>Fixed Zoom In</strong> or <strong>Fixed Zoom Out</strong> button on the Portal toolbar, and all subsequent zooming applies to both the selected layer and the Portal simultaneously.</td>
</tr>
<tr>
<td><img src="image" alt="Fixed Zoom In" /></td>
<td>Fixed Zoom In</td>
<td>Zoom in to the center of the Portal by a fixed percentage (the default is 1.25x, which can be set using the <strong>Zoom Factor</strong> preference described in &quot;Zoom Factor&quot; on page 41).</td>
</tr>
<tr>
<td><img src="image" alt="Fixed Zoom Out" /></td>
<td>Fixed Zoom Out</td>
<td>Zoom out of the center of the Portal by a fixed percentage (the default is 1.25x, which can be set using the <strong>Zoom Factor</strong>.</td>
</tr>
<tr>
<td><img src="image" alt="Play/Pause" /></td>
<td>Play/Pause</td>
<td>Activate the <strong>Flicker</strong> tool or pause/restart the <strong>Blend</strong>, <strong>Flicker</strong>, or <strong>Swipe</strong> operations. If you blend, flicker, or swipe in a Portal (using the right-click menu options), the button automatically changes to <strong>Pause</strong> so that you can pause the action if necessary. Click the button again to resume play.</td>
</tr>
<tr>
<td><img src="image" alt="Faster" /></td>
<td>Faster</td>
<td>Use with <strong>Blend</strong>, <strong>Flicker</strong>, or <strong>Swipe</strong> tools only. Click this button repeatedly to increase the speed of the action.</td>
</tr>
<tr>
<td><img src="image" alt="Slower" /></td>
<td>Slower</td>
<td>Use with <strong>Blend</strong>, <strong>Flicker</strong>, or <strong>Swipe</strong> tools only. Click this button repeatedly to slow down the speed of the action.</td>
</tr>
<tr>
<td><img src="image" alt="Close" /></td>
<td>Close</td>
<td>Close the Portal.</td>
</tr>
</tbody>
</table>

The right side of the Portal toolbar lists the current zoom extent. It updates whenever you click the **Fixed Zoom In** or **Fixed Zoom Out** buttons.
Blending

Blending allows you to gradually transition from one layer to another, by increasing the transparency of top layer. Because blending works using transparency, it is recommended that you not use the transparency enhancement slider when working with this tool. You can perform a manual blending operation by using the transparency slider on a Portal that is not in blend, flicker, or swipe mode.

You must have two or more layers open in the Layer Manager, and at least one of the layers should be displayed in the Image window.

1. Select **Display > Blend** from the menu bar, or click the **Blend** button on the toolbar.
   Blending automatically begins between the top layer and the layer below it in the Layer Manager. ENVI EX creates a new Portal that covers the entire Image window. You can swap the layers displayed in the Portal by right-clicking in a Portal and selecting **Load New Layer**.
   The top layer is initially opaque. Its transparency gradually increases until it is fully transparent. Then, the blend reverses.

2. To control the blending speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal Toolbar.
   **Note:** The Cursor Value information does not update as you move your mouse during a blending operation.

3. You can enhance the top layer anytime during the blending. See "Enhancement Tools" on page 23 for more information.

To blend from an existing Portal:

If you already have a Portal open inside of your layer, you can perform blending just within the Portal using the following steps:

1. Right-click in the Portal and select **Blend**. Blending automatically begins between the top layer in the Layer Manager and the layer that is in the Portal.
   The Portal size and location do not change. The top layer is initially opaque. Its transparency gradually increases until it is fully transparent. Then, the blend reverses.

2. To control the blending speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal Toolbar.

3. You can enhance the top layer anytime during the blending.

Flickering

Flickering allows you to toggle between two layers at a desired speed.

To flicker an entire layer:

You must have two or more layers open in the Layer Manager, and at least one of the layers should be displayed in the Image window.

1. Select **Display > Flicker** from the menu bar, or click the **Flicker** button on the toolbar.
   Flickering automatically begins between the top layer and the layer below it in the Layer Manager. ENVI EX creates a new Portal that covers the entire Image window. You can swap the layers displayed in the Portal by right-clicking in a Portal and selecting **Load New Layer**.

2. To control the flickering speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal toolbar.
Working with Portals

Note: The Cursor Value information does not update as you move your mouse during a flickering operation.

3. You can enhance the top layer anytime during the flickering. See "Enhancement Tools" on page 23 for more information.

To flicker from an existing Portal:

If you already have a Portal open inside of your layer, you can perform flickering just within the Portal using the following steps:

1. Right-click in the Portal and select Flicker. Flickering automatically begins between the top layer in the Layer Manager and the layer that is in the Portal. The Portal size and location do not change.
2. To control the flickering speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal toolbar.
3. You can enhance the top layer anytime during the flickering.

Swiping

Swiping allows you to spatially transition from one layer to another, using a vertical dividing line that moves between two overlapping layers.

1. Select Display > Swipe from the menu bar, or click the Swipe button on the toolbar.
   Swiping automatically begins between the top layer (shown in the right half of the Image window) and the layer below it in the Layer Manager (shown in the left half of the Image window). ENVI EX creates a new Portal that changes size as the swipe progresses. You can swap the layers displayed in the Portal by right-clicking in a Portal and selecting Load New Layer.
   The swipe moves at a default speed from left to right until it reaches the edge of the layer, then it reverses direction.
2. To control the swiping speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal toolbar.
   Note: The Cursor Value information does not update as you move your mouse during a swiping operation.
3. You can enhance the top layer anytime during the swipe. See "Enhancement Tools" on page 23 for more information.

To swipe from an existing Portal

If you already have a Portal open inside of your layer, you can perform swiping just within the Portal using the following steps:

1. Right-click in the Portal and select Swipe. Swiping automatically begins between the top layer in the Layer Manager and the layer that is in the Portal.
2. To control the swiping speed or to pause it, select the Portal layer in the Layer Manager, then use the controls available on the Portal toolbar.
3. You can enhance the top layer anytime during the swiping.
Panning
Click inside of a selected Portal and drag it to move it to a new location. By default, Portals move with the top layer as you pan in the Image window. However, you can also attach (or pin) the Portal to the top layer so that the Portal moves with the layer. This way, when you pan the layer, the Portal stays fixed to its original position relative to the data. See Portal Toolbar, above for more information.

Zooming
Right-click on a Portal name in the Layer Manager, select Zoom To Portal, and choose one of the following options:

- **Full Extent**: Zoom to the full extent of the Portal layer.
- **1:1**: Zoom to a 1:1 extent of the Portal layer.

You can also use the **Fixed Zoom In** and **Fixed Zoom Out** buttons in the Portal toolbar.

Resizing
You can resize a Portal by dragging its corners or sides to a preferred size. To resize a Portal so that it fills a specific area of the Image window, right-click inside the Portal, select Resize Portal, and choose one of the following options:

- **Filled Right Half**
- **Filled Left Half**
- **Filled Top Half**
- **Filled Bottom Half**
- **Filled NW Quarter**
- **Filled NE Quarter**
- **Filled SW Quarter**
- **Filled SE Quarter**

Closing Portals
To close a Portal, choose one of the following options:

- Right-click inside a Portal and select **Close Portal**.
- Click the **Close** button on the Portal toolbar.
- Right-click on the Portal layer name in the Layer Manager and select **Remove**.
Chapter 5: Image Processing

In this chapter you will find:

RX Anomaly Detection  ................................................................. 86
Pan Sharpening  ................................................................. 88
Vegetation Suppression  ................................................................. 90
RX Anomaly Detection

RX Anomaly Detection processing uses the Reed-Xiaoli Detector algorithm to detect the spectral or color differences between a region to test and its neighboring pixels or the entire dataset. This algorithm extracts targets that are spectrally distinct from the image background. RXD is effective when the anomalous targets are sufficiently small, relative to the background. Results from RXD analysis are unambiguous and have proven very effective in detecting subtle spectral features. ENVI EX implements the standard RXD algorithm:

\[ \delta_{\text{RXD}}(r) = (r - \mu)^T K_{\text{LxL}}^{-1} (r - \mu) \]

Where \( r \) is the sample vector, \( \mu \) is the sample mean, and \( K_{\text{LxL}} \) is the sample covariance matrix.

RXD works with multispectral and hyperspectral images. Bad pixels or lines appear as anomalous, but they do not affect the detection of other, valid anomalies. As with any spectral algorithm, exclusion of bad bands increases the accuracy of results. Currently, this algorithm does not differentiate detected anomalies from one another.

References


1. Use the Toolbox to initiate RX Anomaly Detection. Input a multispectral image, and perform optional spatial or spectral subsetting.

2. In the RX Anomaly Detection Parameters dialog, select one of the following options from the Algorithm drop-down list:

   - RXD: Standard RXD algorithm.
   - UTD: Uniform Target Detector, in which the anomaly is defined using \((1 - \mu)\) as the matched signature, rather than \((r - \mu)\). UTD and RXD work exactly the same, but instead of using a sample vector from the data (as with RXD), UTD uses the unit vector. UTD extracts background signatures as anomalies and provides a good estimate of the image background.
   - RXD-UTD: A hybrid of the RXD and UTD methods, in which \((r - 1)\) is used as the matched signature. This is a variant of the UTD approach. Subtracting UTD from RXD suppresses the background and enhances the anomalies of interest. The best condition to use RXD-UTD is when the anomalies have an energy level that is comparable to, or less than, that of the background. In this case, using UTD by itself does not detect the anomalies, but using RXD-UTD enhances them.

3. Using the Mean Source toggle button, specify whether the mean spectrum should be derived from the full dataset (Global) or from a localized kernel around the pixel (Local). If you choose Local, the Local Kernel Size field appears. Specify a kernel size, in pixels, around a given pixel that will be used to create a mean spectrum. The default value is 15.

4. Click the File or Memory button to output the result to file or memory. File output options include ENVI and TIFF/GeoTIFF.
5. Select the **Display Result** check box to automatically display the output result in the Image window. This check box overrides the **Auto Display Files On Open** preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

6. Click **OK**. The Process Manager shows the status of RX Anomaly Detection processing. ENVI EX builds a covariance matrix and calculates a mean spectrum. Then, RXD runs line-by-line. ENVI EX adds the resulting output as a new layer to the Layer Manager.

   You can load the layer to a new Portal and move the Portal around in the Image window, comparing the RXD layer to the top, visible layer in the Image window.
Pan Sharpening

Use Pan Sharpening to sharpen low spatial resolution multispectral data using high spatial resolution panchromatic data. If both datasets are georeferenced, ENVI EX will co-register them on-the-fly and perform Pan Sharpening on the overlapping area between the two images.

ENVI EX performs Pan Sharpening by doing the following:

1. Simulating a panchromatic band from the lower spatial resolution spectral bands.
2. Performing a Pan Sharpening transformation on the simulated panchromatic band and the spectral bands, using the simulated panchromatic band as the first band.
3. Swapping the high spatial resolution panchromatic band with the first Pan Sharpening band.
4. Applying the inverse Pan Sharpening transform to create the pan-sharpened spectral bands.

The low spatial resolution spectral bands used to simulate the panchromatic band must fall in the range of the high spatial resolution panchromatic band or they will not be included in the resampling process.

Both input images must be georeferenced using standard map information. Rational polynomial coefficient (RPC) information or a pseudo projection are currently not supported.

Reference

1. Use the Toolbox to initiate Pan Sharpening. Input a multispectral image with at least two bands, and perform optional spatial or spectral subsetting. For spectral subsetting, you must select two or more bands. For Landsat ETM+ data, select a .txt or .met metadata file instead of an image file.
2. In the Select High Spatial Resolution Pan Input Band dialog, select a single-band panchromatic image. You cannot spatially subset this image; the multispectral image determines the spatial extent.
3. Click OK. The Pan Sharpening Parameters dialog appears.
4. Select an option from the Sensor drop-down list:
   - GeoEye-1: Simulates a panchromatic image for GeoEye-1 using a filter function.
   - IKONOS: Simulates a panchromatic image for IKONOS using a filter function. This option is only available when you select a multispectral image with four bands.
   - QuickBird: Simulates a panchromatic image for QuickBird using a filter function. This option is only available when you select a multispectral image with four bands.
   - Landsat ETM: Simulates a panchromatic image for Landsat ETM+ using a filter function.
   - Unknown: Uses the mean of the multispectral bands to create a low resolution panchromatic image.
     The default is Unknown. If the selected input filename begins with “po_” (upper- or lower-case) and has four bands, the selection defaults to IKONOS.
5. Select the resampling method from the Resampling drop-down list. The choices are as follows:
   - Nearest Neighbor: Uses the nearest pixel without any interpolation to create the high resolution images.
• **Bilinear** (default): Performs a linear interpolation using four pixels to create the high resolution images.

• **Cubic Convolution**: Uses 16 pixels to resample the image. Cubic convolution resampling is significantly slower than the other methods.

6. Click the **File or Memory** button to output the result to file or memory. File output options include **ENVI** and **TIFF/GeoTIFF**.

7. Select the **Display Result** check box to automatically display the output result in the Image window. This check box overrides the **Auto Display Files On Open** preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

8. Click **OK**. The Process Manager shows the status of Pan Sharpening processing. ENVI EX adds the output sharpened image to the Data Manager. The default preferences determine if it is added to the Layer Manager or not.
Vegetation Suppression

Use Vegetation Suppression to remove the vegetation spectral signature from multispectral and hyperspectral imagery, using information from red and near-infrared bands. This method helps you better interpret geologic and urban features and works best with open-canopy vegetation in medium spatial resolution (30 m) imagery.

The algorithm models the amount of vegetation per pixel using a vegetation transform. The model calculates the relationship of each input band with vegetation, then it decorrelates the vegetative component of the total signal on a pixel-by-pixel basis for each band. You can use the results of vegetation suppression for qualitative analysis, but not for subsequent spectral analysis.

Vegetation suppression is most commonly used in lithologic mapping and linear feature enhancement in areas with open canopies. For closed canopies in moderate-resolution data, vegetation suppression is primarily used for linear feature enhancement.

Reference


1. Use the Toolbox to initiate Vegetation Suppression. Input a multispectral file, and perform optional spatial or spectral subsetting. For spectral subsetting, you must select two or more bands.
   - If the associated header contains wavelength information, ENVI EX automatically determines the proper red and infrared bands to use for vegetation suppression. ENVI EX uses the band closest to 0.66 μm as the red band, and it uses the band closest to 0.83 μm as the near-infrared band.
   - If the header does not contain wavelength information, the Select Near Infrared Band dialog appears. Select the near-infrared band. Click OK. The Select Red Band dialog appears. Select the red band.
   - If the image file has wavelength information but does not have a near-infrared or red band, or if it has only one band, ENVI EX issues an error message and ends vegetation suppression.

2. In the Select Output File Parameters, click the File or Memory button to output the result to file or memory. File output options include ENVI and TIFF/GeoTIFF and requires a filename.

3. Select the Display Result check box to automatically display the output result in the Image window. This check box overrides the Auto Display Files On Open preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

4. Click OK. The Process Manager shows the status of vegetation suppression processing. ENVI EX adds the output image to the Data Manager. The default preferences determine if it is added to the Layer Manager or not.
Chapter 6: Using Workflows

In this chapter you will find:

Using Workflows ............................................................................................................... 92
About the Feature Extraction Workflow .............................................................................. 94
About the Classification Workflow ...................................................................................... 133
About the Image Difference Change Detection Workflow ............................................... 141
About the Thematic Change Detection Workflow ............................................................ 147
About the RPC Orthorectification Workflow ...................................................................... 150
Using Workflows

ENVI EX provides workflows to guide you through the process of selecting files, setting parameters, processing images, cleaning up results, and exporting output.

The following workflows are available:

An example workflow panel follows.
To cancel a process that is running, click the \( \times \) button.

**Note:** Canceling a workflow during the Export step does not automatically remove all export files. You may need to perform file maintenance and remove files that were created before you canceled.

**Preview Portals**

Depending on the step of the workflow, a **Preview** check box may be available. To preview how the output will look before continuing in the workflow, enable the **Preview** check box. A Preview Portal opens in the Image window. The Preview Portal works with full or higher resolution views to provide a WYSIWYG (what you see is what you get) result when you adjust parameters. An example Preview Portal is shown below:
About the Feature Extraction Workflow

Feature Extraction is a tool for extracting information from high-resolution panchromatic or multispectral imagery based on spatial, spectral, and texture characteristics. You can use Feature Extraction to extract a wide variety of features such as vehicles, buildings, roads, bridges, rivers, lakes, and fields.

Feature Extraction is designed to work with any type of image data in an optimized, user-friendly, and reproducible fashion so you can spend less time understanding processing details and more time interpreting results. You can also preview your results at each step (through a Preview Portal) as you fine-tune a few simple parameters.

Feature Extraction uses an object-based approach to classify imagery. An object is a region of interest with spatial, spectral (brightness and color), and/or texture characteristics that define the region. Feature Extraction lets you extract multiple features at a time. Traditional remote sensing classification techniques are pixel-based, meaning that spectral information in each pixel is used to classify imagery. This technique works well with hyperspectral data, but it is not ideal for panchromatic or multispectral imagery. With high-resolution panchromatic or multispectral imagery, an object-based method offers more flexibility in the types of features to be extracted.

The Feature Extraction Workflow

Feature Extraction is the combined process of segmenting an image into regions of pixels, computing attributes for each region to create objects, and classifying the objects (with rule-based or supervised classification) based on those attributes, to extract features. The workflow is designed to be helpful and intuitive, while allowing you to customize it to your specific application.

Before starting the workflow, you need to select input files (base image, optional ancillary files, and an optional mask file) for processing. Use the Toolbox to initiate Feature Extraction and to select input images.

Note: Make sure you have adequate disk space before processing very large files.

The workflow consists of two primary steps: Find Objects and Extract Features. The Find Objects task is divided into four steps: Segment, Merge, Refine, and Compute Attributes. When you complete this task, you will perform the Extract Features task, which consists of supervised or rule-based classification and exporting classification results to shapefiles and/ or raster images.

Click Back at any time throughout the workflow to return to a previous step and revise your parameter settings. Click Next to accept the settings and proceed to the next step. You can also enable the Preview option anytime throughout the process to show a Preview Portal, which provides a real-time preview of segmentation or classification results as you adjust parameter settings. Click the Help button at each step to view the corresponding Help topic.
Working with Multiple Layers

As you proceed through the Feature Extraction workflow, several different layers may be available in the Layer Manager. Because of the workflow’s dependency on the display, you can only add new layers; you cannot remove existing layers. To hide or show layers, right-click on the appropriate layer name(s) and select Show or Hide, respectively. Or, reorder layers as needed to view layers of interest.
Overview of Input Files

Before you begin the Feature Extraction workflow, you need to select a base image, any optional ancillary data, and an optional mask file. A base image is the primary image from which features will be extracted. Ancillary data are additional datasets of the same geographic area as the base image, which will aid in classification (for example, height data). Mask data allow you to confine processing to certain areas of the base image.

Use the Toolbox to initiate Feature Extraction and to select input images.

Base images, ancillary data, and mask files are listed in their respective fields under the Select Additional Files category of the Select Fx Input Files dialog. You can remove files from any field by right-clicking in the field and selecting Remove or Remove All. Use the following buttons in the Select Fx Input Files dialog to select input files:

- Base image
- Ancillary data
- Mask image

Selecting a Base Image

The base image is the primary image from which features will be extracted. The map projection of the base image becomes the base map projection for any ancillary data you add.

You can only designate one image as the base image, and you cannot designate an image as both a base and ancillary or mask.

Follow these steps to continue:

1. Expand the Select Additional Files category of the Select Fx Input Files dialog.
2. If you previously selected one file for input, the Base Image field lists that filename. If you selected more than one image file for input, the Base Image field lists only the first filename you selected.
3. To specify a different image to use as the base image, click the Base Image button to make the Base Image field active. Select a filename that you already opened from the Select Fx Input Files dialog, or click the Open File button and select a new file. The Base Image field lists the file you added.
   
   **Note:** Datasets from WCS or JPIP servers cannot be used as input into this workflow.

4. Perform optional spectral or spatial subsetting on the base image.
5. You can continue with selecting ancillary data and/or mask files for input, or click OK in the Select Fx Input Files dialog to begin the Feature Extraction workflow.

If you spatially or spectrally subsetted the base image, the Preparing Data dialog appears with a progress bar. When processing is complete, Feature Extraction proceeds to the Find Objects task of the workflow (see "Segmenting Images" on page 100). At this point, you cannot click Back to return to the data selection steps.
Working with Ancillary Data

You can use raster ancillary data in the Feature Extraction workflow to help extract features of interest. For example, you could combine a LiDAR digital surface model (DSM) with a base image to identify rooftops in a residential area. After computing attributes, you could build a rule using the height information from the DSM to more accurately extract the rooftops.

Multiple ancillary datasets often provide more accurate results in Feature Extraction. In the example above, you could also import a classification map of the residential area to delineate vegetation. Thus, you can build upon your rule set to ignore areas identified as vegetation, reducing clutter in the final result.

To use ancillary data with your base image, the following restrictions apply:

- You can only use raster data for ancillary data.
- Both the base image and ancillary data must have map information. If the ancillary data is not in the same map projection as the base image, ENVI EX will reproject the ancillary data to match the base projection.
- The ancillary data and base image must have some geographic overlap.
- If you spatially subset the base image, the ancillary data will be reprojected to match that spatial extent.
- You can select specific bands to process from the ancillary dataset and base image.

Follow these steps to select ancillary data:

1. Expand the Select Additional Files category of the Select Fx Input Files dialog.
2. Click the Ancillary Data button to make the Ancillary Data field active.
3. Select one or more ancillary files if you already opened them from the Select Fx Input Files dialog, or click the Open File button and select new files to open. Use the Ctrl key to select multiple files. The Ancillary Data field lists the ancillary data files you added.
4. You can continue with selecting a mask file for input, or click OK in the Select Fx Input Files dialog to finish selecting input files. The Preparing Data dialog appears, and ENVI EX reprojects the ancillary data to match the base projection (if needed) and creates a layer stack from the combined bands of the base image and ancillary data.

ENVI EX treats the layer stack as one source file that will be used throughout the rest of the Feature Extraction workflow. You will have an opportunity to save the layer stack at the end of the workflow so that you can restore it for future sessions (instead of re-selecting all of the various data sources used for input).

When the Preparing Data dialog completes, Feature Extraction proceeds to the Find Objects: Segment panel of the workflow (see "Segmenting Images" on page 100). At this point, you cannot click Back to return to the data selection steps.

Working with Masks in Feature Extraction

Masking is a powerful feature in image processing used to reduce clutter and improve accuracy in the final results. Masks allow you to confine image processing to specific areas in the image (a regular mask) or to ignore specific areas in an image for processing (an inverse mask).

You can import a mask file in the data input step (described here). In the Feature Extraction workflow you can also generate a new mask from thresholding results in the Refine step (see "Refining Segments" on page 103).
The following figures show an example of using a mask.

Suppose you want to limit processing to only residential areas, so that you can identify rooftops within the scene. You could create a regular mask (in ENVI EX), similar to the following example. If you were to import this mask during the data selection step, each subsequent step of the workflow would ignore the area associated with the masked pixels.

Restrictions

The following restrictions apply to working with masks:

- You can only use a single-band image or polygon shapefile as a mask file. Multi-band images or point/line shapefiles are not allowed. ENVI EX will convert polygon shapefiles to raster images for the workflow.
- You can only specify one mask file for input.
- A mask must have the same map projection as the base layer. Masks are not reprojected to match the base layer image.
• A raster mask must have the same spatial extent as the base image. Combining ancillary data with a base image creates a layer stack from the two inputs and uses the layer stack as input into Feature Extraction. In some cases, the layer stack will be reprojected and have a different spatial extent than the original base image. If you were to use a raster mask that was created from the original base image in the Feature Extraction workflow, you may receive an error message during segmentation because the spatial extents are different between the layer stack and the raster mask. If you are combining ancillary data and a mask with your base image, you can use the following steps to avoid this reprojection problem: (1) After selecting input data, cancel out of the Feature Extraction workflow. You will be prompted to save the mask and layer stack. (2) Save the vector or raster mask and layer stack to separate raster files. (3) Restart Feature Extraction, and use the layer stack as the base image, and the saved raster mask as the mask file.

• You cannot use the same image for the base and/or ancillary data and/or mask file.

Selecting a Mask File

See "Creating a Mask File" on page 99 for instructions on creating a mask.

1. Expand the Select Additional Files category of the Select Fx Input Files dialog.
2. Click the Mask File button to make the Mask File field active.
3. Select a mask file if you already opened it from the Select Fx Input Files dialog, or click the Open File button and select a new file to open. The Mask File field lists the file you added. You can select a single-band raster image or polygon shapefile as the mask file.
4. By default, Feature Extraction will ignore areas with pixel values of 0 in the mask during processing. To use an inverse version of the mask, right-click on the mask’s filename in the Mask Field and select Inverse. Feature Extraction will then process the areas with pixel values of 0 and will ignore all other pixels.
5. Click OK in the Select Fx Input Files dialog to finish selecting input files. The Preparing Data dialog appears if you selected a polygon shapefile for the mask file.
6. Feature Extraction proceeds to the Find Objects task of the workflow (see "Segmenting Images" on page 100). At this point, you cannot click Back to return to the data selection steps.

Creating a Mask File

Following are some suggested steps for creating a mask file:

1. Open and display an image.
2. From the menu bar, select File > New > Vector Layer. The Create New Vector Layer dialog appears.
3. Enter a Layer Name.
4. From the Record Type drop-down list, select Polygon.
5. Click OK.
6. Use the Vector Create tool to draw polygons in the Image window. The regions outside of the polygon will be ignored during processing when the mask is used as a regular mask.
7. From the menu bar, select File > Save As > New Vector. Save the vector layer to a shapefile.
Segmenting Images

Segmentation is the process of partitioning an image into segments by grouping neighboring pixels with similar feature values (brightness, texture, color, etc.) These segments ideally correspond to real-world objects.

ENVI EX employs an edge-based segmentation algorithm that is very fast and only requires one input parameter (Scale Level). By suppressing weak edges to different levels, the algorithm can yield multi-scale segmentation results from finer to coarser segmentation. The segmentation algorithm calculates a gradient map for the image; it calculates a density function for the gradient map; it calculates a modified gradient map using the original gradient map, density function, and Scale Level; then it segments the modified gradient map. See the "Segmentation-based image processing system" Patent Application for more details.

Choosing a high Scale Level causes fewer segments to be defined, and choosing a low Scale Level causes more segments to be defined. You should ideally choose the highest Scale Level that delineates the boundaries of features as well as possible. Good segmentation ensures that classification results are more accurate. If you choose too high of a Scale Level, the boundaries between segments will not be properly delineated and you will lose features of interest.

You should ensure that features of interest are not grouped into segments represented by other features. You should also ensure that a feature of interest is not divided into too many small segments (over-segmentation; usually the result of a low Scale Level). If you cannot avoid this problem in the Segment step, then you can use Merge in the second step to improve the delineation of feature boundaries. You can also use the Refine step to solve over-segmentation issues for certain features.

Perform the following steps:

1. In the Feature Extraction dialog, enable the Preview option to display a Preview Portal showing the current segmentation results.
   You can use Blend, Flicker, and Swipe tools to view the underlying layer. You can also use the Pan, Zoom, and Transparency tools, although these are for display purposes only; they do not affect Feature Extraction results.
   You cannot adjust the Contrast, Brightness, Stretch, orSharpen values in a Preview Portal.
   If a Preview Portal is displayed over an image, you can use any of ENVI EX’s enhancement tools on the image by first clicking on the image in the Image window or selecting the image layer in the Layer Manager. You can also move the Preview Portal around the image or resize it to look at different areas.
   Note: For optimal Preview Portal performance, set the Zoom to 100 percent before running Feature Extraction. See Zooming.

2. Adjust the Scale Level as necessary. Values range from 0.0 (finest segmentation) to 100.0 (coarsest segmentation; all pixels are assigned to one segment). The default value is 50.0. Increasing the Scale Level results in fewer segments. Use the slider or type a number in the provided field, and press Enter to set this value. As you change the value, the Preview Portal shows the results in real time.
   Following are some tips on changing the value:
   - Click on the slider bar to the right or left of the indicator to move the slider up or down incrementally by a value of 10.0.
   - Click the slider, then use the arrow keys (on your keyboard) to increase or decrease the value by 0.1.
• Click the slider, then press **Home** to move the slider to 100.0 or **End** to move the slider to 0.0.
• Type a value into the provided field and press **Enter**.

3. You can choose to select specific bands for input into the Segment step. For example, suppose you selected a low-resolution DEM as ancillary data for use with a QuickBird high-resolution optical image in Feature Extraction (see "Working with Ancillary Data" on page 97). ENVI EX creates a layer stack from these datasets as input into the Segment step. You would like to retain the shapes of the objects derived from segmentation (to match what you see in the optical image), while ignoring the DEM data. So you could select only the bands in the layer stack corresponding to the optical data, as input into the Segment step.

   Click the **Select Input Bands** button ![Select Input Bands](image). The Select Input Bands dialog appears. All bands from the base image are selected by default. To select a single band, right-click on the image filename and choose **Select None**, then click to select a single band. Or, use the **Ctrl** key to select multiple bands.

   Click **OK**. The Preview Portal updates to show the selected bands of data.

4. When you are satisfied with the results, click **Next** to process the entire image. The Process Manager (in the Status Bar) shows the status of segmentation processing.

   ENVI EX creates a Region Means image, adds it to the Layer Manager, and displays it in the Image window. (An example layer name is `filenameRegionMeans`.) The Region Means image is a raster file that shows the results of the segmentation process. Each segment is assigned the mean band values of all the pixels that belong to that region. Feature Extraction proceeds to the Find Objects: Merge panel.

**References**


## Merging Segments

Merging is an optional step used to aggregate small segments within larger, textured areas such as trees, clouds, or fields, where over-segmentation may be a problem. For example, if your image shows thick vegetation, increasing the **Scale Level** (in the previous Segment step) may not sufficiently delineate tree-covered areas. The results may be over-segmented if you set a small **Scale Level** value or under-segmented if you set a large **Scale Level** value. Merging would be a useful option in this case for improving the delineation of tree boundaries.

The **Merge Level** parameter represents the threshold lambda value, which ranges from 0.0 to 100.0 (see "Background" on page 102). Through an increasing nonlinear mapping, the parameter is more controllable and suitable for preview. You should choose the highest **Merge Level** that delineates the boundaries of features as well as possible.

If merging is not a useful option for your image, you can proceed directly to the Refine step by clicking **Next** in the Merge step (leaving the **Merge Level** at the default value of 0.0). No merging will be performed.

Perform the following steps:

1. Enable the **Preview** option to display a Preview Portal showing the current segmentation results.
2. Adjust the **Merge Level** as necessary. Values range from 0.0 (default; no merging) to 100.0 (all segments merge into one). Use the slider or type a number in the provided field and press **Enter** to set this value. As you change the value, the Preview Portal shows the results in real time. Following are some tips on changing the value:

- Click on the slider bar to the right or left of the indicator to move the slider up or down incrementally by a value of 10.0.
- Click the slider, then use the arrow keys (on your keyboard) to increase or decrease the value by 0.1.
- Click the slider, then press **Home** to move the slider to 100.0 or **End** to move the slider to 0.0.
- Type a value into the provided field and press **Enter**.

3. When you are satisfied with the results, click **Next**. The Preview Portal closes. ENVI EX applies merging to the entire image, and the Process Manager (in the Status Bar) shows the status of merge processing.

ENVI EX creates a merged Region Means image, adds it to the Layer Manager, and displays it in the Image window. (An example layer name is **filenamemergedRegionMeans**.) ENVI EX removes from the Layer Manager the Region Means image created during the Segment step. Feature Extraction proceeds to the Find Objects: Refine panel.

**Background**

ENVI EX employs the Full Lambda-Schedule algorithm created by Robinson, Redding and Crisp (2002). In ENVI EX, the algorithm iteratively merges adjacent segments based on a combination of spectral and spatial information. Merging proceeds if the algorithm finds a pair of adjacent regions, \( i \) and \( j \), such that the merging cost \( t_{i,j} \) is less than a defined threshold lambda value:

\[
t_{i,j} = \frac{|O_i| \cdot |O_j|}{|O_i| + |O_j|} \cdot \left\| \frac{u_i - u_j}{\text{length}(\partial(O_i, O_j))} \right\|^2
\]

Where:

- \( O_i \) is region \( i \) of the image
- \( |O_i| \) is the area of region \( i \)
- \( u_i \) is the average value in region \( i \)
- \( u_j \) is the average value in region \( j \)
- \( \|u_i - u_j\| \) is the Euclidean distance between the spectral values of regions \( i \) and \( j \)
- \( \text{length}(\partial(O_i, O_j)) \) is the length of the common boundary of \( O_i \) and \( O_j \)
Refining Segments

You can choose to refine segmentation results using another optional merging method called thresholding, which is useful for extracting point features (for example, airplanes or buildings) when over-segmentation is a problem. Thresholding is a raster operation that works with one band of your Region Means image to group adjacent segments based on their brightness value (digital number or DN). Thresholding works well with features that are in high contrast to their background (for example, bright aircraft against a dark tarmac).

Choose one of the following options:

- **No Thresholding (default):** No thresholding will be performed. Click Next to proceed to the Find Objects: Compute Attributes panel.

- **Thresholding (advanced):** If you select this option, a histogram of the first band of the Region Means image appears. Follow the steps below to continue.

The Preview option is enabled, and a blank Preview Portal is displayed.

**Note:** You may find it helpful to use the Transparency tool to adjust the transparency of the thresholding results in the Preview Portal so that you can see the underlying image.

Setting Thresholds

Click and drag the dashed vertical lines on the histogram to define the lower and upper limits of the threshold, or enter minimum and maximum values in the fields provided. ENVI EX computes and displays a mask image in the Preview Portal, which dynamically updates to show changes you make to the histogram.

Pixel values below the low threshold and above the high threshold are assigned a value of 0, and values between the thresholds are assigned a value of 255 in the mask image. When you define the lower and upper limits of the threshold, you are essentially defining new boundaries for your features of interest. The black area in the mask image represents one big region, while the white areas represent other distinct regions.

When you click Next, ENVI EX computes a mask image for the entire scene, segments the mask image, and assigns each distinct region a unique identifier. The identifiers are then used in computing attributes. If you do not adjust the histogram values, no thresholding is performed.

Selecting a Different Band for the Refine Step
By default, the first band of the Region Means image is used for thresholding. To change the input band, click the **Select Input Bands** button. The Select Input Bands dialog appears. Select one band from the Region Means image, and click **OK**. The histogram and Preview Portal update to reflect the data from your selected band. (The Region Means image is a raster file that was created during the Segment step that shows the results of the segmentation process. Each segment is assigned the mean band values of all the pixels that belong to that region.)

**Creating a Mask**

Enable the **Create Mask** option if you want to create a raster layer from the mask that appears in the Preview Portal. Creating a mask during the Refine step is useful for filtering out unwanted features or noise from your segmentation results. A mask created during the Refine step is based on segments rather than individual pixels (as with a raster mask selected from the Select Fx Input Files dialog).

To use an inverse version of the mask, enable the **Inverse** option. Feature Extraction will then process areas in the mask with pixel values of 0 and will ignore all other pixels.

When you click **Next**, the mask is combined with the existing Region Means image to produce a new Region Means image, which is displayed in the Image window and added to the Layer Manager. ENVI EX will process areas with pixel values of 1 throughout the remaining workflow. You cannot click **Back** from the Refine step and expect to use this mask when repeating the Segment and Merge steps. You will have an opportunity to save the mask to disk when you exit the Feature Extraction workflow.

If you selected a mask file for input prior to starting the Feature Extraction workflow, and you create a new mask during the Refine step, ENVI EX will combine the two masks into one for the remaining workflow.

**Note**: If you create a mask during the Refine step and proceed with selecting training data for supervised classification, the objects within the masked area will not be highlighted in color when you move your cursor over them. (See "Defining Training Data" on page 110).

**Proceeding with Feature Extraction**

When you are satisfied with the results, click **Next**. The Preview Portal closes. The Process Manager (in the Status Bar) shows the status of threshold processing. ENVI EX creates a refined Region Means image and adds it to the Layer Manager. (An example layer name is `filenamerefinedRegionMeans`). ENVI EX removes from the Layer Manager the Region Means image created during the Merge step.

Feature Extraction proceeds to the Find Objects: Compute Attributes panel.

**Computing Attributes**

Feature Extraction uses an object-based approach to classification, as opposed to pixel-based classification. The benefit of an object-based approach is that objects can be depicted with a variety of spatial, spectral, and texture attributes. In the Compute Attributes step, you define which attributes to compute for each object. Various preference settings control how ENVI EX computes the attributes. See "Feature Extraction Preferences" on page 126. You can use these attributes to help define classes when you perform rule-based or supervised classification.

1. Under the Attributes tab, select any of the following attribute types to compute:
   - **Spatial**: See "Spatial Attributes" on page 106. You must choose to compute spatial attributes if you plan to export segmentation results as described in "Exporting Vectors" on page 109.
   - **Spectral**: See "Spectral Attributes" on page 107.
Computing Attributes

About the Feature Extraction Workflow

- **Texture**: See "Texture Attributes" on page 108.

2. Under the Advanced tab, select any of the following attribute types to compute:
   - **Color Space**: For use with multispectral images only. See "Color Space and Band Ratio Attributes" on page 108.
   - **Band Ratio**: For use with multispectral images only. See "Color Space and Band Ratio Attributes" on page 108.

3. Click **Next**. ENVI EX computes the attributes for each object.

   If you choose to compute spatial attributes, ENVI EX performs an internal raster-to-vector operation and computes spatial attributes from the vectors.

   The previous steps (Segment, Merge, and Refine) can easily create very large segments that represent background objects and are meaningless in the context of classification. Creating vectors from these large regions consumes a lot of memory and results in poor display performance; therefore, ENVI EX ignores these large regions during vectorization. ENVI EX will not vectorize any region with more vertices than you specify in the **Maximum Number of Vector Vertices** preference. If you want to extract very large regions from an image, you should first down-sample the image prior to running Feature Extraction.

   ENVI EX proceeds to the Extract Features: Classify or Export panel of the Feature Extraction dialog.

   **Note**: ENVI EX computes attributes only for purposes of supervised or rule-based classification; the attributes are not passed to any output shapefiles you create during the Export step.
### Spatial Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AREA</td>
<td>Total area of the polygon, minus the area of the holes. Values are in map units.</td>
</tr>
<tr>
<td>LENGTH</td>
<td>The combined length of all boundaries of the polygon, including the boundaries of the holes. This is different than the MAXAXISLEN attribute. Values are in map units.</td>
</tr>
</tbody>
</table>
| COMPACT     | A shape measure that indicates the compactness of the polygon. A circle is the most compact shape with a value of 1 / pi. The compactness value of a square is 1 / 2(sqrt(pi)).  
COMPACT = Sqrt (4 * AREA / pi) / outer contour length |
| CONVEXITY   | Polygons are either convex or concave. This attribute measures the convexity of the polygon. The convexity value for a convex polygon with no holes is 1.0, while the value for a concave polygon is less than 1.0.  
CONVEXITY = length of convex hull / LENGTH |
| SOLIDITY    | A shape measure that compares the area of the polygon to the area of a convex hull surrounding the polygon. The solidity value for a convex polygon with no holes is 1.0, and the value for a concave polygon is less than 1.0.  
SOLIDITY = AREA / area of convex hull |
| ROUNDNESS   | A shape measure that compares the area of the polygon to the square of the maximum diameter of the polygon. The "maximum diameter" is the length of the major axis of an oriented bounding box enclosing the polygon. The roundness value for a circle is 1, and the value for a square is 4 / pi.  
ROUNDNESS = 4 * (AREA) / (pi * MAXAXISLEN^2) |
| FORMFACTOR  | A shape measure that compares the area of the polygon to the square of the total perimeter. The form factor value of a circle is 1, and the value of a square is pi / 4.  
FORMFACTOR = 4 * pi * (AREA) / (total perimeter)^2 |
| ELONGATION  | A shape measure that indicates the ratio of the major axis of the polygon to the minor axis of the polygon. The major and minor axes are derived from an oriented bounding box containing the polygon. The elongation value for a square is 1.0, and the value for a rectangle is greater than 1.0.  
ELONGATION = MAXAXISLEN / MINAXISLEN |
| RECT_FIT    | A shape measure that indicates how well the shape is described by a rectangle. This attribute compares the area of the polygon to the area of the oriented bounding box enclosing the polygon. The rectangular fit value for a rectangle is 1.0, and the value for a non-rectangular shape is less than 1.0.  
RECT_FIT = AREA / (MAXAXISLEN * MINAXISLEN) |
| MAINDIR     | The angle subtended by the major axis of the polygon and the x-axis in degrees. The main direction value ranges from 0 to 180 degrees. 90 degrees is North/South, and 0 to 180 degrees is East/West. |
| MAJAXISLEN  | The length of the major axis of an oriented bounding box enclosing the polygon. Values are map units of the pixel size. If the image is not georeferenced, then pixel units are reported. |
Formulas for calculating COMPACT, CONVEXITY, SOLIDITY, ROUNDNESS, and FORMFACTOR are from Russ (2002).

ENVI EX calculates all of the spatial attributes based on a smoothed version of the geometry, not the original geometry (Douglas and Peucker, 1973). Performing calculations on a smoothed geometry ensures the shape measurements are less sensitive to object rotation.

Reference


Spectral Attributes
The following four attributes are computed for each band $x$ in the original image. The shapefile attributes have $4 \times x$ entries comprising the spectral attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINBAND$_x$</td>
<td>Minimum value of the pixels comprising the region in band $x$.</td>
</tr>
<tr>
<td>MAXBAND$_x$</td>
<td>Maximum value of the pixels comprising the region in band $x$.</td>
</tr>
<tr>
<td>AVGBAND$_x$</td>
<td>Average value of the pixels comprising the region in band $x$.</td>
</tr>
<tr>
<td>STDBAND$_x$</td>
<td>Standard deviation value of the pixels comprising the region in band $x$.</td>
</tr>
</tbody>
</table>
Texture Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TX_RANGE</td>
<td>Average data range of the pixels comprising the region inside the kernel. A kernel is an array of pixels used to constrain an operation to a subset of pixels. Refer to the Texture Kernel Size preference.</td>
</tr>
<tr>
<td>TX_MEAN</td>
<td>Average value of the pixels comprising the region inside the kernel.</td>
</tr>
<tr>
<td>TX_VARIANCE</td>
<td>Average variance of the pixels comprising the region inside the kernel.</td>
</tr>
<tr>
<td>TX_ENTROPY</td>
<td>Average entropy value of the pixels comprising the region inside the kernel. ENVI EX computes entropy, in part, from the Max Bins in Histogram preference.</td>
</tr>
</tbody>
</table>

Color Space and Band Ratio Attributes

In the Compute Attributes step, you can choose to compute hue, saturation, and intensity (HSI) attributes; and a normalized band ratio between two bands in a multispectral image. If you select both options, ENVI EX computes the following attributes and adds them to the "Customized" folder:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BANDRATIO</td>
<td>Values range from -1.0 to 1.0. See Band Ratio below.</td>
</tr>
<tr>
<td>HUE</td>
<td>Hue is often used as a color filter and is measured in degrees from 0 to 360. A value of 0 is red, 120 is green, and 240 is blue.</td>
</tr>
<tr>
<td>SATURATION</td>
<td>Saturation is often used as a color filter and is measured in floating-point values that range from 0 to 1.0.</td>
</tr>
<tr>
<td>INTENSITY</td>
<td>Intensity often provides a better measure of brightness than using the AVGBAND_x spectral attribute. Intensity is measured in floating-point values from 0 to 1.0.</td>
</tr>
</tbody>
</table>

Color Space

To compute HSI color space attributes, you must have an input multispectral file with at least three bands.

1. Enable the **Color Space** option under the Advanced tab of the Compute Attributes step.
   - If the file has wavelength information, ENVI EX chooses the default bands to use in computing the color space. If the file does not have wavelength information, ENVI EX uses the first three bands to compute color space.

   - Optionally click the **Color Space** button in the Compute Attributes step to modify the default bands. The Select Input Bands dialog appears.

2. When you click on band names in the bottom part of the Select Input Bands dialog, color gun assignments will automatically cycle through red, green, then blue (in that order). Click the band name you want to assign to red. A red box appears next to the band name. Repeat for the green and blue bands. Colored boxes appear next to the bands to indicate which color is assigned to those bands.

3. Click **OK** in the Select Input Bands dialog.

Band Ratio

ENVI EX computes a normalized band ratio between two bands, using the following equation:

\[
\frac{(B2 - B1)}{(B2 + B1 + \text{eps})}
\]
Where $\epsilon$ is a small number to avoid division by zero.

Band ratio values range from -1.0 to 1.0 for non-negative data values. For multispectral data, if you assign the red band to B1 and the near-infrared band to B2, then the BANDRATIO attribute is a measure of normalized difference vegetation index (NDVI). Green vegetation has a high NDVI value.

Perform the following steps to compute the BANDRATIO attribute:

1. Enable the Band Ratio option under the Advanced tab of the Compute Attributes step.
   - If the file has wavelength information, ENVI EX chooses the default bands to use in computing the band ratio. If the file does not have wavelength information, ENVI EX uses the first two bands to compute the band ratio.
   - Optionally click the Band Ratio button in the Compute Attributes step to modify the default bands. The Select Input Bands dialog appears.

2. Select the band you want to assign to Band 1. A $B_1$ icon appears next to this band.

3. Select the band you want to assign to Band 2. A $B_2$ icon appears next to this band.

4. Click OK in the Select Input Bands dialog.

### Classifying or Exporting

The Extract Features task guides you through the process of defining features (such as lakes, fields, or vehicles) and performing object-based classification to assign the objects to a feature, using supervised or rule-based classification. You can then export the resulting classification into a polygon shapefile and/or raster map and view a summary and statistics of your results.

When the Extract Features: Classify or Export panel appears (following Compute Attributes), you are presented with three choices. Select an option, and click Next.

- **Choose by Selecting Examples**: See "Supervised Classification" on page 110.
- **Choose by Creating Rules**: See "Rule-Based Classification" on page 118.
- **Export Vectors**: See "Exporting Vectors" on page 109.

### Exporting Vectors

You can choose to export vector objects and attributes from the Find Objects task to a shapefile instead of running supervised or rule-based classification.

**Note**: You must choose to compute spatial attributes (see "Computing Attributes" on page 104) for the Export Vectors option to be available.

After selecting Export Vectors and clicking Next, the Export Vectors dialog appears. Follow these steps to continue:

1. Enter an output directory and filename for the shapefile.

2. Click Export Attributes if you want to write the computed attributes to a .dbf file associated with the output shapefile.
3. Click **Next**. After processing is complete, a summary dialog appears with the processing options and settings you used throughout the Feature Extraction workflow (see "Understanding Reports and Statistics" on page 125).

4. Click **Finish** to exit the Feature Extraction workflow, or click **Back** if you need to revisit any step in the workflow.

**Supervised Classification**

Supervised classification is the process of using training data (samples of known identity) to assign objects of unknown identity to one or more known features. The more features and training samples you select, the better the results from supervised classification. However, selecting an overwhelming number of training samples will cause poor performance during classification and when previewing classification results. You must define at least two features with at least one training sample each before clicking **Next** to proceed to the Export task.

**Defining Training Data**

Training data consist of objects that you select as representative samples of known features. Perform the following steps to define training data:

1. The Extract Features: Supervised Classification panel begins with one undefined feature (Feature_1). As you move around the Region Means image, the objects underlying your cursor are highlighted with the color assigned to that feature.

2. A feature may not appear highly segmented at a visual glance; the color variations of the feature in the Region Means image may be so small that you cannot discern the individual objects that make up the feature. Following is an example of a feature that consists of many different objects.

![Feature Image](image)

To see the boundaries of the individual objects, enable the **Show Boundaries** option under the Features tab. Following is an example.
3. To assign an individual object to a feature, click the Select button in the main toolbar and click on a highlighted object to select it. The color of the object changes to the feature color. Continue selecting objects as training data for a feature. The feature name updates to show the number of objects you added. Choose a variety of different sizes and colors of objects that represent a feature of interest.

To select multiple objects at once, click and drag the cursor to draw a box around the objects. ENVI EX assigns all of the segments that are completely enclosed within the selection box to the feature.

**Note:** Be careful using the selection box because selecting an overwhelming number of training samples will cause poor performance during classification and when previewing classification results. Also, if you created a mask during the Refine step or if you input a mask file at the beginning of the workflow, the objects within the masked area will not be highlighted in color when you move your cursor over them.

**Note:** You cannot select training samples in images with an arbitrary map projection.

4. To remove an individual object from the selection, click on the object. The feature name updates to show one less object.

**Adding and Deleting Features**

1. To define a new feature, click the Add Feature button. A new feature appears in the Feature Extraction dialog with a new color. As you move around the image, the objects underlying your cursor are highlighted with the color assigned to that feature. To select training data for a new feature, click the feature name, then click on individual objects to assign them to that feature.

2. To remove a feature, select that feature name and click the Delete Feature button. Or, right-click on the feature name and select Delete Feature.

**Editing Feature Properties**

1. Choose an option to edit feature properties:
   - Select a feature name and click the Feature Properties button.
   - Right-click on a feature name and select Feature Properties.
   - Double-click a feature name.

The Properties dialog appears.
2. Edit the **Feature Name** and **Feature Color** as appropriate.

3. Click **OK** in the Properties dialog.

**Saving and Restoring Training Data**

You can save your current training data and classification parameters to an XML file, and you can also restore an existing training data file for use during classification. Saving and restoring training data allows you to experiment with different settings and compare/contrast results to determine the best solution.

Following are some scenarios that illustrate the use of training data:

- Define training data for one image, then save iterations of that training data while exploring other, potentially better, options for classifying the image.
- Define training data for one image, then reuse the training data to classify similar images.
- Define training data for multiple images and save all of the training data to the same file, which you can then use to classify other similar images.

The term *similar*, in this case, refers to images collected by the same sensor under similar environmental conditions. For example, you don’t want to use a training data file that you extracted from a QuickBird image with Landsat images. For best results, images should also have the same geographic projection, the same number of bands, and the same workflow parameters (*Scale Level*, *Merge Level*, and thresholds).

The second and third scenarios above are advanced options that are helpful if you have many images from the same sensor (for example, multiple images of the same area) that were collected under roughly the same environmental conditions, and you are interested in extracting the same set of features from each image. You can save and restore training data as an alternative to building a rule set for the images, and you can use the training data with batch processing.

**Training Data Files**

A training data file contains the following information:

- Parameters you used to generate objects during the Find Objects task of the Feature Extraction Workflow (*Scale Level*, *Merge Level*, thresholding values, and computed attributes)
- Classification methods and associated parameters
- Attribute data and training samples for one or more images

You can save multiple sets of training data collected from different images to one XML file. When you restore the XML file, ENVI EX reads the attribute data and uses these objects for supervised classification.

**Saving Training Data**

Follow these steps to save your training data to an XML file.

1. During supervised classification, define at least two features with at least one object selected for each feature.

2. Click the **Save Training Data As** button. The Training Data dialog appears.

3. Select an output directory and XML filename, and click **Open**.
Training data are tied to the **Scale Level**, **Merge Level**, and thresholding values you use in the Find Objects task of the Feature Extraction workflow. So, after saving your training data, you cannot change any of these values and restore the same training data file for use in supervised classification. Each image that you use with restored training data must have the same **Scale Level**, **Merge Level**, and thresholding values.

**Restoring Training Data**

Follow these steps to restore training data for use with the same image.

1. Click the **Restore Training Data** button. The Restore Training Data dialog appears.

2. Select a training data file (.xml), and click **Open**. If the file contains workflow parameters that match those of your current image, ENVI EX restores and displays the training data. The feature list in the Feature Extraction dialog updates to show the new features.

   Follow the steps below to restore a training data file for use with subsequent images. The images do not have to have the same spatial dimensions as the original image from which you created the training data file.

   **Note:** You can only restore one training data file per image. Also, the image must have the same number of bands as the images used to generate the training data file. For example, you cannot process a multispectral image with a training data file built from a set of panchromatic images.

3. Process each subsequent image separately in Feature Extraction, using the same **Scale Level**, **Merge Level**, and **Refine** values.

4. In the Supervised Classification dialog, Select a training data file (.xml), and click **Open**. The feature list in the Feature Extraction dialog updates to show the object count for each feature, and ENVI EX loads the attributes from the original source image. Objects are not displayed in your current image if they were derived from a different source image.

**Saving Edits to a Restored Training Data File**

When working with a restored training data file, you can add or delete features from the feature list or change classification parameters as needed. When you save your updates, the current training data set is updated.

1. Click the **Save Training Data As** button. The Training Data dialog appears. If you choose the same filename as the restored training data file, you will be prompted whether or not to overwrite the existing file.

2. Click **OK** to overwrite the existing training data file, or enter a different filename and click **OK**. Writing your results to a different file gives you the option of versioning your training data files, allowing you to roll back your edits in the future if needed.

When working with a restored training data set, you can delete features from the feature list. If you save your edits, the features you deleted will not appear in the file that you save. If you restore a training data set and delete all of the features, you are essentially starting over again as if you never restored a file. This option allows you to clear out all previously restored parameters if needed.
Importing Ground Truth Data

You can import ground truth data in the form of point and polygon shapefiles, when performing supervised classification. Ground truth data define areas of an image with known feature types, thus it represents a true classification for specific areas of the image. For example, a GIS user can import polygon shapefiles representing known land-cover types into a supervised classification workflow. This saves time because the user does not have to manually select these land-cover types and locations in the image.

You can open multiple shapefiles, select records from multiple attribute viewers (see Step 4 below), and define multiple features. It is recommended that you define one or more new (empty) features before importing ground truth data.

Follow these steps to import ground truth data into your workflow:

1. Click the **Import Truth Data from Shapefile** button. The Select Vector Data for Import dialog appears.

2. Click **Open File**, and select one or more point or polygon shapefiles containing ground truth data. The shapefiles are listed in the Select Vector Data for Import dialog. Click **OK** in this dialog.

3. The vector layers appear in the Image window and Layer Manager and will remain there throughout the rest of the Feature Extraction workflow. An Import Attributes dialog also appears for each shapefile. This dialog is similar to the Attribute Viewer dialog in ENVI EX.

4. In the Supervised Classification panel, select a feature name to which you will add ground truth data. If you have not yet defined any new features (see "Adding and Deleting Features" on page 111), the ground truth data will be added to the default **Feature_1**.

5. If you opened multiple shapefiles, choose the Import Attributes dialog that contains ground truth data you want to import. In that dialog, select one or more records that represent the feature you are interested in. Click the row numbers to select records. Use **Ctrl**-click to select multiple, non-adjacent rows; or use **Shift**-click to select a group of adjacent rows. The vectors associated with the selected records are highlighted in cyan in the Image window.

   **Note:** A shapefile may not necessarily represent ground truth data for only one feature; it may describe several different features. For example, you may have one polygon shapefile that contains ground truth data for different land-cover types (forest, agricultural, urban, etc.)

   **Note:** Attributes associated with the ground truth shapefiles (for example, area, perimeter, population, etc.) cannot be used to improve rule-based or supervised classification results (as described in Computing Attributes). Only the spatial locations of the shapefile records are imported into the classification workflow.

6. Click **Import Selected** in the Import Attributes dialog. ENVI EX adds the selected vector records to the current feature by matching the point or polygon spatial locations with specific objects in the Region Means image. The objects are highlighted with the color assigned to that feature, and the feature name updates to show the number of new objects added. You can delete any unwanted objects or add them to another feature if needed (see "Defining Training Data" on page 110).

7. In the case of polygon shapefiles, all objects in the Region Means image that fall completely underneath the selected polygon will be added to the current feature. Other objects outside of the polygon may also be added if they have the same labels (ID numbers) as the regions within the polygon. This is the default method.
8. You may find that this method adds too many objects to the current feature. Enable the **Convert to Centroid** option if you want ENVI EX to use the centroid of the selected polygons as the basis for adding objects to the current feature. This method treats the centroids of the selected polygons as \textit{point} records when finding associated objects. Click **Import Selected** again. The objects associated with the centroid location are highlighted and added to the current feature.

9. To add ground truth data to a different feature, select that feature name in the Supervised Classification panel. Open a new shapefile, or select different records from your current shapefile (using the corresponding Import Attributes dialog) and add them to your selected feature, using steps 4-6 above.

**Previewing Supervised Classification Results**

After defining at least two features with at least one training sample each, click the **Preview** check box in the Supervised Classification panel to view classification results in a Preview Portal. As you add or remove features, select objects, or add attributes, the Preview Portal dynamically updates to reflect the changes to the classification.

**Note:** Disabling the **Preview** option when selecting training data may improve performance. ENVI EX still recomputes classification results whenever you change the training data.

As you adjust the parameters under the Algorithm tab while the **Preview** option is enabled, click **Update** to see the changes to classification results in the Preview Portal.

After defining features and selecting training data, you can proceed directly to the Export task by clicking **Next**. (See "Exporting Classification Results" on page 124.) You can define up to 47 features. Advanced users can select specific attributes to use in classification, choose a classification method, and define parameters for that method. See "Selecting Attributes for Classification (Advanced)" on page 115 and "Selecting a Supervised Classification Method (Advanced)" on page 116.

**Selecting Attributes for Classification (Advanced)**

Once you have selected your training data, you can choose spatial, spectral, and/or texture attributes to use in further classifying a feature. (See "Computing Attributes" on page 104 for a description of each attribute.) You must select at least one attribute before continuing.

Some attributes are more useful when differentiating objects, and classification results may not be as accurate when you use all attributes equally since the irrelevant attributes could introduce noise into the results. Consider using the **Auto Select Attributes** feature, described in the table below. This feature is particularly useful when you have a large number of objects.

**Note:** ENVI EX computes attributes only for purposes of classification; the attributes are not passed to any output shapefiles you create during the Export task. The order of the attributes in the Selected Attributes list does not affect the classification results.

Follow these steps to select attributes for classification:

1. Click the **Attributes** tab in the Supervised Classification panel. By default, all attributes are automatically added to the Selected Attributes list.
2. To select individual attributes for classification, expand the Spectral, Texture, and Spatial folders to see their respective attributes. Each attribute is shown with an icon. (The "Customized" folder contains the Color Space and Band Ratio attributes if you calculated them for a multispectral image.) Use the following buttons to select or unselect attributes:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select Attribute</td>
<td>Select an individual attribute, then click this button to move the attribute to the Selected Attributes list. If you select a folder (such as Spatial), this selects all the attributes in that folder.</td>
</tr>
<tr>
<td></td>
<td>Unselect Attribute</td>
<td>Select an individual attribute from the Selected Attributes list, then click this button to remove the attribute from the Selected Attributes list.</td>
</tr>
<tr>
<td></td>
<td>Select All Attributes</td>
<td>Click this button to add all spatial, spectral, texture, and customized (if any) attributes to the Selected Attributes list.</td>
</tr>
<tr>
<td></td>
<td>Unselect All Attributes</td>
<td>Click this button to remove all attributes from the Selected Attributes list.</td>
</tr>
<tr>
<td></td>
<td>Auto Select Attributes</td>
<td>Click this button if you want ENVI EX to determine the best attributes to use for classifying features. The underlying logic is based on the reference below. This button is enabled once you define at least two features with at least two objects each.</td>
</tr>
</tbody>
</table>

3. Select an attribute name and enable the Show Attribute Image option to view a grayscale image of attribute values among all of the objects in the scene. The attribute image helps you select the appropriate attributes to define a rule for a certain feature. If the objects belonging to the feature have a high contrast relative to the other objects, then the attribute is a good choice for this rule. You can adjust the image transparency to view the underlying image if needed, using the Transparency slider on the main toolbar.

You can also use the cursor to roam over objects in the image and view the objects’ attribute values in the Cursor Value panel. If you select a different attribute, the display will update.

Reference


Selecting a Supervised Classification Method (Advanced)

Follow these steps to select a classification method:

1. Click the Algorithm tab in the Supervised Classification panel.
2. Select a method from the Classification Algorithm drop-down list, and define the appropriate parameters. (See "K Nearest Neighbor" on page 117 and "Support Vector Machine" on page 117.) To reset parameters to their default values, click Reset.

As you adjust the parameters under the Algorithm tab while the Preview option is enabled (see "Previewing Supervised Classification Results" on page 115), click Update to see the changes to classification results in the Preview Portal.

3. Click OK.
K Nearest Neighbor

The K Nearest Neighbor classification method considers the Euclidean distance in n-dimensional space of the target to the elements in the training data, where n is defined by the number of object attributes used during classification. This method is generally more robust than a traditional nearest-neighbor classifier, since the K nearest distances are used as a majority vote to determine which class the target belongs to. The K Nearest Neighbor method is much less sensitive to outliers and noise in the dataset and generally produces a more accurate classification result compared with traditional nearest-neighbor methods.

Enter an odd integer value of 1 or higher in the K Parameter field. The default value is 1. The K Parameter is the number of neighbors considered during classification. Experiment with different values to see which gives you the best result, but realize that changing the value changes the classification results considerably. The ideal choice for K Parameter depends on the dataset and the training data you select. Larger values tend to reduce the effect of noise and outliers, but they may cause inaccurate classification. Typically, values of 3, 5, or 7 work well.

For example, suppose you have four classes and you set the K Parameter to 3. ENVI EX returns the distances from the target to the three nearest neighbors in the training dataset. The distances are 5.0 (class A), 6.0 (class A), and 3.0 (class B). In this case, the target is assigned to class A because it found two close neighbors in class A that "out-vote" the one from class B, even though the class B neighbor is actually closer.

Support Vector Machine

Support Vector Machine (SVM) is a classification system derived from statistical learning theory. When you select this option, you need to define various parameters:

1. Select the Kernel Type to use in the SVM classifier from the drop-down list. Depending on the option you select, additional fields may appear. All of these options are different ways of mathematically representing a kernel function. The Radial Basis Function kernel type (default) works well in most cases.

   **Linear:**
   \[ K(x_i, x_j) = x_i^T x_j \]

   **Polynomial:**
   \[ K(x_i, x_j) = (\gamma x_i^T x_j + r)^d, \ \gamma > 0 \]

   **Radial Basis Function:**
   \[ K(x_i, x_j) = \exp(-\gamma \|x_i - x_j\|^2), \ \gamma > 0 \]

   **Sigmoid:**
   \[ K(x_i, x_j) = \tanh(\gamma x_i^T x_j + r) \]
2. If the **Kernel Type** is **Polynomial**, set the **Degree of Kernel Polynomial** to specify the degree used for the SVM classification. The minimum value is 1 (default), and the maximum value is 6. Increasing this parameter more accurately delineates the boundary between classes. A value of 1 represents a first-degree polynomial function, which is essentially a straight line between two classes. A value of 1 works well when you have two very distinctive classes. In most cases, however, you will be working with imagery that has a high degree of variation and mixed pixels. Increasing the polynomial value causes the algorithm to more accurately follow the contours between classes, but you risk fitting the classification to noise.

3. If the **Kernel Type** is **Polynomial** or **Sigmoid**, specify the **Bias in Kernel Function** for the kernel to use in the SVM algorithm (shown as "r" in the above equations). The default value is 1.00.

4. If the kernel type is **Polynomial**, **Radial Basis Function**, or **Sigmoid**, use the **Gamma in Kernel Function** field to set the gamma parameter used in the kernel function. This value is a floating-point value greater than 0.01. The default is the inverse of the number of computed attributes.

5. Specify the **Penalty Parameter** for the SVM algorithm to use. This value is a floating-point value greater than 0.01. The default value is 100.0. The penalty parameter controls the trade-off between allowing training errors and forcing rigid margins. The more you increase this value, the more the parameter suppresses training data from "jumping" classes as you make changes to other parameters. Increasing this value also increases the cost of misclassifying points and causes ENVI EX to create a more accurate model that may not generalize well.

6. Use the **Classification Probability Threshold** field to set the probability that is required for the SVM classifier to classify a pixel. Pixels where all rule probabilities are less than this threshold are unclassified. The range is from 0.0 to 1.0. The default is 0.0. Increasing this value results in more unclassified pixels.

**References**


**Rule-Based Classification**

Rule-based classification is an advanced method that lets you define features by building rules based on object attributes. Rule-based classification is a powerful tool for feature extraction, often performing better than supervised classification for many feature types. Rule-building is primarily based on human knowledge and reasoning about specific feature types: For example, roads are elongated, some buildings approximate a rectangular shape, vegetation has a high NDVI value, and trees are highly textured compared to grass.

Taking this concept a step further, you define a rule using one or more conditions; for example, you could define the rule for "lake" as the following:

- Objects with an area greater than 500 pixels AND
- Objects with an elongation less than 0.5 AND
- Objects with a band ratio value less than 0.3
And you could define the rules for "road" as the following:

- Objects with an elongation greater than 0.9 AND
- Objects with a compactness less than 0.3 AND
- Objects with a standard deviation less than 20

Each object represents a data point (sample) in the attributes’ n-dimensional space. You can define multiple rules (thus building a rule set) for a given feature in cases where the objects assigned to a feature belong to more than one cluster in n-dimensional space. The following figure shows an example 2D plot of the AREA versus AVGBAND_1 attributes:

Using this example, you may need to define multiple rules for the feature type "building" to cover different types of buildings such as small white buildings, buildings with red roofs, etc.

**Reference**


**Fuzzy Logic**

Traditional rule-based classification is based on strict binary rules, for example: objects meeting the rules for "tree" are classified as "tree," objects meeting the rules for "urban" are classified as "urban," and objects meeting neither rule remain unclassified. Fuzzy logic is an important element in rule-based classification. Rather than classifying an object as fully "true" or "false" (as in binary rules), fuzzy logic uses a membership function to represent the degree than an object belongs to a feature type.

Information extraction from remote sensing data is limited by noisy sensor measurements with limited spectral and spatial resolution, signal degradation from image pre-processing, and imprecise transitions between land-use classes. Most remote sensing images contain mixed pixels that belong to one or more classes. Fuzzy logic helps alleviate this problem by simulating uncertainty or partial information that is consistent with human reasoning.
The output of each fuzzy rule is a confidence map, where values represent the degree that an object belongs to the feature type defined by this rule. In classification, the object is assigned to the feature type that has the maximum confidence value.

With rule-based classification, you can control the degree of fuzzy logic of each condition when you build rules.

Building Rules

Perform the following steps to build new rules:

1. The Extract Features: Rule-Based Classification panel begins with one undefined feature (Feature_1) and one undefined rule (indicated by an icon).

2. To begin building a rule, choose one of the following options:
   - Double-click a rule name.
   - Select a rule name and click the Add Attribute to Rule button.
   - Right-click on a rule name and select Add Attribute to Rule.

   The Attribute Selection dialog appears.

Selecting Attributes

Follow these steps to select attributes for classification:

1. Expand the Spectral, Texture, Spatial, or Customized folders. Each attribute is shown with an icon.

2. Select an attribute name and enable the Show Attribute Image option to view a grayscale image of attribute values among all of the objects in the scene. The attribute image helps you select the appropriate attributes to define a rule for a certain feature. If the objects belonging to the feature have a high contrast relative to the other objects, then the attribute is a good choice for this rule. You can adjust the image transparency to view the underlying image if needed, using the Transparency slider on the main toolbar.

   You can also use the cursor to roam over objects in the image and view the objects’ attribute values in the Cursor Value panel. If you select a different attribute, the display will update.

3. Double-click on an attribute name, or select an attribute name and click Next. An interactive histogram dialog appears. The histogram shows the frequency of occurrence (y-axis) of the attribute values (x-axis) for all of the vector objects in the image.

4. To define minimum and/or maximum values for an attribute, click and drag the dashed vertical lines on the histogram. Or, type minimum and maximum values in the provided fields, and press Enter.

5. The Show Rule Confidence Image option is enabled by default. As you adjust the histogram range, the Preview Portal updates to show the relative confidence of each object belonging to a feature. The higher the brightness of an object, the higher the confidence that the object belongs to the feature. If an object is very dark, it likely does not belong to the feature.
You can observe the brightness values of the objects in the Cursor Value category of the ENVI EX interface. Because of the fuzzy logic applied underneath, you will notice that some objects have a brightness value between 0 and 255. If your rule set only has one rule, any object with a brightness value greater than 255 times the Confidence Threshold value (in the Advanced Settings dialog) will be classified as the feature. The default Confidence Threshold value is 0.4. So if the brightness value of an object is greater than 102, then this object will be classified as the feature using this rule.

6. Move the Fuzzy Tolerance slider bar to adjust the degree of fuzzy logic applied to that rule, to better model the uncertainty inherent in classification. The default value is 5.0 percent, and the maximum value is 20.0 percent.

When you adjust the Fuzzy Tolerance to a larger value, more objects will appear in the transition area between feature and non-feature. If you set the Fuzzy Tolerance to 0.0 percent, no fuzzy logic is applied when distinguishing among features.

When working with multiple rules or a rule defined by multiple attributes, it is recommended to set the Fuzzy Tolerance to a non-zero value. When you enable fuzzy logic in this manner, ENVI EX will not reject the object as a certain feature type using a single binary condition; instead, it considers information from all conditions to make a decision.

Suppose an object belongs to the feature type "water" if the mean spectral value of band 1 is less than 50.00 AND the area is larger than 500.00. If an object has a mean spectral value of 30.00 for band 1 AND an area of 499.00, according to binary classification, ENVI EX would reject this object as belonging to the feature type "water." Fuzzy logic would allow you to better approximate the uncertainty in human reasoning so that the object would have a very high probability of belonging to the "water" feature type.

Following are some tips on changing the value:

- Click on the slider bar to the right or left of the indicator to move the slider up or down incrementally by a value of 10.0.
- Click the slider, then use the arrow keys (on your keyboard) to increase or decrease the value by 0.1.
- Click the slider, then press Home to move the slider to 100.0 or End to move the slider to 0.0.
- Type a value into the provided field and press Enter.

7. From the Membership Function Set Type drop-down list, select S-Type (default) or Linear. Membership functions are mathematical concepts for modeling the underlying data distribution. Feature Extraction defines two membership function sets to model the fuzzy concepts of "greater than," "less than," and "in between." See Jin and Paswaters (2007) for the theory behind S-Type and piecewise linear membership function sets. The ideal option depends on the distribution of the input variable values. With the same Fuzzy Tolerance value, the S-type membership function set provides a lesser degree of fuzziness than the linear membership function set.

8. Click the Logic NOT check box to apply an inverse of the attribute values. The confidence image (in the Preview Portal) updates accordingly.

9. This step only applies if you have already defined at least one attribute for this rule. From the AND drop-down list, select a logic method to combine the current condition with the previous condition. The choices are AND (default) or OR.
10. When you are satisfied with the attribute settings, click OK. An icon appears under the rule name in the Rule-Based Classification panel to indicate that you have added an attribute to the rule. The icon is followed by a brief summary of the attribute definition.

**Editing Rule Properties**

1. Select a rule name and click the Rule Properties button, or right-click on a rule name and select Rule Properties. The Properties dialog appears.

2. Enter a Rule Weight value between 0 and 1.00 if you want to assign the rule a lower confidence level (if you think the rule is less reliable than others). The default value of 1.00 is sufficient in most cases.

**Managing Features and Rules**

- To define a new feature, click the Add Feature button. A new, undefined feature with one undefined rule is added to the feature list.

- To delete a feature, select a feature name and click the Delete Feature button.

- To add a new rule to a feature, select a feature name and click the Add Rule to Feature button. Or, right-click on a feature name or rule name under that feature, and select Add Rule to Feature. A new, undefined rule appears under the feature name.

- To delete a rule, select the rule name and click the Delete Rule button. Or, right-click on the rule name and select Delete Rule.

- To start over and define a new rule set, click the New Rule Set button. A warning dialog asks if you want to delete all of your existing rules and features. Click OK if you wish to continue and to delete any previously defined rules. The Rule-Based Classification panel begins with one undefined feature (Feature_1) and one undefined rule.

- To load an existing rule set from disk, click the Restore Rule Set button. A file selection dialog appears. Select an XML file (.xml) containing a rule set, and click Open.

- To save a rule set that you have been working on, click the Save Rule Set As button. A file selection dialog appears. Select an output XML filename (.xml), and click Open.

- To display a summary of your current rule sets, click the Display Rule Set button. The Display Rule Set dialog appears with a text summary of the rules you have defined. For example:

```
Rule Set: #1 (1.000): If area > 630.0000 AND avgband_2 < 307.0000 AND stdband_4 > 100.0000, then object belongs to "Tree". #2 (1.000): If tx_variance > 1000.0000, then object belongs to "Urban".
```

- To edit attributes, choose one of the following options:
  - Double-click an attribute name.
  - Select an attribute name, and click Edit Attribute.
• Right-click on an attribute name, and select **Edit Attribute**.
• To delete attributes, choose one of the following options:
  • Select an attribute name, and click **Delete Attribute**.
  • Right-click on an attribute name, and select **Delete Attribute**.

### Advanced Settings

1. From the Rule-Based Classification dialog, click the **Advanced Settings** button. The Advanced Setting dialog appears.
2. Enter a **Confidence Threshold** value. During classification, an object is assigned to the class with the maximum confidence value or it remains unclassified if the maximum confidence value is below the **Confidence Threshold**. Values range from 0 to 1.00. The default value is 0.40.
3. From the **AND Operator** drop-down list, select one of the following options to apply to the entire rule set. Assume the membership function value of condition C1 is $m_1$, and the membership function value of condition C2 is $m_2$.
   - **min**: (default) The confidence value of C1 AND C2 is $\min(m_1, m_2)$.
   - **product**: The confidence value of C1 AND C2 is $m_1 \times m_2$.
4. From the **OR Operator** drop-down list, select one of the following options to apply to the entire rule set. Assume the membership function value of condition C1 is $m_1$, and the membership function value of condition C2 is $m_2$.
   - **max**: (default) The confidence value of C1 OR C2 is $\max(m_1, m_2)$.
   - **probabilistic**: The confidence value of C1 OR C2 is $m_1 + m_2 - m_1 \times m_2$.
5. Enter a **Default Fuzzy Tolerance** value to change the default **Fuzzy Tolerance** value in the interactive histograms. This is useful if you want to use the same value among all the rules that you define. Values range from 0 to 20 percent. The default value is 5 percent. Changing this value does not affect rules that you have already built.
6. From the **Default Membership Function Set Type** drop-down list, select **S-Type** (default) or **Linear** to define the default membership function set type used in the interactive histograms. This is useful if you want to use the same membership function set type among all the rules that you define. Membership functions are mathematical concepts for modeling the underlying data distribution. The ideal option depends on the distribution of the input variable values. Changing this value does not affect rules that you have already built. See Jin and Paswaters (2007) for the theory behind S-Type and piecewise linear membership function sets.

### Reference

Previewing Rule-Based Classification Results

After defining at least one feature with at least one rule, click the Preview check box in the Rule-Based Classification panel to view classification results in a Preview Portal. Undefined rules are ignored. You can move the Preview Portal around the image to look at classification results for different areas.

Exporting Classification Results

When you have finished the required steps in the Supervised Classification or Rule-Based Classification panels, click Next to proceed to the Export Features panel.

The Export Vector Results option (under the Vector Output tab) is enabled by default. You can choose to export classification results to a single shapefile or to individual shapefiles for each feature.

For rule-based and supervised classification, only those features that were used in classification (those with at least one object assigned to them) will be exported. If you are performing rule-based classification, the Export Features step will not complete if none of the features you defined are used in classification.

1. Choose one of the following options:

   • Enable the Export Features to a Single Layer option, and select Polygon, Point, or Line from the drop-down list provided. This option is not selected by default. Then select an output shapefile name.

   • Click the check boxes next to feature names to output individual features to their own shapefiles. Select Polygon, Point, or Line from the corresponding drop-down lists. Selecting Line will convert polygon objects to the centerline, and selecting Point will output a point shapefile that represents the centers of polygon objects. Select an output directory to save the shapefiles. The shapefiles will have the same names as the feature names you specified during classification.

   • Click the Export Attributes check box to write attributes associated with the vector objects (following classification) to the .dbf file associated with the output shapefile. For polygon shapefiles, all attributes will be written. For polyline shapefiles, only the length attribute will be computed. No attributes will be written for point shapefiles.

2. If you selected to output vector results to a Line shapefile, an Advanced button appears. When you click the Advanced button, the Centerline Parameters dialog appears. Here, you can modify the default parameters for centerline calculations. The default values work well in most cases, but you have the option to modify the values if your polyline results are unacceptable. After experimenting with different values, you can click Reset to return to the default values if needed.

   • Prune: This option is selected by default. Pruning means that unwanted edges will be removed from the medial axis.

   • Remove Spurs: This option is selected by default so that spurs will be removed from polylines.

   • If the Remove Spurs option is enabled, use the Spur Threshold field to set the maximum spur length. Values range from 0.1 to 1. The default value is 0.5.

   • Angle (degrees): Minimum angle allowed for the medial axis. Values range from 0 to 90 degrees. The default value is 60 degrees.

   • Distance: Minimum distance allowed for the weighted medial axis. Values range from 0 to (no units). The default value is 0, which gives the best results in most cases.
Smoothing Vectors

Enable the Smoothing option to generalize all of your polyline and polygon vectors using the Douglas-Peucker line simplification algorithm. You cannot select specific vectors to generalize. See Smoothing Polygons for more details on how ENVI EX applies this algorithm, and how to set the Smoothing Threshold (Pixels) value.

Reference


Exporting Classification Images

Click the Image Output tab, then enable the Export Class Results option if you want to export rule-based or supervised classification results to an image in ENVI raster format.

When creating shapefile and/or image output, you can choose to automatically load the results by clicking the Display Datasets After Export check box. This option is enabled by default. Click Next in the Export step to create vector shapefiles and/or classification images. Feature Extraction proceeds to the Report and Statistics panel.

If you click Back to change any classification options, then click Next to proceed to the Export Features panel, the default Export options are selected.

Exporting Rule Images

Click the Image Output tab, then enable the Export Rule Results option if you want to export a rule confidence image from rule-based or supervised classification results to an image in ENVI raster format. This is a multi-band image that shows the relative confidence of each object belonging to a feature. See "Selecting Attributes" on page 120 for a more detailed description of this image.

When creating shapefile and/or image output, you can choose to automatically load the results by clicking the Display Datasets After Export check box. This option is enabled by default. Click Next in the Export Features panel to create vector shapefiles and/or classification images. Feature Extraction proceeds to the Report and Statistics panel.

If you click Back to change any classification options, then click Next to proceed to the Export Features panel, the default Export options are selected.

Understanding Reports and Statistics

After you export your classification results, you are presented with a summary of the processing options and settings you used throughout the Feature Extraction workflow. The Report tab lists the following items:

- Filename of the input image file used for Feature Extraction
- Scale Level, Merge Level, and thresholding values used in the Refine step
- Types of attributes computed: Spatial, Spectral, Texture, Color Space, and/or Band Ratio. Bands used for Color Space and Band Ratio attributes are also reported.
- Classification type: Rule-Based or Supervised
- Rule sets used for rule-based classification
- Algorithm used for supervised classification
• Summary of export options, including feature names and types, output shapefile names and directories. The Report tab only describes features that were classified and exported.
• Smoothing Threshold (Pixels) values, and filenames of classification images

This information may vary slightly if you access the report from the Extract Features: Export Vectors panel rather than from the classification steps.

A Statistics tab is also available if you exported your classification results to vector shapefiles. The Statistics tab presents a table view of the features you defined. The Statistics tab only describes features that were classified and exported. The following columns are provided:

- **Feature Name**: The names assigned to each of your features
- **Feature Count**: The total number of polygons, polylines, or points belonging to each feature

The following additional columns are provided for polygon features only and are in map units determined by the input image:

- **Total Area**
- **Mean Area**
- **Maximum Area**
- **Minimum Area**

You can sort the table cells by right-clicking anywhere in the table and selecting **Sort by selected column forward** (ascending order) or **Sort by selected column reverse** (descending order).

### Saving Reports

You can save all of the information under the Report and Statistics tabs to a text file by clicking **Save Text Report**. The Save FX Report dialog appears. Select an output filename and location, and click **OK**.

### Modifying Export Options

After viewing the processing summary, you can click **Finish** to exit the Feature Extraction workflow. Or, click **Back** to go back to the Export step and change the output options for classification results.

If you click **Back**, any output that you created is removed from the Data Manager and Layer Manager. If you click **Next** from the Export Features panel without making any changes, Feature Extraction will not re-create the output. You must make at least one change in the Export Features panel for Feature Extraction to create new shapefiles and/or classification images.

### Feature Extraction Preferences

To edit Feature Extraction preferences, select **File > Preferences** from the menu bar, then select **Feature Extraction** in the Preferences dialog tree.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm on Exit</td>
<td>Enable or disable whether ENVI EX confirms that you want to exit the Feature Extraction workflow when you exit Feature Extraction. The default is <strong>True</strong>.</td>
</tr>
<tr>
<td>Enable Drag Events in Preview</td>
<td>Enable or disable whether the Preview Portal updates on-the-fly as you drag the Scale Level and Merge Level sliders or if you adjust the interactive histogram values in rule-based classification. The default is <strong>False</strong>, which means the Preview Portal is only updated when you let go of the sliders.</td>
</tr>
</tbody>
</table>

126 ENVI EX User's Guide
### Feature Extraction Preferences

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview Foreground Color</td>
<td>Set the boundary color in the Segment and Merge Preview Portals. The default color is green ([0,255,0]).</td>
</tr>
<tr>
<td>Default Scale Level</td>
<td>Set an initial value for the segmentation Scale Level. The default value is 50.</td>
</tr>
<tr>
<td>Max Bins in Histogram</td>
<td>Set the number of bins used for textural calculations during vectorization. Larger values require more memory to store the histogram but result in higher accuracy for images with a higher bit depth. The default value is 256.</td>
</tr>
<tr>
<td>Number of Vectors Per Tile</td>
<td>Set the number of vectors that are simultaneously read into memory during vectorization. Increasing this value should slightly improve vectorization performance at the cost of using more memory. The default value is 100000.</td>
</tr>
<tr>
<td>Use Spatial Attributes</td>
<td>The default value is True, which means the Spatial check box is enabled in the Compute Attributes step. Set this preference to False if you do not want to calculate spatial attributes during the Feature Extraction workflow.</td>
</tr>
<tr>
<td>Use Spectral Attributes</td>
<td>The default value is True, which means the Spectral check box is enabled in the Compute Attributes step. Set this preference to False if you do not want to calculate spectral attributes during the Feature Extraction workflow.</td>
</tr>
<tr>
<td>Use Textural Attributes</td>
<td>The default value is True, which means the Texture check box is enabled in the Compute Attributes step. Set this preference to False if you do not want to calculate texture attributes during the Feature Extraction workflow.</td>
</tr>
<tr>
<td>Use Color Space Attributes</td>
<td>The default value is True, which means the Color Space check box is enabled in the Compute Attributes step for multispectral images. Set this preference to False if you do not want to calculate color space attributes during the Feature Extraction workflow.</td>
</tr>
<tr>
<td>Use Band Ratio Attributes</td>
<td>The default value is True, which means the Band Ratio check box is enabled in the Compute Attributes step for multispectral images. Set this preference to False if you do not want to calculate the band ratio attribute during the Feature Extraction workflow.</td>
</tr>
<tr>
<td>Texture Kernel Size</td>
<td>Set the kernel size used to perform texture calculations during vectorization. Use an odd number of 3 or higher. The maximum value is 19. The default value is 3. Larger values provide more information at the expense of slower performance.</td>
</tr>
<tr>
<td>Maximum Number of Vector Vertices</td>
<td>Set the maximum number of vertices that ENVI EX produces for any single polygon during the Compute Attributes step. The default value is 200000. Smaller values cause ENVI EX to ignore regions that do not meet the criteria for creating vector polygons. As the value increases, ENVI EX tries to include larger regions at the expense of slower performance.</td>
</tr>
<tr>
<td>Maximum File Size of Shapefiles (Mbytes)</td>
<td>Set the approximate maximum file size of shapefiles if you choose to create vector output during the Export task. The default value is 500 MB.</td>
</tr>
<tr>
<td>Delete Temporary Directory on Exit</td>
<td>Throughout the Feature Extraction workflow, ENVI EX creates several temporary files and directories. You can choose to automatically delete these when exiting ENVI EX by setting this preference to Yes (the default).</td>
</tr>
<tr>
<td>Smooth Vectors on Export</td>
<td>Set this preference to True if you want the option to generalize your polyline and polygon vectors using the Douglas-Peucker line simplification algorithm (in the Export step following classification). Set this preference to False if you do not want the smoothing option to appear in the Export step.</td>
</tr>
</tbody>
</table>
Feature Extraction Tips and Tricks

Following are some helpful tips for progressing through the Feature Extraction workflow.

Extract Features Task

The following tips and tricks pertain to the Extract Features task of the Feature Extraction workflow.

Supervised Classification

The more features and training data you select, the better the results from supervised classification. However, selecting an overwhelming number of training data will cause poor performance during classification and when previewing classification results.

After defining at least two features with at least one training sample each, you can click the Preview check box in the Extract Features task to view classification results in a Preview Portal. As you add or remove features, select objects, or add attributes, the Preview Portal dynamically updates to reflect the changes to the classification. Disabling the Preview option when selecting training data may improve performance.

ENVI EX still recomputes classification results whenever you change the training data. As you adjust the parameters under the Algorithm tab while the Preview option is enabled, click Update to see the changes to classification results in the Preview Portal.

Collecting Training Data

When you begin supervised classification, you may need to click once in the image to activate the process of collecting training data. Then as you move around the image, the objects underlying your cursor are highlighted with the color assigned to the currently selected feature.

You can enable the Show Boundaries option under the Features tab to view the boundaries of the individual objects.

Try to select objects with a wide variety of sizes, shapes, and colors, that represent a given feature.

To select multiple objects at once, click and drag the cursor to draw a box around the objects. ENVI EX assigns all of the segments that are completely enclosed within the selection box to the feature. However, be careful using the selection box because selecting an overwhelming number of training samples will cause poor performance during classification and when previewing classification results.

You must define at least two features to perform supervised classification.

Saving and Restoring Training Data

You can save multiple sets of training data collected from different images to one XML file. When you restore the XML file, ENVI EX reads the attribute data and uses these objects for supervised classification.

---

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview on by Default</td>
<td>Set this preference to True if you want the Preview option to be enabled throughout the Feature Extraction workflow, thus always displaying a Preview Portal. The default value is False.</td>
</tr>
<tr>
<td>Smoothing Threshold (pixels)</td>
<td>Set the default number of pixels to use in vector smoothing. This preference only applies if you set the Smooth Vectors on Export preference to True. You can still set the Smoothing Threshold (Pixels) value in the Export dialog, regardless of this preference.</td>
</tr>
</tbody>
</table>
Training data are tied to the Scale Level, Merge Level, and thresholding values you use in the Find Objects task of the Feature Extraction workflow. So, after saving your training data, you cannot change any of these values and restore the same training data file for use in supervised classification. Each image that you use with restored training data must have the same Scale Level, Merge Level, and Refine values.

You can only restore one training data file per image. Also, the image must have the same number of bands as the images used to generate the training data file. For example, you cannot process a multispectral image with a training data file built from a set of panchromatic images.

If you want to use the same training data file for similar images, those images should be from the same sensor under similar environmental conditions. For example, you don’t want to use a training data file that you extracted from a Quickbird image with Landsat images. For best results, images should also have the same geographic projection, the same number of bands, and the same workflow parameters (Scale Level, Merge Level, and thresholds).

**Rule-Based Classification**

If you enable the **Show Attribute Image** option, you can adjust the image transparency to view the underlying image if needed, using the Transparency slider on the main toolbar. You can also use the cursor to roam over objects in the image and view the objects’ attribute values in the Cursor Value panel. If you select a different attribute, the display will update.

When viewing the rule confidence image, you can observe the brightness values of the objects in the Cursor Value category of the ENVI EX interface. Because of the fuzzy logic applied underneath, you will notice that some objects have a brightness value between 0 and 255. If your rule set only has one rule, any object with a brightness value greater than 255 times the **Confidence Threshold** value (in the Advanced Settings dialog) will be classified as the feature. The default **Confidence Threshold** value is 0.4. So if the brightness value of an object is greater than 102, then this object will be classified as the feature using this rule.

When working with multiple rules or a rule defined by multiple attributes, it is recommended to set the **Fuzzy Tolerance** to a non-zero value. When you enable fuzzy logic in this manner, ENVI EX will not reject the object as a certain feature type using a single binary condition; instead, it considers information from all conditions to make a decision.

After defining at least one feature with at least one rule, click the **Preview** check box in the Extract Features task to view classification results in a Preview Portal. Undefined rules are ignored. You can move the Preview Portal around the image to look at classification results for different areas.

**Exporting Classification Results**

If you choose to smooth your vector results, keep in mind that values greater than 10 for the **Smoothing Threshold (Pixels)** value are seldom useful. In most cases, you should choose a value between 1 and 5. Experiment with different values to determine the ideal amount of smoothing.

After viewing reports and statistics, you can click **Finish** to exit the Feature Extraction workflow. Or, click **Back** to go back to the Export step and change the output options for classification results.

If you click **Back**, any output that you created is removed from the Data Manager and Layer Manager. If you click **Next** from the Export step without making any changes, Feature Extraction will not re-create the output. You must make at least one change in the Export step for Feature Extraction to create new shapefiles and/or classification images.
Find Objects Task

The following tips and tricks pertain to the Find Objects task of the Feature Extraction workflow.

Segmenting Images

If the Preview option is enabled, you can click once in the Image window to select the image layer, then increase the transparency of the image (using the Transparency slider in the main toolbar). This helps you better discern the segments displayed in the Preview Portal.

You should ideally choose the highest Scale Level that delineates the boundaries of features as well as possible. If you choose too high of a Scale Level, the boundaries between segments will not be properly delineated and you will lose features of interest. You should ensure that features of interest are not grouped into segments represented by other features.

You should also ensure that a feature of interest is not divided into too many small segments (over-segmentation; usually the result of a low Scale Level). If you cannot avoid this problem in the Segment step, then you can use Merge in the second step to improve the delineation of feature boundaries.

Throughout the process of segmenting images, merging segments, and refining segments, you can easily create very large segments that represent background objects and are meaningless in the context of classification. Creating vectors from these large regions consumes a lot of memory and results in poor display performance; therefore, ENVI EX ignores these large regions during vectorization. If you want to extract very large regions from an image, you should first down-sample the image prior to running Feature Extraction.

Merging Segments

Merging is an optional step used to aggregate small segments within larger, textured areas such as trees, clouds, or fields, where over-segmentation may be a problem. For example, if your image shows thick vegetation, increasing the Scale Level (in the previous Segment step) may not sufficiently delineate tree-covered areas. The results may be over-segmented if you set a small Scale Level value or under-segmented if you set a large Scale Level value. Merging would be a useful option in this case for improving the delineation of tree boundaries.

If merging is not a useful option for your image, you can proceed directly to the Refine step by clicking Next in the Merge step (leaving the Merge Level at the default value of 0.0). No merging will be performed.

Refining Segments

When setting thresholds, you may find it helpful to use the Transparency tool to adjust the transparency of the thresholding results in the Preview Portal so that you can see the underlying image.

Computing Attributes

In the Compute Attributes step, band ratio and color spaceattributes reside in the Customized folder.

ENVI EX computes attributes only for purposes of supervised or rule-based classification; the attributes are not passed to any output shapefiles you create during the Export task.

You must choose to compute spatial attributes if you plan to export segmentation results and for the Export Vectors option to be available in the Extract Features task.
Miscellaneous Tips and Tricks

Note: Make sure you have adequate disk space before processing large files.

Working with Multiple Layers

As you proceed through the workflow and create Region Means images, the Layer Manager will show multiple raster layers. Because of the workflow’s dependency on the display, you can only add new layers; you cannot remove existing layers. To hide or show layers, right-click on the appropriate layer name(s) and select Show or Hide, respectively. Or, reorder layers as needed to view layers of interest.

Working with Preview Portals

For optimal Preview Portal performance, set the Zoom to 100 percent before running Feature Extraction.

You can use Blend, Flicker, and Swipe tools to view the underlying layer when a Preview Portal is displayed. You can also use the Pan, Zoom, and Transparency tools, although these are for display purposes only; they do not affect Feature Extraction results.

You cannot adjust the Contrast, Brightness, Stretch, or Sharpen values in a Preview Portal.

If a Preview Portal is displayed over an image, you can use any of ENVI EX’s enhancement tools on the image by first clicking on the image in the Image window or selecting the image layer in the Layer Manager. You can also move the Preview Portal around the image or resize it to look at different areas.

If tile rendering performance is slow or non-responsive in the Preview Portal, try setting the preference Use Graphics Card to Accelerate Enhancement Tools to No. To effectively use this preference, ensure your hardware and software meet the listed requirements. See "Display General Preferences" in ENVI EX Help for details.

Working with Slider Bars

The following tips apply to slider bars used for Scale Level, Merge Level, and Fuzzy Tolerance parameters.

- Click on the slider bar to the right or left of the indicator to move the slider up or down incrementally by a value of 10.0.
- Click the slider, then use the arrow keys (on your keyboard) to increase or decrease the value by 0.1.
- Click the slider, then press Home to move the slider to 100.0 or End to move the slider to 0.0.
- Type a value into the provided field and press Enter.

Working with Ancillary Data

To use ancillary data with your base image, the following restrictions apply:

- You can only use raster data for ancillary data; vector data is not allowed.
- Both the base image and ancillary data must have map information. If the ancillary data is not in the same map projection as the base image, ENVI EX will reproject the ancillary data to match the base projection.
- The ancillary data and base image must have some geographic overlap.
- If you spatially subset the base image, the ancillary data will be reprojected to match that spatial extent.
• You can select specific bands to process from the ancillary dataset and base image.

**Working with Masks**

The following restrictions apply to working with masks in Feature Extraction:

• You can only use a single-band raster image or polygon shapefile as a mask file. Multi-band images or point/line shapefiles are not allowed. ENVI EX will convert polygon shapefiles to raster images for Feature Extraction.

• You can only specify one mask file for input.

• A raster mask must have the same spatial extent and map projection as the base image. Masks are not reprojected to match the base image.

• You cannot use the same image for the base and/or ancillary data and/or mask file.
About the Classification Workflow

The Classification workflow allows you to categorize pixels in an image into many classes. You can perform an unsupervised classification with no training data, or you can perform a supervised classification, where you provide training data and specify a classification method of Maximum likelihood, Minimum distance, Mahalanobis distance, or Spectral Angle Mapper (SAM).

In the Classification workflow, you do the following:

- Select a file
- Select a classification method
- Set parameters for unsupervised classification or define training data for supervised classification
- Optionally refine the classification output
- Save classification results

References

Mahalanobis, Maximum Likelihood, Minimum Distance:


Spectral Angle Mapper:


ISODATA:


Selecting a File for Classification

In the File Selection panel you choose the file to use for classification. You can optionally apply a spatial or spectral subset, and you can optionally apply a mask to the input. Classification input requires a minimum of two bands. The supported input types are ENVI, TIFF, NITF, JPEG 2000, JPEG, ERDAS IMAGINE, ESRI raster layer, and geodatabase raster.

1. Use the Toolbox to initiate Classification.

   If you want to open a geodatabase or a remote dataset, click Browse in the File Selection panel, then click Open Remote Dataset in the Classification Input File dialog. The Remote Connection Manager dialog appears.

   Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.
Note: When using ESRI layer files as a data source for workflows, you expand the ESRI layer and select the data source. ArcGIS .lyr files consist of a set of rules for displaying and working with datasets. Information in .lyr files can include symbols, classifications, labeling rules, and other information describing the appearance and actions of the layer. When visualizing an ESRI layer in an ENVI application, the properties are inherited from ArcGIS. If you open the source data for an ESRI layer, you will use stretch and other properties from the ENVI application, and the two may not display the same way.

2. To perform optional spatial or spectral subsetting, click **Browse** in the File Selection panel.

3. To apply a mask, select the **Input Mask** tab in the File Selection panel. "Working with Masks in a Workflow" on page 134 provides details about masking.

   Note: Reprojected vectors are not supported when the original input data has RPCs. To apply a mask in this case, either draw the mask on the image in the Image window, or use the RPC Orthorectification workflow to reproject the image to standard map projections, then use the orthorectified image and the shapefile as inputs.

4. Click **Next**. The Select a Method panel appears.

**Working with Masks in a Workflow**

Masking is a powerful feature in image processing used to reduce clutter and improve accuracy in the final results. Masks allow you to confine image processing to specific areas in the image (a regular mask) or to ignore specific areas in an image for processing (an inverse mask).

You can import a mask file in the data input step (described here). The mask file can be a raster or a vector.

The following figures show an example of using a mask.

Suppose you want to limit processing to only residential areas, so that you can identify rooftops within the scene. You could create a regular mask (in ENVI EX), similar to the following example. If you were to import this mask during the data selection step, each subsequent step of the workflow would ignore the area associated with the masked pixels.
Restrictions

The following restrictions apply to working with masks:

- You can only use a single-band image or polygon shapefile as a mask file. Multi-band images or point/line shapefiles are not allowed. ENVI EX will convert polygon shapefiles to raster images for the workflow.
- You can only specify one mask file for input.
- A raster mask is pixel-based and the map information is ignored.
- A raster mask must have the same spatial size as the base image. A vector mask will be reprojected to match the base image. The vector mask must overlap with the base image.

Selecting a Mask File

See "Creating a Mask File" on page 99 for instructions on creating a mask.

1. Select the Input Mask tab in the File Selection panel.
2. Enter the path and filename for the Mask File.

   To navigate to a file, click Browse. The Mask File dialog appears. Do one of the following:
   - If the file you want to use is listed in the dialog, select it.
   - Click Open File to open a new file. The Open dialog appears.
   - Click Open Remote Dataset to open a geodatabase. The Remote Connection Manager dialog appears.

By default, the workflow will ignore areas with pixel values of 0 in the mask during processing. To use an inverse version of the mask, select the Inverse Mask check box. The workflow will process the areas with pixel values of 0 and will ignore all other pixels.

If you need to clear the mask from file input, clear the filename from the Mask File field.

Creating a Mask File

Following are some suggested steps for creating a mask file:
1. Open and display an image.
2. From the menu bar, select **File > New > Vector Layer**. The Create New Vector Layer dialog appears.
3. Enter a layer name.
4. From the **Record Type** drop-down list, select **Polygon**.
5. Click **OK**.
6. Use the **Vector Create** tool to draw polygons in the Image window. The regions outside of the polygon will be ignored during processing when the mask is used as a regular mask.
7. From the menu bar, select **File > Save As > New Vector**. Save the vector layer to a shapefile.

### Selecting a Classification Method

In the Choose a Classification Method panel, select the type of workflow you want to follow.

1. Select one of the following:
   - **No Training Data**: opens the Unsupervised Classification panel to begin the unsupervised classification workflow. The unsupervised method does not rely on training data to perform classification.
   - **Use Training Data**: opens the Supervised Classification panel to begin the supervised classification workflow. The supervised method uses training data from existing vector files, or from regions you interactively create on the image to perform classification.

2. Click **Next**. If you selected **No Training Data**, the Unsupervised Classification dialog appears. If you selected **Use Training Data**, the Supervised Classification dialog appears.

### Using Unsupervised Classification

Unsupervised classification clusters pixels in a dataset based on statistics only, without any user-defined training classes. The unsupervised classification technique available is ISODATA.

ISODATA unsupervised classification starts by calculating class means evenly distributed in the data space, then iteratively clusters the remaining pixels using minimum distance techniques. Each iteration recalculates means and reclassifies pixels with respect to the new means. This process continues until the percentage of pixels that change classes during an iteration is less than the change threshold or the maximum number of iterations is reached.

In the Unsupervised Classification panel, set the values to use for classification.

1. Enter the **Requested Number of Classes** to define. The default is **5**.
   - **Note**: If the output will be used on ArcMap or ArcCatalog, creating a 30 or more classes will cause ArcMap or ArcCatalog to use a stretch renderer by default. You can modify the ArcMap or ArcCatalog default by adding a new registry key. For steps, contact Technical Support.

2. If you wish to set additional parameters, click the **Advanced** tab.
   - Enter the **Maximum Iterations** to perform. If the **Change Threshold** is not met before the maximum number of iterations is reached, the classification process ends. The default is **10**.
b. Enter the **Change Threshold %** to specify when to end the classification process. When the percentage of pixels that change classes during an iteration is less than the threshold value, the classification process ends. The default is 2.

3. Click **Next**. The classification process begins, and the status displays on the Unsupervised Classification panel.

When the classification process is complete the Cleanup panel appears.

### Using Supervised Classification

Supervised classification clusters pixels in a dataset into classes based on user-defined training data. The training data can be polygons from existing vector layers, or they can be polygons that you interactively create on a loaded image. The training data must be defined before you can continue in the supervised classification workflow (see below). Once defined, select the classes that you want mapped in the output.

Supervised classification methods include Maximum likelihood, Minimum distance, Mahalanobis distance, and Spectral Angle Mapper (SAM).

In the Supervised Classification panel, select the supervised classification method to use, and define training data.

1. From the **Algorithm** drop-down list, select the classification method to use:

   - **Maximum Likelihood**: assumes that the statistics for each class in each band are normally distributed and calculates the probability that a given pixel belongs to a specific class. Each pixel is assigned to the class that has the highest probability (that is, the maximum likelihood).
   
   - **Minimum Distance**: uses the mean vectors for each class and calculates the Euclidean distance from each unknown pixel to the mean vector for each class. The pixels are classified to the nearest class.
   
   - **Mahalanobis Distance**: is a direction-sensitive distance classifier that uses statistics for each class. It is similar to the maximum likelihood classification, but assumes all class covariances are equal, and therefore is a faster method. All pixels are classified to the closest training data.
   
   - **Spectral Angle Mapper** (SAM) is a physically-based spectral classification that uses an \( n \)-D angle to match pixels to training data. This method determines the spectral similarity between two spectra by calculating the angle between the spectra and treating them as vectors in a space with dimensionality equal to the number of bands. This technique, when used on calibrated reflectance data, is relatively insensitive to illumination and albedo effects. SAM compares the angle between the training mean vector and each pixel vector in \( n \)-D space. Smaller angles represent closer matches to the reference spectrum. The pixels are classified to the class with the smallest angle.

2. Define the training data to use for classification, as described below. A minimum of two classes, with at least one training sample per class, must be defined to perform classification. You can define training data by as described below.

3. To preview how the chosen method will look before processing, enable the **Preview** check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change classification type and/or training data, and preview the results again, as needed.

4. Click **Next**. The classification process begins, and the status displays on the Supervised Classification panel.

When the classification process is complete the Cleanup panel appears.
Loading Previously Defined Training Data

When you load training data that uses a different projection as the input image, ENVI EX reprojects it. If the training data uses different extents, the overlapping area is used for training.

Note: Loading previously defined training data replaces any training data that were drawn on the screen previously.

1. Click the **Load Training Data Set** button 📁. The Select Training Data dialog appears.
2. Click **Open File**. In the Open dialog, select an input file and click **Open**.
   
   or

   Click **Open Remote Dataset** to open a geodatabase file. The Remote Connection Manager dialog appears.
3. Click **OK**. The layer displays in the Image window.

Interactively Defining Training Data

When you select **Use Training Data**, the **Polygon Annotation**, **Rectangle Annotation**, and **Ellipse Annotation** buttons are enabled and a new layer named **Training Areas** is added to the Layer Manager.

To provide adequate training data, create a minimum of two classes, with at least one region per class. If you applied a mask to the input data, create training samples within the masked area only.

- To select a class to modify, select it from the **Training Regions** tree.
- Add, move, and edit regions in the selected class. See Creating Polygon Annotations, Creating Rectangle Annotations, or Creating Ellipse Annotations for details. Do not draw regions outside the raster bounds.
- To add a new class, click the **Add Class** button 📚, or right-click and select **Add Class**.
- To delete a class, select the class to delete and click the **Delete Class** button ✗, or right-click on the class and select **Delete Class**.
- To save the training data, click the **Save Training Data Set** button.
- To edit the properties for a class, see the following.

Editing Class Properties

To change the properties for a class, select the class to edit and click the **Edit Class Properties** button 📧, or right-click on the class and select **Edit Class Properties**.

- **Class Name** is the name of the class that will be output in the results.
- **Class Color** is the color that will display for that class in the results.
- **Fill Interior** specifies whether the polygon has a fill (Solid) or no fill (None).
Cleaning Up Classification Results

The optional Cleanup step refines the classification result. You can preview what the refinement will look like before you apply the settings. Performing cleanup is an optional step; to skip it click Skip and continue to the export step.

Tip: If you plan to save the classification vectors to a file in the final step of the workflow, the Cleanup step is recommended. Performing cleanup significantly reduces the time needed to export classification vectors.

1. Enable the check boxes for the cleanup methods you want to use. The following are available:
   - Enable Smoothing: removes salt and pepper noise during cleanup.
   - Enable Aggregation: removes small regions.
2. Enter values for the cleanup methods you enabled:
   - Specify the Smooth Kernel Size using an odd number (e.g., 3 = 3x3 pixels). The square kernel’s center pixel will be replaced with the majority class value of the kernel. The default is 3.
   - Specify the Aggregate Minimum Size in pixels. Regions with a size of this value or smaller are aggregated to an adjacent, larger region. The default is 9.
3. To preview the cleanup result before processing, enable the Preview check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change the cleanup settings and preview the results again, as needed.
4. Click Next. The Export panel appears.

Exporting Classification Results

In the Export panel, you can save the following output:
- Classification results to an image
- Classification results to vectors
- Statistics that were generated during processing to a text file

To export results:
1. In the Export Files tab, enable the check boxes for the exports you want to output. The following are available:
   - Export Classification Image: saves the classification result to an image. The supported image output formats are ENVI and geodatabase.
   - Export Classification Vectors: saves the vectors created during classification. The supported vector output formats are shapefile and geodatabase. The output area units are in square meter.
     Note: Depending on the image size, exporting to vectors may be time-consuming. To reduce the export time, performing the Cleanup step prior to export is recommended.
2. In the fields provided, enter the path and filename for each of the export types, or click Browse to navigate to a directory and select a filename. If you select GDB (for geodatabase), click Browse to open the Select an Output Database dialog.
     Note: For geodatabases, you cannot save a classification to a personal geodatabase. The classes will not be retained.
3. To save statistics on the classes, select the **Export Statistics** tab. The output area units are in square meter.

4. Enter the path and filename for the statistics file in the field provided, or click **Browse** to navigate to a directory and select a filename.

5. Click **Finish**. ENVI EX creates the output, adds the new layers to the Layer Manager, and saves the files to the directories you specified.
About the Image Difference Change Detection Workflow

Image difference change detection compares two images—typically from Landsat or QuickBird—of the same geographic extent, taken at different times, and it identifies differences between them. The difference can be computed on a specified input band or on a feature index, and you can optionally apply thresholding.

In the Image Difference Change Detection workflow, you do the following:

- Select a file
- Set parameters for image difference change detection
- Optionally apply thresholding
- Optionally refine the classification output
- Save change detection results

References

Image Difference Change Detection:


Auto-thresholding:


Selecting a File for Image Difference Change Detection

In the File Selection panel, you choose two images to include in image difference change detection. You can apply a spatial subset, and/or a mask to the first image you select. The supported input types are ENVI, TIFF, NITF, JPEG 2000, JPEG, ESRI raster layer, and geodatabase raster.

File inputs can have standard map projections or be pixel-based. A pseudo projection does not provide spatial locations with the accuracy needed for use in image difference change detection.

1. Use the Toolbox to initiate Image Difference.

   If you want to open a geodatabase or a remote dataset, click Browse in the File Selection panel, then click Open Remote Dataset in the Select Time 1 File dialog. The Remote Connection Manager dialog appears.

   Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.

   Note: When using ESRI layer files as a data source for workflows, you expand the ESRI layer and select the data source. ArcGIS .lyr files consist of a set of rules for displaying and working with datasets. Information in .lyr files can include symbols, classifications, labeling rules, and other information describing the appearance and actions of the layer. When visualizing an ESRI layer in an ENVI application, the properties are inherited from ArcGIS. If you open the source data for an ESRI layer, you will use stretch and other properties from the ENVI application, and the two may not display the same way.

2. To perform optional spatial subsetting, click Browse in the File Selection panel.

3. To apply a mask, select the Input Mask tab in the File Selection panel. "Working with Masks in a Workflow" on page 134 provides details about masking.

   Note: Reprojected vectors are not supported when the original input data has RPCs. To apply a mask in this case, either draw the mask on the image in the Image window, or use the RPC Orthorectification workflow to reproject the image to standard map projections, then use the orthorectified image and the shapefile as inputs.

4. Select the Input Files tab again.

5. Enter the path and filename for the Time 2 File.

To navigate to a file, click Browse. The Select Time 2 File dialog appears. Do one of the following:

   • If the file you want to use is listed in the dialog, select it.
   • Click Open File to open a new file. The Open dialog appears.
   • Click Open Remote Dataset to open a geodatabase or remote dataset. The Remote Connection Manager dialog appears.

   Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.

6. Click Next. The Image Difference panel appears.

Image Difference Change Detection

In the Image Difference panel, set the parameters to use for the difference analysis.
In the **Difference Band** tab:

1. Select one of the following:
   - **Input Band**: Performs difference analysis on a specific band in the image.
   - **Feature Index**: Performs difference analysis on a specific feature. The available feature indices are Normalized Difference Vegetation Index (NDVI), Normalized Difference Water Index (NDWI), Normalized Difference Built-up Index (NDBI), and an opposite Normalized Burn Ratio (-NBR).
     
     **Note**: The Feature Index option is available only when the input files are multispectral or hyperspectral.

2. If you are using **Input Band**, select a band from the drop-down list.

3. To use advanced settings for band input, select the **Advanced** tab. If you see that the two images have obviously different dynamic ranges caused by different illumination conditions, enable the **Radiometric Normalization** check box. Otherwise, leave the check box disabled. Radiometric normalization minimizes radiometric differences between two images caused by inconsistencies of acquisition conditions, such as changes caused by different atmospheric and illumination conditions. The radiometric normalization process applies a gain and an offset to the Time 2 image so that it has the same mean and standard deviation as the Time 1 image.

4. If you are using **Feature Index**, select one of the following indices from the drop-down list:
   - **Vegetation Index (NDVI)**: The Normalized Difference Vegetation Index transforms multispectral data into a single image band where vegetation distribution is bright.
   - **Water Index (NDWI)**: The Normalized Difference Water Index produces a single grayscale image, where water is bright.
   - **Built-up Index (NDBI)**: The Normalized Difference Built-up Index produces a single grayscale image, where built-up areas are bright.
   - **Burn Index**: The Burn Index is the opposite of the Normalized Burn Ratio (-NBR). It produces a single grayscale image where burn areas are bright. The result is the same as the Differenced Normalized Burn Ratio.

     See References for additional information about the feature indices.

5. To use advanced settings for the feature index, select the **Advanced** tab. Specify the bands for **Band 1** and **Band 2**. The workflow provides default bands for each index type. The equation the workflow uses for computing the feature index is:

   $$(\text{Band}_2 - \text{Band}_1) / (\text{Band}_2 + \text{Band}_1)$$

6. To preview how the parameter settings look before processing, enable the **Preview** check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change settings and preview the results again, as needed.

7. Click **Next**. The difference analysis begins.

   When image difference processing is complete, the Thresholding or Export panel appears.

**Choose Thresholding or Export**

In the Thresholding or Export panel, select one of the following:
• **Apply Thresholding**: takes you to the Change Thesholding panel, where you can set parameters that help the workflow process determine the areas that have big change. "Change Thresholding" on page 144 describes the settings. When you select this option, you can export multiple outputs at the end of the workflow.

• **Export Image Difference Only**: provides a shorter workflow that does not include thresholding, and takes you directly to the Export panel. When you select this option, you export only a difference image.

**Change Thresholding**

In the Change Thresholding step for image difference change detection, specify the type of change you want to show between the two images. You can use pre-set auto-thresholding techniques, and you can manually adjust thresholding.

1. In the **Auto-Thresholding** tab, select the change of interest from the **Select Change of Interest** drop-down list. The choices are:
   - **Increase and Decrease**: Shows areas of increase (in blue) and decrease (in red).
   - **Increase Only**: Shows areas of increase (in blue) only.
   - **Decrease Only**: Shows areas of decrease (in red) only.

2. In the **Select Auto-Thresholding Method** drop-down list, select one of the following:
   - **Otsu’s**: A histogram shape-based method. It is based on discriminate analysis and uses the zeroth- and the first-order cumulative moments of the histogram for calculating the value of the thresholding level.
   - **Tsai’s**: A moment-based method. It determines the threshold so that the first three moments of the input image are preserved in the output image.
   - **Kapur’s**: An entropy-based method. It considers the thresholding image as two classes of events, with each class characterized by Probability Density Function (PDF). The method then maximizes the sum of the entropy of the two PDFs to converge on a single threshold value.
   - **Kittler’s**: A histogram shape-based method. It approximates the histogram as a bimodal Gaussian distribution and finds a cutoff point. The cost function is based on the Bayes classification rule.

See References for additional information about the auto-thresholding methods.

3. To set thresholding manually by selecting the **Manual** tab. The **Increase Threshold** value controls the thresholding on areas of increase. The **Decrease Threshold** value controls the thresholding on areas of decrease. Use the following to set the thresholds:
   - Use the **Increase Threshold** and the **Decrease Threshold** slider bars to increase and/or decrease the threshold values.
   - Enter the threshold values into the fields provided.
   - Use the up arrow and right arrow keyboard keys to increase the value by 0.0001.
   - Use the down arrow and left arrow keyboard keys to decrease the value by 0.0001.
   - Use the **Page Up** and **Page Down** keyboard keys to increase/decrease the values by 10 percent.
• Click the Reset button to return to the default value.

4. To preview how the thresholding settings look before processing, enable the Preview check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change settings and preview the results again, as needed.

5. Click Next. When you click Next, the difference image will be classified into Big Increase, Big Decrease, and Other, based on the threshold values. The Cleanup panel appears.

Cleaning Up Change Detection Results

The cleanup step refines the change detection result. You can preview what the refinement will look like before you apply the settings. Performing cleanup is an optional step; to skip it click Skip and continue to the export step.

Tip: If you plan to save the vectors created during processing to a file in the final step of the workflow, the Cleanup step is recommended. Performing cleanup significantly reduces the time needed to export vectors.

1. Enable the check boxes for the cleanup methods you want to use. The following are available:
   • Enable Smoothing removes salt and pepper noise during cleanup.
   • Enable Aggregation removes small regions.

2. Enter values for the cleanup methods you enabled:
   • Specify the Smooth Kernel Size using an odd number (e.g., 3 = 3x3 pixels). The square kernel’s center pixel will be replaced with the majority class value of the kernel. The default is 3.
   • Specify the Aggregate Minimum Size in pixels. Regions with a size of this value or smaller are aggregated to an adjacent, larger region. The default for thematic change detection is 9. The default for image difference change detection is 100.

3. To preview the cleanup result before processing, enable the Preview check box. A Preview Portal appears. You can change the cleanup settings and preview the results again, as needed.

4. Click Next. The Export panel appears.

Exporting Image Difference Change Detection Results

If you did not apply thresholding during the workflow, you can save the difference image to a raster file. See Step 3 below.

If you did apply thresholding during the workflow, you can save the following output:
• Change class results to an image
• Change class results to vectors
• Change statistics to a text file
• Difference results to an image

To export results:

1. In the Export Files tab, enable the check boxes for the exports you want to output. The following are available:
• **Export Change Class Image**: saves the thresholding result to an image. The supported image output formats are ENVI and geodatabase.

• **Export Change Class Vectors**: saves the vectors created during thresholding. The supported vector output formats are shapefile and geodatabase. The output area units are in square meters.

  **Note**: Depending on the image size, exporting to vectors may be time-consuming. To reduce the export time, performing the Cleanup step prior to export is recommended.

2. In the fields provided, enter the path and filename for each of the export types, or click **Browse** to navigate to a directory and select a filename. If you select **GDB** (for geodatabase), click **Browse** to open the Select an Output Database dialog.

3. In the **Additional Export** tab, enable the check boxes for any other exports you want to output. If you did not apply thresholding during the workflow, the only available option is **Export Difference Image**.

   If you did apply thresholding, the following are available:

   • **Export Change Class Statistics**: saves statistics on the thresholding image. The output area units are in square meter.

   • **Export Difference Image**: saves the difference image to an image. The supported image output formats are ENVI, geodatabase, and TIFF.

4. In the fields provided, enter the path and filename for each of the export types, or click **Browse** to navigate to a directory and select a filename. If you select **GDB** (for geodatabase), click **Browse** to open the Select an Output Database dialog.

5. Click **Finish**. ENVI EX creates the output, adds the new layers to the Layer Manager, and saves the files to the directories you specified.
About the Thematic Change Detection Workflow

The thematic change detection workflow takes two classification images of the same scene taken at different times and identifies differences between them. The resulting classification image shows class transitions, for example, from class 1 to class 2. Thematic change detection can be used to analyze land use, land cover change, deforestation, urbanization, agricultural expansion, water variability, and more.

In the Thematic Change Detection workflow, you do the following:

- Select a file
- Set parameters for thematic change detection
- Optionally refine the classification output
- Save thematic change detection results

Selecting a File for Thematic Change Detection

In the File Selection panel, you choose two classification images to include in thematic change detection. You can apply a spectral subset, and/or a mask to the first image you select. The supported input types are ENVI, ERDAS IMAGINE, ESRI feature layer, and geodatabase feature class.

File inputs need to have standard map projections or be pixel-based. A pseudo projection does not provide spatial locations with the accuracy needed for use in thematic change detection.

1. Use the Toolbox to initiate Thematic Change.

   If you want to open a geodatabase, click Browse in the File Selection panel, then click Open Remote Dataset in the Select Time 1 Classification Image File dialog. The Remote Connection Manager dialog appears.

   Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.

   Note: When using ESRI layer files as a data source for workflows, you expand the ESRI layer and select the data source. ArcGIS .lyr files consist of a set of rules for displaying and working with datasets. Information in .lyr files can include symbols, classifications, labeling rules, and other information describing the appearance and actions of the layer. When visualizing an ESRI layer in an ENVI application, the properties are inherited from ArcGIS. If you open the source data for an ESRI layer, you will use stretch and other properties from the ENVI application, and the two may not display the same way.

2. To perform optional spectral subsetting, click Browse in the File Selection panel.

3. To apply a mask, select the Input Mask tab in the File Selection panel. "Working with Masks in a Workflow" on page 134 provides details about masking.

   Note: Reprojected vectors are not supported when the original input data has RPCs. To apply a mask in this case, either draw the mask on the image in the Image window, or use the RPC Orthorectification workflow to reproject the image to standard map projections, then use the orthorectified image and the shapefile as inputs.

4. Select the Input Files tab again.

5. Enter the path and filename for the Time 2 Classification Image File.

   To navigate to a file, click Browse. The Select Time 2 Classification Image File dialog appears. Do one of the following:
• If the file you want to use is listed in the dialog, select it.
• Click Open File to open a new file. The Open dialog appears.
• Click Open Remote Dataset to open a geodatabase or remote dataset. The Remote Connection Manager dialog appears.

  Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.

6. Click Next. The Thematic Change panel appears.

Using Thematic Change Detection

In the Thematic Change panel, you set parameters to use for change detection.

1. If the two input classification images have the same number of classes that use the same class name, the Only Include Areas That Have Changed check box is available, and is enabled by default. When the check box is enabled, ENVI EX groups those classes into a class named no change if there was no difference detected during processing. Otherwise, the output is a new classification image that includes all class transition information.

2. To preview how the parameter settings look before processing, enable the Preview check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change settings and preview the results again, as needed.

3. Click Next. Thematic change processing begins.

When processing is complete, the Cleanup panel appears.

Cleaning Up Change Detection Results

The cleanup step refines the change detection result. You can preview what the refinement will look like before you apply the settings. Performing cleanup is an optional step; to skip it click Skip and continue to the export step.

Tip: If you plan to save the vectors created during processing to a file in the final step of the workflow, the Cleanup step is recommended. Performing cleanup significantly reduces the time needed to export vectors.

1. Enable the check boxes for the cleanup methods you want to use. The following are available:
   • Enable Smoothing removes salt and pepper noise during cleanup.
   • Enable Aggregation removes small regions.

2. Enter values for the cleanup methods you enabled:
   • Specify the Smooth Kernel Size using an odd number (e.g., 3 = 3x3 pixels). The square kernel’s center pixel will be replaced with the majority class value of the kernel. The default is 3.
   • Specify the Aggregate Minimum Size in pixels. Regions with a size of this value or smaller are aggregated to an adjacent, larger region. The default for thematic change detection is 9. The default for image difference change detection is 100.

3. To preview the cleanup result before processing, enable the Preview check box. A Preview Portal appears. You can change the cleanup settings and preview the results again, as needed.

4. Click Next. The Export panel appears.
Exporting Thematic Change Detection Results

In the Export panel, you can save the following output:

- Thematic change detection results to an image
- Thematic change detection results to vectors
- Class transition statistics to a text file

To export results:

1. In the Export Files tab, enable the check boxes for the exports you want to output. The following are available:
   - **Export Thematic Change Image**: saves the classification result to an image. The supported image output formats are ENVI and geodatabase.
   - **Export Thematic Change Vectors**: saves the vectors created during classification to a shapefile. The supported vector output formats are shapefile and geodatabase. The output area units are in square meter.
     
     **Note**: Depending on the image size, exporting to vectors may be time-consuming. To reduce the export time, performing the Cleanup step prior to export is recommended.

2. Enter the path and filename for each of the export types you select in the field provided, or click Browse to navigate to a directory and select a filename. If you select GDB (for geodatabase), click Browse to open the Select an Output Database dialog.

3. To save statistics on thematic change, select the Export Thematic Change Statistics tab. The output area units are in square meter.

4. Enter the path and filename for the statistics file in the field provided, or click Browse to navigate to a directory and select a filename.

5. Click Finish. ENVI EX creates the output, adds the new layers to the Layer Manager, and saves the files to the directories you specified.
About the RPC Orthorectification Workflow

The RPC Orthorectification workflow performs orthorectification of a single-scene image using the rational polynomial coefficients (RPC) model. Orthorectification geometrically corrects the data to remove distortions that occur during image capture. ENVI EX supports data from the following sensors:

- GeoEye-1
- IKONOS
- OrbView-3
- QuickBird
- WorldView-1

Data from each of these sensors typically include an ancillary RPC file.

ENVI EX also supports the ENVI format with RPC INFO defined in the header and the NITF format with RPC information in the metadata. If you have both standard map information and RPC INFO in the header, you need to remove the standard map information in the ENVI header to continue.

The following are required input for RPC orthorectification:

- The image to rectify
- RPC model
- Elevation information

Websites that provide DEM data with higher resolution are:

- ASTER Global Digital Elevation Map (GDEM): http://www.gdem.aster.ersdac.or.jp/

References

RPC Orthorectification:


EGM96 Data:


Selecting Files for RPC Orthorectification

In the File Selection panel, you choose one input image with RPC information and one digital elevation model (DEM) image that provides elevation information.

The input image must have the associated RPC information. These coefficients are required for the rational function expansion to convert ground coordinates into sensor coordinates. When you select a file for input, ENVI EX searches for the RPC coefficients in one of the following ways:

- For GeoEye-1: An RPC filename consisting of the root name of the source data file appended with the extension .pvl.
Using RPC Orthorectification

• For IKONOS: An RPC filename consisting of the root name of the source image plus _rpc.txt.
• For OrbView-3: An RPC filename consisting of the root name of the source data file, but without the _image prefix, and appended by _metadata.pvl.
• For QuickBird: An RPC filename consisting of the root name of the source data file appended with the extension .rpb.
• For WorldView-1: An RPC filename consisting of the root name of the source data file appended with the extension .rpb.
• For ENVI: A header file containing RPC information.
• For NITF: RPCB or RPCA metadata tag in the metadata.

To select the files:
1. Use the Toolbox to initiate RPC Orthorectification.
2. To perform optional spatial subsetting, click Browse in the File Selection panel.
3. In File Selection panel, enter the path and filename for the DEM File, or click Browse.
   To navigate to a file, click Browse. The Select DEM File dialog appears. Do one of the following:
   • If the file you want to use is listed in the dialog, select it.
   • Click Open File. The Open dialog appears.
   • Click Open Remote Dataset to open a geodatabase or remote dataset. The Remote Connection Manager dialog appears.
     Note: Datasets from WCS servers are allowed as input. Datasets from JPIP or WMS servers are not allowed as input.
4. Click Next. The RPC Orthorectification panel appears.

Using RPC Orthorectification

In the RPC Orthorectification panel, you select the output filename and set advanced parameters.
1. In the Output tab, select the type of Output File to create. ENVI, geodatabase, and TIFF are the supported output formats.
2. Enter the path and filename for the orthorectified image in the field provided.
   or
   Click Browse. In the Select Output Filename dialog, select an output filename and directory and click Open. If you select GDB (for geodatabase), click Browse to open the Select an Output Database dialog.
3. To set parameters, select the Advanced tab.
4. By default, the Geoid Correction check box is enabled. The RPC Orthorectification workflow performs geoid correction by using the Earth Gravitational Model 1996 to automatically determine the geoid offset value.
Generally, leave the check box enabled. Most DEMs contain elevations that are above mean sea level (MSL), and the geoid correction is a constant value that is added to every value in the DEM. The geoid height value is the height of the geoid above the WGS-84 ellipsoid. The value accounts for the difference between the elevation above MSL and the elevation above the ellipsoid (ellipsoid height). RPC orthorectification requires the ellipsoid height for each pixel. Geoid correction is necessary to provide accurate orthorectification if the DEM data is the elevation above MSL.

5. Enter an output pixel size, in meters. The default is close to the input pixel size, in meters.

6. Select an **Image Resampling** technique from the drop-down list. The resampling technique determines the pixel values in the input image when it is converted from its current orientation into the new orientation. The choices are:
   - **Nearest Neighbor**: Uses the nearest pixel without any interpolation,
   - **Bilinear**: Performs a linear interpolation using four pixels to resample.
   - **Cubic Convolution**: Uses 16 pixels to approximate the sinc function using cubic polynomials to resample the image.

   The default is **Bilinear**.

7. To preview how the orthorectification will look before processing, enable the **Preview** check box. A Preview Portal appears. The Preview Portal works with full or higher resolution views. You can change the **Geoid Correction** option and preview the results again, as needed.

8. Click **Finish**. ENVI EX processes the input and adds the orthorectified image to the Layer Manager.
Chapter 7: Working with Vectors

In this chapter you will find:

About Vectors ................................................................................................................. 154
Working with Vector Records ......................................................................................... 155
Creating Vector Layers ..................................................................................................... 157
Creating Vector Records .................................................................................................. 158
Editing Vector Records and Vertices ............................................................................. 160
Editing Vector Layer Properties .................................................................................... 168
Viewing Attributes .......................................................................................................... 169
Vector Tips and Tricks ...................................................................................................... 170
About Vectors

You can create vector records in new and existing vector layers, and you can edit vector records and vertices. When a vector layer has been modified, the icon next to the layer name in the Layer Manager becomes shaded to indicate the layer has changed. You can save or discard those changes as needed, and are prompted to do so when you attempt to change the active vector layer or create a new vector layer. At any point while using the vector tools, you can do the following:

- Save the changes to the original file or to a new file (described in "Saving Files" on page 192).
- With the Vector Create tool selected, right-click in the Image window or right-click on the layer name in the Layer Manager and select Revert to clear all vector record edits and return the layer to the state it was in after it was last saved.

Note: You cannot edit a vector layer originating from a geodatabase or referenced by an ESRI layer. However, you can access and edit the source data for an ESRI layer. For more information on ESRI layers, see "Displaying ESRI Layers and Feature Classes" on page 60.

If an attribute table exists for the layer, the following occurs:

- When you add a new vector record, a new empty record is added to the table.
- When you group, join, or merge vector records, the records for the individual vectors are removed from the table and a new blank record is for the multipart or multipoint vector.
- When you ungroup multipart or multipoint records, the record for the multipoint or multipart vector is removed from the table and a new blank record is added for each individual vector.
- When you delete an existing vector record or vertex, its record is removed from the table.
- When you edit existing vector records or vertices, the attribute values are not changed. This may mean, depending on the type of edits made, that the values in that record are no longer valid.

For information on setting preferences for vectors, see "Vector Preferences" on page 48.
Working with Vector Records

Vector records can be either a point, multipoint, polyline, or polygon. For polylines and polygons, you can group two or more vector records to create a multipart vector record. For points, the layer must be already set up as a multipoint layer to be able to use multipoint functions, such as grouping individual points or creating a new multipoint.

Some examples follow.

**Grouping Individual Vector Records**

To group individual vector records into a single multipart vector record, use either the group or merge function:

**Before grouping/merging:**

- Each polyline is an individual vector record; you can select them separately.

**After grouping/merging:**

- The polylines are grouped into a single multipart vector record; selecting one polyline selects all in the multipart.

**Merging Overlapping Polygons or Polylines**

To merge two overlapping or touching polylines or polygons into a single polygon, use the merge function:

**Before merging:**

- Separate, overlapping polygons, with one polygon selected.

**Before merging:**

- Before completing the merge, you can preview how it will look.

**After merging:**

- The polygons are merged into a single vector record.

**Grouping Polygons**

To group two polygons where one is inside the other and retain both polygons, use the group function. You cannot group polygons that are overlapping or touching. The result is a polygon with a hole:
Merging Polygons

Conversely, to merge two polygons where one is inside the other and remove the inner polygon, use the merge function. You cannot group polygons that are overlapping or touching. Using the merge function removes the polygon hole:

Merging and grouping affects the records in the attribute table (described in "Viewing Attributes" on page 169). These details are provided in "Creating Vector Records" on page 158 and "Editing Vector Records and Vertices" on page 160.
Creating Vector Layers

You can create new vector layers by using an existing vector or raster layer to define the extents and map projection.

1. From the menu bar, select **File > New > Vector Layer**, or right-click on the Layers folder in the Layer Manager and select **New > Vector Layer**. The Create New Vector Layer dialog appears.

2. Optionally enter a **Layer Name** for the new layer. If you do not enter a name, ENVI EX uses the default name **New Vector** until you save the layer.

3. Select the vector layer type from the **Record Type** drop-down list. The choices are **Point**, **Multipoint**, **Polyline**, and **Polygon**. The last selection used is the default.

4. Select the source file to use for the new layer’s base projection. Do one of the following:
   - Select a source file from the **Source Data** list. To view information about the file, select the filename and click **File Information**.
   - Open a new source file by clicking **Open File**, browsing for and selecting a file, then selecting it from the Source Data list.

5. Click **OK**. This adds the new layer to the Layer Manager as the active vector layer, and the **** button is selected on the toolbar.

6. Add new vector records as described in .

7. Save the new layer as a shapefile as described in . If you changed the name of the layer when you saved it, the Layer Manager updates to show the new name.

   Saving the new layer creates a new attribute table. The attribute table consists of the numeric attribute RECORD_ID. To view the attribute table, see "Viewing Attributes" on page 169.

Once created, you can hide, rename, remove, and reorder vector layers.
Creating Vector Records

You can add new vector records to a vector layer. The vector records you add will be of the same type that already exists in the layer (for example, new vector records added to a polygon layer will also be polygons).

Though you can create self-intersecting polygons, it is not recommended that you do so. See the ESRI Shapefile Technical Description for more information about self-intersecting polygons.

To create vector records, the layer to modify must be set as the active layer in the Layer Manager. If you have multiple annotation layers loaded and you need to set the active layer, right-click on the layer name and select Set as Active Layer.

If the vector layer has an associated attribute table, creating a vector record adds a new blank record to the attribute table.

Creating Polyline, Polygon, and Multipart Vector Records

Polygons must contain a minimum of three vertices. Polylines must contain a minimum of two vertices.

1. Click the Vector Create button.
2. In the Image window, add the new vector records.
   - To draw polygons or polylines, click and drag to draw a polygon or polyline.
   - To create polygons or polylines one vertex at a time, click and release where you want the first vertex to be, move the cursor to where the next vertex will be and click and release again. Repeat as many times as needed.
   - If needed, use the Backspace key to undo polygon or polyline vertices, or right-click and select Clear.
3. To accept the vector record, you can use one of the following:
   - Double click.
   - Press the Enter key.
   - Right-click and select Accept, Save, or Save As. For more information about selecting a save option, see "About Vectors" on page 154.

If an attribute table exists for the vector layer, a new blank record for the vector is added.

4. If you want to group the two or more newly added polygons or polylines into a multipart vector record:
   - Use Shift-click to select the vectors you want to group. The polygons to group cannot be overlapping or touching.
   - Right-click and select Group. The vectors are grouped into a single multipart vector record. If an attribute table exists for the vector layer, the entries for the individual vector records are removed and a new blank entry for the multipart vector record is added.
   - Save or discard layer changes.

Creating Point and Multipoint Records

Points are added as individual vector records. If you want to add or group points into a single multipoint vector record, the point layer must already be designated as a multipoint file. Designating the file as a multipoint layer is done outside of ENVI EX.
1. Click the **Vector Create** button.

2. In the Image window, click and release at each location you want to add a point.

3. To accept the points, you can use one of the following:
   - Press the **Enter** key to accept the points as individual points.
   - Right-click and select **Accept as Individual Points**, to accept each point as an individual vector record.
   - Right-click and select **Accept as Multipoint** to accept the points as a single multipoint vector record. This option is available only if the layer is a multipoint file.
   - Right-click and select **Save** or **Save As**. For more information about selecting a save option, see "About Vectors" on page 154.

   If an attribute table exists for the vector layer, a new blank record for the each individual point, or a new blank record for the multipoint, is added.

4. Save or discard layer changes.
Editing Vector Records and Vertices

You can edit vector records and vertices in a variety of ways. Editing a vector layer with an associated attribute table does not change the existing attribute values. Therefore, depending on the type of edits you make, this may mean the values in that record are no longer valid.

To perform any editing functions, the layer to edit must be set as the active layer in the Layer Manager. To set the active layer, right-click on the layer name and select **Set as Active Layer**.

If a reduced resolution level of the vector file is displayed, then updates (such as delete) do not immediately show until you save the file. Saving the file creates a new reduced resolution vector file.

To save or discard layer changes, see "About Vectors" on page 154 for details.

**Selecting Vector Records or Vertices**

To select vector records to edit, use the following methods when using the **Vector Edit** tool. Selected vectors appear in cyan highlight:

- Click to select or deselect an individual vector record. Repeat to select/deselect multiple vector records.
- Click and drag to draw a box around the vector record(s) to select. This method is recommended when selecting polygons with holes.
- Click the **Select** tool to select one or more vector records, then select the **Vector Edit** button to perform edits. **Shift** + click will add vector records to your selection. **Ctrl** + click will remove single selected records.
- To deselect all selected vector records, right-click and select **Clear Selections**.

To select vertices to edit, use the following methods when using the **Vertex Edit** tool:

- Click on the vector record to edit. The color of the selected vector changes to dark blue. When selecting a multipart vector record, only one part is selected.
- The vertex nearest the cursor position is highlighted by a pink square.
- Move the cursor over other vertices to change which one is selected.

**Moving Points or Vertices**

1. Click the **Vertex Edit** button.
2. Do one of the following:
   - To move points, select the point to move.
   - To move a vertex, select the polyline or polygon to edit, then place the cursor over the vertex to move.
   - Click and drag to move the point or vertex to the new location. You can optionally use the up, down, left, and right keyboard keys to move the location one screen pixel in the direction of the arrow.
   - Release the mouse button to reposition the point or vertex.
   - To accept the changes, either click off the point or vector record, or right-click and select **Accept Changes**, **Save**, or **Save As**.
To reject the changes, right-click and select Clear Changes.

**Snapping to a Nearby Vertex**

You can move a polyline or polygon vertex by snapping it to the nearest vertex.

1. Click the **Vertex Edit** button.
2. Select the vector record to edit.
3. Position the cursor over the vertex to move.
4. Right-click and select **Snap to Nearest Vertex**. The vertex position snaps to the next-nearest vertex in the display.
5. To accept the changes, either click off the vector record, or right-click and select **Accept Changes**, **Save**, or **Save As**.
   
   To reject the changes, right-click and select Clear Changes.

**Adding a Vertex to a Polyline or Polygon**

You can add additional vertices to a polygon or polyline.

1. Click the **Vertex Edit** button.
2. Select the polyline or polygon to edit.
3. Position the cursor over or near the vector area where you want to add the vertex.
4. Right-click and select **Insert Vertex**.
5. To accept the changes, either click off the vector record, or right-click and select **Accept Changes**, **Save**, or **Save As**.
   
   To reject the changes, right-click and select Clear Changes.

**Joining Polylines**

Use this option to join two polylines. You can see a preview of what a connection will look like before you accept the change.

1. Click the **Vector Join** button.
2. Select the first polyline to include in the join.
3. Click and hold the mouse over the vertex that you want to connect from.
4. Drag the cursor to the polyline you want to connect to. The preview line automatically snaps to the nearest vertex as you drag the cursor. Release the mouse button when the desired vertex is selected.
5. Right-click and select **Join**. If an attribute table exists for the vector layer, ENVI EX removes the entries for the individual polylines and adds a new blank entry for the joined polyline.

**Merging Polylines or Polygons**

You can merge two or more polylines or polygons to create a single multipart record. Use the **Merge** option when you have two or more overlapping or touching polylines or polygons you want to merge into one polyline or polygon. For examples of merging, see "Working with Vector Records" on page 155.

1. Click the **Vector Edit** button.
2. To preview what the polyline or polygon will look like before you complete the merge, right-click in
   the Image window and enable **Show Merge**.

3. Select the polylines or polygons to merge.

4. Right-click and select **Merge**. The polylines or polygons are merged into a single polyline or
   polygon. If an attribute table exists for the vector layer, ENVI EX removes the records for the
   individual polylines or polygons and adds a new blank record for the merged polyline or polygon.

### Grouping and Ungrouping Vector Records

You can group individual vector records into a single multipart vector record. If you want to group points,
the point layer must already be designated as a multipoint file. For examples of grouping, see "Working with
Vector Records" on page 155.

1. Click the [button](#).
2. Select the polylines or polygons to group or ungroup.
3. Right-click and select **Group**. The vector records are grouped into a single multipart vector record.
   If an attribute table exists for the vector layer, ENVI EX removes the records for the individual
   vectors and adds a new blank record for the multipart vector.

When you ungroup a multipart vector record, it breaks down the multipart vector into the individual vector
records.

1. Click the **Vector Edit** button.
2. Select the multipart vector record to ungroup.
3. Right-click and select **Ungroup**. The single multipart vector record is broken down into the
   individual vector records. If an attribute table exists for the vector layer, ENVI EX removes the
   record for the multipart vector and adds a new blank record for each individual vector.

### Splitting Polylines and Polygons

To split a polyline:

1. Click the **Vertex Edit** button.
2. Select the polyline to split.
3. Move the cursor over the polyline until you highlight the vertex where you want the split to occur.
4. Right-click and select **Split at Vertex**. The polyline is divided into two polylines. If an attribute table
   exists for the vector layer, ENVI EX removes the records for the individual polyline and adds a new
   blank record for the two new polylines.
5. To accept the changes, either click off the vector record, or right-click and select **Accept Changes,
   Save**, or **Save As**.

To reject the changes, right-click and select **Clear Changes**.

To split a polygon, mark the vertices where you want the split to occur:

1. Click the **Vertex Edit** button.
2. Select the polygon to split.
3. Position the cursor over a vertex to mark for the split.
4. Right-click and select **Mark Vertex**. This marks one of the two vertices between which the split will occur.

To unselect the marked vertex, right-click and select **Clear Marks**.

5. Repeat the previous two steps to select and mark the second vertex. If there are vertices between the two that are marked, they are selected as well. The section to split is marked in cyan.

To unselect the marked vertices, right-click and select **Clear Marks**.

6. Right-click and select **Split at Marked Vertices**. The polygon splits into two new polygons by dividing them at the marked vertices. If an attribute table exists for the vector layer and the selected part is within a multipart record, ENVI EX replaces the data from the original part by the data for one of the split-off parts and adds a new part for the other split-off part. If the selected part is the only part in the record, ENVI EX deletes the original record and adds one new record for each split-off part.

7. To accept the changes, either click off the vector record, or right-click and select **Accept Changes**, **Save**, or **Save As**.

To reject the changes, right-click and select **Clear Changes**.

**Deleting Vertices**

To delete a single vertex from a polyline or polygon:

1. Click the **Vertex Edit** button.
2. Select the polyline or polygon to edit.
3. Position the cursor over the vertex to delete.
4. Right-click and select **Delete Vertex**.

To delete multiple vertices, mark the vertices in the vector record to delete:

1. Click the **Vertex Edit** button.
2. Select the polyline or polygon to edit.
3. Position the cursor over a vertex to delete.
4. Right-click and select **Mark Vertex**. This marks one of the vertices to delete in cyan.

To unselect the marked vertex, right-click and select **Clear Marks**.

5. Repeat the previous two steps to select the second vertex to delete. If there are additional vertices between the two that are marked, they are selected as well. The entire section to delete is marked in cyan.

To unselect the marked vertices, right-click and select **Clear Marks**.

If the vertices selected between your marks are different from what you want, you can invert the selection by right-clicking and selecting **Invert Marks**.

6. Right-click and select **Delete Marked Vertices**.

**Removing Polygon Holes**

You can remove interior holes from multipart polygon vector records.

1. Click the **Vector Edit** button.
2. Select the vector record to edit.
3. Right-click and select **Remove Holes**. The hole is removed. If an attribute table exists for the vector layer, ENVI EX removes the record for the vector record.

**Deleting Vector Records**

You can delete one or more vector records at a time.

1. Click the **Vector Edit** button.
2. Select the vector record to edit.
3. Right-click and select **Delete**. The vector record is removed. If an attribute table exists for the vector layer, the record for the vector is removed.

**Smoothing Polygons**

Use the **Smooth** option to interactively smooth individual polygon vectors, using the Douglas-Peucker line-simplification algorithm.

This option allows you to smooth polygons on a case-by-case basis versus setting the **Smoothing Threshold** preference for Feature Extraction, which smooths all polygons at once when you export Feature Extraction vector results to shapefiles.

Follow these steps to smooth polygon vectors:

1. Click the **Vector Edit** button.
2. Select the polygon vector(s) to edit.
3. Right-click and select **Smooth**. The Choose Smoothing Threshold dialog appears.
4. Enter a **Smoothing Threshold (pixels)** integer value to indicate the level of generalization, if any. The default value is 1. A larger value results in straighter lines and less detail in your polylines and polygons. The maximum value is 99, although values greater than 10 are seldom useful. The following figure shows a comparison of different pixel values:
5. You can repeat this step as many times as necessary to achieve the desired smoothing.

Note: You cannot edit a vector layer originating from a geodatabase or referenced by an ESRI layer. However, you can access and edit the source data for an ESRI layer. For more information on ESRI layers, see "Displaying ESRI Layers and Feature Classes" on page 60.

Background

The Douglas-Peucker line-simplification algorithm uses the minimum number of vertices to describe a feature at a given scale. It is best suited for generalizing curved features such as rivers and not for structured objects such as buildings. The algorithm starts by identifying the first and last points in a polyline or polygon and drawing an imaginary line between them.
For all the points in between, the algorithm identifies the one with the greatest distance (d) to this baseline. If this distance is greater than the **Smoothing Threshold (pixels)** value that you specify, the algorithm keeps this point and defines two sub-polylines from the point. The algorithm repeats the process with each sub-polyline until none of the points’ distances from each successive baseline is greater than the **Smoothing Threshold (pixels)**. The points that are kept when the iteration finishes describe the new feature.

A smoothed polygon will have a minimum of five vertices, and a smoothed polyline will have a minimum of four vertices. ENVI EX determines how the image is projected and translates the **Smoothing Threshold (pixels)** value into map units before applying the smoothing.

**Reference**


**Rectangulating Polygons**

Use the **Rectangulate** option to smooth any polygon vectors so that they are more rectangular in shape. This is especially useful for rooftops, buildings, fields, parking lots, etc. Follow these steps:
1. Click the **Vector Edit** button.

2. Select the polygon vector(s) to edit.

3. Right-click and select **Rectangulate**. You can repeat this step as many times as necessary to achieve the desired smoothing.

Rectangulating first applies a Douglas-Peucker line simplification algorithm using a smoothing factor that is fixed at a slightly larger size than the pixel size for the shapefile. Once the polygons are smoothed, it finds the dominant edges in each polygon. If a vertex is close to one of the dominant edges, it moves to lie along the edge.

The process cleans the results and removes line segments that are smaller than the pixel size of the shapefile. The smoothed polygon always has the same or fewer number of vertices than the input vector.

The results of the smoothing algorithm depend on the quality of the input data. If the original polygon vectors contain a lot of irregularity and noise, it is best to first smooth the vectors with your favorite smoothing algorithm before using **Rectangulate**. You can also try setting a high **Smoothing Threshold (Pixels)** value with the **Smooth** tool before using **Rectangulate** (see Smoothing Polygons).

**Note:** Rectangulating may occasionally convert long, narrow objects into polylines.

**Reference**

Editing Vector Layer Properties

Edit the properties of a vector layer through the Properties dialog. Right-click on the layer name or portal name in the Layer Manager and select **Properties** to open the Properties dialog.

The parameters listed in the dialog vary, depending on if the vector layer contains points, polylines, or polygons.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show</strong></td>
<td>True</td>
</tr>
<tr>
<td><strong>Record Type</strong></td>
<td>Polygon</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>(255,0,0)</td>
</tr>
<tr>
<td><strong>Line Style</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Thickness</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Fill Interior</strong></td>
<td>False</td>
</tr>
<tr>
<td><strong>Fill Color</strong></td>
<td>(153,0,0)</td>
</tr>
</tbody>
</table>

To edit fields with drop-down lists, double-click in the field and select a value.

**Show**: Enable or disable showing the layer in the Image window and the Overview window. The default is **True**. You can also enable and disable showing the layer by right-clicking on the layer name in the Layer Manager and selecting **Show**.

**Record Type**: Displays the type of records in the layer (polygon, polyline, etc.).

**Color**: The color of the vectors in the layer. Colors are automatically assigned to the vectors when the layer is displayed. If you display multiple layers, different colors are assigned for each layer. For example, the first layer displayed is red, the second layer is green, the third layer is blue, and so forth.

**Line Style**: (Polylines and Polygons only) The line style for the polygons or polylines. Style choices range from no line to solid, dashed, or dotted lines.

**Thickness**: (Polylines and Polygons only) The line thickness. Choices range from 1 pt to 10 pts. thickness.

**Fill Interior**: (Polygons only) Enable or disable using a fill color for polygons.

**Fill Color**: (Polygons only) If the **Fill Interior** setting is **True**, the color to use for the polygon interior.

**Symbol**: (Points only) The symbol type for point vectors. The choices are plus symbol, asterisk, dot, diamond, triangle, square, and X.

**Symbol Size**: (Points only) The size of the symbol. Choices range from 1 pt to 100 pts.

**Note**: You cannot edit a vector layer originating from a geodatabase or referenced by an ESRI layer. However, you can access and edit the source data for an ESRI layer. For more information on ESRI layers, see “Displaying ESRI Layers and Feature Classes” on page 60.
Viewing Attributes

If a vector or ESRI feature class layer has an associated attribute table, you can open and view the attributes. Right-click on the layer name in the Layer Manager and select View Attributes to open the Attribute Viewer. If you have a vector layer with unsaved edits, the View Attributes option is unavailable. Either save the layer or revert the changes to enable the option.

When the attribute table is open, click on a vector in the Image window to highlight the record in the Attribute Viewer. Conversely, click on the row number in the Attribute Viewer to highlight the vector in cyan in the Image window. To select multiple records or rows, press and hold the Shift or Ctrl key as you click.

To sort the attribute table data, click on the heading of the row you want to sort by, then right-click for menu options. You can sort the column forward (ascending order), reverse (descending order), or you can return the column to its original sort order.

Attribute data for a selected vector also appears in the Cursor Value window.
Vector Tips and Tricks

When you create a new vector layer, you use the projection from an existing vector or raster file as the projection for the new layer. The new layer is not actually saved until you add vector records to it and then use the Save As option.

By default, the new vector layer is saved to the Output Directory. If you need to create many new vector layers, it may be helpful to change this preference to point to the directory you are working in. All vector layers you create in ENVI EX are saved as shapefiles (.shp).

You can export a vector layer to a geodatabase by using the Save to ArcGIS Geodatabase menu option. See "Saving Files" on page 192.

If you have not saved the vector layer, you can use the Undo option to undo creating the new layer. If you have saved the new vector layer, you must delete it via your operating system (e.g. Windows Explorer).

The additional files for vector layers are as follows:

- For .evf and .shp files, the application creates a quadtree file (.qtr) and a rasterization file (.zrf).
- If the Build Reduced Vertices File preference is enabled, the application performs data reduction on files with high-density vertex data and creates a reduced data file (filename_reduced.ext).
- Shapefiles have an attribute file (.dbf) and a shapefile shape index (.shx).
- If the polygons in a polygon vector layer are filled, the application creates a tesselation file (.tsl).

If you have a problem saving your vector layer, close the vector file but leave your session running, then try deleting the .qtr and .ztr files via your operating system (e.g. Windows Explorer). Reopening the vector file creates new versions of the quadtree and reduced data files. Make the desired changes to the layer and you should be able to save them.

In the case of very large vector files (those with over 50K records), it is recommended that you view individual attributes using the Cursor Value window rather than attempting to use the View Attributes option. Using this method will help to avoid lengthy wait times as the Attribute table is populated and displayed.

To open the attributes table, the layer must be saved for the View Attributes option to be enabled. If this option is disabled, either save the layer or revert the changes to the layer to enable the View Attributes option.

To move points, you need to use the Vertex Edit tool.

To group points, the original file must be a multipoint file.

To select a polygon/polyline, you must click near one of its vertices, though individual vertices are not initially visible. If you have difficulty selecting the object, typically it is because it is long and/or straight and has few vertices to select. Keep clicking along the area of the polygon/polyline at intervals and you will soon click near a vertex, which in turn selects the entire polygon/polyline.

Clicking outside of a vector in the Image window will select the nearest vector record. In the case of an ESRI feature class layer, you must be within four pixels of the vector record in order to select it.
Chapter 8: Working with Feature Counting

In this chapter you will find:

About Feature Counting ..................................................................................................... 172
About Feature Counting

The Feature Counting tool enables you to mark features in raster and vector data. You can mark multiple feature types and add descriptions of them. You can mark individual features, and you can create feature type categories to help differentiate the markings between feature types.
Marking, Editing, and Deleting Features

Marking Features

1. Click the Feature Counting button 🍎. The Feature Counting dialog displays.

2. Click the Edit Feature Type Properties button 🛠. The Properties dialog displays.

3. Enter a Name for the feature type (for example, WaterFeatures). The name format accepts underscores (Water_Features) but does not accept spaces (Water Features).

4. Optionally enter a Description for the feature type. The description applies to all features you mark as this feature type. You can also add descriptions that are specific to individual features, which is described in Editing Feature Properties.

5. Click OK.

6. In the Image window, click on the feature you want to mark. A row is added to the Feature Counting dialog, containing the lat/lon location or pixel coordinates of the feature. A Feature Counting layer is added to the Layer Manager. All features you mark are included in that layer.

7. To add more information about the feature you marked, double-click in the Description field in the Feature Counting dialog and enter a description. Press Enter to accept the description.

Creating a Feature Type

You can add new feature types through the Feature Counting dialog to help organize marked features.

1. In the Features tab, click the Add Feature Type button 🎨. ENVI EX adds a new feature type to the list, named Feature_x.

2. Select the new feature name and click the Edit Feature Type Properties button 🛠, or right-click on the name and select Edit Properties. The Properties dialog appears.

3. Enter a Name for the new feature type (for example, WaterFeatures). The name format accepts underscores (Water_Features) but does not accept spaces (Water Features).

4. Optionally enter a Description that will apply to all features marked as this type.
   Tip: If needed, you can add a description for an individual feature after you mark it. See "Marking, Editing, and Deleting Features" on page 173 for details.

5. If desired, change the remaining properties for the new feature type.

6. Click OK.

Editing Feature Properties

The appearance of feature marks is determined by default settings in ENVI EX. You can change the settings for a feature type through the Feature Counting dialog.

1. In the Feature Counting dialog Features tab, select the name of the feature type you want to edit.

2. Either right-click and select Edit Properties, or click the Edit Feature Properties button 🛠. The Properties dialog appears.
Marking, Editing, and Deleting Features

3. Edit the fields as needed. To edit fields with drop-down lists, double-click in the field and select a value. The following properties are available:

   **Symbol:** The symbol to use for marking features. Click in this field and select **Edit** to open a dialog containing symbol choices. The available symbols are based on the selected **Font.** Select a symbol and click **OK.**

   **Color:** The symbol color.

   **Font:** The symbol font. The available symbols to choose from vary, depending on the font you specify.

   **Size:** The symbol size.

   **Name:** The name of the feature type. This name displays in the Feature Counting dialog **Features** tab. If you enter a name with spaces, the spaces do not display in the Feature Counting dialog.

   **Description:** The description of the feature type. All features marked for a feature type show this description in the Feature Counting dialog **Features** tab. To add a description specific to a marked feature, edit the **Description** field in the **Features** tab row that contains the feature location.

4. Click **OK.**

**Deleting Features**

You can delete marks for individual features, and you can delete feature types by using the Feature Counting dialog.

To delete a feature counting mark:

1. In the **Features** tab, select the row of the feature you want to delete.

2. Click the **Delete Selected Feature** button **X**. The row is removed from the Feature Counting dialog, and the mark is removed from the Image window.

To delete a feature type:

1. In the **Features** tab, select the name of the feature type to delete (for example, **Feature_1**).

2. Either right-click and select **Delete Feature Type**, or click the **Delete Feature Type** button **X**. The feature type and all of the features marked as that type are removed from the Feature Counting dialog, and all the feature marks for that type are removed from the Image window. Deleting a feature type cannot be undone.
Saving the Feature Counting Layer

You can save the feature counting layer to a .dbz file so that you can restore the data in a future ENVI EX session. See "Restoring Features" on page 177 for details. You can save the feature counting layer to a new file each time you save it, or you can overwrite a previously saved .dbz file.

1. In the Feature Counting dialog Features tab, click the Save Features button . The Save Features dialog appears.

2. Enter a path and filename, then click OK.
Jumping to Features

Once you have features marked, you can "jump" to them and center the selected feature in the Image window.

Go to a feature using one of the following:

- Click on the **Jump to First Feature** button to go to the first feature listed in the data table.

- Click on the **Jump to the Previous Feature** button to go to the feature listed above the current selected feature in the data table.

- Click on the **Jump to the Next Feature** button to go to the feature listed below the current selected feature in the data table.

- Click on the **Jump to Last Feature** button to go the last feature listed in the data table.

- With the **Enable Table Goto** check box enabled, click on a row in the data table. If you do not want the Image window to automatically center over features while you are selecting rows in the data table, disable this check box. (Clicking the **Jump to** buttons will still result in the Image window centering over features.)

ENVI EX centers the Image window over the selected feature.
Restoring Features

You can restore feature counting data that were previously saved.

1. In the Feature Counting dialog Features tab, click the Restore Features button. The Restore Features dialog appears. If you have another feature counting layer open, ENVI EX first prompts you to save it.

2. Select the .dbz file to restore.

3. Click Open. ENVI EX opens the feature counting layer and displays the data in the Image window. The rows of the Feature Counting dialog show the feature data. If another feature counting layer was open, ENVI EX first closes that layer, then restores the one you selected.
Viewing the Feature Counting Report

The feature counting report provides a list of marked features. If you created multiple feature types, the report is divided by feature types.

1. In the Feature Counting dialog, select the Report tab.
2. Click Update Report. The Report tab is updated with information about all features types that were marked. To clear the report data, click Clear.
3. If you want to save the feature counting report as a text file, click Save. The Save Feature Counting Report dialog appears.
4. Enter a filename and location, then click OK.
Chapter 9: Working with Annotations

In this chapter you will find:

About Annotations .............................................................. 180
Creating Annotation Layers .................................................. 181
Adding Annotation Items to an Annotation Layer ...................... 182
Editing Annotation Item Properties ....................................... 186
Deleting Annotation Items .................................................... 188
Annotation Tips and Tricks .................................................. 189
About Annotations

You can create new annotation layers in ENVI EX (.anz) and add annotation items to those layers to highlight features of interest. You can view annotation files that were created in ENVI (.ann) and NITF annotation segments. You can edit annotations and save them to new .anz files (you cannot edit them and save the changes to the original files).

When an annotation layer has been modified, the icon next to the layer name in the Layer Manager becomes shaded, to indicate the layer has changed. You can save or discard those changes as needed. At any point while using the Annotation tools, you can do the following:

- Save the changes to the original .anz file or to a new .anz file (described in "Saving Files" on page 192).
- With any Annotation tool selected, right-click in the Image window or right-click on the layer name in the Layer Manager and select Revert to clear all annotation item edits and return the layer to the state it was in after it was last saved.

Note: Pixel-based .anz and all .ann annotation files are not supported in the Print Layout view. If sending data to the Print Layout view does not produce desirable results, it is recommended you use the Chip Display to Print option. For more information see "Working with the Print Layout View" on page 201.

For information on setting preferences for annotations, see "Annotation Preferences" on page 46.
Creating Annotation Layers

You can create new annotation layers by using an existing raster, ESRI layer, vector, or annotation layer to define the extents.

One way to create a new annotation layer is to do the following:

1. Select one of the annotation toolbar buttons.
2. Add annotations in the Image window. ENVI EX adds the new layer to the Layer Manager using the default name New Annotation. ENVI EX uses the default name until you save the layer.

Another way to create a new annotation layer follows:

1. From the menu bar, select File > New > Annotation Layer, or right-click on the Layers folder in the Layer Manager and select New > Annotation Layer. The Create New Annotation Layer dialog appears.
2. Optionally enter a Layer Name for the new layer. If you do not enter a name, ENVI EX uses the default name New Annotation until you save the layer.
3. Select the source file to use to define the new layer’s extents and map projection.
4. Click OK. ENVI EX adds the new layer to the Layer Manager as the active annotation layer. The Text Annotation button is selected in the toolbar.
5. Add new annotation items as described in "Adding Annotation Items to an Annotation Layer" on page 182.

You can hide and remove annotation layers. You can reorder annotation layers in the Layer Manager, but the order is not maintained if you use File > Save As to save the image to a NITF output file. If you want to maintain reordered layers in output, use the File > Chip Display To option to burn in the annotation.

Transparency is available for annotation layers. All other Enhancement tools and Portal tools are not available for annotation layers.
Adding Annotation Items to an Annotation Layer

You can add new annotation items to an annotation layer.

To create annotation items, the layer to modify must be set as the active annotation layer in the Layer Manager. If you have multiple annotation layers loaded and you need to set the active layer, right-click on the layer name and select Set as Active Annotation Layer.

You can reorder annotation items in the Layer Manager.

Note: Pixel-based .anz and all .ann annotation files are not supported in the Print Layout view. If sending data to the Print Layout view does not produce desirable results, it is recommended you use the Chip Display to Print option. For more information see "Working with the Print Layout View" on page 201.

Creating Text Annotations

1. Click the Text Annotation button.

   Tip: To change preferences for a text annotation before you create it, or as you are creating it, select the annotation using the Select tool then right-click in the Image window and select Preferences. "Text Annotation Preferences" on page 46 describes the settings.

2. In the Image window, click where you want to add text and begin typing.
   - To create superscript text, press the Ctrl+U keys and type the text you want as superscript.
   - To create subscript text, press the Ctrl+D keys and type the text you want as subscript.
   - To return to regular text from superscript or subscript, press the Ctrl+N keys and type.
   - To insert a line break, press the Ctrl+Enter keys and type on the new line.
   - To add four spaces between letters, press the Tab key.
   - To delete typed text, you can highlight the text with the cursor and type over it, highlight the text and press the Delete key, or use the Backspace key.
   - To delete the text annotation before it is accepted, press the Esc key.
   - To move the selected annotation to a different location, click and drag.

3. To accept the text, press the Enter key. The annotation item is added to the Layer Manager under the annotation layer tree, and it is selected by default. To unselect it, press the Esc key.

4. To save the annotation, right-click in the Image window and select Save or Save As. For more information about selecting a save option, see "About Annotations" on page 180.

Creating Symbol Annotations

1. Click the Symbol Annotation button.

   Tip: To change preferences for a symbol annotation before you create it, or as you are creating it, select the annotation using the Select tool then right-click in the Image window and select Preferences. "Symbol Annotation Preferences" on page 46 describes the settings.

2. In the Image window, click in each location you want to add a symbol. The annotation item is added to the Layer Manager under the annotation layer tree. If you need to move the annotation to a different location, click on the selected symbol and drag.
3. To save the annotation, right-click in the Image window and select Save or Save As. For more information about selecting a save option, see "About Annotations" on page 180.

Creating Polygon Annotations

Polygons must contain a minimum of three vertices.

1. Click the **Polygon Annotation** button.

   **Tip:** To change preferences for a polygon annotation before you create it, or as you are creating it, select the annotation using the **Select** tool then right-click in the Image window and select **Preferences**. "Polygon Annotation Preferences" on page 47 describes the settings.

2. In the Image window, add the new polygons.

   - Click and drag to draw polygons.
   - To create polygons one vertex at a time, click where you want the first vertex to be, move the cursor to where the next vertex will be, and click again. Repeat as many times as needed.
   - To change the position of a vertex before adding the next one, place the cursor over the vertex until the object selector is visible (in pink), then click and drag it to a new location.
   - To delete the polygon and start again, press the **Esc** key.
   - To move the annotation to a different location, click on it in the Image window and drag.
   - To resize the polygon, click and drag on any of the selection handles.

3. To accept the polygon, you can use one of the following:

   - Double click.
   - Press the **Enter** key.
   - Right-click and select **Accept**, **Save**, or **Save As**. For more information about selecting a save option, see "About Annotations" on page 180.

   The annotation item is added to the Layer Manager under the annotation layer tree.

Creating Polyline Annotations

Polylines must contain a minimum of two vertices.

1. Click the **Polyline Annotation** button.

   **Tip:** To change preferences for a polyline annotation before you create it, or as you are creating it, select the annotation using the **Select** tool then right-click in the Image window and select **Preferences**. "Polyline Annotation Preferences" on page 47 describes the settings.

2. In the Image window, add the new polylines.

   - Click and drag to draw polylines.
   - To create polylines one vertex at a time, click where you want the first vertex to be, move the cursor to where the next vertex will be, and click again. Repeat as many times as needed.
   - To change the position of a vertex before adding the next one, place the cursor over the vertex until the object selector is visible (in pink), then click and drag it to a new location.
   - To delete the polyline and start again, press the **Esc** key.
Adding Annotation Items to an Annotation Layer

- To move the annotation to a different location, click on it in the Image window and drag.

3. To accept the polyline, you can use one of the following:
   - Double click.
   - Press the Enter key.
   - Right-click and select Accept, Save, or Save As. For more information about selecting a save option, see "About Annotations" on page 180.

The annotation item is added to the Layer Manager under the annotation layer tree.

Creating Rectangle Annotations

1. Click the Rectangle Annotation button.
   
   **Tip:** To change preferences for a rectangle annotation before you create it, or as you are creating it, select the annotation using the Select tool then right-click in the Image window and select Preferences. "Polygon Annotation Preferences" on page 47 describes the settings.

2. In the Image window, add the new rectangles.
   - To draw a rectangle, click and drag.
   - To draw a square, press the Ctrl key as you click and drag.
   - If needed, right-click and select Delete to delete the rectangle.
   - To move the annotation to a different location, click on the rectangle and drag.
   - To resize the rectangle, click and drag on any of the selection handles.

The annotation item is added to the Layer Manager under the annotation layer tree.

3. To save the annotation, right-click in the Image window and select Save or Save As. For more information about selecting a save option, see "About Annotations" on page 180.

Creating Ellipse Annotations

1. Click the Ellipse Annotation button.
   
   **Tip:** To change preferences for an ellipse annotation before you create it, or as you are creating it, select the annotation using the Select tool then right-click in the Image window and select Preferences. "Polygon Annotation Preferences" on page 47 describes the settings.

2. In the Image window, add the new ellipse.
   - To draw an ellipse, click and drag.
   - To draw a circle, press the Ctrl key as you click and drag.
   - If needed, right-click and select Delete to delete the ellipse.
   - To move the annotation to a different location, click on the ellipse and drag.
   - To resize the ellipse, click and drag on any of the selection handles.

The annotation item is added to the Layer Manager under the annotation layer tree.

3. To save the annotation, right-click in the Image window and select Save or Save As. For more information about selecting a save option, see "About Annotations" on page 180.
Creating Arrow Annotations

1. Click the **Arrow Annotation** button.

   **Tip:** To change preferences for an arrow annotation before you create it, or as you are creating it, select the annotation using the Select tool then right-click in the Image window and select **Preferences**. "Arrow Annotation Preferences" on page 47 describes the settings.

2. In the Image window, add the new arrows.
   - Click and drag to draw arrows.
   - If needed, right-click and select **Delete** to delete the arrow.
   - To move the annotation to a different location, click on the arrow and drag.
   - To move an endpoint, click and drag on any of the selection handles.

   The annotation item is added to the Layer Manager under the annotation layer tree.

3. To save the annotation, right-click in the Image window and select **Save** or **Save As**. For more information about selecting a save option, see "About Annotations" on page 180.

Creating Picture Annotations

You can add a picture annotation, such as an icon, using an image file that is one or three bands of byte data readable by ENVI EX. "Supported File Formats" on page 52 lists the supported formats.

1. Click the **Picture Annotation** button.

   **Tip:** To change preferences for a picture annotation before you create it, see "Picture Annotation Preferences" on page 47.

2. In the Image window, click where you want to place the picture annotation. The Select Input dialog appears.

3. In the Select Input File dialog, click **Open File**. The Open dialog appears.

4. Select an image file and click **Open**. The file is added to the top of the Select Input File dialog.

5. Select the filename from the list, then click **OK**. The picture is added to the annotation layer, and it is listed in the Layer Manager under the annotation layer tree. To move it to a different location, click on the picture and drag. To resize the picture, click and drag on any of the selection handles.

6. To save the annotation, right-click and select **Save** or **Save As**. For more information about selecting a save option, see "About Annotations" on page 180.
Editing Annotation Item Properties

You can change the properties of an annotation item after you create it.

To access the properties, right-click in the Layer Manager on the annotation item you want to modify and select Properties. (You do not need to change which annotation layer is the active layer beforehand.) You can also click on the annotation item in the Image window, then right-click and select Properties.

The Properties dialog appears, listing settings specific to the annotation item type. The example below shows settings specific to a text annotation item.

The following table describes all of the annotation properties you can change, listed alphabetically. Some of the properties are used by more than one annotation item type.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Head Fill</td>
<td>Enables or disables filling the interior of the arrow head for an arrow annotation.</td>
</tr>
<tr>
<td>Arrow Head Size</td>
<td>Changes the size of the arrow head for an arrow annotation, in points.</td>
</tr>
<tr>
<td>Arrow Heads</td>
<td>Changes the angle of the arrow head for an arrow annotation, in degrees.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Changes the background color for a text or symbol annotation.</td>
</tr>
<tr>
<td>Background Fill</td>
<td>Changes the background fill color for a text or symbol annotation.</td>
</tr>
<tr>
<td>Character</td>
<td>Changes the character used for a symbol annotation.</td>
</tr>
<tr>
<td>Color</td>
<td>Changes the color of a text or symbol annotation.</td>
</tr>
<tr>
<td>Fill Color</td>
<td>Changes the fill color of a polygon, rectangle, or ellipse annotation.</td>
</tr>
<tr>
<td>Fill Interior</td>
<td>Enables or disables filling the interior of a polygon, rectangle, or ellipse annotation.</td>
</tr>
<tr>
<td>Font Name</td>
<td>Changes the font used for a text or symbol annotation.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Changes the font size for a text or symbol annotation.</td>
</tr>
<tr>
<td>Font Style</td>
<td>Changes the font style (e.g., bold) for a text annotation.</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Changes the horizontal alignment of a text annotation.</td>
</tr>
<tr>
<td>Line Color</td>
<td>Changes the line color for a polyline, arrow, polygon, rectangle, or ellipse annotation.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Changes the line style (e.g., dashed line styles) for a polyline, arrow, polygon, rectangle, or ellipse annotation.</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>Changes the thickness of lines on a polyline, arrow, polygon, rectangle, or ellipse annotation.</td>
</tr>
</tbody>
</table>
## Editing Annotation Item Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rotate with View</strong></td>
<td>Enables or disables rotating the annotation along with the data in the Image window.</td>
</tr>
<tr>
<td><strong>Scale on Zoom</strong></td>
<td>Enables or disables scaling the text, symbol, or picture annotation size according to the zoom level. If set to <strong>True</strong>, the item’s size increases or decreases accordingly when the zoom level increases or decreases. If set to <strong>False</strong>, the item’s size remains the same, regardless of the zoom level.</td>
</tr>
<tr>
<td><strong>Show</strong></td>
<td>Enables or disables showing the annotation in the Image window.</td>
</tr>
<tr>
<td><strong>Show Outline</strong></td>
<td>Enables or disables showing the outline of a polygon, rectangle, or ellipse annotation.</td>
</tr>
</tbody>
</table>
Deleting Annotation Items

There are two ways you can delete annotation items you added to a layer: select the annotation using the **Select** tool or select an item from the Layer Manager annotation tree. You can delete one or more items at a time.

To delete annotation items from the Image window:

1. Click the **Select** tool.
2. Click to select an individual annotation item, or click and drag to draw a box around multiple annotation items to select them. The selected annotation items appear in the Image window with red handles and are selected in the Layer Manager annotation tree.
3. Press the **Delete** key, or right-click and select **Delete**.

To delete annotation items from the Layer Manager:

1. In the Layer Manager, select the item to delete in the annotation tree.
2. Right-click and select **Delete**.

If you unintentionally delete an annotation item, use the **Undo** and **Redo** buttons or the **Edit > Undo action** option from the menu bar.
Annotation Tips and Tricks

When you create a new annotation layer, you use the extents from an existing annotation, vector, or raster file as the extents for the new layer. The new layer is not actually saved until you add annotation items to it and then use the **Save As** option.

By default, the new annotation layer is saved to the **Output Directory**. If you need to create many new annotation layers, it may be helpful to change this preference to point to the directory you are working in.

To select or edit an annotation item when you have annotation layers open with different extents, first double-click on the annotation item in the Layer Manager to bring it into view. Doing this also enables the right-click context menu, so you can edit the annotation item as needed.

**Note:** Pixel-based .anz and all .ann annotation files are not supported in the Print Layout view. If sending data to the Print Layout view does not produce desirable results, it is recommended you use the Chip Display to Print option. For more information see "Working with the Print Layout View" on page 201.
Annotation Tips and Tricks
Chapter 10: Creating Output

In this chapter you will find:

Saving Files .................................................................................................................................. 192
The Select Input File Dialog ........................................................................................................ 196
Chipping the Display .................................................................................................................... 198
Working with the Print Layout View ............................................................................................ 201
Saving Files

Use **File > Save As** to output image data to memory or to disk in ENVI format, NITF (.ntf), or TIFF/GeoTIFF (.tif), or to output vector layer changes to an .evf file. For vector files, the vector layer you wish to save must be the active layer, and it must have been modified.

For images, ENVI EX does not retain display enhancements in the output file when you use **Save As**. These include rotating, zooming, contrast, brightness, sharpening, stretching, Portals, or viewing multiple layers. Use the **File > Chip Display To** options to retain display enhancements. (See "Chipping the Display" on page 198 for details.)

**Note**: You cannot edit or save an ESRI layer file.

### Saving the Image to Memory

When you output to memory, ENVI EX creates output in ENVI format and adds it to the Data Manager.

1. From the menu bar, select **File > Save As**. The Select Input File dialog appears.
2. Select an input file and perform optional spectral and spatial subsetting, then click **OK**. The Save File As Parameters dialog appears.
3. Click the **File or Memory** button to select **Output Result to Memory**.
4. Select the **Display Result** check box to automatically display the output result in the Image window. This check box overrides the **Auto Display Files On Open** preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.
5. Click **OK**. If you selected the **Display Result** check box, ENVI EX automatically displays the result. The result is also added to the Data Manager. The output name includes **{Memory}**, followed by the file dimensions and data type.
6. If you did not select to automatically display the output, display the memory result using the Data Manager. See "Displaying Multispectral Images" on page 59 or "Displaying Grayscale or Classification Images" on page 60 for details.

   If the memory output is a spatial subset of the original image and you display it with the original image, the Overview window and Image window show the extent of the subset with a red box when the layer is selected in the Layer Manager.

### Saving the Image to Disk

When you save a file to a new output format, you are saving it to disk at full resolution.

1. From the menu bar, select **File > Save As**. The Select Input File dialog appears.
2. Select an input file and perform optional spectral and spatial subsetting, then click **OK**. The Save File As Parameters dialog appears.
3. From the **Output File** drop-down list, select an output format. The following options are available:
   - **NITF**: NITF 2.0 and 2.1 or NSIF 1.0. If you select this option, the **Compression** drop-down list appears. See Saving NITF Files for more information about the available options.
• **ENVI**: ENVI image format. When you select this option, ENVI EX writes the data to ENVI format and creates and saves an associated header file (.hdr) to disk. This option is disabled for input NITF files with multiple image segments.

• **TIFF**: TIFF and GeoTIFF. This option is disabled for input NITF files with multiple image segments.

*Note*: If you previously saved an image to memory during this session, click the **File or Memory** button to enable the **Output File** drop-down list.

4. Click the **File Select** button 📖 to choose an output destination and filename. Click **Open**.

5. Select the **Display Result** check box to automatically display the output result in the Image window. This check box overrides the **Auto Display Files On Open** preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

6. Click **OK**. If you selected the **Display Result** check box, ENVI EX automatically displays the result. The result is also added to the Data Manager.

7. If you did not select to automatically display the output, display the memory result using the Data Manager. See "Displaying Multispectral Images" on page 59 or "Displaying Grayscale or Classification Images" on page 60 for details.

   If your new file is a spatial subset of the original image and you display it with the original image, the Overview window and Image window show the extent of the subset with a red box when the layer is selected in the Layer Manager.

**Saving Vector or Annotation Changes to the Current File**

Use **Save** to output vector or annotation layer changes using the current filename. The layer to save must be the active layer, and must have been modified.

*Note*: The **Save** option overwrites the contents of the original file. To save changes and leave the original file as-is, use the **Save As** option described after these steps.

1. Select one of the following:
   • From the menu bar, select **File > Save**.
   • With any Vector or Annotation tool selected, right-click in the Image window and select **Save**.
   • Right-click on the layer name in the Layer Manager, and select **Save**.

   For vectors, a message dialog appears, warning that saving changes will permanently alter the contents of the file.

2. Click **OK**.

   If you attempt to exit ENVI EX and have a layer with unsaved changes, you are prompted to save the file. The current file will be overwritten. If you do not want to overwrite the original file, click **No**.

**Saving Vector or Annotation Changes to a New File**

Use **Save As** if you are saving a new vector or annotation layer for the first time, if you edited an ENVI annotation (.ann) file or a NITF annotation segment, or if you are saving an ENVI EX .anz file to a new filename.
1. Select one of the following:
   - From the menu bar, select **File > Save As**.
   - With any Vector or Annotation tool selected, right-click in the Image window and select **Save As**.
   - Right-click on the layer name in the Layer Manager and select **Save As**.

2. If you selected **File > Save As** from the menu bar, the Select Input File dialog appears. Select the layer to save from the list of open files and click **OK**. The Save As dialog appears.

   If you right-clicked in the Image window and selected **Save As**, ENVI EX assumes the layer to save is the active layer.

3. In the Save As dialog, enter a filename and/or directory and click **Save**. ENVI EX defaults to the **Output Directory** preference setting for the output directory. Navigate to a different directory as needed before saving.

   When you output vector or annotation layer changes to a new filename, ENVI EX makes the new file the active layer. The old file is removed from the Layer Manager, but it is still open and available to reload through the Data Manager.

   When you output edited NITF annotation segments to an .anz file, the file is not saved as a segment of the NITF file. It will be listed in the Data Manager as an individual file.

### Selecting an Output Geodatabase

You can save raster and vector datasets that are open in ENVI EX to a geodatabase. Follow these steps to continue:

1. Select one of the following menu options, depending on the program you are using:
   - Raster datasets in ENVI: From the ENVI main menu bar, select **File > Save File As > ArcGIS Geodatabase**.
   - Vector datasets in ENVI: In the Available Vectors List, select a vector layer by clicking on the name. Select **File > Export Layers to ArcGIS Geodatabase**.
   - Raster and vector datasets in ENVI EX: From the menu bar, select **File > Save to ArcGIS Geodatabase**.

   If you are saving raster datasets in ENVI or raster/vector datasets in ENVI EX, the Select Input File dialog appears.

2. Select a dataset, and click **OK**.

   The Process Manager updates to show export progress to a geodatabase. The Process Manager displays the progress, but the coordination between ENVI EX and ArcMap does not allow the process to be canceled once initiated.

   The Select Output Geodatabase dialog appears. This dialog lists all available geodatabases to which ENVI EX is connected.

3. If the destination geodatabase is not present in this list, click **Connect**. The Connection Properties dialog appears. See "Managing Connection Properties" on page 72 for instructions on connecting to a dataset. If successful, the new connection is added to the Destination Geodatabase list and selected by default.
4. Select a geodatabase from the **Destination Geodatabase** list.

5. In the Select Output Geodatabase dialog, enter a dataset name in the **Output Name** field. The default is the name of the input dataset. Dataset names must not exceed 128 characters.

6. Optionally set any configuration keywords. (For more information on configuration keywords, see the ArcGIS Help.)

7. Click **OK**. ENVI EX verifies that the output geodatabase has sufficient write permissions and that you have a valid ArcGIS® license. (See also **ESRI License Type** in ENVI EX preferences.)

**Restrictions**

- You must have an ArcView license to save to a personal or file geodatabase and an ArcEditor or ArcInfo license to save to an enterprise geodatabase. Contact your ESRI sales representative to purchase a license.
- Personal geodatabases store datasets within a Microsoft Access data file (.mdb), which is limited in size to 2 GB.
- Enterprise geodatabases require a login. Users with read-only access cannot save data to an enterprise geodatabase.
- You cannot load vector data with unsaved edits to a geodatabase.
- You can save point, line, polygon, and multipoint vector data to a geodatabase. Vector files in ENVI vector format (.evf) with multiple record types are not supported.
- In ENVI EX, display enhancements you add to a raster image (contrast stretching, sharpening, etc.) are not retained when saving the image to a geodatabase. You can use the **Chip from Display** options to retain display enhancements.
- Traditional map information from input raster data will be retained upon saving to a geodatabase. RPC information, affine map transformations (kx/ky or a pseudo projection), and custom projections are not retained when saving to a geodatabase.
- You cannot save a vector dataset (feature class) to an ArcGIS feature dataset from ENVI EX. After saving a feature class to a geodatabase, use ArcCatalog software to drag the feature class to a feature dataset if needed.
- For NITF data, you can only save individual image segments to a geodatabase. Annotation segments and files with multiple image segments are not supported. ENVI EX will not export NITF metadata to a geodatabase.
- Metadata that is supported in ArcGIS will transfer upon saving to a geodatabase.
- Detailed information on geodatabase types, their structure, and their support in ArcGIS can be found in the ArcGIS Desktop help.
The Select Input File Dialog

When you use the File > Save As menu option or double-click any of the Processing items in the Toolbox, the Select Input File dialog appears. See the following sections for instructions on working with input files.

Opening New Files from the Select Input File Dialog

1. In the Select Input File dialog, click Open File. The Open dialog appears.
2. Select an input file and click Open. For ESRI layer files, expand the layer to select the source data, then click Open. The file is added to the top of the Select Input File dialog. The Select Input File dialog does not support vector files or ESRI feature classes.
3. Perform any optional spectral or spatial subsetting, as described later in this topic.
4. Expand the File Information category to view pertinent file information. See "Accessing File Information" on page 62 for details.
5. Click OK.

Selecting Previously Opened Files

The following steps describe how to select an input file from a list of files that you already opened. You will typically perform this step when initiating any of the Processing and Workflows options.

1. In the Select Input File dialog, click a filename in the tree view. For ESRI layer files, expand the layer to select the source data. Note that the Select Input File dialog does not support vector files or ESRI feature classes.
2. Perform any optional spectral or spatial subsetting, as described later in this topic
3. Expand the File Information category to view pertinent file information. See "Accessing File Information" on page 62 for details.
4. Click OK.

Selecting a Spectral Subset

When you perform spectral subsetting, you can only output to ENVI or TIFF formats, or you can create output to memory.

1. In the Select Input File dialog, expand the tree view next to a filename to see a list of bands for that file. All of the bands are selected by default.
2. To select a spectral subset, right-click on the filename and select Select None. Then, use the Ctrl key to select non-adjacent bands (or use the Shift key to select a range of bands).
3. If you decide to use all bands, right-click on the filename and select Select All. No spectral subsetting will be performed.

Selecting a Spatial Subset

Use spatial subsetting to limit applying a function to a spatial subset of the image.

1. In the Select Input File dialog, click Spatial Subset. The Spatial Subset dialog appears.
2. Choose an option for subsetting:
• Enter beginning and ending sample numbers in zero-based file coordinates in the **Samples** and **to** fields. The **Number** field updates accordingly.

• Enter beginning and ending line numbers in zero-based file coordinates in the **Lines** and **to** fields. The **Number** field updates accordingly.

• Enter a value in the **Number** field to adjust the ending numbers for the **Samples** and **Lines** fields accordingly.

• If available, click **Use Display Extent** to spatially subset based on the extent of the image displayed in the Image window. The **Samples**, **Lines**, **to**, and **Number** fields update with the respective image coordinates. This option is different from **Chip Display To** because display enhancements are not retained in the output. This option is disabled if you have rotated the image or if the selected image is not displayed.

• Click **Use Full Extent** to use the full extent of the image. The **Samples**, **Lines**, **to**, and **Number** fields update with the full range of samples and lines for the image.

3. Click **OK**. The spatial subset text on the Select Input File dialog is updated to show the new spatial subset.

If you display the subset with the original image, the Overview window and Image window show the extent of the subset with a red box.
Chipping the Display

Use the File > Chip Display To options to create a screen capture of all layers displayed in the Image window. Any display enhancements, zooming, rotating, or Portals that are displayed in the Image window are burned into the output image. ENVI EX creates an 8-bit, three-band image at screen resolution, even if the input data is a only single vector layer or consists of one band (a grayscale image).

You must display the layer(s) prior to using Chip Display To options. The menu options are disabled if you do not have any layers displayed. You can display any combination of image and/or vector layers for a chip.

Output Chip to Memory

1. Display the layer(s) you wish to chip in the Image window. You can use the Zoom, Pan, Rotate, or enhancement tools to customize the display.

2. From the menu bar, select File > Chip Display to > File or click the Chip to File button. The Chip to File Parameters dialog appears.

3. Click the File or Memory button to select [Output Result to Memory].

4. Select the Display Result check box to automatically display the output result in the Image window. This check box overrides the Auto Display Files On Open preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

5. Click OK. If Display Result was enabled, the result is loaded in the Image window. The output is also added to the Data Manager. The output name includes {Memory}, followed by the file dimensions and data type.

6. If Display Result was disabled, display the memory result using the Data Manager. See "The Data Manager" on page 58 for details.

Output Chip to Disk

1. Display the layer(s) you wish to chip in the Image window. You can use the Zoom, Pan, Rotate, or enhancement tools to customize the display.

2. From the menu bar, select File > Chip Display To > File. The Chip to File Parameters dialog appears.

3. Select an output format from the Output File drop-down list. The following options are available:
   - NITF: NITF 2.0 and 2.1 or NSIF 1.0. If you select this option, the Compression drop-down list appears. See Saving NITF Files for more information about the available options.
     Note: You will lose all NITF metadata if you use Chip Display to > File. Default metadata values will be used based on NITF preferences. To save your metadata, use File > Save As to create output instead.
   - ENVI: ENVI image format. When you select this option, ENVI EX creates and saves an associated header file (.hdr) to disk.
   - TIFF: TIFF and GeoTIFF
   - JPEG: JPEG
   - JPEG2000: JPEG2000
Selecting an Output Geodatabase

Note: If you previously saved to memory during this session, click the File or Memory button to enable the Output File drop-down list.

4. Click the File Select button to choose an output destination and filename. Click Open.

5. Select the Display Result check box to automatically display the output result in the Image window. This check box overrides the Auto Display Files On Open preference. If you clear this check box, the output result does not automatically display after saving. ENVI EX remembers your last selection each subsequent time you create output.

6. Click OK. If Display Result was enabled, ENVI EX loads the result in the Image window. The output is also added to the Data Manager.

7. If Display Result was disabled, display the memory result using the Data Manager. See "The Data Manager" on page 58 for details.

Output Chip to the Print Layout View

1. Display the layer(s) you wish to chip in the Image window. You can use the Zoom, Pan, Rotate, or enhancement tools to customize the display.

2. From the menu bar, select File > Chip Display To > Print to export the chipped image display to the Print Layout view. Any display enhancements, zooming, rotating, or Portals that are displayed in the Image window are burned into the Print Layout image.

ENVI EX creates an 8-bit, three-band image at screen resolution, even if the input data is a only single vector layer or consists of one band (a grayscale image). This results in the creation of a Legend (if the Legend is included in the associated Map Template) displaying Chip as the layer name followed by the RGB information.

For more information on the Print Layout view, see "Working with the Print Layout View" on page 201.

Output Chip to ArcMap

Use Chip Display To > ArcMap to export a chipped image display to ArcMap. The exported image retains all display enhancements and annotations you added in ENVI EX. Follow these steps to proceed:

1. From the menu bar, select File > Chip Display To > ArcMap.

2. If ArcMap is not already running, ENVI EX will initiate it for you. The dataset will automatically display in ArcMap with the ArcMap default enhancements, and it will be added as a new layer to the ArcMap table of contents.

3. If you have one or more instances of ArcMap already running, an ArcMap Instances dialog appears. Select an instance to display your dataset, or start a new instance of ArcMap. Click OK.

Raster datasets in GeoTIFF or NITF format, those stored in a geodatabase, and those referenced by an ESRI layer file) can pass directly into ArcMap without any conversion. For all other formats, ENVI EX temporarily converts the datasets to GeoTIFF format before passing them to ArcMap. These are stored in the location you specify as the Temporary Directory in the Directories Preferences.

Datasets exported to ArcMap remain open in ENVI EX.

Output Chip to PowerPoint
This feature is only available on Windows 32-bit and 64-bit platforms with the PowerPoint presentation graphics program installed.

1. Display the layer(s) you wish to chip in the Image window. You can use the Zoom, Pan, Rotate, or enhancement tools to customize the display.

2. From the menu bar, select File > Chip Display To > PowerPoint. If you have not yet started the PowerPoint program, it will automatically start and the chipped image is added to a slide in a new presentation. If the PowerPoint program is already open, the PowerPoint Presentations dialog appears.

3. Choose one of the following options for the PowerPoint Presentations dialog:
   - If you have more than one presentation open in the PowerPoint program, select the presentation where you want the chip to be added, and click OK (or, double-click the presentation name). The chipped image is added to a new slide at the end of your presentation.
   - If you only have one presentation open, select the presentation name and click OK (or double-click the presentation name). The chipped image is added to a new slide at the end of your presentation.
   - Select Start a new presentation and click OK if you are running the PowerPoint program and want to start a new presentation while working in an existing presentation. The chipped image is added to a slide in a new presentation.

If your source image contains map information, the geographic coordinates of the chipped image are added to the Notes field in the presentation.
Working with the Print Layout View

From the menu bar, select **File > Print**. The Print Layout view provides a powerful way to view, modify, print, and export maps.

By default, the Print Layout view will be displayed in the ArcMap Normal template (**Normal.mxt**). You can change the **Default Map Template** and/or the **Map Template Directory** Printing preferences. You can also apply existing templates (**.mxt**) using the **Map Template** button. Use ArcMap to create, edit, and save templates. For more information on setting preferences, see "Print Layout Preferences" on page 45. For more information on templates and the **Normal.mxt** template, see the ArcGIS Help.

The Print Layout view currently support datasets with the following types of georeferencing:

- Geographic coordinate systems
- Projected coordinate systems
- RPC coefficients

Images with any other types of georeferencing (RSM, affine map transformations kx/ky, pseudo projections, x/y start) are not supported in the Print Layout view. Pixel-based annotation files (**.anz**) and all annotation files (**.ann**) are not supported in the Print Layout view. If sending data to the Print Layout view does not produce desirable results, it is recommended you use the **Chip Display to Print** option.

### Print Layout Tools

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Map Template..." /></td>
<td>Map Template</td>
<td>Select and apply an ArcMap map template (<strong>.mxt</strong>) to the Print Layout view. Once applied, the template name appears next to the <strong>Map Template</strong> button.</td>
</tr>
<tr>
<td><img src="image" alt="Select Elements" /></td>
<td>Select Elements</td>
<td>Select, resize, and move text, graphics, and other objects in the Print Layout view.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom In</td>
<td>Zoom in on the Print Layout view by clicking a point or dragging a box. You can also zoom in and out by rolling the mouse wheel. To exit this tool, click the <strong>Select Elements</strong> button.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom Out</td>
<td>Zoom out on the Print Layout view by clicking a point or dragging a box. You can also zoom in and out by rolling the mouse wheel. To exit this tool, click the <strong>Select Elements</strong> button.</td>
</tr>
<tr>
<td><img src="image" alt="Fixed Zoom In" /></td>
<td>Fixed Zoom In</td>
<td>Zoom in on the center of the Print Layout view.</td>
</tr>
<tr>
<td><img src="image" alt="Fixed Zoom Out" /></td>
<td>Fixed Zoom Out</td>
<td>Zoom out on the center of the Print Layout view.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Whole Page" /></td>
<td>Zoom Whole Page</td>
<td>Zoom to view the whole Print Layout view.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom to 100%" /></td>
<td>Zoom to 100%</td>
<td>Zoom the Print Layout view to 100 percent (1:1).</td>
</tr>
<tr>
<td><img src="image" alt="Pan" /></td>
<td>Pan</td>
<td>Pan across the Print Layout view by dragging.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh View" /></td>
<td>Refresh View</td>
<td>Refresh the Print Layout view.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In (Elements)" /></td>
<td>Zoom In (Elements)</td>
<td>Zoom in on a data frame inside the Print Layout view by clicking a point or dragging a box. To exit this tool, click the <strong>Select Elements</strong> button.</td>
</tr>
</tbody>
</table>
### Working with the Print Layout View

**Selecting an Output Geodatabase**

**Zoom Out (Elements)**
Zoom out on a data frame inside the Print Layout view by clicking a point or dragging a box. To exit this tool, click the **Select Elements** button.

**Zoom Full Extent (Elements)**
Zoom to view the entire data frame inside the Print Layout view.

**Pan (Elements)**
Pan the data frame inside the Print Layout view by dragging.

**Display Help**
Provide detailed information on the Print Layout view.

**Print**
Send the Print Layout view to a printer or plotter. There are a number of customizable options. For detailed information on each option or field in the Print dialog, right-click on an option or field in the dialog and choose **What’s This?**

**Export**
Save the Print Layout view to an image or graphic interchange file type. Each export type contains customizable options. Click the **Options** drop-down arrow at the bottom of the page to expand/contract the Options pane. Right-click on field names in the Options pane and select **What’s This?** to access more information about each option.

- **Windows Enhanced Metafile (.emf)** - Can contain vector and raster data. Useful in Windows documents because the vectors can be resized without compromising quality. No support for font embedding and exclusively a Windows format.

- **Encapsulated PostScript (.eps)** - Uses PostScript, the publishing industry standard for print-ready documents. Can be inserted as a graphic in most page layout applications and can be edited in many drawing applications. Supports embedding of fonts (users without ESRI fonts can still view symbology). Colors can be defined in CMYK or RGB.

- **Adobe Illustrator Vector Graphic (.ai)** - Best format for post-processing in Adobe Illustrator. Preserves most layers but does not support font embedding. Colors can be defined in CMYK or RGB.

- **Portable Document Format (.pdf)** - Designed for distribution because they are consistently viewable and printable across different platforms. Editable in many graphics applications and retain annotation, labeling, and attribute data for map layers. Supports embedding of fonts. Colors can be defined in CMYK or RGB.
Selecting an Output Geodatabase

Editing Text, Graphics, and Objects in the Print Layout View

Using the Select Elements toolbar button, click to select text, graphics, and objects in the Print Layout view and move them, delete them, or resize them (text cannot be resized). Text can be modified by double-clicking on the text field then typing the text into the provided dialog. Legend Properties can be modified by double-clicking on the legend. For detailed information on each option or field in the Legend Properties dialog, right-click on an option in the dialog and choose What’s This?.

Select an element and:

<table>
<thead>
<tr>
<th>Button</th>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitmap (.bmp)</td>
<td>Windows native raster image format commonly inserted as graphics in a variety of document types. Can store pixel data at several bit depths. Can be compressed using the lossless RLE method but are generally much larger than JPEG or PNG files. Vector files do not resize well (they lose quality).</td>
<td></td>
</tr>
<tr>
<td>JPEG (.jpg)</td>
<td>Web-ready compressed image file commonly inserted as graphics in a variety of document types. Because JPEG files use a lossy compression algorithm, they are not the best option for vectors, text, or symbology (PNG and GIF provide better vector support). Support 24-bit color.</td>
<td></td>
</tr>
<tr>
<td>Tagged Image File Format (.tif)</td>
<td>Versatile raster format (but not viewable by a web browser). Can store pixel data at several bit depths. Can be compressed with lossy or lossless compression. Best choice for importing into cross-platform image editing applications.</td>
<td></td>
</tr>
<tr>
<td>Graphics Interchange Format (.gif)</td>
<td>Web-ready standard raster format. Lossless RLE or LZW compression results in small file size. Supports transparency and 8 bits per pixel (256 colors). The limited color support means there is some color limitation for maps that contain continuous raster data.</td>
<td></td>
</tr>
</tbody>
</table>

Close the Print Layout view.
• Press the **Delete** key to delete it.
• Click and drag a corner to resize it. Text cannot be resized. If the map, data frame, or scale bar is enlarged or reduced, the scale bar will remain correct.
• Click on the element and drag it to move it.
Chapter 11: Working with the NITF Module

In this chapter you will find:

About the NITF/NSIF Module and NITF for ArcGIS ........................................................... 206
The NITF/NSIF Format ...................................................................................................... 207
Data Extension Segments and Tagged Record Extensions .............................................. 213
NITF Preferences .............................................................................................................. 218
Display Levels ................................................................................................................ ... 220
NITF Map Information ....................................................................................................... 222
Displaying NITF Images ..................................................................................................... 224
Viewing NITF Metadata ..................................................................................................... 225
Editing NITF Metadata ....................................................................................................... 227
Saving NITF Files ............................................................................................................. . 229
Chipping the Display to NITF ............................................................................................. 232
NITF Save As .................................................................................................................... 234
About the NITF/NSIF Module and NITF for ArcGIS

The National Imagery Transmission Format (NITF) standard is a raster format defined by the NITF Standards Technical Board. The Joint Interoperability Test Command (JITC) certifies systems implementing the NITF format for compliance with the standard. Both the NITF/NSIF Module and NITF for ArcGIS® provide JITC-compliant support for the NITF file format and they are required for compliant NITF support in ENVI and ArcGIS respectively. Both the ENVI 4.5 NITF/NSIF Module and NITF for ArcGIS 1.0 were tested by the JITC and both have been recommended for full compliance registration to complexity level 7 for NITF 2.1 and complexity level 6 for NITF 2.0 (the highest for each format). ENVI 4.7 and NITF for ArcGIS 1.1 are in compliance with these standards.

Contact the JITC (http://jitc.fhu.disa.mil/) for detailed information about the NITF certification program, including functional read/write breakdown and testing anomalies.

The NITF/NSIF Module and NITF for ArcGIS are available at additional cost from ITT Visual Information Solutions or your ENVI distributor. The NITF for ArcGIS license is included with the NITF/NSIF Module license. It can also be purchased separately at additional cost from ITT Visual Information Solutions, ESRI®, or your ENVI Distributor. If you have ArcGIS 9.3 or later installed, you can license NITF then install and run NITF for ArcGIS. NITF for ArcGIS provides the ability to read NITF data within the ArcGIS environment and create data products with ArcGIS Desktop that comply with the latest NITF specifications.

NITF File Support

NITF is a complex imagery and image exploitation information format capable of containing a wide variety of image and non-image information. Currently, there are three different versions of the NITF specification: NITF 1.1, NITF 2.0, and NITF 2.1. Each is similar to the others in many ways, but each also has its own characteristics.

Both the NITF/NSIF Module and NITF for ArcGIS provide the ability to read NITF 2.0, NITF 2.1, NSIF 1.0 and legacy NITF 1.1 files, and write NITF 2.0, NITF 2.1, and NSIF 1.0 datasets.

The NITF format is used extensively in the United States. The multinational members of the North Atlantic Treaty Organization (NATO) use the NATO Secondary Image Format (NSIF). The NSIF 1.0 format is identical to the NITF 2.1 format, with the exception of the version name in the file header. In place of NITF02.10, this field contains NSIF01.00.

General information about the NITF format, and specific information about the NITF 2.1 format, also applies to the NSIF format.
The NITF/NSIF Format

A valid NITF dataset provides a main header identifying the file as a NITF dataset and describing the contents of the file. The header is usually followed by one or more data segments. Each data segment consists of a segment subheader identifying the type and properties of the data, followed by the data itself. See "NITF Segments" on page 208 for more information on data segments.

Main Header

A NITF dataset may contain any or all types of segments available for that version, but every NITF dataset must contain a main header. The main NITF header describes the entire file, including origination information, security information, file version and size, and the number and type of all data segments contained in the NITF dataset.

Data Segments

Data segments can be any of the following types:

- "Security Segments" on page 209
- "Image Segments" on page 209
- "Graphic/Symbol Segments" on page 211
- "Label Segments" on page 211
- "Annotation Segments" on page 211
- "Text Segments" on page 212
- "Data Extension Segments" on page 213

References

For more detailed information about the NITF/NSIF format and its components, see the technical specifications listed in the following table. These documents and others, including compression schemes are available from the NITF Technical Board (NTB) Web site.

<table>
<thead>
<tr>
<th>For information about...</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>NITF 2.1</td>
<td>MIL-STD-2500C</td>
</tr>
<tr>
<td>NITF 2.0</td>
<td>MIL-STD-2500A</td>
</tr>
<tr>
<td>NSIF 1.0</td>
<td>STANAG 4545</td>
</tr>
<tr>
<td>CGM Graphics</td>
<td>MIL-STD-2301A</td>
</tr>
<tr>
<td>Controlled Extensions for NITF 2.1</td>
<td>STDI-0002</td>
</tr>
<tr>
<td>Test program plan</td>
<td>N-0105-98</td>
</tr>
<tr>
<td>BIIF Profile for JPEG 2000, Version 01.00</td>
<td>BPJ2K01.00</td>
</tr>
<tr>
<td>Federal Information Processing Standards Publication 10-4</td>
<td>FIPS PUB 10-4</td>
</tr>
</tbody>
</table>
NITF Segments

While NITF datasets without graphical data are supported, most datasets contain one or more displayable segments. Displayable segments are image, graphic/symbol, or label segments that contain graphical information and text for display. These segments contain instructions about how the graphical data they contain should be displayed relative to any other displayable segments, resulting in a composite display encompassing all graphical information in the dataset.

Multiple Displayable Segments

The NITF format supports multiple image, graphical, and displayable text elements. A NITF dataset can contain all displayable segments (image, graphic/symbol, and label), making it possible for raw image information and additional exploitation material to co-exist nondestructively within the dataset. Each displayable segment contained in the NITF dataset contains information controlling the location of the display element in the composite. Each segment also contains a display level that determines which elements should be displayed on top of others, obscuring the lower-level displayable elements from view without corrupting the hidden portion of those lower-level displayable elements. For more information, see "Display Levels" on page 220. Below is an example of a NITF 2.1 dataset with multiple displayable segments.
Security Segments

The NITF format was designed to contain information deemed sensitive, so it includes header data describing the status of any information that is not available to the general public. The main file header contains security information describing the security level of the entire NITF dataset, and each segment also contains security information in its subheader, as the confidentiality of data within a file may vary. The security level of the entire file (T = Top Secret, S = Secret, C = Confidential, R = Restricted, U = Unclassified) is the same as or higher than that of the most restricted segment in the file. NITF 2.0 uses the same fields as NITF 1.1 to contain security information, while NITF 2.1 deprecated some security information fields and added new fields.

These changes are described below. For a detailed description of these security fields, consult the NITF specifications to determine which metadata are relevant to the version of your NITF file.

<table>
<thead>
<tr>
<th>NITF 1.1/2.0 Security Fields</th>
<th>NITF 2.1 Security Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification</td>
<td>Classification</td>
</tr>
<tr>
<td></td>
<td>Classification System</td>
</tr>
<tr>
<td>Codewords</td>
<td>Codewords</td>
</tr>
<tr>
<td>Control and Handling</td>
<td>Control and Handling</td>
</tr>
<tr>
<td>Releasing Instructions</td>
<td>Releasing Instructions</td>
</tr>
<tr>
<td></td>
<td>Declassification Type</td>
</tr>
<tr>
<td></td>
<td>Declassification Date</td>
</tr>
<tr>
<td></td>
<td>Declassification Exemption</td>
</tr>
<tr>
<td></td>
<td>Downgrade</td>
</tr>
<tr>
<td></td>
<td>Downgrade Date</td>
</tr>
<tr>
<td></td>
<td>Classification Text</td>
</tr>
<tr>
<td></td>
<td>Classification Authority Type</td>
</tr>
<tr>
<td>Classification Authority</td>
<td>Classification Authority</td>
</tr>
<tr>
<td></td>
<td>Classification Reason</td>
</tr>
<tr>
<td></td>
<td>Security Source Date</td>
</tr>
<tr>
<td>Control Number</td>
<td>Security Control Number</td>
</tr>
<tr>
<td>Downgrade</td>
<td></td>
</tr>
<tr>
<td>Downgrading Event</td>
<td></td>
</tr>
</tbody>
</table>

Image Segments

Image segments contain raster data, typically image data, intended for display or analysis. Image segments in a NITF file contain displayable image information. Each image segment contains a single image consisting of one or more bands of data (NITF 2.0 allows one, three, or four bands of data in an image, and NITF 2.1 allows up to 999 bands). All bands within an image segment must have the same data type, dimensions, storage order, and map information, although these characteristics can vary across different
image segments. Each image segment may contain specific display instructions, including color lookup tables for single-band images and default display bands for multi-band images. Images can be stored in integer data types in NITF 2.0 and in integer and real data types in NITF 2.1. Images can also be compressed using a variety of algorithms including JPEG DCT, Vector Quantization, Bi-level, JPEG 2000 NPJE (NITF 2.1 only), and JPEG 2000 EPJE (NITF 2.1 only). Images can be broken into blocks, providing an orderly set of subimages (or subarrays). Additional information describing the collection, intended use, wavelengths, and comments can also be stored with the image.

Image Masks

Mask information stored in image segments identifies pixels that are invalid or not intended to be displayed, and should therefore not be displayed.

Images that are rotated or have gaps can also contain a mask indicating which portions of the image should not be used for display or analysis. Two types of image masks are used in NITF files:

- **Blocked image masks** are used to mask entire blocks of image data.
- **Transparent pixel masks** are used for masking individual pixels or groups of pixels within an image block.

When an image segment containing masked blocks or pixels is displayed, pixels from images or graphics underneath the image segment show through and are displayed even though they would ordinarily be obscured. If a transparent pixel occurs with nothing displayed under it, or if for any other reason there is no display information for a pixel, the background color specified in the main file header is displayed.

In the image below, the textual, symbol, and graphical annotations are CGM graphics.
Graphic/Symbol Segments

Symbol segments can contain Computer Graphics Metafile (CGM), bitmap, or object elements, while label segments contain graphical text elements. The CGM format allows direct control of all display elements contained in the graphic including color, size, and orientation of objects. CGM graphics can contain complex lines and polygons, as well as displayable text. Multiple annotations can be combined in a single CGM, so symbol segments with CGM graphics may actually contain multiple sets of graphical primitives.

NITF 2.1 files can contain graphic segments with CGM graphic and graphical text elements, while NITF 2.0 files contain two segment types for the same purpose: symbol segments and label segments. Both the NITF 2.0 symbol segment and the NITF 2.1 graphic segment can contain CGM graphics.

The NITF 2.1 graphic segment can only contain CGM graphics, but NITF 2.0 symbol segments can contain other graphical display elements as well. Symbol segments can contain bitmaps (color-mapped bitmaps to be displayed on the composite) or objects (graphics from a limited set of graphical primitives, including lines, arrows, circles, and rectangles).

For NITF 2.1, the bitmap and object symbol types as well as the label segment have been deprecated. Bitmaps are stored in image segments instead of symbols, and object symbols and labels have been removed in favor of the more general and powerful CGM.

Label Segments

Label segments, available only in NITF 2.0, contain displayable text intended to be drawn with the NITF display. In addition to this text, a label segment includes display instructions such as font, color, size, and a background color to display behind the text.

There are many required CGM elements to draw the data contained in a NITF 2.0 label segment. Element details are described in MIL-STD-2301A.

Annotation Segments

NITF 2.0 symbol and label segments, as well as NITF 2.1/NSIF 1.0 graphics segments, are collectively referred to as annotation segments in the software, as illustrated below.

Image, text, and extension segments are available in every version of NITF, while label and symbol segments can occur only in NITF 2.0 datasets. Graphic segments occur only in NITF 2.1 datasets.
Because of the similarity between the symbol segments and label segments in NITF 2.0 files, and the graphic segments in NITF 2.1 files, the software combines these segments into a single conceptual type (annotation segments). Annotation segments can contain symbol, label, or graphic segments, and they might include text, ellipses, polylines, bitmaps, and other objects. Annotation segments do not exist in any NITF file, and they are not mentioned in the NITF specification documents. They are a simplification used to reduce the overall number of segment types.

Annotation segments and image segments both carry information intended to be displayed graphically, and both are referred to as displayable segments in the documentation.

**Annotation Objects**

Because CGM graphics are capable of displaying multiple graphical elements, each annotation segment must be capable of storing multiple displayable features. In the software, these displayable features are referred to as annotation objects. Each annotation segment contains one or more annotation objects. NITF 2.0 and 2.1 annotation segments can contain multiple CGM annotation objects; each NITF 2.0 annotation segment can only contain one non-CGM label, bitmap, or object symbol annotation object. The type of object determines which fields will be filled in the annotation object.

**Text Segments**

Text segments contained in a NITF dataset consist of textual information that is not intended for graphical display. This information may be textual notes explaining target information, or the text segment may be used for passing US Message Text Format (USMTF) and text notes to other users.
Data Extension Segments and Tagged Record Extensions

Two types of extension segments, data and reserved, provide storage within the file structure for additional information that cannot be contained in the file or segment header. Data extension segments are used as necessary for storing Tagged Record Extensions (TREs), and the reserved extension segment is reserved for future expansion of the NITF format.

Data Extension Segments

Data Extension Segments (DESes) contain data that cannot be stored in the other NITF segments. An example is the NCDRD Attitude Data DES, CSATTA. A list of unclassified, registered DESes is available at http://jitc.fhu.disa.mil/nitf/tag_reg/des.htm.

Supported DESes

The software only supports NITF Commercial Dataset Requirements Document (NCDRD) DESes. You cannot edit, create, or delete NCDRD DESes through the Metadata Editor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Filename</th>
<th>Long Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSATTA</td>
<td>CSATTA_DES.xml</td>
<td>Attitude Data</td>
</tr>
<tr>
<td>CSSHPA</td>
<td>CSSHPA_DES.xml</td>
<td>Shapefile</td>
</tr>
</tbody>
</table>

If a NITF file contains valid supported Data Extension Segments (DESes), the DESes are automatically saved in the output file. When opening a NITF image, the DES user-defined subheader will not be read if the input data format does not mirror the format in the accompanying XML definition file. When writing a NITF file that contains a DES with no corresponding XML file, the software passes through this unknown DES in NITF 2.1 and NSIF 1.0 files only. The software does not support unknown DESes in NITF 2.0 files. See also: "Preserving DESes" on page 236.

Tagged Record Extensions

TREs may be present in NITF files to contain types of information that cannot be stored in the NITF file header or segment subheaders. One or more TREs that apply to the entire NITF dataset can be present in the file header, and each segment (image or text) can also have one or more TREs associated with it. In some cases, TREs are applied to the data in a file or segment to enhance the utility of the data. Unless there is a large amount of data in a TRE, the TRE data is stored in the main header or segment subheader to which the TRE applies. For TREs too large to fit in the segment TRE area, a Data Extension Segment (DES) is created at the end of the file, and a pointer to this DES is stored within the header.

TREs come in two forms: Registered Extensions (REs) and Controlled Extensions (CEs). The NITF Standard Technical Board (NTB) maintains a registry of known CEs and REs: the main difference between them is that both the TRE name and TRE layout of CEs are controlled by the NTB, whereas only the TRE names of REs are registered with the NTB to prevent different users from using the same TRE name. Therefore, CEs can be interpreted based on the published information contained in the NTB repository, whereas REs require specific knowledge of the TRE contents available to the creator of the TRE that may not be available to the data consumer.
An example of a TRE is the RPC00B (Rapid Positioning Capability) TRE that can be associated with an image segment in a NITF dataset. This TRE provides coefficients that can be used to orthorectify the associated image segment. Other Controlled Extension TREs specify processing history, information about specific targets in an image, collection information, and other types of metadata.

The JITC repository of Controlled Extension and Registered Extension TREs can be viewed online at http://jitc.fhu.disa.mil/nitf/tag_reg/tagroup.htm.

For information on classified TREs, contact ITT Visual Information Solutions Technical Support.

**Supported TREs**

There are two levels of TRE support in the NITF/NSIF Module:

- **Unsupported TREs**: TREs for which no definition is available, or the definition does not match the physical layout of the TRE. Only the raw data of TREs of this type can be viewed.

- **Supported TREs**: TREs that match a valid TRE definition. The data in these TREs can be read and written. The data in these TREs can be viewed with the appropriate header information in the NITF Metadata Viewer (see: "Viewing NITF Metadata" on page 225). These TREs may be parsed into their specific components, and the value associated with each field in the TRE is displayed in the NITF Metadata Viewer. To view the information contained in this type of TRE, open the TRE container. Each field in the TRE is displayed as a single entry.

The data in these TREs can be written into file, image, and text segments of new NITF files. When saving to NITF, you can view these TREs in the NITF Metadata Viewer (see: "Editing NITF Metadata" on page 227). Although the supported TREs for writing data can be displayed in the editor, only PIA TREs can be added, edited, or removed from their associated file header, image, annotation, or text segment.

Each TRE supported by the software references an XML definition file. Definition files for a partial list of the NTB-registered CEs are installed with the software. Support for TREs can be added by creating TRE definitions for the desired TREs. For more information about these TREs, contact ITT Visual Information Solutions Technical Support.

When opening a NITF image, the software does not parse the TRE fields if there is no corresponding XML definition file. When writing a NITF file that contains a TRE with no corresponding XML file, the software passes through this unknown TRE.

The following table describes TREs that the software currently supports for reading and writing data. The Reference column provides links to the following NITF specification documents:

- **DIGEST**: The Digital Geographic Information Exchange Standard (DIGEST) Part 2, Annex D: IMAGE INTERCHANGE FORMAT (IIF) ENCAPSULATION SPECIFICATION
  http://164.214.2.51/ntb/baseline/docs/digest

- **ENGRDA**: Engineering Data (ENGRD) Support Data Extension (SDE) Version 1.0
  http://www.gwg.nga.mil/ntb/baseline/docs/stdi-0002_v3/App%20N.doc

- **ISOJ2K**: BIIF Profile for JPEG 2000
  http://www.ismc.nga.mil/ntb/baseline/docs/bpj2k01/ISOJ2K_profile.pdf

- **RSM**: Replacement Sensor Model Tagged Record Extensions Specification for NITF 2.1
  http://164.214.2.51/ntb/coordinationitems/RSM__NITF_TRE’s_delivery_July_23_04.pdf

- **STDI0002**: The Compendium of Controlled Extensions for NITF version 2.1
  http://www.ismc.nga.mil/ntb/baseline/docs/stdi0002/final.pdf
- **STDI0006**: National Transmission Format (NITF) Version 2.1 Commercial Dataset Requirements Document (NCDRD)
  http://164.214.2.51/ntb/baseline/docs/stdi0006/STDI-0006-NCDRD-15Sep05.doc

- **VIMAS**: Visible, Infrared, and Multispectral Airborne Sensor Support Data Extensions (SDE) for NITF version 2.0

<table>
<thead>
<tr>
<th>TRE Name</th>
<th>Filename</th>
<th>Descriptive Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCHZB</td>
<td>ACCHZB.xml</td>
<td>Horizontal Accuracy Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>ACCPOB</td>
<td>ACCPOB.xml</td>
<td>Positional Accuracy Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>ACCVTB</td>
<td>ACCVTB.xml</td>
<td>Vertical Accuracy Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>ACFTA</td>
<td>ACFTA.xml</td>
<td>Aircraft Information Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>ACFTB</td>
<td>ACFTB.xml</td>
<td>Aircraft Information Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>AIMIDA</td>
<td>AIMIDA.xml</td>
<td>Additional Image Identification Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>AIMIDB</td>
<td>AIMIDB.xml</td>
<td>Additional Image Identification Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>BANDSA</td>
<td>BANDSA.xml</td>
<td>Multispectral/ Hyperspectral Band Parameters</td>
<td>STDI0002</td>
</tr>
<tr>
<td>BANDSB</td>
<td>BANDSB.xml</td>
<td>Extended Multispectral/Hyperspectral Band Parameters</td>
<td>STDI0002</td>
</tr>
<tr>
<td>BCKGDA</td>
<td>BCKGDA.xml</td>
<td>Background Data</td>
<td>STDI0002</td>
</tr>
<tr>
<td>BLOCKA</td>
<td>BLOCKA.xml</td>
<td>Image Block Information</td>
<td>STDI0002</td>
</tr>
<tr>
<td>BNDPLB</td>
<td>BNDPLB.xml</td>
<td>Bounding Polygon</td>
<td>DIGEST</td>
</tr>
<tr>
<td>CMETAA</td>
<td>CMETAA.xml</td>
<td>Complex Metadata Tagged Record Extension Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>CSCRNA</td>
<td>CSCRNA.xml</td>
<td>Corner Footprint</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSDIDA</td>
<td>CSDIDA.xml</td>
<td>Dataset Identification</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSCCGA</td>
<td>CSCCGA.xml</td>
<td>Cloud Cover Grid</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSEPHA</td>
<td>CSEPHA.xml</td>
<td>Ephemeris Data</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSEXRA</td>
<td>CSEXRA.xml</td>
<td>Exploitation Reference Data</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSPROA</td>
<td>CSPROA.xml</td>
<td>Processing Information</td>
<td>STDI0006</td>
</tr>
<tr>
<td>CSSFAA</td>
<td>CSSFAA.xml</td>
<td>Sensor Field Alignment Data</td>
<td>STDI0006</td>
</tr>
<tr>
<td>ENGRDA</td>
<td>ENGRDA.xml</td>
<td>Engineering Data. To view this TRE, rename ENGRDA.xml with ENGRDA.xml in the bin folder of your software distribution.</td>
<td>ENGRDA</td>
</tr>
<tr>
<td>EXOPTA</td>
<td>EXOPTA.xml</td>
<td>Exploitation Usability Optical Information</td>
<td>STDI0002</td>
</tr>
<tr>
<td>EXPLTA</td>
<td>EXPLTA.xml</td>
<td>Exploitation Related Information Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>EXPLTB</td>
<td>EXPLTB.xml</td>
<td>Exploitation Related Information Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>GEOLOB</td>
<td>GEOLOB.xml</td>
<td>Local Geographic (lat/long) Coordinate System Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>GEOPSB</td>
<td>GEOPSB.xml</td>
<td>Geographical Positioning for geo-referencing parameters including datum, ellipsoids</td>
<td>DIGEST</td>
</tr>
<tr>
<td>GRDPSB</td>
<td>GRDPSB.xml</td>
<td>Grid Positioning Version B</td>
<td>DIGEST</td>
</tr>
<tr>
<td>HISTOA</td>
<td>HISTOA.xml</td>
<td>Softcopy History Tagged Record Extension</td>
<td>STDI0002</td>
</tr>
<tr>
<td>ICHIPA</td>
<td>ICHIPA.xml</td>
<td>Image Chip Support Data Extension Version A</td>
<td>DIGEST</td>
</tr>
<tr>
<td>ICHIPB</td>
<td>ICHIPB.xml</td>
<td>Image Chip Support Data Extension Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>IOMAPA</td>
<td>IOMAPA.xml</td>
<td>Input/Output Mapping Tagged Record Extension</td>
<td>STDI0002</td>
</tr>
<tr>
<td>J2KLRA</td>
<td>J2KLRA.xml</td>
<td>JPEG 2000 Parameters</td>
<td>ISOJ2K</td>
</tr>
<tr>
<td>TRE Name</td>
<td>Filename</td>
<td>Descriptive Name</td>
<td>Reference</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>MAPLOB</td>
<td>MAPLOB.xml</td>
<td>Local Cartographic (x/y) Coordinate System Extension</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MENSRA</td>
<td>MENSRA.xml</td>
<td>Airborne SAR Mensuration Data Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MENSRB</td>
<td>MENSRB.xml</td>
<td>Airborne SAR Mensuration Data Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MPDSRA</td>
<td>MPDSRA.xml</td>
<td>Mensuration Data</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MSTGTA</td>
<td>MSTGTA.xml</td>
<td>Mission Target</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MTIRPA</td>
<td>MTIRPA.xml</td>
<td>Moving Target Information Report Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>MTIRPB</td>
<td>MTIRPB.xml</td>
<td>Moving Target Information Report Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>NBLOCA</td>
<td>NBLOCA.xml</td>
<td>(Number of Bytes) Image Block or Frame is Offset.</td>
<td>STDI0002</td>
</tr>
<tr>
<td>OFFSET</td>
<td>OFFSET.xml</td>
<td>(NITF 2.1) Offset of the first pixel of an image from the first pixel of the full image.</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PATCHA</td>
<td>PATCHA.xml</td>
<td>Patch Information Version A</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PATCHB</td>
<td>PATCHB.xml</td>
<td>Patch Information Version B</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAEQA</td>
<td>PIAEQA.xml</td>
<td>Profile for Imagery Archives Equipment</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAEQA***</td>
<td>PIAEVA.xml</td>
<td>Profile for Imagery Archives Event</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAEVA***</td>
<td>PIAEVA.xml</td>
<td>Profile for Imagery Access Event</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAIMB**</td>
<td>PIAIMB.xml</td>
<td>Profile for Imagery Archives Image</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAIMC*</td>
<td>PIAIMC.xml</td>
<td>Profile for Imagery Access Image</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAPEA**</td>
<td>PIAPEA.xml</td>
<td>Profile for Imagery Archives Person</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAPEB**</td>
<td>PIAPEB.xml</td>
<td>Profile for Imagery Access Person</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAPRC**</td>
<td>PIAPRC.xml</td>
<td>Profile for Imagery Archives Product</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIAPRD*</td>
<td>PIAPRD.xml</td>
<td>Profile for Imagery Access Product</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIATGA</td>
<td>PIATGA.xml</td>
<td>Profile for Imagery Archives Target</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PIATGB*</td>
<td>PIATGB.xml</td>
<td>Profile for Imagery Access Target</td>
<td>STDI0002</td>
</tr>
<tr>
<td>PRJPSB</td>
<td>PRJPSB.xml</td>
<td>Projection Parameters Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>REGPTB</td>
<td>REGPTB.xml</td>
<td>Registration Points Extension</td>
<td>DIGEST</td>
</tr>
<tr>
<td>RPC00A</td>
<td>RPC00A.xml</td>
<td>Rapid Positioning Capability Support Data Extension</td>
<td>VIMAS</td>
</tr>
<tr>
<td>RPC00B</td>
<td>RPC00B.xml</td>
<td>Rapid Positioning Capability Support Data Extension</td>
<td>STDI0002</td>
</tr>
<tr>
<td>RSMIDA</td>
<td>RSMIDA.xml</td>
<td>RSM Identification</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMPIA</td>
<td>RSMPIA.xml</td>
<td>RSM Polynomial Identification</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMPCA</td>
<td>RSMPCA.xml</td>
<td>RSM Polynomial Coefficients</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMDC0A</td>
<td>RSMDC0A.xml</td>
<td>RSM Direct Error Covariance</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMDC0B</td>
<td>RSMDC0B.xml</td>
<td>RSM Adjustable Parameters</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMMECA</td>
<td>RSMMECA.xml</td>
<td>RSM Error Covariance</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMGIA</td>
<td>RSMGIA.xml</td>
<td>RSM Ground-to-image Grid identification</td>
<td>RSM</td>
</tr>
<tr>
<td>RSMGG0A</td>
<td>RSMGG0A.xml</td>
<td>RSM Ground-to-image Grid</td>
<td>RSM</td>
</tr>
<tr>
<td>SECTGA</td>
<td>SECTGA.xml</td>
<td>Secondary Target Information</td>
<td>STDI0002</td>
</tr>
<tr>
<td>SENSRA</td>
<td>SENSRA.xml</td>
<td>EO-IR Sensor Parameters</td>
<td>STDI0002</td>
</tr>
<tr>
<td>STDIDC</td>
<td>STDIDC.xml</td>
<td>Standard ID Extension</td>
<td>STDI0002</td>
</tr>
<tr>
<td>STREOB</td>
<td>STREOB.xml</td>
<td>Stereo Information</td>
<td>STDI0002</td>
</tr>
</tbody>
</table>
Displaying NCDRD DES Shapefiles

ENVI EX reads and displays vector shapefiles that are stored in the CSSHPA Data Extension Segment (DES). The NITF/NSIF Module in ENVI EX currently only supports reading, displaying, and passing through shapefiles from this DES.

1. Select File > Open from the menu bar, or click the Open button. The Open dialog appears.
2. Open a NITF file that contains one or more CSSHPA DESes. Click OK.
3. Open the Data Manager to see a list of the available vector shapefiles.
4. Right-click on a vector name in the Data Manager, and select Load Vector. The shapefile overlays the NITF image in the Image window.

<table>
<thead>
<tr>
<th>TRE Name</th>
<th>Filename</th>
<th>Descriptive Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>USE00A</td>
<td>USE00A.xml</td>
<td>Exploitation Usability Extension</td>
<td>STDI0002</td>
</tr>
</tbody>
</table>

* Indicates TREs that can be created, edited and deleted.

** Indicates TREs that can only be edited and deleted. These TREs cannot be added.
NITF Preferences

To edit NITF preferences, select File > Preferences from the menu bar, then select NITF in the ENVI EX Preferences dialog tree.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NITF File Cache Size</td>
<td>The cache size for the NITF image. The default is 256 MB.</td>
</tr>
<tr>
<td>Automatically View Metadata</td>
<td>Enable or disable automatically displaying the NITF Metadata Viewer dialog when you open a NITF file. The default is False.</td>
</tr>
<tr>
<td>Suppress Input Warning Messages</td>
<td>Enable or disable showing NITF input warning messages when opening a NITF file. The default is True.</td>
</tr>
<tr>
<td>Originating Station ID</td>
<td>The station ID of the organization in which the image originated. If you enter your own value, that value will be used in the output file. If this preference field is initially empty, the software populates it with ENVI EX. Set this preference field to NO CHANGE (all uppercase) if you want the software to pass through the input value with no change.</td>
</tr>
<tr>
<td>Originator’s Name</td>
<td>The name of the image’s originator. If this preference field is initially empty, it remains empty in the output file. If you enter your own value, that value will be used in the output file. Set this preference field to NO CHANGE (all uppercase) if you want the software to pass through the input value with no change.</td>
</tr>
<tr>
<td>Originator’s Phone Number</td>
<td>The telephone number of the image’s originator. If this preference field is initially empty, it remains empty in the output file. If you enter your own value, that value will be used in the output file. Set this preference field to NO CHANGE (all uppercase) if you want the software to pass through the input value with no change.</td>
</tr>
<tr>
<td>File Title Chip Prefix</td>
<td>The prefix to add to the File Title metadata if you save a spatial subset. The default is Chip_hhmmss_of_, where the hour (hh), minute (mm), and second (ss) reflect the time that you create the subset. If you remove this default value and enter your own text, the software appends your text to the filename.</td>
</tr>
<tr>
<td>IID2 Chip Suffix</td>
<td>The suffix to add to the IID2 field that indicates the output file contains chipped images (NITF 2.1 only). The default value is CHIP. If the original IID2 field plus the IID2 Chip Suffix field is larger than 80 characters, the IID2 Chip Suffix field will be truncated.</td>
</tr>
<tr>
<td>HISTOA Processing Site</td>
<td>The name of the company who performed the processing event. Enter up to 10 characters of text. This preference fills in the PSITE field of the HISTOA Processing Site.</td>
</tr>
</tbody>
</table>

New NITF File Metadata Preferences

This section of NITF preferences contains NITF file metadata defaults. Descriptions of the NITF file metadata fields are in MIL-STD-2500B or MIL-STD-2500A. These preferences only pertain to Chipping the Display, or when you save a non-NITF file to NITF format (using Save As).
New PIA TRE Metadata Preferences

This section of NITF preferences contains PIA TRE file metadata defaults. Descriptions of the PIA TRE metadata fields are in STDI-0002. These preferences only pertain to creating new PIA TRES, as described in "Editing NITF Metadata" on page 227.
Display Levels

Each displayable segment in a NITF dataset is assigned a display level that determines the order of display. Segments with higher display levels are displayed over those with lower display levels.

The image below shows these levels and their corresponding displayable segments.

The image above illustrates the composition of a composite NITF file. In this example, three annotation segments are displayed on top of a base image segment, another image segment is displayed as an inset, and the composite of these elements is displayed on a gray background.

The image below shows the composite of the three annotation segments, the two image segments, and the gray background. While the annotations obscure portions of the underlying image in the composite image, each annotation exists as a separate segment that can be displayed or hidden without affecting the underlying image.
Wavelength Information

Wavelength information can be stored in several different ways in a NITF image segment. The BANDSB TRE contains the most information, followed by the BANDSA TRE, and the band subcategory settings contain the least information. The software will attempt to read wavelength information from a NITF file from each of those locations, in order, until wavelength information is found. If no information is present in any of these locations, the file is opened without wavelength information.
NITF Map Information

Map information in a NITF file can come from multiple sources, which are found in rapid positioning capability (RPC) TREs, DIGEST GeoSDE TREs, or in the IGEOLO image header field. See "Order and Precedence for Reading NITF Map Information" on page 223 for the order in which the software reads this map information for NITF files. The following sections describe these types of map information.

RPC00A and RPC00B

If the RPC00A or RPC00B TRE exists, the RPC model is used to emulate a projection by default. If RPC information is available in a NITF file, the projection description in ENVI EX includes the string *RPC* prior to the name of the coordinate system in which the image resides.

If the Image Chip Support Data Extension Version B TRE (ICHIPB) is also present, information from this TRE is used to specify the offsets for the resulting map information. These offsets are needed to ensure the map information is consistent with the original positioning data.

For users with data containing RPC parameters in the RPC00A or RPC00B TRE, the NSDE TRE definition files and support code are required.

DIGEST GeoSDE TREs

The software uses Digital Geographic Information Exchange Standard (DIGEST) GeoSDE TREs to improve georeferencing accuracy in NITF images. The software can use the Geo Positioning Information Extension (GEOPSB) and Projection Parameters Extension (PRJPSB) TREs stored in the file header, and the Local Geographic (lat/long) Coordinate System Extension (GEOLOB) and Local Cartographic Coordinate System (MAPLOB) TREs stored in the image segment subheader. Only these GeoSDEs are supported.

A complete, valid GeoSDE TRE set requires a GEOPSB TRE in the file header. This TRE defines the basic coordinate system information including ellipsoid, datum, units, and whether the coordinate system is geographic or cartographic (projected). If the GEOPSB TRE specifies a cartographic coordinate system, it must also be accompanied in the file header by the PRJPSB TRE, which specifies the associated projection and defines the projection parameters, if required.

In addition, only one of the following TREs must be present in the image segment to which the map information applies: GEOLOB, MAPLOB, GRDPSB, or REGPTB. Because GRDPSB and REGPTB TREs are not supported, image segments containing these TREs must obtain map information from another source. The GEOLOB TRE is provided if the GEOPSB TRE specifies a geographic projection, and the MAPLOB TRE specifies a cartographic projection. Both TREs store the coordinate location of the upper-left corner of the image and the (x, y) pixel size.

NITF images containing projection codes are not supported. The software cannot use the MAPLOB TRE to find map information. Unrecognized datum codes default to WGS-84.

When packing NITF files, you cannot create, edit, or delete the DIGEST GeoSDE TREs. If the NITF file contains valid GEOLOB or GEOPSB TREs, they are preserved if you save the file to a NITF-formatted file. If you are chipping the scene, the ICHIPB TRE is added.

ICORDS and IGEOLO

The software uses the image coordinate representation (ICORDS) and image geolocation (IGEOLO) header field in the image subheader to calculate map information for an image.

These image subheader fields contain values relative to how map information is displayed:
• ICORDS: A character representing the coordinate system of the image. The character can specify either UTM or Geographic coordinates, or may specify that no corner coordinates are present.

• IGEOL0: The coordinates for each of the four corner points. If the corner points are rectified, the upper-left corner position and the pixel size are calculated and standard map information is generated for the image. Otherwise, the four corner points are used to calculate a polynomial warp used to individually calculate the coordinate location for each pixel. The polynomial warp process results in what is referred to in ENVI EX as a pseudo projection, which can be identified in the projection description by the inclusion of the string *pseudo* prior to the name of the coordinate system in which the image resides.

Order and Precedence for Reading NITF Map Information

If a NITF file contains multiple sources of map information, the order and precedence for reading the coordinate system is as follows. ENVI EX reads one sensor-based coordinate system (RPC) and up to one rectangular or warp coordinate system (tie point and pixel size, or affine map transformation).

1. RPC information: the software attempts to locate and use RPC map information for the file.

2. MAPLOB, PRJPSB, and GEOPSB TREs: Map information (if available) will be imported from these TREs, and tie point and pixel sizes will be created in the specified projection. If the projection is not supported, this information is considered invalid and the next georeferencing method is attempted.

3. GEOLOB and GEOPSB TREs: If available, tie point and pixel size will be imported from these TREs in a geographic coordinate system.

4. IGEOL0 field in the NITF image subheader: the software parses this subheader field; if it finds valid coordinates, it determines if they are rectified. If so, tie point and pixel size are computed for the image. Otherwise, an affine map transformation is used to determine georeferencing for the image.
Displaying NITF Images

NITF files appear in the Data Manager with their own icon. Each NITF segment appears in that group as a separate layer. For NITF files with multiple image segments, they appear as subfolders under the NITF file. For NITF files with multiple image segments, the name of each image segment begins with the highest level of security found in the file, followed by the word Image, followed by the number of the image segment (Image #1 for example). The image segment name is then followed by the band names, which include the word Band and the index number (except in the case of a single-band image). An example is Band_1.

Displaying Images Using the NITF/NSIF Module

Following are some rules for displaying images using the NITF/NSIF Module:

- The NITF/NSIF Module reads and displays NITF 2.0 label and symbol segments including CGM graphics, object graphics, and bitmaps.
- The NITF/NSIF Module reads and displays data in NITF 2.1 graphics segments, including CGM graphics.
- The NITF/NSIF Module reads and displays vector shapefiles stored in the CSSHPA Data Extension Segment (DES).
- The NITF/NSIF Module does not read NITF files that contain no image segments.
- The NITF/NSIF Module does not currently support the M8 image compression format.
- The NITF/NSIF Module reads and displays files that contain a segment marked "no display." If the Suppress Input Warning Messages NITF preference is set to False, a message will display to notify you that a "no display" image is being opened.
- If a NITF file contains one or more image segments marked for display and one or more marked "no display," the "no display" image segments are ignored.

The NITF/NSIF Module uses specific rules to display an image, which take precedence over any Data Manager Preferences that you set.

Special Cases

The contents of the image representation (IREP) and band representation (IREPBAND) fields in the image subheader affect how NITF images display. The IREP values that occur most frequently are MONO (monochrome), RGB (three-band true color), RGB\LUT (single-band image with color palette), MULTI (multi-band imagery), and NODISPLY (image not intended for display). The IREPBAND values used in this process are R (Red), G (Green), B (Blue), M (Mono), and LU (Look-Up Table). The image contains one IREP value for the image segment, and one IREPBAND value for each band in the dataset.

- Images with the IREP value RGB\LUT will be displayed in true color by default, and the image will be decomposed into red, green, and blue bands.
- Multiple-band images with three bands identified as R, G, and B are displayed as RGB composites, and the three bands will be represented as red, green, and blue bands.
- If no RGB values are found in the image, and there is a band marked LU, this band will be displayed with the lookup table applied.
- If the image contains a band with the value M, it is displayed as a grayscale image.
- If a NITF file contains a lookup table and mask, the software ignores the lookup table and uses the mask.
Viewing NITF Metadata

The NITF Metadata Viewer allows you to view the metadata in the header and subheaders of a NITF file and optionally save the metadata to an ASCII file. You can also view the contents of TREs, DESes, annotation segments, and text segments in the file. To view the metadata of a NITF file, perform the following steps:

1. In the Data Manager or Layer Manager in ENVI EX right-click on the NITF filename and select View NITF Metadata. The NITF Metadata Viewer dialog appears. The number and type of items shown vary according to the dataset being displayed. The metadata displayed in each item vary per different versions of NITF.

2. Click the + next to the file header, image segment, text segment, or DES to expand the information available. See NITF Metadata Icons for information on identifying the types of metadata that may appear in a particular container. Metadata are grouped as follows:

   **NITF File Header Metadata**
   Security Metadata
   TRE Metadata (if present)

   **Image Segment Metadata**
   Security Metadata
   Band Metadata (one for each band)
   TRE Metadata (if present)

   **Text Segment Metadata** (if present)
   Security Metadata
   TRE Metadata (if present)

   **Data Extension Segments** (DESes, if present)
   Security Metadata
   User-defined Subheader (if present)

   **Annotation Segment Metadata** (if present)
   Security Metadata
   Annotation Object Metadata (if present)
   TRE Metadata (if present)

   **Note**: Header and segment fields are described in MIL-STD-2500C and MIL-STD-2500A.

3. To optionally save the metadata to an ASCII file, click **Save Metadata**. The Output Metadata Filename dialog appears. Enter an output filename (.txt) and click **Save**.

4. **Click Close** to dismiss the NITF Metadata Viewer.

NITF Metadata Icons

The following icons appear in the NITF Metadata Viewer to identify the types of metadata that may appear in a particular container:

<table>
<thead>
<tr>
<th>Container</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Header</td>
<td>☝</td>
<td>Contains metadata common to the entire NITF file. In addition to file metadata, this container can contain tags or security metadata pertaining to the entire file.</td>
</tr>
</tbody>
</table>
Viewing NITF Metadata from IAS Datasets

NITF metadata are only present for datasets on IAS servers that are in NITF format or that were converted from NITF to JPEG2000. To view NITF metadata from an IAS dataset:

1. Open the dataset using File > Open Remote Dataset.
2. In the Data Manager, right-click on the image name and select View NITF Metadata. The NITF Metadata Viewer dialog appears.
3. If the NITF preference Automatically View Metadata in ENVI EX is set to True, the metadata are automatically displayed.
4. When you save an IAS dataset to NITF format, the NITF metadata are passed to the NITF output file, using the same rules as inheriting NITF metadata in the NITF/NSIF Module. See “Saving NITF Files” on page 229 for details.

Note: To stream and view NITF imagery and metadata from IAS servers, you must have a NITF/NSIF Module license.

<table>
<thead>
<tr>
<th>Container</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td><img src="image" alt="security icon" /></td>
<td>Contains security metadata for the file, image segment, text segment, annotation segment, or data extension segment.</td>
</tr>
</tbody>
</table>
| TRE             | ![TRE icon](image) | A white icon contains metadata for a TRE that cannot be edited.  
A green icon contains editable metadata for the tag.  
A blue icon contains TREs from a TRE Overflow DES. |
| DES             | ![DES icon](image) | Contains Data Extension Segments (DESes). This container may contain security metadata and user-defined subheader fields. |
| Single-band Image Segment | ![image icon](image) | Contains image metadata for a single-band image segment. In addition to information about the image band, this container may contain security metadata, image comments, and tag metadata containers. |
| Multi-band Image Segment | ![image icon](image) | Contains image metadata for a multiple-band image segment. In addition to information about the image bands, this container may contain security metadata, image comments, and tag metadata containers. |
| Annotation Segment | ![annotation icon](image) | Contains metadata for an annotation segment. In addition to one or more annotation object containers, this container may contain security tag metadata containers. |
| Text Segment    | ![text icon](image) | Contains metadata for a text segment. |
Editing NITF Metadata

Access the NITF Metadata Editor during Save As or when Chipping the Display to NITF.

**Note:** Header and segment fields are described in MIL-STD-2500C and MIL-STD-2500A.

1. Click the **Metadata Editor** button during Save As or when Chipping the Display to NITF.
2. Click the NITF file header, image segment, or text segment to view the corresponding metadata fields. Black text indicates that you can edit that field.
3. Optionally, create new PIA TREs; add, edit, or delete text segments; or delete annotation segments. Click **OK** to save your changes.

Creating New PIA TREs

Profile for Imagery Access TREs and Profile for Imagery Archive TREs (both of which you can create, edit, and delete) are discussed in detail in "Preserving PIA TREs" on page 237. You can also set default PIA TRE file metadata using NITF Preferences.

To create new PIA TREs, perform the following steps:

1. Click the **Metadata Editor** button during Save As or when Chipping the Display to NITF.
2. Right click on the NITF file header, image segment, annotation segment, or text segment to which to add the PIA TREs, and select **Add <PIA TRE>** or click the **Add PIAs** button.
3. Select which PIA TREs and how many of the TREs you want, then click **OK**.

**Note:** The PIAPRD TRE is the only PIA TRE that you can attach to a file header, and you can only add one PIAPRD TRE. You can only add one PIAIMC TRE to an image segment.

Adding, Editing, or Deleting NITF Text Segments

Adding Text Segments

1. Click the **Metadata Editor** button during Save As or when Chipping the Display to NITF.
2. Right click on the NITF file header, image segment, annotation segment, or text segment to which to add the text segment, and select **Add Text** or click the **Add Text** button.
3. Type your text in the field provided, and click **OK**. You can alternatively click the **Import ASCII** button to import a text file, and click **OK**. A new text segment appears in the tree view. The properties for that text segment automatically display.

Editing Text Segments

To edit existing text, click in the **Text** field, click the right arrow, and select **Edit**.

Deleting Text Segments

1. Click the **Metadata Editor** button during Save As or when Chipping the Display to NITF.
2. Right click on the text segment you wish to delete, and select **Delete Text** or click the **Delete Text** button.
Deleting NITF Annotation Segments

1. Click the Metadata Editor button during Save As or when Chipping the Display to NITF.

2. Right click on the annotation segment you wish to delete, and select Delete Annotation or click the Delete Annotation button.
Saving NITF Files

There are a number of ways to save NITF files:

- Create a new file from an existing NITF dataset using NITF Save As. You can also use this to create a subset of a NITF image or edit NITF metadata.
- Create a new file from an existing raster dataset using NITF Save As.
- Create a screen capture of all layers in the display using File > Chip Display To.

The options listed above differ in the metadata that the software passes through or fills in by default. These differences are detailed in the Save As NITF and Chipping the Display to NITF help topics.

The software attempts to determine a reasonable set of default values for all of the file parameters before a file is exported; however, you have the ability to edit these values before creating an output file. Many of the default values, such as the image size and data type, are determined by the data being exported. The NITF Metadata Editor shows the information that you can edit in a NITF file.

Main Header

You must check the set of parameters to be added to the NITF header fields to ensure internal consistency with the requirements set forth in the NITF specification before you can write a NITF dataset. This validation is performed automatically before any new NITF dataset is created. If the validation fails, an error message is generated that indicates the source of the failure, including the name of the field causing the error and a short description of the error. In most cases, you will have the opportunity to correct any errors before continuing.

Supported Data Types for NITF Export

Supported data types and other criteria for export are described in the following table.

<table>
<thead>
<tr>
<th>Compression Type</th>
<th>NITF 2.0</th>
<th>NITF 2.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td># of Bands: 1, 3, or 4</td>
<td># of Bands: 1-999</td>
</tr>
<tr>
<td></td>
<td>Data Types:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 8-bit unsigned integer</td>
<td>• 8-bit unsigned integer</td>
</tr>
<tr>
<td></td>
<td>• 16-bit unsigned integer</td>
<td>• 16-bit unsigned integer</td>
</tr>
<tr>
<td>JPEG DCT</td>
<td># of Bands: 1 or 3</td>
<td># of Bands: 1 or 3</td>
</tr>
<tr>
<td></td>
<td>Data Types: Byte</td>
<td>Data Types: Byte</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 16-bit signed integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 32-bit unsigned integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 32-bit signed integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• floating-point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• double precision</td>
</tr>
</tbody>
</table>
You can edit all security and origination information contained in the file, along with image settings controlling how the image is written (including image blocking settings) using NITF Preferences. Many of these settings have no required values, some have only a short list of acceptable values, and others are dependent on the values present in other fields.

### NPJE

You can save NITF 2.1 images in NPJE (NSIF Preferred JPEG 2000 Encoding) with numerically lossless and visually lossless settings.

If you choose JPEG 2000 NPJE compression, the software creates a J2KLRA TRE and removes the existing J2KLRA TRE, if present. If you save a file containing a J2KLRA TRE to an uncompressed file, the software removes the J2KLRA TRE.

### EPJE

You can save NITF 2.1 images in Exploitation Preferred JPEG 2000 Encoding (EJPJE) format with visually lossless and numerically lossless settings. When saving from a NITF file with an existing J2KLRA TRE, a new J2KLRA TRE is created because the image is being recompressed. NITF EPJE files display faster than NPJE files and EPJE is a required output format for IEC workstations.

The software cannot create an EPJE file without creating a temporary file. It uses the default temporary directory specified in NITF Preferences.
Transcoding

If you are saving a single C8 image segment without subsetting it, two additional options appear in the Compression drop-down list in the Save As dialog:

- Transcode NPJE to EPJE
- Transcode EPJE to NPJE

If you select one of these transcoding options, the image codestream is reordered to match the profile as closely as possible, and the codestream is neither decompressed nor recompressed.

The following changes may occur in the codestream, depending on the input profile of the codestream and the output option selected:

- Progression order (LRCP vs. RLCP)
- Segmentation and ordering of tile-parts
- PLT and TLM marker segments

The following do not change:

- Tile size
- Code-block size
- Quality
- Number of decomposition levels
- Wavelet transform
- Number of guard bits

If the image segment contains a J2KLRA or HISTOA TRE, these are updated with the appropriate information.

Note: Transcoding is not available for image segments that are embedded JPEG 2000 files.

NITF Compression Types

The types of compression available (if any) are determined by the data type and the NITF output version selected, as indicated in the table below. Higher compression rates result in smaller files with lower quality.

The following table shows the available compression types.

<table>
<thead>
<tr>
<th>NITF Output Version</th>
<th>Data Type</th>
<th>Compression Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>All versions</td>
<td>1- or 3-Band Byte</td>
<td>JPEG DCT (High compression)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JPEG DCT (Medium compression)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JPEG DCT (Low compression)</td>
</tr>
<tr>
<td>NITF 2.1 and NSIF 1.0 (NPJE, EPJE)</td>
<td>Any Integer data type</td>
<td>JPEG 2000 NPJE (Visually Lossless)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JPEG 2000 NPJE (Numerically Lossless)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JPEG 2000 EPJE (Visually Lossless)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JPEG 2000 EPJE (Numerically Lossless)</td>
</tr>
<tr>
<td></td>
<td>Floating Point, Double</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chipping the Display to NITF

This topic describes using the Chip Display To option to create a screen capture of all layers in the display. All segments, vectors, and display properties are burned into the image and the software creates 8-bit, three-band output at the resolution you specify. Single-band images are output to three bands. To save an existing dataset as a new NITF file, see "NITF Save As" on page 234.

The software can create new NITF datasets in NITF 2.0, NITF 2.1 and NSIF 1.0 format from existing raster data. In addition, some of the information written to the file, such as origination information and security settings, will be the same for all files you create. For these settings, you can set NITF Preferences to populate these fields by default. It is highly recommended that you customize these settings prior to creating any new NITF datasets.

When you create a new file from an existing dataset using the Chip Display To option, the software generates all new header settings. The file date and time are set to the current date and time.

Using Chip Display To

1. From the ENVI EX menu bar, select File > Chip Display To > File or click the Chip to File toolbar button.
2. Accept the default resolution, or change the resolution by typing in the Resolution field or by clicking the up/down arrows next to this field. Pixel width and height are displayed. Click OK.
3. Accept the default directory location and file name, or click Browse to select a directory location and type a file name. By default, the file name will be untitled.ntf.
4. Select a compression type from the Compression drop-down list.
5. Using the Metadata Editor button, you can optionally edit the NITF metadata and add PIA tags and text segments before saving the file.
6. Click OK.
7. Use the Data Manager in ENVI EX to display the output image.

If your new file is a spatial subset of the original image and you display it with the original image, the Overview window and Image window in ENVI EX show the extent of the subset with a red box when the layer is selected in the Layer Manager.

Image Segments

NITF image segments can be created from any supported data type except 64-bit integer and complex. Image segments are populated in this way:

- **Security information, date and time:** The security information for the image segment is read from the NITF Preferences and the image date and time are set. For NITF 2.1 files, the date and time is set to UNKNOWN; for NITF 2.0 files, the date and time is set to Jan. 1, 1970 (because NITF 2.0 does not recognize UNKNOWN).

- **Rows, columns, bands, and data type:** The number of rows, columns, bands, and the data type of the output dataset is determined from the input dataset. If the number of rows and columns is less than 4096, the block size is set to the full image size. For larger images, the image is set to a block size of 1024x1024.

- **Compression:** By default, the image is uncompressed.
• **Map information:** If the image has map information in UTM, this information is written to the file using the MGRS representation supported in both NITF 2.0 and 2.1. Other map information will be converted into geographic coordinates for export.

The software may also create GEOPSB, PRJPSB, GEOLOB, or MAPLOB TREs if the input file contains map information.
NITF Save As

This topic describes using the Save As option to save an existing NITF or raster dataset to a new NITF file. To save a screen capture of all layers in the Image window, see "Chipping the Display to NITF" on page 232.

When you create a new NITF file from an existing dataset, the header settings from the source dataset are saved to the new file, except for the following values:

- The file date and time are set to the current date and time.
- The number of file copies is incremented (unless it is currently set to 0), and this copy number is set to the number of copies.
- For existing NITF files, any image segment with a compression setting not supported for output is set to uncompressed by default.
- For existing NITF files, the output version will be the same as the input version. For all other file types, the version number is set via the New NITF File Metadata, NITF Version field in the NITF Preferences.

Image segments cannot contain masks used to alter image values for display, when you create NITF output. The software passes through or fills in by default some metadata. For more information, see the following topics:

- "Preserving NITF Annotation Segments" on page 236
- "Preserving DESes" on page 236
- "Preserving TREs" on page 237
- "Preserving PIA TREs" on page 237
- "Preserving NITF Text Segments" on page 237
- "Preserving PIA TREs" on page 237

Saving an Existing NITF File to NITF Using Save As

When saving an existing NITF file to NITF using the Save As option, metadata that is contained in the original dataset will be passed through to the new NITF file.

NITF 2.1 images can be saved in NSIF Preferred JPEG 2000 Encoding (NPJE) format with numerically lossless and visually lossless compression settings. NITF 2.1 images can also be saved in Exploitation Preferred JPEG 2000 Encoding (EPJE) format with visually lossless and numerically lossless settings.

When saving with the NPJE compression, ENVI EX creates a J2KLRA TRE and removes the existing one, if present. If you save a file containing a J2KLRA TRE to an uncompressed file, ENVI EX removes the J2KLRA TRE.

ENVI EX cannot create an EPJE file without creating a temporary file. ENVI EX uses the Temporary Directory specified in the Preferences.
Saving a Raster File to NITF Using NITF Save As

The software can create new NITF datasets in NITF 2.0, NITF 2.1 and NSIF 1.0 format from existing raster data. Some of the information written to the file, such as origination information and security settings, will be the same for all files you create. For these settings, you can set NITF Preferences to populate these fields by default. It is highly recommended that you customize these settings prior to creating any new NITF datasets.

Using NITF Save As

1. From the ENVI EX menu bar, select File > Save As.
2. Optionally, expand the file name (in a file with one or more image segments) and select an individual segment to save. If a NITF file contains one or more image segments marked for display and one or more marked "no display," the "no display" image segments are not shown in this dialog. However, when you save this file using the Save As option, the "no display" image segments are passed through with the NITF file.
3. Perform optional spatial subsetting, then click OK.
4. Accept the default directory location and file name, or click Browse to select a directory location and type a file name. By default, the file name will be untitled.ntf.
5. Select a compression type from the Compression drop-down list. This option will be unavailable for files with multiple image segments. In this case, the compression type is passed through from the existing file.
6. Using the Metadata Editor button, you can optionally edit the NITF metadata and add PIA tags and text segments before saving the file. See "Editing NITF Metadata" on page 227 and for more information.
7. Click OK.

Image Segments

NITF image segments can be created from any supported data type except 64-bit integer and complex. Image segments are populated in this way:

- **Security information, date and time:** The security information for the image segment is read from the NITF Preferences, and the image date and time are set. For NITF 2.1 files, the date and time is set to UNKNOWN; for NITF 2.0 files, the date and time is set to Jan. 1, 1970 (because NITF 2.0 does not recognize UNKNOWN).

- **Rows, columns, bands, and data type:** The number of rows, columns, bands, and the data type of the output dataset is determined from the input dataset. If the number of rows and columns is less than 4096, the block size is set to the full image size. For larger images, the image is set to a block size of 1024x1024.

- **Compression:** By default, the image is uncompressed.

- **Map information:** If the image has map information in UTM, this information is written to the file using the MGRS representation supported in both NITF 2.0 and 2.1. Other map information will be converted into geographic coordinates for export.
The software supports creation of the RPC00B TRE when exporting to any NITF file containing RPC information. The RPC00B TRE is automatically created when this information is available, and the ICHIPB TRE is created if needed. These TREs will be stored in the image segment of the new NITF file. The ICHIPB TRE is required if a spatial subset of the input image is selected or the input image is a subset of a larger product.

The software may also create GEOPSB, PRJPSB, GEOLOB, or MAPLOB TREs if the input file contains map information.

- **Image and band representation:** For single-band images, the image representation field is set to MONO and the band representation is set to M, while three-band byte images have RGB as the image representation, with the band representations set to R, G, and B. For any other band count, the image representation will be set to MULTI and, if a set of default bands is specified for this file, these bands will have their representations set to R, G, and B to indicate that these bands should be displayed by default. See the table below for more information.

<table>
<thead>
<tr>
<th>Type of Image</th>
<th>Image (Representation)</th>
<th>Band (Representation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-band image</td>
<td>MONO</td>
<td>M</td>
</tr>
<tr>
<td>Three-band byte image</td>
<td>RGB</td>
<td>R,G,B</td>
</tr>
<tr>
<td>Other image</td>
<td>MULTI</td>
<td>R,G,B (if specified)</td>
</tr>
</tbody>
</table>

- **Wavelength information:** If wavelength information is not available for the file, or if only one band is being exported, the image category is set to VIS, and the band subcategory is left blank. If wavelength information is available, the software will attempt to convert the wavelength into nanometers, then write that information into the band subcategory. In this case, the image category is set based upon the number of input bands: HS is used for files with more than 200 bands, and MS is used for files with 2-200 bands. All other fields are left blank. The BANDSB TRE is automatically created and populated with all available information when the input file contains wavelength information.

**Preserving DESes**

When you save an existing NITF file to NITF format, supported DES segments are preserved in the new file. The software currently only supports NITF Commercial Dataset Requirements Document (NCDRD) DESes. See "Data Extension Segments" on page 213 for a list of supported DESes. You cannot edit, create, or delete NCDRD DESes through the NITF Metadata Editor. When writing a NITF file that contains a DES with no corresponding XML file, the software passes through this unknown DES.

**Preserving NITF Annotation Segments**

When you save an existing NITF file to NITF format, the software preserves CGM annotation segments. You cannot alter any data or metadata associated with the annotation segment, however you can edit the following fields in the NITF Metadata Editor: Annotation ID, Annotation Name, and Annotation Security Fields.

You cannot add annotation segments when creating a new NITF file from a non-NITF file. You can delete annotation segments from a NITF file when saving.

If you subset a NITF image file containing annotation segments, the following rules apply:
• If an annotation segment is attached to the file (level 0) and you subset the file, the annotation location does not change. The annotation will be in the same location in the input and output file but may not be in the same relative location to other objects in the file.

• If an image segment is entirely or partially inside the subset and has one or more annotation segments attached to it, the annotation segments are saved. In the output file, the annotation segments are in the same relative location to the image they are attached to as they are in the input file.

• If an image segment is outside the subset and has one or more annotation segments attached to it, the image and annotation segments are discarded. Any segments attached to the discarded annotation segment are also dropped.

• If you subset a file and the annotation segment location is to the left of the subset, the annotation segment is discarded because negative common coordinate system (CCS) location values are not allowed in NITF files.

• Annotation segment graphics are not subsetted; they pass through unchanged.

Preserving NITF Text Segments

When you save a NITF file to a new NITF file, text segments and associated TREs are preserved (included) in the new file. In NITF 2.1, text segments are attached to either the file or an image segment of a NITF image file by using an attachment level field, TXTALVL. The attachment level is the display level of an image or graphic segment to which the text segment is attached; a value of 0 indicates the attachment is to the file header. Per the NITF Specification, NITF 2.0 text segments do not have attachment levels.

Preserving TREs

When you save a NITF file to a new NITF file, supported TREs associated with any exportable segments are preserved in the new file (see: "Tagged Record Extensions" on page 213). A warning message is provided if any TRE is not supported.

If you select a spatial subset of an input dataset for output, the ICHIPB TRE is used to maintain the relationship of the output image data to the source image data and to ensure the validity of any other TRE. The ICHIPB TRE contains the size and position of the subset and is written in the image segment. A new ICHIPB TRE is added to the list of TREs when you export an image segment with a TRE with any spatial subset other than the entire image. If the ICHIPB TRE already exists, it is modified for the new (smaller) subset of the initial subset to still contain the correct parameters from the original source image, not the initial subset.

If a NITF image segment contains HISTOA TREs and NEVENTS is not equal to the maximum value of 99 in the last HISTOA TRE, the software automatically updates this TRE upon output. If NEVENTS is equal to 99 in the last HISTOA TRE, the software creates a new HISTOA TRE. The software does not create a new HISTOA TRE if the input NITF image segment does not contain a HISTOA TRE.

Preserving PIA TREs

Profile for Imagery Access and Profile for Imagery Archive (PIA) TREs are used to hold information required by the Standards Profile for Imagery Access (SPIA). A variety of government agencies require these TREs in NITF image products. When you save a NITF file to a new NITF file, the PIA TREs associated with the file header and any image, symbol, label, or text segments are preserved in the new file.

There are 10 unique PIA TREs; newer PIA TREs are labeled Profile for Imagery Access, and older PIA TREs are labeled Profile for Imagery Archive.
You can edit, delete, and save both sets of PIA TREs in NITF files, but you can only create the Profile for Imagery Access TREs shown in the table below. You can create the TREs with user-defined default values using NITF Preferences, and you can save (pack) these to an output NITF file. The software updates PIAPRC and PIAPRD TREs with the current date and time when you create NITF output.

<table>
<thead>
<tr>
<th>PIA TRE</th>
<th>Header Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIAPRD</td>
<td>File</td>
<td>Profile for Imagery Access Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Information about products derived from a source image</td>
</tr>
<tr>
<td>PIAIMC</td>
<td>Image</td>
<td>Profile for Imagery Access Image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Additional image information</td>
</tr>
<tr>
<td>PIATGB</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Access Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about targets in a segment. One TRE per target</td>
</tr>
<tr>
<td>PIAPEB</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Access Person</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about people in a segment. One TRE per identified person</td>
</tr>
<tr>
<td>PIAEVA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Access Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about events in a segment. One TRE per identified event</td>
</tr>
<tr>
<td>PIAEQA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Access Equipment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about equipment in a segment. One TRE per identified piece of equipment</td>
</tr>
</tbody>
</table>

The table below lists Profile for Imagery Archive TREs from an output NITF file that you can edit or delete, but not create.

<table>
<thead>
<tr>
<th>PIA TRE</th>
<th>Header Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIAPRC</td>
<td>File</td>
<td>Profile for Imagery Archive Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Information about products derived from a source image</td>
</tr>
<tr>
<td>PIAIMB</td>
<td>Image</td>
<td>Profile for Imagery Archive Image</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Additional image information</td>
</tr>
<tr>
<td>PIATGA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Archive Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about targets in a segment. One TRE per target</td>
</tr>
<tr>
<td>PIAPEA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Archive Person</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about people in a segment. One TRE per identified person</td>
</tr>
<tr>
<td>PIAEVA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Archive Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about events in a segment. One TRE per identified event</td>
</tr>
<tr>
<td>PIAEQA</td>
<td>Image, Symbol, Label, or Text</td>
<td>Profile for Imagery Archive Equipment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Descriptive data about equipment in a segment. One TRE per identified piece of equipment</td>
</tr>
</tbody>
</table>
For detailed information on these TREs, see the NITFS Technical Board document STDI-0002.
Glossary

AATSR
Advanced Along-Track Scanning Radiometer; an ENVISAT sensor.

absorption feature
A region of the electromagnetic spectrum where a given material absorbs radiation, shown by a low point in a spectral curve. Each material has unique absorption features, which serve as identifying characteristics.

abundance image
In hyperspectral analysis, an image whose values represent the fractions of total spectrally integrated radiance or reflectance of a pixel contributed by each spectrally unique material.

ACRES
Australian Centre for Remote Sensing.

across track
The imaging direction perpendicular to the along track direction of a satellite or aircraft. The across track viewing angle determines the swath.

active layer
The layer that you select to edit, when multiple annotation or vector layers are open. The Crosshairs and Vector tools work on the active vector layer. The Annotation tools work on the active annotation layer.
adaptive filter
A type of spatial filter that uses the standard deviation of those pixels within a local box (kernel) surrounding each pixel to calculate a new pixel value. Typically, the original pixel value is replaced with a new value. Unlike a typical low-pass smoothing filter, adaptive filters preserve image sharpness and detail while suppressing noise.

adjacency effect
The change in a pixel value caused by photons that reflect off the ground and scatter into the sensor field-of-view; radiance from neighboring pixels affects the measured radiance of a target pixel. The algorithms in the Atmospheric Correction Module in ENVI account for this effect.

ADRG
ARC Digitized Raster Graphics; a National Geospatial-Intelligence Agency (NGA) data format.

aerosol scattering
Redirection of electromagnetic energy caused by aerosols, which are particles suspended in the atmosphere.

AIRSAR
Airborne Synthetic Aperture Radar; a NASA Jet Propulsion Laboratory (JPL) sensor.

algorithm
A step-by-step procedure for performing a specific task, such as a mathematical formula or a set of instructions on a computer program.

along track
The imaging direction parallel to the direction that a satellite or aircraft moves.

alpha residuals
In hyperspectral analysis, alpha residuals are spectra that are a function of emissivity only. They have a similar shape as emissivity spectra but have a zero mean.

annotation
A graphic element added to an image or map composition. Annotation objects include, but are not limited to, symbols, shapes, polylines, text, arrows, scale bars, borders, map keys, declination diagrams, color ramps, images, and plots.

anomalies
Targets whose signatures are spectrally distinct from their surroundings.

apparent reflectance
Reflectance recorded at the sensor; also defined as radiance normalized by solar irradiance. Apparent reflectance is not true reflectance because shadows and directional effects have not been accounted for.

arbitrary profile
Also called a transect; a line drawn on an image, whose underlying data values are graphed in a cross-section plot.
area-based matching
A method of automatic image-to-image registration that compares the gray scale values of patches of two or more images and tries to find conjugate image locations based on the similarity of the gray scale value patterns.

ASAR
Advanced Synthetic Aperture Radar; an ENVISAT sensor.

ASCII
American Standard Code for Information Interchange; a simple text format.

aspect
The direction (azimuth) that a surface faces, typically in degrees clockwise from North (0 degrees); a parameter used in topographic modeling.

ASTER
Advanced Spaceborne Thermal Emission and Reflection Radiometer; a NASA EOS sensor.

atmospheric correction
A method used to correct sensor radiance for atmospheric effects by mathematically modeling the physical behavior of radiation as it passes through the atmosphere.

atmospheric window
A region of the electromagnetic spectrum in which satellites and aircraft cannot acquire measurements because of substances that absorb solar radiation (the most common are water vapor and CO2).

ATSR
Along Track Scanning Radiometer; an ERS-1 and ERS-2 sensor.

attributes
Data that describe the properties of a point, line, or polygon record in a GIS. Attributes are typically stored in table format.

autocorrelation
In multivariate statistics, a measure of correlation among residuals from a regression equation. An autocorrelation (r) value of 1.0 or -1.0 indicates a strong relationship between successive residuals, and a value of 0 indicates no relationship. In remote sensing, autocorrelation provides an indication of the local homogeneity of a data set, by evaluating the overall pattern between proximity and similarity of pixel values.

AVHRR
Advanced Very High Resolution Radiometer (NOAA).

AVIRIS
Airborne Visible/Infrared Imaging Spectrometer (NASA/JPL).

background
All pixels in a scene that are not an anomaly or target.
band
A discrete portion of the electromagnetic spectrum measured by an aircraft or satellite sensor. Legacy multispectral sensors typically have fewer, wider bands, while modern hyperspectral sensors have hundreds of bands that each measure a very narrow range of wavelengths.

Band Math
An ENVI tool that allows you to define and apply mathematical expressions to spatial image data, resulting in a new output image.

band ratio
The process of dividing one spectral band by another to enhance their spectral differences and to reduce the effects of topography.

BandMax
An algorithm developed by the Galileo Group, Inc., used to increase classification accuracy of targets in hyperspectral analysis. BandMax determines an optimal set of bands to help separate targets from known background materials.

batch mode
Performing a linear sequence of ENVI processing tasks in a non-interactive manner.

batch mode routine
An IDL program that includes ENVI library routines to perform a non-interactive image processing task.

BIL
Band Interleaved by Line; a raster interleave type that stores the first line of the first band, followed by the first line of the second band, followed by the first line of the third band, interleaved up to the number of bands. Subsequent lines for each band are interleaved in similar fashion. This format provides a compromise in performance between spatial and spectral processing and is the recommended file format for most ENVI processing tasks.

BIP
Band Interleaved by Pixel; a raster interleave type that stores the first pixel for all bands in sequential order, followed by the second pixel for all bands, and so forth, interleaved up to the number of pixels. This format provides optimum performance for spectral (z) access of the image data.

BSQ
Band Sequential; a raster interleave type whereby each line of the data is followed immediately by the next line in the same spectral band. This format is optimal for spatial (x,y) access of any part of a single spectral band.

buffer
A user-specified extension zone around a point, line, or polygon. In a buffer zone image, each pixel represents the distance from that pixel to the nearest pixel of the selected class(es). Pixels that fall beyond a user-specified maximum distance threshold are set to that maximum distance.
byte order

The order of bytes in integer, long integer, 64-bit integer, unsigned 64-bit integer, floating-point, double-precision, and complex data types. Following are the two methods of byte order: Host (Intel): Least significant byte first (LSF); byte order=0 in the ENVI Header; used in Intel-based (Windows, Linux, MacIntel) platforms. Network (IEEE): Most significant byte first (MSF); byte order=1 in the ENVI Header; used in Macintosh and Unix platforms.

CADRG

Compressed ARC Digitized Raster Graphics; an NGA data format.

CCRS

Canadian Centre for Remote Sensing.

change detection

The process of comparing two or more images acquired at different times.

chip

Spatial subset or screen shot (as in Chip Display To...)

CIB

Controlled Image Base; an NGA data format.

classification

The process of assigning pixels of a multispectral image to discrete categories. Supervised classification is a general technique that uses information derived from a few areas of known identity to classify unknown pixels in the remaining image. Unsupervised classification is an automated technique that searches for natural groups, or clusters, of pixels based on their brightness in several bands. Unlike the supervised method, unsupervised classification does not begin with a predefined set of classes.

clustering

The statistical analysis of a set of pixels to detect their inherent tendency to form clusters in n-dimensional (n-D) measurement space.

CMYK

Cyan, magenta, yellow, and key, or black. These are the four colors of ink used in the traditional method of printing hardcopy images.

color ramp

An annotation object that shows a gradual transition from one color to another. For a gray scale image, the transition is from the minimum to the maximum gray scale value. For a color image, the color ramp is the distribution of the selected color palette.

color space

A mathematical way of representing color in terms of intensity values, often as a 3D model.

color table

A special lookup table that associates screen brightness values with specific RGB values. For a color image, the output colors consist of different red, green, and blue values. For a gray scale image, the red, green, and blue data values are the same for a given data value.
color transform

A method used to convert RGB images to a different color space, and vice-versa; by applying a contrast stretch in another color space, you can highlight certain features in an image. Also see "data fusion" and "image sharpening."

color-infrared composite

Also called CIR, or false-color composite; An image where the near-infrared band (0.76 - 0.9 microns) is displayed in red, the red band (0.6 - 0.7 microns) is displayed in green, and the green band (0.5 - 0.6 microns) is displayed in blue.

compound widget

In ENVI programming, a predefined widget that ENVI automatically builds for you when you call the appropriate library routine in your user function (see the ENVI Reference Guide for a list of library routines). Each compound widget performs a specific task that is often needed in a custom graphical user interface for image processing.

confusion matrix

Also called a contingency matrix. A table used to assess classification accuracy and misclassification between categories. The matrix is size m x m, where m is the number of classes. The rows in the matrix represent classes that are assumed to be true, while the columns represent classes derived from remote sensing imagery. The matrix also lists errors of commission and omission.

contour line

A line that follows the same elevation on a topographic map.

contrast stretch

A method of improving the contrast of a remote sensing image by stretching the original range of digital numbers (DNs) across the full contrast range of the display. The most commonly used stretches in ENVI are Equalization, Gaussian, and Linear.

convolution

The process of applying a spatial filter on an image, where each pixel is based on a weighted average of coefficients within an n x n matrix surrounding the pixel (where n is an odd number).

correlation

A statistical measure of the linear relationship between two data sets. If they vary in the same direction, the correlation is positive; if they vary in the opposite direction, the correlation is negative.

correlogram

A plot of autocorrelation values at multiple lag distances; a measure of how autocorrelation decreases as distance increases. For example, if you specify a maximum lag distance of 5 pixels, autocorrelation is calculated for lags of 5, 4, 3, 2, and for each pixel's nearest neighbors.

covariance

A statistical measure of the tendency of two variables to move or vary together; more specifically, the simultaneous deviations of two variables from their means.

data dimensionality

The number of variables (bands) present in a data set.
data fusion
The process of displaying two data sets of the same area together in one RGB color composite. The data sets must be registered and resampled so that they have the same orientation, pixel size, and image dimensions. A popular example of data fusion is to apply an HSV color transform to one image, replace the value band with another image, then reverse the color transform. This produces an image that merges the color characteristics of one image with the spatial characteristics of another image.

datum
A reference point or surface against which position measurements are made, and an associated model of the shape of the earth for computing positions. Different nations and agencies use different datums based on local reference points. Examples include the NAD83 and NAD27.
decision tree
A classification technique that uses a series of binary decisions to place pixels into classes. Each decision point divides pixels into two classes based on an expression. Then you can divide each new class into two more classes based on another expression, and so on.
decline diagram
An annotation object that includes any combination of arrows pointing to true north, grid north, and magnetic north.
delaunay triangulation
An image-to-image warping method that fits triangles to irregularly spaced tie points and interpolates values to the output grid.

DEM
Digital elevation model; a raster data set where each pixel represents an elevation value.
density slice
A method for converting the continuous gray tone of an image into a series of density intervals, or slices, each corresponding to a specific digital range.
deskew
A preprocessing method used to correct systematic distortions caused by earth rotation and scan skew; these were especially evident in Landsat MSS imagery.
destripe
A preprocessing method used to remove periodic scan line striping in image data. This type of striping is often seen in Landsat MSS data (every 6th line) and, less commonly, in Landsat TM data (every 16th line).

DIMAP
Digital Image Map; a SPOT data format.
display group
A term that refers collectively to the Scroll window, Image window, and Zoom window in ENVI.
display group menu bar
The menu bar in the Image window of a display group.
DLG
Digital Line Graph; a USGS vector data format.

DMSP
Defense Meteorological Satellite Program (U.S. Air Force).

DN
Digital number; also called "pixel value."

DOQ
Digital Orthophoto Quadrangle; a USGS data format.

DRG
Digital Raster Graphics; a scanned topographic map generated by the USGS.

DTED
Digital Terrain Elevation Data; an NGA data format.

DXF
Data Exchange Format; a format for storing vector data in ASCII or binary files.

dynamic overlay
An ENVI feature that allows you to immediately overlay and toggle (flicker) between two linked images.

ECW
Enhanced Compressed Wavelet; a proprietary data format developed by Earth Resource Mapping that is primarily intended for aerial imagery.

EFFORT
Empirical Flat Field Optimal Reflectance Transformation; an algorithm that polishes out noise and errors that may appear in hyperspectral apparent reflectance data, thus improving the accuracy of the data and making apparent reflectance spectra appear more like spectra of real materials.

eigenvalues
Transformation coefficients in principle components analysis that can be used to determine the percent of total variance explained by each of the principle components.

eigenvectors
A set of weights applied to band values to obtain principal components; they show the relative contributions of the different original bands to the final principal components bands.

electromagnetic spectrum
The full spectrum of electromagnetic radiation, extending from short cosmic waves to long radio waves.

ellipsoid
A smooth mathematical surface that is used to represent the geometric model of the earth. Its axes approximate the dimensions of the earth, rotated around the polar axis. Examples include the Clark ellipsoid of 1866 and the GRS80 ellipsoid.
emissivity
The ratio of the radiance emitted from an object at a particular wavelength to the radiance that a black-body would emit at the same temperature and wavelength. An emissivity of 1.0 is a perfect blackbody (a perfect absorber). Most earth surface types have emissivities between 0.9 and 1.0.

dendmember
A pure spectrally unique material that occurs in a scene.

terprise
A computer network that allows information technology to be shared in an organization.

ENVI header file
A text file that must accompany an image file and reside in the same directory as the image file. The header file lists required image characteristics such as number of samples, number of lines, number of bands, offset, file type, byte order, data type, and storage order.

ENVI main menu bar
The main menu that appears when you start ENVI.

ENVI save files
Binary files that contain the basic ENVI library routines and internal variables required to run ENVI.

ENVIISAT
Environmental Satellite (European Space Agency)

EOSEarth Observing System (NASA)

EOSAT
Earth Observation Satellite Company

epipolar images
A stereo pair of images in which the left and right image are oriented such that ground control points (GCPs) have the same y-coordinates on both images, thus removing one dimension of variability. Epipolar images are generated based on epipolar geometry and are used to extract a DEM.

EROS
Earth Resources Observation System.

ERSEuropean Remote Sensing satellite (European Space Agency).

ESA
European Space Agency.

ESRI
Environmental Systems Research Institute.
ESRI layer
In ArcGIS, a layer file is a reference to a data source, such as a shapefile, coverage, geodatabase fea-
ture class, or raster, that defines how that data source should be symbolized on a map. ESRI layer can
also refer to a layer dragged from ArcMap or ArcCatalog to the Image window.

ETM+
Enhanced Thematic Mapper; a Landsat-7 sensor.

event handler
IDL code that manages events generated by widgets.

EVF
ENVI vector file; a format that ENVI uses to store vector data, no matter what the input native format
is. EVF is the most efficient format for storing and manipulating vector information within ENVI.

exterior orientation
In photogrammetry, the process of transforming image coordinates to object (ground) coordinates us-
ing ground control points (GCPs).

feathering
The process of blending the edges of overlapping areas in input images for pixel-based and map-based
mosaicking.

feature
Also called "spatial feature." A user-defined geographic phenomenon that can be modeled or repre-
sented using geographic data sets. Examples include roads, buildings, grasslands, and water bodies.

feature class
A feature class is a collection of geographic features with the same shape type (point, line, or polygon),
attributes, and spatial reference. Feature classes can be stored in geodatabases, shapefiles, or other for-
mats.

feature-based matching
A method of automatic image-to-image registration that extracts distinct features from images and
identifies features that correspond to one another (by comparing feature attributes and location).

FFT
Fast Fourier Transform; a filter used to transform image data into a complex output image showing its
various spatial frequency components.

fiducial marks
A series of four or eight crosshairs placed along the edge of aerial camera film during exposure. The
intersection of imaginary lines connecting opposite fiducial marks corresponds to the principal point
of the photograph. Fiducial marks are used primarily to orthorectify aerial photographs.

field spectra
Spectra of natural features such as minerals or vegetation, analyzed in the field using a handheld spec-
trometer. Field spectra are often used as a baseline, or true spectra for identification of minerals or veg-
etation types from hyperspectral remote sensing imagery.
filter function

A function which is used to adjust the intensity of a pixel based on its distance from a geometric element.

FLAASH

Fast Line-of-sight Atmospheric Analysis of Spectral Hypercubes; a first-principles atmospheric correction modeling tool for retrieving spectral reflectance from hyperspectral radiance images. FLAASH is a separate add-on module in ENVI.

flat binary

A general raster format where data are stored as a binary stream of bytes in BSQ, BIP, or BIL format.

fly-through

A 3D animation along a hypothetical flight path in a 3D SurfaceView.

frame central projection

A modeling scenario used to compute rational polynomial coefficients (RPCs) in frame camera and digital (frame central) aerial photography. This projection has one perspective center, which is collinear in space with its object point and image point.

function

In ENVI programming, a program unit containing one or more IDL statements that returns a value. Functions take the following form: Result = FUNCTION_NAME(Argument [, Optional Argument])

FWHM

Full width half maximum; an engineering term that pertains to the signal curve of a sensor; in a plot of the measured signal (which approaches a near-Gaussian distribution), the FWHM is the horizontal distance between the two points on the signal curve that are half the maximum value. FWHM is an important measure of the quality of an imaging device and its spectral resolution.

gain

In ENVI, a value that is multiplied by the pixel value to scale it into physically meaningful units of radiance: radiance = DN * gain + offset

GCP

Ground control point; a point on the ground whose location is known through a horizontal coordinate system or vertical datum. A GCP relates a point in a remote sensing image (x,y) to a geographic point on the earth (latitude/longitude, for example).

GCTP

General Cartographic Transformation Package.

gerographic coordinate system

A coordinate system for defining locations on the earth's surface using a 3D spherical model that includes an angular unit of measure, a prime meridian, and a datum.

geroid

An undulating surface that approximates the shape of the earth and mean sea level throughout the world. The direction of gravity is perpendicular to the geoid at every point. The geoid is the reference surface for surveying and some inertial navigation systems. An example is the OSU91A geoid.
GeoJP2
A format extension to JPEG2000 for embedding coordinate system and georeferencing information in a JPEG2000 JP2 format file. The GeoJP2 format was developed by Mapping Science, Inc.

g eo metric ally corrected
An image that has been adjusted to remove geometric distortions caused by lens distortion, sampling rate variation, sensor drift, topographic relief, and other factors.

g eoreference
To map a remote sensing image to a known location on the earth, by referencing it to a map projection.

g eoreferenced
A defined location in physical space in map projections or coordinate systems.

GeoTIFF
A public-domain metadata standard that allows geographic information to be embedded within a TIFF file. Remote sensing software uses the metadata to position the geographic data.

GI S
Geographic information system.

GLT
Geographic lookup table; a binary file that maps an input pixel to an output pixel based on input geometry information. A GLT file contains integer pixel location values that are sign-coded to indicate if a certain output pixel is real or interpolated from nearest-neighbor resampling. The two bands of a GLT file refer to the original sample number and original line number, respectively. You can georeference your data directly from a GLT file.

GPS
Global positioning system.

gray scale
A range of black to white tones as displayed on a monitor or in an image; a gray scale image is created when the red, blue, and green color guns of the monitor are assigned the same value for each pixel.

HDF
Hierarchical Data Format; a data structure developed by the National Center for Supercomputing Applications.

HDF-EOS
Hierarchical Data Format - Earth Observing System; a format used for storing data from NASA EOS sensors that adds geolocation objects (grid, point, and swath) to the HDF format.

hill shade image
A color shaded-relief image created by transforming a color image into HSV color space, replacing the value band with a shaded-relief image, and transforming the color image back to RGB space.

histogram
A plot that shows the frequency of occurrence (y-axis) of the brightness values (x-axis) of an image. You can adjust the histogram for each band (red, green, and blue).
HLS
Hue-lightness-saturation color space.

HSV
Hue-saturation-value color space.

hyperspectral
A term used to describe data sets typically composed of 100 to 200 (or more) spectral bands of relatively narrow, contiguous, bands (5 to 10 nm). Hyperspectral imaging creates a large number of images from contiguous regions of the electromagnetic spectrum. This increases sampling of the spectrum (versus multispectral data) and greatly increases the amount of information available to a researcher. Also see "imaging spectrometer."

IDL
Interactive Data Language.

IGM
Input Geometry file; an ancillary file that provides map information in two bands: one for x coordinates and another for y coordinates. Many data sets include IGM files in their distribution. An IGM file itself is not georeferenced, but it contains georeferencing information for each original, raw pixel in an image.

IKONOS
A GeoEye high-resolution satellite that produces 1 m panchromatic and 4 m multispectral imagery.

image box
The red box inside a Scroll window that defines the area covered in the Image window.

image coordinates
Also called "pixel coordinates." The location of an image pixel in generic (sample, line) coordinates. Image coordinates always increase (one unit for every pixel) with increasing sample and line number. Also see XSTART and YSTART.

image cube
A color image created from a multispectral or hyperspectral file where the data set is shown with an image represented on the face of a cube and the spectral information of the edge pixels depicted on the other faces.

image sharpening
The process of merging a low-resolution color image with a high-resolution gray scale image (with resampling to the high-resolution pixel size).

Image window
The window in a display group that displays the image at full resolution. If the image is large, the Image window displays the subsection of the image defined by the Scroll window Image box. See Display Groups on page 46 for an example.
imaging spectrometer

A sensor designed to collect hyperspectral imagery. Examples include AVIRIS and HyMap. Many spectral images are acquired simultaneously, where each pixel in an image contains a continuous spectrum with typically hundreds of spectral measurements that is used to analyze surface features and atmospheric constituents.

incidence angle

In a radar system, the angle defined by the incident radar beam and the vertical (normal) to the intercepting surface. In pushbroom sensors, the along track incidence angle is the angle between the vertical position of the satellite and its forward or backward viewing direction. The across track incidence angle is the angle (in degrees) between the vertical position of the satellite and its side-viewing direction when the sensor is scanning along the side.

interactive user routine

In ENVI programming, a user function that performs some type of interactive analysis and is triggered by certain events or user selection. Examples include plot functions, Spectral Analyst functions, user-defined map projection types, user-defined units, user-defined RPC readers, and user move routines.

interior orientation

In photogrammetry, the process of transforming scanned image pixel coordinates to image coordinates defined by fiducial marks in the aerial photograph.

interleave

A term that refers to how raster image data are stored. See BSQ, BIL, and BIP.

IRS

Indian Remote Sensing satellite (Government of India, Department of Space).

JERS

Japanese Earth Resources Satellite (Japan Aerospace Exploration Agency).

JITC

Joint Interoperability Test Command; an organization that certifies systems implementing the NITF data format for compliance with NITF standards.

JPEG

Joint Photographic Experts Group image format.

JPL

Jet Propulsion Laboratory (NASA).

kernel

An array of pixels used for digital image filtering or to constrain an operation to a subset of pixels.

laboratory spectra

Spectra of materials (such as minerals or vegetation types) measured with a spectrometer in a controlled laboratory environment. Laboratory spectra are often used as a baseline, or true spectra for identification of materials from hyperspectral remote sensing imagery.
Lambertian

A surface that emits or reflects radiation isotropically, according to Lambert's law; a perfectly diffusing surface; the brightness (luminance, radiance) of a lambertian surface is constant regardless of the angle from which it is viewed.

LAS

A binary data format that contains LIDAR point data records.

layer stacking

The process of building a multi-band file from georeferenced images of various pixel sizes, extents, and projections. The output file has a geographic extent that either encompasses all of the input file extents or encompasses only the data extent where all of the files overlap.

library routines

DL programs that encompass nearly all of the functionality in ENVI. The ENVI Reference Guide contains a complete index and full reference page for each library routine.

lidar

Light detection and ranging; a technology that determines distance to an object or surface by measuring the time delay between a laser pulse transmission and detection of the return signal.

line

The y component of a raster image coordinate pair (x,y); same as row.

line central projection

A model used to compute rational polynomial coefficients (RPCs) in imagery from pushbroom sensors and line central aerial photography. Each scan line has its own projection center.

line of sight

A spatial analysis tool that determines which pixels can be seen from a specific pixel within any file that has an associated DEM; topographic features will obscure some pixels from view.

logarithmic residual

An input spectrum divided by the spectral geometric mean (the mean of all bands for each pixel) of a data set, which is then divided by the spatial geometric mean (the mean of all pixels for each band). Logarithmic residuals are used to remove solar irradiance, atmospheric transmittance, instrument gain, topographic effects, and albedo effects from radiance data.

LUT

Lookup table; a static table that associates an image pixel value with a specific screen brightness value; used for contrast-stretching an image.

majority analysis

A post-classification tool used to change spurious pixels within a large single class to that class. You specify a kernel size, and the center pixel in the kernel is replaced with the class value represented by the majority of the pixels in the kernel.

map projection

A mathematical method of representing the earth on a flat plane. Hundreds of map projections are available to satisfy various project requirements (accurate distance, accurate navigation, equal area, etc.)
MAS

MODIS Airborne Simulator (NASA)

mask

An image consisting of zeros and ones that, when applied to another image, tells ENVI which pixels in that image to analyze (ones) and which pixels to ignore (zeros). A mask is useful, for example, if you want to calculate image statistics while ignoring missing data values.

mean spectrum

The average spectra of all pixels in an image or kernel.

MERIS

Medium Resolution Imaging Spectroradiometer; an ENVISAT sensor.

meta file

A virtual file in ENVI that is essentially a combination of image files or bands treated as the same input file. An ENVI meta file is a text file with names and locations of files on disk. When you select the meta file for input or processing, ENVI retrieves the image data from the individual disk files and treats them as if they were part of the same input file for processing.

minority analysis

A post-classification tool where you enter a kernel size, and the center pixel in the kernel is replaced with the class value represented by the minority of the pixels in the kernel.

MNF rotation

Minimum Noise Fraction; a transform used to determine the inherent dimensionality of image data, to segregate noise from the data, and to reduce the computational requirements for subsequent processing. MNF rotation consists of two principal component transformations, with a noise whitening step.

MODIS

Moderate Resolution Imaging Spectroradiometer; a NASA EOS sensor aboard the Aqua and Terra satellites.

MODTRAN

An atmospheric radiative transfer model developed by the Air Force Research Laboratory that predicts path radiances and transmissions through the atmosphere and can be used to describe vertical profiles of water vapor, ozone, and aerosols. The FLAASH module uses MODTRAN code.

morphological filter

A filter based on mathematical morphology that changes the shape and connectivity of an object. Unlike a convolution filter that multiplies neighborhood pixels by values you specify within a kernel, a morphological filter only works with the data in the neighborhood itself and uses either a statistical method or mathematical formula to modify the pixel upon which it is focused. The most common morphological filters are dilation, erosion, opening, and closing.

mosaic

A set of overlapping aerial or satellite-based images whose edges are matched to form a continuous pictorial representation of a portion of the Earth's surface.

MPEG

Moving Picture Experts Group; a data format for digital audio and video.
MRLC
Multi-Resolution Land Characteristic; a Landsat TM and DEM data format.

MSS
Multispectral Sensor; a Landsat sensor.

multiband file
A digital image that contains more than one band of data.

multilooking
A method for reducing speckle noise in synthetic aperture radar (SAR) data and for changing the size of a SAR file by averaging neighboring pixels throughout the image.

multispectral
The ability of a remote sensing instrument to detect wavelengths in two or more spectral bands.

nadir
The point on the ground that lies vertically beneath the perspective center of the aerial camera lens or satellite sensor.

NDVI
Normalized Difference Vegetation Index; a vegetation index used to transform multispectral data into a single image band whose values indicate the amount of green vegetation present in the pixel. ENVI uses the standard NDVI algorithm, where NIR is a near-infrared band: \( \text{NDVI} = \frac{\text{NIR} - \text{Red}}{\text{NIR} + \text{Red}} \)

NITF
National Imagery Transmission Format.

NLAPS
National Landsat Archive Production System; a Landsat TM and MSS data format.

NMEA
National Marine Electronics Association data format; the NMEA-0183 format is commonly used with a GPS.

NOAA
National Oceanic and Atmospheric Administration.

normalize
To transform a set of measurements so they may be compared in a meaningful way. Normalization commonly refers to rescaling minimum and maximum values between two or more data sets so all of the values range from 0 to 1, allowing the data sets to be directly compared.

NSIF
NATO Secondary Image Format; a data format similar to NITF that is used by members of the North Atlantic Treaty Organization (NATO).

object
A region of interest with spatial, spectral, and/or texture characteristics (brightness, color, etc.) that define the region.
object-based processing
Techniques that classify a set of input objects rather than classifying pixels individually.

offset
In the context of remote sensing: A correction value added to or subtracted from every pixel in an image, typically by using image arithmetic (Band Math in ENVI). A variable added to the gain in a regression equation for sensor calibration. The number of bytes of embedded header information present in the file (ENVI skips these bytes when reading the file).

OLS
Operational Linescan System; a NOAA DMSP data format.

orthorectify
To remove the effects of radial relief displacement and imaging geometry from remote sensing imagery.

panchromatic
A sensor that detects electromagnetic energy in one very broad band, which includes most of the visible light spectrum. In aerial photography, panchromatic refers to a type of film that is sensitive to all wavelengths of visible light.

PDS
Planetary Data System data format.

pedestal height
The height of a polarization signature (above 0), calculated by averaging the following four polarization combinations from SAR data: Orientation (deg) Ellipticity (deg) ------------------------ ------------------------
- 0 -45 90 -45 0 45 90 45

phase image
An image derived from polarimetric SAR data whose values represent the phase difference between the horizontal and vertical polarizations. The phase difference is measured in either radians or degrees and ranges from -pi to pi, or -180 degrees to 180 degrees.

PICT
Windows QuickDraw Picture format

Pixel Purity Index
A tool used to find the most spectrally pure (extreme) pixels in multispectral and hyperspectral images. These typically correspond to mixing endmembers. The PPI is computed by repeatedly projecting n-D scatter plots on a random unit vector. ENVI records the extreme pixels in each projection (those pixels that fall onto the ends of the unit vector) and it notes the total number of times each pixel is marked as extreme. A Pixel Purity Image is created where each pixel value corresponds to the number of times that pixel was recorded as extreme.

pixel-based processing
The traditional approach to exploitation and classification where each pixel in an image is treated as an independent data point.
plot function

In ENVI programming, a user function that you can add to and call from the Plot_Function menu of any ENVI plot window.

PNG

Portable Network Graphics image format.

polarization signature

A plot of radar backscattered power as a function of ellipticity and orientation angles of the incident radar wave.

polyline

A continuous line composed of one or more segments; a vector and annotation object.

Portal

A floating window in the Image window that allows you to view multiple layers in the Layer Manager simultaneously.

principal components analysis

A mathematical technique that transforms a multivariate data set into a new coordinate system such that the axes, or principal components, of the new coordinate system are uncorrelated. In remote sensing, an image is created for each principal component. Because the principal component rotation maximizes the variance in the first few principal components bands, these bands usually contain most of the coherent image information and can be used to isolate features in the data.

procedure

In ENVI programming, a sequence of one or more IDL statements that you can assign a name (thus creating an IDL program), compile, and call from the IDL or ENVI command line, using the following form: PROCEDURE_NAME, Argument [, Optional_Argument]

projected coordinate system

A coordinate system that uses Cartesian coordinates (x,y) to describe a geographic location.

proxy server

A server that sits between your computer and remote servers to which you connect. If you consistently have trouble connecting to remote servers, you may have a proxy server installed. The application does not attempt to connect through a proxy server, unless you specify one. JPIP/IAS servers do not support proxy servers.

pseudo projection

An affine map transformation that can be computed when a standard map projection is not available. ENVI applies a mathematical transformation to warp the image and calculate geographic coordinates for each pixel. The pixel size varies in the rectified image. This type of projection contains a high degree of variability and is not geographically accurate; the (x,y) locations in the rectified image are only "best guesses."

pyramid layers

Copies of a data set at various reduced resolutions. They are used to speed image display by reducing the resampling required when displaying large portions of an image at low resolution.
QUAC
Quick Atmospheric Correction; an automated atmospheric correction method in ENVI for retrieving spectral reflectance from multispectral and hyperspectral images.

QuickBird
A Digital Globe high-resolution satellite that provides 61 cm panchromatic and 2.4 m multispectral imagery.

QuickMap
An ENVI feature that allows you to quickly create a map composition from an image. You can add grid lines, scale bars, titles, north arrows, declination diagrams, and logos. You can save your settings as a QuickMap template that you can use with other images.

Quorum
A type of receiving station that creates AVHRR 16-bit High Resolution Picture Transmission (HRPT) files with two header frames. The Quorum format does not have georeferencing information.

RADARSAT
Radar Satellite (Canadian Space Agency).

radiance
A measure of the amount of electromagnetic radiation leaving a point on the surface. More precisely, it is the rate at which light energy is emitted in a particular direction per unit of projected surface area. The standard unit is W/m². Most remote sensing devices directly measure radiance.

raster
A grid-based data structure for storing images where each cell, or pixel, contains a single data value.

reflectance
The ratio of radiant energy reflected by a body to the energy incident on it, usually denoted as a percentage.

region
A broad term that refers to a group of pixels with the same spatial or spectral characteristics.

register
To geometrically align two or more images of the same scene so the images can be superimposed. The images can come from different viewpoints, different times, and different sensors. Following are the two most common methods of registration: Image-to-image registration: Correct a reference (warped) image to match base image geometry, using tie points between the two images. Image-to-map registration: Assign a reference image to geographic coordinates, using GCPs with known ground locations.

resample
To apply a geometric transformation to an original data set; more specifically, the interpolation method used to derive output pixel values based on input pixel values, taking into account the computed distortion. The most common resampling methods are Nearest Neighbor, Bilinear, and Cubic Convolution.
RGB
Red, Green, Blue; the primary colors that are mixed to display the color of pixels on a computer monitor.

RGB color composite
An image that uses the red, green, and blue guns of the display device to form a color additive representation of color.

RMS error
Root mean square error; a statistical measure that represents the difference between measured and predicted data points. In ENVI, RMS error is often used to evaluate a set of GCPs for georeferencing.

ROC curve
Receiver operating characteristic; a curve used to visualize the performance of a classification method, in order to select the proper decision threshold. ROC curves compare a series of rule image classification results for different threshold values with ground truth information.

ROI
Region of interest; a point, polyline, or polygon object drawn on an image, used to define a specific area of interest for extracting classification statistics, masking, and other operations in ENVI. From a processing standpoint, ROIs are pixel addresses with associated data.

routine
A general IDL programming term that refers to both functions and procedures.

RPC
Rational polynomial coefficients; used to build interior and exterior orientation in photogrammetry.

RSM
Replacement sensor model; an alternate representation of sensor geometric information that corrects the deficiencies of RPC-based sensor models. RSM contains a variety of enhancements over the RPC model, including: Increased accuracy over images with large number of rows or columns (such as image strips) by breaking the image into tiles with separate models. The ability to store varying degrees of complexity in the polynomial representation used.

RST
Rotation, scaling, and translation; a warping method used in image registration that uses an affine transformation with at least three ground control points.

rule image
An image calculated for each ROI in a supervised classification. They are called rule images because a rule is applied to the pixel values in the images to determine the class to which each pixel should be assigned. The pixel values in the rule images, and the rule used to assign classes, depend on the specific classifier used. For example, with Maximum Likelihood classification, the pixel values in a rule image for one class are equal to the likelihood that each pixel belongs to that class. Whichever rule image has the highest likelihood value for a pixel is the class to which that pixel is assigned.

RXD
Reed-Xiaoli anomaly detection algorithm.
sample

The x component of a raster image coordinate pair (x,y); same as column.

SAR

Synthetic aperture radar.

scale factor

A division factor used to convert integer-scaled reflectance or radiance data into floating-point values. For example, for reflectance data scaled into the range of 0 to 10,000, set the scale factor to 10,000. For uncalibrated integer data, set the scale factor to the maximum value the instrument can measure ((2^n) - 1, where n is the bit depth of the instrument).

scatter plot

A plot of measurements from two or more bands of data.

Scroll window

The window in a display group that displays the full image at subsampled resolution. This window appears only when an image is larger than what ENVI can display in the Image window at full resolution.

SDE

Spatial Database Engine; a database or information system containing spatial data that you can query. An "enterprise SDE" is a shared environment that allows multiple users to access the same database or information system.

SeaWiFS

Sea-viewing Wide Field-of-view Sensor; a NASA satellite that collects global ocean color data.

semivariance

A statistic that uses the squared difference between neighboring pixel values to provide a measure of dissimilarity within a dataset. It has the same units as the input dataset, and its values are greater than or equal to 0.

semivariogram

A plot of semivariance values at multiple lag distances; a measure of how autocorrelation decreases as distance increases.

shaded relief

An image created during the topographic modeling process that renders terrain in 3D by use of graded shadows that would be cast by the sun from a northwest direction.

shapefile

A vector file format; a set of files that contain points, arcs, or polygons that hold tabular data and a spatial location. One shapefile consists of three individual files, ending with .shp, .shx, and .dbf file extensions.

shift difference

The process of differencing adjacent pixels to the right and above each pixel and averaging the results to obtain the noise value to assign to the pixel being processed. The best noise estimate is gathered using the shift-difference statistics from a homogenous area rather than the whole image.
Sigma nought
A measure of the mean backscatter of a radar signal from an area of 1 m² on the earth's surface, typically denoted in decibels (dB). Sigma nought describes the backscattering strength of a distributed target, rather than a discrete target.

SIR-C
A synthetic aperture radar (SAR) instrument built by NASA/JPL and Ball Communication Systems Division for NASA. SIR-C flew aboard the Space Shuttle and provided L-band and C-band measurements.

slope
The percentage or degree change in elevation over distance; a parameter used in topographic modeling.

SMACC
Sequential Maximum Angle Convex Cone; a sub-pixel spectral tool in ENVI that finds spectral endmembers and their abundance throughout an image.

smooth
To average pixel values within adjacent areas to produce more gradual transitions.

solar azimuth
The angle a horizontal projection of a direct ray from the sun makes with the True North-south axis, typically denoted as clockwise from True North through 360 degrees.

solar elevation
The angle of the sun above the horizon, extending from 0 degrees (horizon) to 90 degrees (directly overhead).

solar spectrum
The part of the electromagnetic spectrum occupied by the wavelengths of solar radiation. About 99 percent of solar radiation is constrained to 300 nm (ultraviolet) to 3,000 nm (near-infrared).

spatial filter
A filter that removes certain spatial frequencies from an image and enhances features in the remaining image. A high pass filter enhances high spatial frequencies. A low pass filter enhances low frequencies in an image, thus smoothing the image. Following is a sample 3 x 3 kernel used for low-pass filters. An edge enhancement filter enhances edges of features in an image, making them easier to analyze.

spatial profile
A plot of pixel values along a line placed in the image.

spatial resolution
A measure of the smallest angular or linear separation between two objects that a sensor can resolve.

Spectral Analyst function
In ENVI programming, a user function that implements a custom spectral mapping method to match an unknown spectrum to the materials in a spectral library. You can add this user function to ENVI's Spectral Analyst and call it from the ENVI menu system.
Spectral Hourglass Wizard

A tool in ENVI that takes you through a step-by-step process for locating spectral endmembers within a hyperspectral data set and mapping their locations and sub-pixel abundances. When written in a certain format, the processing flow resembles an hourglass shape.

spectral library

A collection of spectra measured in the field or laboratory for materials (minerals, vegetation types, etc.) that are often used as a baseline, or true spectra, for identification of materials from spectral remote sensing imagery.

spectral mapping method

Also called a spectral similarity technique; a method in hyperspectral analysis for matching image spectra to known (reference) spectra, usually from a spectral library. Following are descriptions of the spectral mapping methods used in ENVI. Binary Encoding: A method that encodes data and endmember spectra into zeros and ones, based on whether a band falls below or above the spectrum mean, respectively. Linear Spectral Unmixing: A sub-pixel method that determines the relative abundance of materials depicted in multispectral or hyperspectral imagery based on the materials' spectral characteristics. LS-Fit: A linear band prediction method that uses least-squares fitting. You can use it to find regions of anomalous spectral response in a dataset. It calculates the covariance of the input data and uses it to predict the selected band as a linear combination of the predictor bands plus an offset. Matched Filtering: A method that finds the abundance of user-defined endmembers using a partial unmixing technique. Matched filtering maximizes the response of a known endmember and suppresses the response of the unknown background, thus matching the known signature. It provides a rapid means of detecting specific materials based on matches to library or image endmember spectra and does not require knowledge of all the endmembers within an image scene. Mixture Tuned Matched Filtering (MTMF): A method that performs Matched Filtering and adds an infeasibility image to the results. The infeasibility image is used to reduce the number of false positives that are sometimes found when using Matched Filtering. Spectral Angle Mapper (SAM): A physically-based spectral classification method that uses an n-D angle to match pixels to reference spectra. The algorithm determines the spectral similarity between two spectra by calculating the angle between the spectra and treating them as vectors in a space with dimensionality equal to the number of bands. Spectral Feature Fitting (SFF): A method that compares the fit of image spectra to reference spectra using a least-squares technique. SFF is an absorption-feature-based methodology. The reference spectra are scaled to match the image spectra after the continuum is removed from both data sets.

Spectral Math

An ENVI tool that allows you to apply mathematical expressions or IDL procedures to spectra and to selected multiband images, as long as the number of bands and spectral channels match.

spectral resolution

The wavelength range that a particular band measures. For example, Landsat-7 ETM+ Band 1 detects wavelengths from 0.45 microns to 0.52 microns. The Landsat-7 ETM+ panchromatic band detects wavelengths from 0.50 microns to 0.90 microns. So, Band 1 has a finer spectral resolution than the panchromatic band. Spectral resolution does not refer to the number of bands available from a particular sensor.

SPOT

Satellite Pour l'Observation de la Terra; a series of earth observation satellites launched by Spot Image of France; the spatial resolution of SPOT data varies from 2.5 to 20 m.
SRF
Spectral response function; engineering data that quantify the spectral response and sensitivity of
detectors on an airborne or satellite sensor. The term SRF also refers to a data format that contains SRF
data for particular sensors.

SRTM
Shuttle Radar Topography Mission (NASA/JPL).

statistics
Numbers or values that help describe the characteristics of a selected group of data.

subsample
To create an output image of reduced resolution based on every nth pixel from an input image.

super GLT
A geographic lookup table (GLT) file that contains information about how many and which input pix-
els contribute to the output pixel; a super GLT is not an image file.

synthesize
With respect to polarimetric radar data, the process of building an image representing backscatter at
specified ellipticity and orientation angles from a scattering (or related) matrix.

system calibration
The process of converting digital numbers (DNs, which represent the sensor response) in a remote
sensing image to radiance or reflectance above the atmosphere, using pre-launch gain and offset val-
ues.

targets
Materials with a known spectral signature that you want to identify in an image. Examples include
minerals, vehicles, and vegetation types.

temporal resolution
How often a sensor obtains imagery of a particular area.

texture
The frequency of change and spatial arrangement of pixel values in an image, as a function of spatial
scale. A flat image in which all digital numbers (DNs) are equal is said to have a uniform texture.

texture filter
A filter used to delineate surface features (for example, biophysical properties of a forest canopy) that
cause local variations in image brightness. A texture filter is helpful for identifying objects that are
more characterized by their texture than by intensity.

thermal band
A band that detects radiation from the far infrared part of the electromagnetic spectrum, between ap-
proximately 7.0 to 15 microns. A thermal band detects emitted, rather than reflected, radiation from
the earth.
threshold

A value above which a process is performed and below which it will not be performed. For example, you can specify a change threshold of 50 percent in a K-Means supervised classification, which means the clustering process ends when the number of pixels in each class changes by 50 percent or less.

tie points

The location of a single feature across two overlapping images, used in image-to-image registration.

TIFF

Tagged Image File Format

tile

For ENVI to process images that are much larger than the total amount of RAM available on the system, large images are broken into pieces that are small enough for the system to handle. Each piece is called a tile. When the image is processed, only one tile is read into memory at a time.

TIMS

Thermal Infrared Multispectral Scanner; a NASA/JPL and Daedalus Enterprises sensor.

TM

Thematic Mapper; a Landsat sensor.

TOPSAR

Topographic Synthetic Aperture Radar; a NASA/JPL airborne radar interferometer.

transform

An image processing operation that changes data to another data space, usually by applying a linear function. The goal of most transforms is to improve the presentation of information. Transformed images are often more easily interpreted than the original data.

true-color composite

An image where the red band (0.6 to 0.7 microns) is displayed in red, the green band (0.5 to 0.6 microns) is displayed in green, and the blue band (0.4 to 0.5 microns) is displayed in blue.

user function

A custom program that you can write in IDL, C, Fortran, or another high-level programming language that performs an interactive ENVI processing task. If you write a user function in IDL, you can incorporate ENVI library routines into the code and call the user function from the ENVI menu system to run it.

user-defined RPC reader

In ENVI programming, a user function that reads a custom rational polynomial coefficients (RPC) file format. You can add the user function to, and call it from, the Generic RPC menu option in ENVI.

USGS

United States Geological Survey.
UTD

Uniform Target Detector; an anomaly detection algorithm in which the anomaly is defined using \((1 - m)\) as the matched signature, rather than \((r - m)\). UTD and the RXD algorithm work exactly the same, but instead of using a sample vector from the data (as with RXD), UTD uses the unit vector. UTD extracts background signatures as anomalies and provides a good estimate of the image background.

UTM

Universal Transverse Mercator map projection; a system of plane coordinates based upon 60 north-south zones, each 6 degrees of longitude wide, that circle the earth. UTM coordinates consist of the Zone number, an easting (distance in meters or kilometers east of the western edge of the Zone), and a northing (distance in meters or kilometers from the equator).

UUID

Universally Unique Identifier; an identifier standard used in software development that enables distributed systems to uniquely identify information without significant central coordination.

vector

A data structure for storing spatial data that consists of points, lines, and polygons. Lines (also called arcs) are defined by beginning and end points, which meet at nodes. The locations of these nodes and the topological structure are usually stored explicitly.

vegetation index

A measure of some vegetation property calculated from reflected solar radiation measurements made across the optical spectrum (400 to 3,000 nm). A vegetation index is constructed from reflectance measurements in two or more wavelengths to analyze specific characteristics of vegetation, such as total leaf area and water content.

vertical exaggeration

The process of multiplying all of the elevation values in a DEM by a scale factor to exaggerate the landscape's relief when viewed in a 3D perspective.

virtual border

An annotation object that consists of a temporary border around an image displayed in ENVI. You can enter the border width (in pixels) and place other annotation objects within the virtual border.

Virtual Mosaic

A saved mosaic template used as an alternative to saving a mosaic to disk. When you restore a Virtual Mosaic template file, ENVI opens the individual image files that make up the mosaic and puts them together on the fly. You can display a Virtual Mosaic file in ENVI and annotate it, stretch it, etc., like any other image. Using a Virtual Mosaic prevents multiple files from containing the same images and therefore saves disk space.

warp

To stretch an image to fit its ground control points (GCPs), so that distance and area are uniform in relationship to real-world measurements. ENVI performs warping with rotation, scaling, and translation (RST); polynomial, or Delaunay triangulation.

wavelength

Velocity divided by frequency of an electromagnetic wave. In general, the mean distance between maxima or minima of a roughly periodic wave pattern.
widget
A simple graphical object such as a push button or slider, created in IDL, that allows user interaction with a pointing device (usually a mouse) and a keyboard. You can construct and manipulate graphical user interfaces in IDL using widgets.

WorldView-1
A Digital Globe high-resolution satellite that provides 50 cm panchromatic imagery.

WorldView-2
A Digital Globe high-resolution satellite that provides 46 cm panchromatic imagery.

X Profile and Y Profile
A cross-section of data along the x-axis, and y-axis, of an image, respectively. X and Y Profiles are also called horizontal and vertical profiles, respectively.

XSTART and YSTART
Variables in an image header file that define the image coordinates for the first pixel in the image. For most images, ENVI sets the default XSTART and YSTART values to 1, defining the first pixel in an image with a coordinate of (1,1). Thus, if the image were an IDL 2D array variable, the data contained in subscript position [0, 0] correspond to image coordinates (1,1). If XSTART or YSTART are set to any other values (including negative numbers or 0), the image coordinates begin incrementing from these values.

XWD
X Windows Dump

Z Profile
A spectrum plot of the pixel under the cursor, through all bands of the image.

Zoom box
The red box inside an Image window that defines the extent of the Zoom window.

Zoom window
The window in a display group that displays the subsection of the image defined by the Image window Zoom box. The resolution is at a user-defined zoom factor based on pixel replication or interpolation.
Index

A
ancillary data 97
annotations 180
  adding to an annotation layer 182
  arrows 185
  creating layers 181
  deleting 188
  deleting segments (NITF) 228
  displaying 61
  editing properties 186
  in Print Layout view 201
  pictures 185
  polygons 183
  polylines 183
  segments (NITF) 211
  symbols 182
  text 182
  tips and tricks 189
  toolbar buttons 18
anomaly detection 86
ArcMap 59
  exporting datasets to 59
  exporting image display to 199
  geolink with image window 75
arrow annotations 185
attribute tables 169
attributes (feature extraction) 104
  band ratio 108
color space 108
images 120
selecting in supervised classification 115
spatial 106
spectral 107
texture 108
automatically displaying files 40
B
band ratio attribute 108
band selection 60
base images 96
base layers 29
blending 81
brightness 23
C
category bars 25
change detection
  cleanup 145, 148
  image difference 142
  refining results 145, 148
  thematic 147
chipping 198
  the display 198
  the display to NITF 232
  to ArcMap 199
  to disk 198
classification 133
  cleanup 139
  defining training data 138
  exporting results 139
  method 136
  refining results 139
  rule-based 118
  selecting input file 133
  supervised 137
  supervised (feature extraction) 110
  unsupervised 136

cleaning up classification results 139

closing files 62
color space attributes 108
compression types (NITF) 231
computer graphic metafile (CGM) 211
contrast 23
copyrights 2
crosshairs 17
CSSHPA DES 217
cursor path history 25
cursor value 35

D
data extension segments (DESes) 213
data manager 58
  displaying annotation layers 61
  displaying ESRI layers and feature classes 60
  displaying grayscale images 60
  displaying multispectral images 59
  displaying vector layers 61
  file information 62
  preferences 40
  selecting bands 60
  toolbar 58
DIGEST TRE 222
directories 41
display levels (NITF) 220
  annotation segments 211
  image segments 209
Douglas-Peucker algorithm 165
DTED data 52
dynamic range adjustment 23

E
EPJE compression 231
equalization stretches 23
error messages 39
ESRI layers 60
exporting
  Adobe Illustrator Vector Graphic (.ai) 202
  Bitmap (.bmp) 202
  classification results 139
  Encapsulated PostScript (.eps) 202
  feature extraction results to images 125
  feature extraction results to shapefiles 124
  Graphics Interchange Format (.gif) 202
  image difference change detection results 145
  JPEG (.jpg) 202
  Portable Document Format (.pdf) 202
  Portable Network Graphics (.png) 202
  Scalable Vector Graphics (.svg or .svgz) 202
  Tagged Image File Format (.tif) 202
  thematic change detection results 149
  vector objects to shapefiles 109
  Windows Enhanced Metafile (.emf) 202

F
favorite servers 73
feature class 61
feature counting 172
  creating feature types 173
  deleting 174
  editing properties 173
  jump to feature 176
  marking features 173
  restoring data 177
  saving layer 175
  toolbar button 17
  viewing feature report 178
feature extraction 94
  introduction 94
  masks 97
  method 109
  preferences 126
  file formats 52
  file information 62
  flickering 81
  flying 16
  Full Lambda-Schedule algorithm 102
  fuzzy logic 119
  fuzzy tolerance 121
G
Gaussian stretches 23
geodatabases 66
  opening 73
  refreshing 70
  remote connections 69
  retaining display enhancements when saving 195
  saving 194
  specifying connection URLs 72
  supported platforms 64
GeoEye-1 data 54
geoid offset value 151
geolink with ArcMap 75
GEOLOB TRE 222
GEOPSB TRE 222
GeoTIFF files with metadata 53
go to tool 20
graphic segments (NITF) 211
ground truth data 114
H
history 25
HSI color space 108
I
IAS servers 65
  managing connection properties 72
  NITF data 66
ICORDS 222
IGEOLO 222
image difference change detection 141
  exporting results 145
  feature index 142
  input band 142
  selecting input files 142
  thresholding 144
image processing toolbox 33
image segments (NITF) 209
  chipping 232
  saving 235
image tiles 55
image window 13
  linking with ArcMap 75
input file formats 52
interactive stretching 24
interface 12
IREP field (NITF) 224
IREPBand field (NITF) 224
ISODATA classification 136
J
JITC 206
JPEG 2000 servers 65
JPIP servers
  JPEG 2000 65
  JPIP 65
  managing connection properties 72
jumping to a location 20
K
K Nearest Neighbor classification 117
L
label segments (NITF) 211
Landsat data 53
layer manager 28
layer stacking 97
layers 28
  active 30
  base 29
  creating annotation layers 181
  creating vector layers 157
  editing 30
  ESRI 60
  hiding and showing 32
  loading into portals 33
  ordering 32
  portal zoom options 83
  removing 32
  selecting 30
  spatial resolution 29
  turning on and off 32
  types 28
  zoom options 32
linear stretches 23
linking
  image window with ArcMap 75
logarithmic stretches 23
M
Mahalanobis classification 137
map information 29
  chipping in NITF 233
  layers 29
  NITF 222
  reading in NITF 223
  saving in NITF 235
map layout view 201
map template 201
Print Layout view 45
MAPLOB TRE 222
masks
creating 99, 135
creating in Refine step 104
in feature extraction 97
in workflows 134
inverse 99
NITF 234
selecting in feature extraction 99
selecting in workflow 135
maximum likelihood classification 137
measuring 22
membership function set types 121
mensuration 22
merging segments 101
metadata (NITF)
adding text segments 227
creating PIA TREs 227
ing feature extraction 99
editing 227
icons 225
viewing 225
minimum distance classification 137
multiple files 28
N
NITF 206
adding, editing, deleting text segments 227
annotation objects 212
annotation segments 211
chipping image segments 232
chipping the display 232
compression types 231
data extension segments 213
data segments 207
deleting annotation segments 228
display levels 220
displaying wavelength information 221
graphic segments 211
IAS servers 66
image segments 209
label segments 211
main header 207
preferences 218
rules for displaying images 224
saving image segments 235
saving wavelength information 236
security segments 209
segments 208
symbol segments 211
technical specifications 207
text segments 212
viewing metadata 225
NITF metadata
adding text segments 227
creating PIA TREs 227
ing feature extraction 99
editing 227
icons 225
NPJE compression 231
O
OGC servers 64
keywords 67
WCS 65
WMS 65
opening 53
file formats 52
files in ArcMap 59
geodatabases 64
remote datasets 64
optimized linear stretches 23
orthorectification 150
geoid correction 151
selecting input files 150
output formats 192
output to memory 192
overview window 25
multiple images 26
path history 25
view box 25
P
pan sharpening 88
panning 16
path history 25
performance tips and tricks 50
PIA TREs
creating 227
preserving 237
picture annotations 185
pixel information 17
polygons 183
annotations 183
ellipse 184
rectangle 184
training data 138
polyline annotations 183
portals 78
blend, flicker, swipe 80
closing 83
loading layers 33
moving 83
panning 83
resizing 83
toolbar 80
toolbar buttons 22
working with 79
preferences 38
annotations 46
application 39
arrow annotations 47
data manager 40
directories 41
display 41
feature extraction 126
NITF 218
overview window 41
picture annotations 47
polygon annotations 47
polyline annotations 47
print layout 45
pyramids 44
symbol annotations 46
text annotations 46
vectors 48
preview portals 93
in feature extraction 100
in workflows 93
print layout exports 202
print layout view 201
process manager 14
projections 29
pyramids 55
building 55
preferences 44
Q
quadtreess 56
R
RapidEye data 53
rectangularizing polygons 166
reduced resolution 55
refining segments 103
region means images 101
remote datasets 64
authentication 68
connecting directly to JPIP, IAS, OGC
datasets 66
connecting to servers and geodatabases 69
connection properties 72
editing properties 71
favorites 73
managing 69
specifying URLs 72
supported platforms 64
reports (feature extraction) 125
reprojecting images 29
rotating the display 19
RPC00A and RPC00B TREs 222
RPCs
base layers 29
NITF 222
orthorectification 150
reading NITF 223
RSETs 55
rule confidence images 120
rule sets 122
adding and deleting 122
building 120
displaying 122
rule-based classification 118
building rules 120
editing feature properties 111
editing rule properties 122
exporting results to images 125
exporting results to shapefiles 124
managing features and rules 122
previewing results 124
selecting attributes 120
RX anomaly detection 86
S
saving files 192
chipping the display to NITF 232
exporting to other file types 202
NITF 229
NITF compression types 231
NITF Save As 234
preserving NITF TREs 237
scale level 100
scaling Print Layout view 45
screen captures
chip to file 16
output chip 198
security segments (NITF) 209
segmenting images 100
sharpening
display 24
pan 88
smoothing polygons 164
smoothing vectors (feature extraction) 125
spatial attributes 106
spatial subsetting 196
Spectral Angle Mapper classification 137
spectral attributes 107
spectral subset 196
square root stretches 23
statistics (feature extraction) 125
status bar 14
  preferences 44
stretching 23
  interactive 24
  preferences 43
  types 23
subsetting
  spatial subset 196
  spectral subset 196
supervised classification 137
  feature extraction 110
    adding and deleting features 111
    choosing a method 116
    editing feature properties 111
    exporting results to images 125
    exporting results to shapefiles 124
    ground truth data 114
    K Nearest Neighbor 117
    previewing results 115
    saving and restoring training data 112
    selecting attributes 115
    Support Vector machine 117
    training data 138
Support Vector Machine classification 117
supported formats 52
swiping 82
symbol segments (NITF) 211
symbols 182
  annotations 182
  training data 138
system logging 39
T
tagged record extensions (TREs) 213
  GeoSDE 222
  PIA 227
  preserving PIA TREs 237
preserving TREs 237
RPC00A 222
RPC00B 222
text annotations 182
text segments (NITF) 212
  adding 227
texture attributes 108
thematic change detection 147
  changed areas 148
  exporting results 149
  selecting input files 147
thresholding 103
  feature extraction 103
  image difference change detection 144
toolbar buttons 15
toolbox 33
training data
  defining in classification 138
  defining in feature extraction 110
  editing 113
  file format 112
  options for saving and restoring 112
  restoring 113
  saving 112
transcoding (NITF) 231
transparency 24
troubleshooting
  annotations 189
  feature extraction 128
  performance 50
  vectors 170
U
unsupervised classification 136
US message text format (USMTF) 212
UTD anomaly detection 86
V
vectors 154
  adding vertices 161
  attribute tables 169
  creating layers 157
  creating records 158
  data reduction 56
  deleting records 164
  deleting vertices 163
  displaying 61
  editing 160
  grouping 162
  joining polylines 161
  layer properties 168
merging 161
moving points 160
multipart 158
multipoint 158
quad display 56
rectangulating 166
removing holes 163
selecting 160
smoothing 164
splitting 162
tips and tricks 170
toolbar buttons 17
ungrouping 162
working with 155
vegetation suppression 90
vertices 160
  adding 161
  deleting 163
  editing 160
  moving 160
  selecting 160
  snapping 161
view box 25

W
wavelength information (NITF)
  displaying 221
  saving 236
WCS servers 65
  managing connection properties 72
WMS servers 65
  managing connection properties 72
workflows 92
  classification 133
  feature extraction 94
  image difference change detection 141
  masks 134
  orthorectification 150
  thematic change detection 147
  toolbox 33

Z
zooming 20
  layers 32
  portal layers 83
  preferences 41
  toolbar buttons 20